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1. Introduction to MCUXpresso IDE

1.1

MCUXpresso IDE User Guide -

MCUXpresso IDE version 11.0.0 is a low-cost microcontroller (MCU) development platform
ecosystem from NXP. It provides an end-to-end solution enabling engineers to develop
embedded applications from initial evaluation to final production.

The MCUXpresso platform ecosystem includes:

. - a software development environment for creating applications for
NXP’s ARM Cortex-M based MCUs including “LPC”, “Kinetis” and iMX RT" ranges.

. (introduced in MCUXpresso IDE version 10.1), comprising
of Pins, Clocks and Peripherals Tools that are designed to work with SDK projects and are
fully integrated and installed by default.

. , each offering a package of device support and example software
extending the capability and part knowledge of MCUXpresso IDE.

e The range of LPCXpresso development boards, each of which includes a built-in “LPC-
Link”, “LPC-Link2", or CMSIS-DAP compatible debug probe. These boards are developed in
collaboration with Embedded Artists.

¢ The range of Tower and Freedom development boards, most of which include an OpenSDA
debug circuit supporting a range of firmware options.

¢ Therange of IMX RT Series EVK development board which include an OpenSDA debug circuit
supporting a range of firmware options, or high performance FreeLink (LPC-Link2 compatible)
debug probe.

¢ The standalone “LPC-Link2” debug probe.

This guide is intended as an introduction to using MCUXpresso IDE. It assumes that you have
some knowledge of MCUs and software development for embedded systems.

Note: MCUXpresso IDE incorporates technology and design from LPCXpresso IDE. This means
that users familiar with LPCXpresso IDE will find MCUXpresso IDE looks relatively familiar.

MCUXpresso IDE Overview of Features

MCUXpresso IDE is a fully featured software development environment for NXP's ARM-
based MCUs, and includes all the tools necessary to develop high-quality embedded software
applications in a timely and cost effective fashion.

MCUXpresso IDE is based on the Eclipse IDE and includes the industry standard ARM GNU
toolchain. It brings developers an easy-to-use and unlimited code size development environment
for NXP MCUs based on Cortex-M cores (LPC, Kinetis and iMX RT). The IDE combines the
best of the widely popular LPCXpresso and Kinetis Design Studio IDE’s, providing a common
platform for all NXP Cortex-M microcontrollers.

MCUXpresso IDE is a free toolchain providing developers with no restrictions on code or
debug sizes. It provides an intuitive and powerful interface with profiling, power measurement
on supported boards, GNU tool integration and library, multicore capable debugger, trace
functionality and more. MCUXpresso IDE debug connections support Freedom, Tower, EVK,
LPCXpresso and custom development boards with industry leading open-source and commercial
debug probes including LPC-Link2, P&E and SEGGER.

The fully featured debugger supports both SWD and JTAG debugging, and features direct
download to on-chip and external flash memory.

For the latest details on new features and functionality, please visit:

http://lwww.nxp.com/mcuxpresso/ide
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1.1.1

MCUXpresso IDE User Guide -

Summary of Features

Complete C/C++ integrated development environment

» Eclipse-based IDE with many ease-of-use enhancements
* Built on Eclipse 2018-12 and CDT 9.6.0
¢ The IDE installs with various Eclipse Plugins including:
 Git, and support for P&E Micro debug probes
« The IDE can be further enhanced with many other Eclipse plugins
e Command line tools are included for integration into build, test, and manufacturing systems

Industry standard GNU toolchain GCC v 8.2.1 2018g4-Release including:

¢ C and C++ compilers, assembler, and linker
e Converters for SREC, HEX, and binary

Advanced project wizards

« Simple creation of pre-configured applications for
« Extendable with

» Device-specific support for NXP's ARM-based MCUs (including LPC, Kinetis and iMX RT)

. of linker scripts for correct placement of code and data into Flash
and RAM
« Extended support for flexible placement of

¢ Automatic generation of MCU-specific startup and device initialization code

* Note: No assembler required with Cortex-M MCUs

Advanced multicore support

 Provision for for each core in multicore MCUs
¢ Debugging of within a single IDE instance, with the ability to link
various debug views to specific cores

Fully featured native debugger supporting SWD and JTAG connection via LinkServer

¢ Built-in optimized for internal and external QSPI and Hyper Flash
¢ High-level and instruction-level

. and

* Views of CPU and on-chip

¢ Support for multiple devices on the JTAG scan-chain

Full install and integration of 3rd party debug solutions from:

Library support

¢ Redlib: a small-footprint embedded C library
¢ RedLib-nf: a smaller footprint library offering reduced fprintf support
« RedLib-mb: a library variant offering enhanced semihosting performance
* Newlib: a complete C and C++ library
* NewlibNano: a new small-footprint C and C++ library, based on Newlib
¢ LPCOpen MCU software libraries
¢ Cortex Microcontroller Software Interface Standard (CMSIS) libraries and source code
« Extendible support per device via MCUXpresso SDKs

Trace functionality

« Instruction trace via Embedded Trace Buffer (ETB) on certain Cortex-M3/M4/M7 based MCUs
or via Micro Trace Buffer (MTB) on Cortex-M0O+ based MCUs
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» Providing a snapshot of application execution with linkage back to source, disassembly and
profile
e SWO Trace on Cortex-M3/M4 based MCUs when debugging via LPC-Link2, providing
functionality including:
* Profile tracing
« Interrupt tracing
« Datawatch tracing
* Printf over ITM
* Note: Now extended to work with P&E Micro and SEGGER J-Link, in addition to native
LinkServer

LinkServer Power Measurement

¢ On LPCXpresso boards, sample power usage at adjustable rates of up to 200 ksps; average
power usage display option

e Explore detailed plots of collected data in the IDE

« Export data for analysis with other tools

MCUXpresso Configuration Tools

. , designed to work with SDK projects are fully integrated
and installed by default

1.1.2 Supported Debug Probes

MCUXpresso IDE installs with built in support for 3 debug solutions. This support includes the

installation of all necessary drivers and supporting software.

Note: Certain mbed boards require a serial port driver to be recognised and this one exception

must be installed separately for each board. The driver is linked from Help -> Additional

Resources -> MBED Serial Port Driver Website

In normal use MCUXpresso IDE presents a similar interface and array of features for each of

the solutions listed below:s

Native LinkServer (including CMSIS-DAP) as also used in LPCXpresso IDE

« this supports a variety of debug probes including OpenSDA programmed with CMSIS-DAP
firmware, LPC-Link2 etc.

« https://community.nxp.com/message/630896

P&E Micro

« this supports a variety of debug probes including OpenSDA programmed with P&E compatible
firmware and MultiLink and Cyclone probes

* http://www.pemicro.com/

SEGGER J-Link

e this supports a variety of debug probes including OpenSDA programmed with J-Link
compatible firmware and J-Link debug probes

¢ https://lwww.segger.com/

Please see for more details.

Note: Kinetis Freedom and Tower boards typically provide an on-board OpenSDA debug circuit.

This can be programmed with a range of debug firmware including:

« mBed CMSIS-DAP — supported by LinkServer connections

e DAP-Link — supported by LinkServer connections (DAP-Link is preferred to mBed CMSIS-DAP
when available)
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e J-Link — supported by SEGGER J-Link connections
¢ P&E — supported by P&E connections

The default firmware can be changed if required, for details of the procedure and range of
supported firmware options please information visit: http://www.nxp.com/opensda

Tip

@ Under Windows 10, OpenSDA Bootloaders might experience problems and the
OpenSDA LED will blink an error code. The following article discusses the problem
and how it can be fixed: https://mcuoneclipse.com/2018/04/10/recovering-opensda-
boards-with-windows-10

1.1.3 Development Boards

NXP have a large range of development boards that work seamlessly with MCUXpresso IDE
including:

LPCXpresso Boards for LPC

These boards provide practical and easy-to-use development hardware to use as a starting point
for your LPC Cortex-M MCU based projects.

¥ A9 0000VWO _

Figure 1.2. LPCXpresso Development Board (LPCXpresso54608)

For more information, visit: http://www.nxp.com/lpcxpresso-boards
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Freedom and Tower Boards for Kinetis

Similarly, for Kinetis MCUs there are many development boards available including the popular
Freedom and Tower ranges of boards.

ST

Figure 1.3. Tower (TWR-KV58F220M)

For more information, visit: http://www.nxp.com/pages/:TOWER_HOME

Figure 1.4, Freedom (FRDM-K64F)

For more information, visit: http://www.nxp.com/pages/:FREDEVPLA
iMX RT Crossover Processor Boards

iMX RT based boards bring the convergence of low power applications processors with high-
performance microcontrollers.
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Figure 1.5. i.MX RT Series (MIMXRT1050-EVK)

For more information, visit: https://www.nxp.com/pages/:IMX-RT-SERIES
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2. New Features in MCUXpresso IDE 11.0.0

MCUXpresso IDE User Guide -

The MCUXpresso IDE team are pleased to bring a host of new features to this release continuing
our strategy of both customer focused and general product improvements, including:

Product

¢ Improved capability simplifying the update procedure for Mac and Linux
users inline with users of Windows

IDE
¢ New for all debug solutions
» shows usage against allocated RAM allocation for bare metal
projects
* Live Heap updates and stack when paused
¢ New extends and replaces the Symbol Browser

« incorporating detailed memory usage plus hyperlinked Memory Content and Static Call
Graph display

¢ Revamped
* New Editor for linker scripts, linker templates and debug map files
« providing linked navigation of file contents
¢ Quick Start panel -> now displays the current settings for Library
Debug
* Redesigned LinkServer dialogue offering improved functionality

and ease of use
« this is reflected in a new LinkServer Launch configuration icon
« New launch configuration tab for all debug solutions to allow the loading of
from additional images
« Improved performance for Single Stepping LinkServer debug connections
« Implemented support for SWO Trace on Cortex-M33 based MCUs
. are now available for SEGGER JLINK and P&E Micro debug
probes in addition to LinkServer LPC-Link2
¢ LinkServer internal flash drivers prioritised over supplied SDK drivers

. now Multicore aware ensuring slave project attach settings
are observed

¢ Improved now displays Fault Address when available

Project

e Imported or new will now expand to show the source file containing the main

function and also open this file within the editor
¢ Improved display of Components in
¢ Quick Start panel -> now displays the current settings

SDK

« Improved SDK installation and refresh time
¢ Redesigned New and Import SDK example wizard
* incorporating Error Decorators

Please also see the supplied ReadMe document for further information and details of bug fixes
etc. This document is located within the product’s installation folder.
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3. Features introduced in MCUXpresso IDE version 10.3.0
and 10.2.0

Below are the significant features introduced in the last two major releases of MCUXpresso IDE
(10.3.0 shown first).

MCUXpresso IDE User Guide -

Product

Major product restructuring to support the roll out of (new features/bug
fixes) to existing installations via the Eclipse Software update mechanism
« Scripts to create a command line environment now supplied in DOS and Bash versions
» Use of these scripts is described within the Installation Guide
SDK installation options improved, see
Windows version now uses Busybox (from the GNU MCU Eclipse Windows Build Tools project)
to provide Unix-like layer for GCC tools
v10.2.0:
All previous Pro Edition features have been incorporated into the standard Free edition and
the Pro edition has been discontinued
Built upon latest Eclipse Oxygen and offering significantly faster project builds
¢ includes a new

IDE

New automatically displayed (for LinkServer) should a CPU fault occur
Improved with enhanced display and grouping options

are now only automatically generated for the selected build
configuration
Project can now be edited in place for settings and wizards

Project Explorer view enhanced to display current project build configuration for the selected
project (also displayed in Quickstart view)

Preliminary support for new MCUs based on the ARM Cortex M33

v10.2.0:

Redesigned

« with links for for all supported Debug Solutions

Support for new MCUs both via internal part support and also new version 2.4 SDKs

Projects

Project association with an SDK (MCU) can now be flexibly managed, maintaining existing
memory configuration if desired see
v10.2.0:
Many enhancements for improved includng:
» Drag and Drop of projects for import and export
« Options for project local inclusion of: SDK part support, flash drivers, and LinkServer connect
and reset scripts

introduced to enable easy visibility and editing of project

configurations
for all debug solutions delivered via project launch

configurations

Debug

SWO trace features are now available for SEGGER JLINK and P&E Micro debug probes in
addition to LinkServer LPC-Link2

LinkServer LPC-Link2 firmware now softloaded as v5.224 and offers faster operation and
improved flash programming performance

All information provided in this document is subject to legal disclaimers © 2019 NXP Semiconductors. All rights reserved.
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LinkServer debug probes now support selection via their serial number (for command line use)
v10.2.0:
Increased integration of our supported debug solutions including:
. is re-architected to provide support for LinkServer, P&E and
SEGGER debug solutions
« offering binary flash programming and erase capability for all supported debug solutions
 with a feature set integrated into the QuickStart panel, project Launch Configurations and
from the IDE as before
« Instruction trace is seamlessly supported by LinkServer, P&E and SEGGER debug solutions
including printf are further optimised to deliver
approximately double the performance of the previous release
via new library variant Redlib MB and
LinkServer which can deliver both a further increase in performance and no disruption to code
executing with time critical interrupts
LinkServer
« Live global variable values can now be traced both in graphical and tabular forms
to simplify complex peripheral views

LinkServer Flash Programming

extended to support iMX RT MCUs
Programming of data flash regions on certain Kinetis parts is now supported
Improved flash programming performance and reliability
v10.2.0:
LinkServer via self configuring flash
drivers
« using JEDEC SFDP (Serial Flash Discovery Protocol) available for LPC18/43, LPC546xXx,
LPC540xx (iMX RT to be made available post release)

SDK

MCUXpresso IDE User Guide -

SDK part support is now generated within the current workspace eliminating issues that could
arise if multiple IDEs were launched

 part support is intelligently regenerated when required avoiding unnecessary delays

SDK drag and drop location can now be set via a workspace preference

Installed SDK view improved to display version information and enhanced tooltips

v10.2.0:

SDK Manifest Analyser to provide visibility of SDK XML description

Easy access to

Extension of SDK Component Management to allow

* improved SDK Component Management

General Improvements in SDK Handling including:

» SDK version string now present and reported in SDK view (SDK version 2.4 only)
« user selection of versioned internal XML descriptions (enabled via preference)
 better automatic support for SDKs with overlapping capabilities

All information provided in this document is subject to legal disclaimers © 2019 NXP Semiconductors. All rights reserved.
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4. IDE Overview

The following chapter provides a high level overview of the features offered by the IDE itself.

4.1

MCUXpresso IDE User Guide -

Documentation and Help

MCUXpresso IDE is based on the Eclipse IDE framework, and many of the core features
are described well in generic Eclipse documentation and in the help files to be found on the
MCUXpresso IDE’s Help -> Help Contents menu. It also provides access to the MCUXpresso
IDE User Guide (this document), as well as the documentation for the compiler, linker, and other
underlying tools.

MCUXpresso IDE documentation comprises a suite of documents including:

¢ MCUXpresso IDE Installation Guide

* MCUXpresso IDE User Guide (this document)

e MCUXpresso IDE LinkServer SWO Trace Guide

*« MCUXpresso IDE LinkServer Instruction Trace Guide

e MCUXpresso IDE LinkServer Power Measurement Guide
e MCUXpresso IDE FreeRTOS Debug Guide

*« MCUXpresso (IDE) Config Tools User’'s Guide

To obtain assistance on using MCUXpresso IDE, visit: http://www.nxp.com/mcuxpresso/ide

Related web links can be found at Help -> Additional resources as shown below:

Search |

() Help Contents

MCUXpresso IDE User Guide
%' Search

Show Contextual Help

Show Active Keybindings... 8L
Tips and Tricks...
Cheat Sheets...

@ Eclipse User Storage >
% Check for Updates

gk Install New Software...

& Eclipse Marketplace...

®2 Additional resources

[ Product Information
s MCUXpresso IDE support forum

A

Show welcome page

MCUXpresso IDE website

MCUXpresso SDK website
MCUXpresso SDK Builder

LPCOpen Resources

» Code Bundles for LPCBOO Family devices

» OpenSDA probe firmware

LPCScrypt - LPC-Link2 probe firmware

» LPC11U35 CMSIS-DAP probe firmware

=
a8
=

SEGGER J-Link website
PEMicro website

MBED Serial Port Driver website
'MCU on Eclipse' blogs

When MCUXpresso IDE is launched, a Welcome page is displayed (usually within the Editor
view). This page contains product information including a link to the User Guide. If this page is

not required on startup, it can be disabled via unticking the preference at:

All information provided in this document is subject to legal disclaimers
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4.2

Windows and Linux : Window -> Preferences -> MCUXpresso IDE -> General -> Show welcome
view. Mac: __ MCUXpresso IDE -> Preferences -> MCUXpresso IDE -> General -> Show
welcome view__.

Workspaces

When you first launch MCUXpresso IDE, you will be asked to select a Workspace, as shown
in Figure 4.1.

Figure 4.1. Workspace selection

[ ] MCUXpresso |DE Launcher
Select a directory as workspace

MCUXpresso |IDE uses the workspace directory to store its preferences and development artifacts.

Workspace: | /Users/nxp/Documents/MCUXpressolDE_11 .0.0J'workspacel “ Browse...

} Recent Workspaces

~ Copy Settings
Workbench Layout
Working Sets
Preferences

4.3

MCUXpresso IDE User Guide -

A Workspace is simply a directory used to store projects and data. MCUXpresso IDE can only
access a single Workspace at a time.

Tip
@ It is possible to run multiple instances of the IDE in parallel with each instance
accessing a different Workspace.

If you tick the Use this as the default and do not ask again option, then MCUXpresso IDE
will always start up with the chosen Workspace opened; otherwise, you will always be prompted
to choose a Workspace.

You may change the Workspace that MCUXpresso IDE is using, via the File -> Switch
Workspace option.

Note: you may choose to copy settings (preferences) from an existing workspace to the new
workspace using the various Copy Settings tick box options.

Perspectives and Views

The overall layout of the main MCUXpresso IDE window is known as a Perspective. Within
each Perspective are many sub-windows, called Views. A View displays a set of data in the IDE
environment. For example, this data might be source code, hex dumps, disassembly, or memory
contents. Views can be opened, moved (dragged), docked, and closed, and the layout of the
currently displayed Views can be saved and restored.

Typically, MCUXpresso IDE operates using the single Develop Perspective, under which both
code development and debug sessions operate as shown in Figure 4.4. This single perspective
simplifies the Eclipse environment, but at the cost of slightly reducing the amount of information
displayed on screen.
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Note: New in MCUXPresso IDE version 11.0.0, the Develop Perspective has been redesigned
to make better use of screen space and also support new features.

Alternatively, MCUXpresso IDE can operate in a “dual Perspective” mode such that the C/
C++ Perspective is used for developing and navigating around your code and the Debug
Perspective is used when debugging your application.

Note: when within the debug perspective, the concept of a selected project remains. The Blue
Debug button tool tip will display this selected project. Also, if a debug operation is started within
the Debug perspective and a switch is made to the Develop perspective, the IDE will automatically
open a debug stack view to display the active debug connection.

You can manually switch between Perspectives using the Perspective icons in the top right of
the MCUXpresso IDE window, as shown in Figure 4.2.

Figure 4.2. Perspective selection

RPN TR

New perspectives can be selected by clicking the view+ icon. Once a view has been selected, it
icon will appear within the horizontal section as highlighted above.

All Views in a Perspective can also be rearranged to match your specific requirements by
dragging and dropping. If a View is accidentally closed, it can be restored by selecting it from the
Window -> Show View dialog. The default layout for a perspective can be restored at any time
via Window -> Perspective -> Reset Perspective.

Commonly used Views for Analysis (Trace) and RTOS debugging have been made more readily
available via top level drop down menus as shown below:

Figure 4.3. Additional Views

FreeRTOS  Window Gl Window
“-| SWO Trace Config & Task List

% SWO Profile Queue List
&c SWO Data Timer List
wa SWO Int Trace Heap Usage

wla SWO Int Table

£ SWO Stats

g SWO Int Stats

s SWO Counters

m> SWO ITM Console

€ Instruction Trace
F@ Instruction Trace Config

® Power Measurement Tool
& Average Power

MCUXpresso IDE User Guide -

One selected, these additional views will appear alongside the Console view but can be relocated
as desired.
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Note: The rest of this guide assumes the default Develop Perspective is used.

4.4 Major Components of the Develop Perspective

) #, workspace_new1 - frdmk641_bubble/source/bubble.c - MCUXpresso IDE

° w
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Figure 4.4, Develop Perspective (whilst debugging)

1. Quickstart / Variables / Breakpoints
¢ On the lower left of the window, the Quickstart Panel View (shown) has fast links to
commonly used features. From here you can launch various wizards including New Project,
Import projects from SDK and also from the File System plus options such as Build, Debug,
Export etc.. The large icon in each section will perform the first option in the group i.e.
New project, Build, Debug. Also, the Debug group contains debug solution specific

* Note: This Panel is essential to the operation of MCUXpresso IDE and so cannot be
removed from the perspective.
« Sitting in parallel to the Quickstart Panel, the Variables View allows you to see and edit
the values of local variables.
e Sitting in parallel to the Quickstart Panel, the Breakpoints View allows you to see and
modify currently set and
2. Project Explorer / Peripherals / Registers / Faults

e The Project Explorer view (shown) gives you a view of all the projects in your current

« many editing and configuration features are available from this view including new
options and
« When debugging, the Peripherals view allows you to display a list of the MCU
and project memory regions. Selecting a peripheral or memory region

will spawn a new window to display the detailed content. Note: depending on your MCUs
configuration, some peripherals may not be powered/clocked and hence their content will
not display.

* When debugging, the improved Registers view allows you to view the
and their content within the CPU of your MCU.
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» Pseudo registers are also displayed here such as ‘cycle delta’ which shows the calculated
number of cycles since the last pause
¢ Also displayed here is the Faults view, which will appear automatically if a CPU
(such as hard fault) occurs. This view decodes CPU registers to provide detailed information
indicating the reason for the fault occurring.

. Console / Installed SDKs / Problems / Trace Views / Power Measurement

« On the mid lower of the window are Console, Installed SDK and Problems Views etc. The
Console View displays status information on compilation and debug operations, as well as
displaying semihosted program output.

e The view (shown) enables the management of installed SDKs. New
SDKs can be added using drag and drop. Other SDK management features are also
provided from this view including unzip, explore and delete.

» SDK Documentation can be browsed and extracted

e The Problems View shows all compiler errors and warnings and will allow easy navigation
to the error location in the Editor View.

e The Image Information View
e This view provides detailed information on an images (or

object) static memory footprint (usage and content).

e Trace Views
« Trace Views including Instruction Trace, SWO Trace and Power are not shown on this

screenshot, however these views may be selected when required from the Analysis Menu.
For more information on Trace functionality, please see the MCUXpresso IDE SWO Trace
Guide and/or the MCUXpresso IDE Instruction Trace Guide.

e The SWO Trace Views allow you to gather and display runtime information using the
SWO/SWYV technology that is part of Cortex-M3/M4/M7/M33 based parts.

e The Instruction Trace view on certain MCUs, you can capture and view instruction trace
data downloaded from the MCU’s Embedded Trace Buffer (ETB) or Micro Trace Buffer
(MTB).

« The Power Measurement View, this view is capable of displaying real-time target power
usage. For more information please see the MCUXpresso IDE Power Measurement
Guide.

. Editor

¢ Centrally located is the Editor, which allows creation and editing of source code and other
text files. When debugging, this is where you can see the code you are executing and can
step from line to line. By pressing the ' i->' icon at the top of the Debug view, you can switch
to stepping from source to assembly instructions. Clicking in the left margin will set and
delete
« New in MCUXpresso IDE version 11.0.0 are providing structure,
keyword and linkage for debug Map files, Linker Script and Linker Template files.

. Debug

e The Debug View appears when you are your projects. This view shows
you the debug stack, in the “stopped/paused” state you can click within the stack and inspect
items in scope such as local variables.

. Outline / Global Variables

¢ The Outline View allows you to quickly locate symbols, declarations, functions within the
editor view.
 Sitting in parallel is the Global Variables View (shown) which allows you to see and edit
the values of Global variables.
» Variables can be monitored while the target is running using the
and features.

. Memory / Heap and Stack

« The Memory View provides a range of options for viewing target memory
e The Heap and Stack View (shown) enables easy monitoring of
values for bare metal projects.
* Warnings are given when preset limits are approached or exceeded

. Quick Access/Perspective Selection

All information provided in this document is subject to legal disclaimers © 2019 NXP Semiconductors. All rights reserved.
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« Enables quick access to features such as views, perspectives etc. for example enter ‘Error’
to view and open the IDE’s Error Log, or ‘Trace’ to view and open the various LinkServer

Trace views.

« Perspective Selection allows you to switch between the various defined perspectives.

9. Icon Bar Shortcuts

¢ Various useful shortcuts, for example to open a project’'s workspace or to open a terminal
at the projects location with the IDE’s environment. Hover here and popup dialogues will

explain the various options.

New Project

New or Imported Projects will appear in the Project Explorer view. New in MCUXpresso IDE
version 11.0.0, projects will automatically expand to show the source file containing the main

function. This source file will also be opened into the editor for convenience as shown below.

[{5 Project 2 deriph Regist Faults = B[4 bubblec 2
= ®| - 2

v < frdmk64f_bubble <Debug> :{Lnt main (void)
» @ Project Settings = ™ = {0};
» illincludes fxos_data_t sensorData = {@};
» 2 CMSIS fxos_config_t config = {0};

2 uintB_t sensorRange =0

» (Baccel uint8_t dataScale = 0;
» (£ board intl6_t xData =0;
» &8 component int16_t ybata = 0;
» GB device uintB_t i = 0;

A uintB_t array_addr_size = @;
> (O drivers status_t result = KStatus_Fail;
¥ (& source

I3 /* Board pin, clock, debug console init */
» Id bubble.c BOARD_InitPins();
» L semihost_hardfault.c BOARD_BootClockRUN() ;
» @Bsrc BOARD_I2C_ReleaseBus();
» (2 startup BUARD,IlC,ConngureP{nsH:
» &S utilities BOARD_InitDebugConsole();
» (=doc /% 12C ipitialize =/

Figure 4.5. New or Imported Project

BOARD_Accel_I2C_Init();

/% Configure the I2C function %/
config. I2C_SendFunc = BOARD_Accel_I2C_Send;
config.I2C_ReceiveFunc = BOARD_Accel_I2C_Receive;

array_addr_size = sizeof(g_accel_address) / sizeof(g_accel_address[@]);

for (i =@; i < array_addr_size; is+)
{

config.slaveAddress = g_accel_address[i];
/% Initialize accelerometer sensor */
result = FX0S_Init(&fxosHandle, &config);
%f (result == kStatus_success)

break;

4.4.2

MCUXpresso IDE User Guide -

Project Settings

Project Virtual Nodes are contained within a Project providing virtual folder to display and allow

the easy editing of project settings.
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't Project Explorer 22 "2, Peripherals+ il Registers . Symbol Viewer
v =5 frdmkB4f_led_blinky

Figure 4.6. Project Settings

1010

¥ Bk Alscciiad SOF . =i, Edit Libraries »
o hame = 'SDK_2.x_FRDM-KB4F" e e
o version = '2.4.0'

v =) Libraries (and semihosting) © Edit MCU
o Library (C) = 'Redlib (semi ot
v & MCU P —

i Edit memory
o chip = '"MKB4FN1TMOxxx12' dman .
o package = 'MKB4FNTMOVLL12:
o processor = 'cotf
¥ i Memory
o Flash name='PROGRAM_FLASH' typgs=
o RAM name="SRAM_UPPER'
o RAM2 name='SRAN_L
o RAM3 names
v [T Options
o Defined symbols (-D) (C) = '[_REDLIB__, CPU_MKB4FN1MOVLL12_cm4, CPU_MKB4FNTMOVLL 2,
» 4, Binaries
> | Includes
» (2 CMSIS
» (2 board
» (B drivers
» [ source
» (2 startup
» (2 utilities
» (= Debug
» = doc
.frd mk64f_led_blinky LinkServer Debug.launch
.frd mk64f_led_blinky LinkServer Release.launch

[ Edit options

sh' address="0x0" size="0x100000"' FTFE_4K.cfx
AM' address="0x20000000" size='0x30000"

R' type='RAM' address="0x1fffO000" size="0x10000"

_RAM' type="RAM' address="0x14000000" size='0x1000"

4.4.3

MCUXpresso IDE User Guide -

These are automatically generated for any project and provide a quick way to view many key
project settings. In addition, a right click on these nodes provides direct options to edit the
associated settings that otherwise require many more mouse clicks to reach.

Updating MCUXpresso IDE

Introduced in MCUXpresso IDE version 10.3.0 is the facility to update an installation to
incorporate new features, updates and/or to roll out bug fixes etc. To facilitate this mechanism,
MCUXpresso IDE version internals have been significantly restructured locating key components
with Eclipse style plugins.

Tip

Locating low level components is now more difficult due to both the complex directory
structure but also because component locations may change after an update is
performed. Therefore to simplify the experience a number of softlinks are available
within the install_dir/ide as discussed in section below “Locating IDE Components”

By default, when an update is released by NXP, a notification of the availability will appear at
the bottom of the screen.

All information provided in this document is subject to legal disclaimers © 2019 NXP Semiconductors. All rights reserved.
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Updates Available X

MCUXpresso IDE updates are available

IDE | Click to continue to the installation page

Figure 4.7. Update Notification

Alternatively you can check for updates via Help -> Check for Updates. If updates are available
you will be presented with a dialogue similar to that below:

& @ Available Updates
Available Updates

Check the updates that you wish to install. | -

/
Name Wersion Id
[§- GNU ARM PEMicro Interface Debugging Support 3.7.8.201810122006 com.pemicro.debug.gdbjtag.pne.feature.fe...
i MCUXpresso IDE base functionality 10.3.0.201810111056 com.crt.pcxpresso.feature.feature.group
gk MCUXpresso IDE Configuration Tools Integration 1.1.0.201810111248 com.nxp.swtools.mcuxpressoide feature.fe...
@ [§-MCUXpresso IDE LinkServer and Pre-installed part support 10.3.0.201810151121 com.nxp.mcuxpresso.tools.core feature.fea...
@ gk MCUXpresso IDE SDK handling 10.3.0.201810111544 com.nxp.mcuxpresso.core.datamodels.feat...
@ g-MCUXpresso IDE Trace and Power 10.3.0.201810111148 com.nxp.mcuxpresso.trace.feature.feature....
Select All Deselect All
Details
@ <sock | (NN | Conce

Figure 4.8. Updating MCUXpresso IDE Components

Simply, ensure the required updates are checked and click Next. At this point the components
will be downloaded and installed into MCUXpresso IDE. After installation a restart will be required
before new features are available.

Note: In addition to updates for MCUXpresso IDE, updates to the MCUXpresso Config tools and
PEMicro debug solution are also delivered using this mechanism.

Major product releases will only be delivered as full product installations

4.4.4 Locating IDE Components

MCUXpresso IDE consists of many components, some of which may be used independently
from the IDE. Also included are documents, examples, scripts, drivers etc. that may need to be
referenced from within the IDE.

Due to the structural changes introduced in MCUXpresso IDE version 10.3.0, the paths for certain
items may be both different from previous releases and may change after a product update (and
also be quite long). For example, the IDE bin folder will now be at a location of the form:

<install_dir>/ide/plugi ns/ com nxp. ncuxpresso. tool s. bi n. macosx_11. 0. 0. 2019xxxxxx/ bi nari es

Therefore, to simplify the location of certain folders, shortcuts (or symbolic links) are installed
into the products install_dir/ide/ directory. These can be used directly to locate components or
items, or within script paths.

MCUXpresso IDE User Guide - All information provided in this document is subject to legal disclaimers © 2019 NXP Semiconductors. All rights reserved.
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Shortcuts are available for the following directories:

bin -> install_dir/ide/bin

Examples -> install_dir/ide/Examples
Wizards -> install_dir/ide/Wizards
tools -> install_dir/ide/tools

In practice, these link will allow paths to be used unchanged from earlier version of
MCUXpressolDE, yet will always reference the latest plugin components.

All information provided in this document is subject to legal disclaimers
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5. Debug Solutions Overview

MCUXpresso IDE installs with built-in support for 3 debug (hardware) solutions; comprising the
as used in LPCXpresso IDE. Plus support for

both and . This support includes the installation of
all necessary drivers and supporting software.

The rest of this chapter discusses these different Debug solutions. For general information on
debugging please see the chapter

Note: Within MCUXpresso IDE, the debug solution used has no impact on project setting or build
configuration. Debug operations for basic debug are also identical.

5.1 Starting a Debug Session

With a suitable board and debug probe connected (usually via USB), to start a debug session:

1. select a project to debug within the MCUXpresso IDE Project View
2. click Debug from within the MCUXpresso IDE QuickStart View

) Quickstart Panel &3 Variables ]

I Project: evkmimxrt1060_iled_blinky [Debug] i

~ Create or import a project

B8 New project...
. Import SDK example(s)...

& Import project(s) from file system..

~ Build your project

& Build
& Clean
~ Debug your project ‘ E" ﬂ'

| 4% Debug ]
~ Miscellaneous

B Edit project settings

. MCUXpresso Config Tools> >

®2 Quick Settings>>

& Export project(s) to archive (zip)

(ie

L& Export project(s) and references to archive (zip)
we Build all projects [Debug]

) B

¢ a debug probe discovery operation is automatically performed to display the available
debug connections (i.e. the detected debug probes), including LinkServer, P&E and J-Link
compatible probes.

3. select the required debug probe and click OK

« at this stage a project is automatically created within the project
containing debug specific configurations

« if the debug connection is successful a Debug view will appear typically showing the project
has stopped on main()

%5 Debug 2 i v= A
v evkmimxrt‘l060j\ed,blinky LinkServer Debug [C/C++ (NXP Semiconductors) MCU Application]
v 2 evkmimxrt1060_iled_blinky.axf [MIMXRT1062xxxxA (cortex-m7)]
¥ Thread #1 1 (Suspended : Breakpoint)
= main() at led_blinky.c:57 0x60002572
s arm-none-eabi-gdb (8.2.50.20181213)
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Tip

@ Once a project has been debugged, the launch configuration will contain details of
the debug probe used. Subsequent debug sessions will automatically select this
probe if it is available.

From this point onwards, the low level debug operations are controlled by one of the debug
solutions mentioned above.

However, from the users point of view most common debug operations within the IDE will appear
the same (or broadly similar), for example:

¢ Automatic inheritance of part knowledge
» Automatic downloading (programming) of generated image to target Flash memory
¢ LinkServer/CMSIS-DAP Flash programming — see the chapter

¢ Automatic
e Setting and
. (single, step in step out etc.)

e Viewing and editing , ; )

* Viewing and editing
¢ New in MCUXpresso version 11.0.0

. are supported for all debug solutions
e Viewing

¢ Introduced in MCUXpresso IDE version 10.2.0 :

« Instruction Trace is supported for all debug solutions, please see Instruction Trace Guide
for more information

. is supported for all debug solutions
¢ Introduced in MCUXpresso IDE version 10.3.0 :

« SWO Trace is supported for all debug solutions including profiling, interrupt trace etc. please
see SWO Trace Guide for more information

» Viewing details of execution faults via the (automatically displayed for
faults generated during LinkServer debug, a pause will be required for other debug solutions)

Additional documentation is also available covering:

* Power Measurement — please see Power Measurement Guide
¢ FreeRTOS Debug — please see FreeRTOS Debug Guide

Note: In addition MCUXpresso IDE will dynamically manage each debug solutions connection
requirements allowing multiple sessions to be started without conflict. For debug of Multicore
MCUs please refer to the section

It is important to note that certain operations such as the handling of features via

may be different for each debug solution. Furthermore, advanced debug
features and capabilities may vary between solutions and even similar features may appear
different within the IDE.

P&E Micro and SEGGER debug solutions also provide a number of advanced features, details
can be found at their respective web sites.

An Introduction to Launch Configuration Files

The debug properties of a project in MCUXpresso IDE are held locally within each project in
Jaunch files (known as launch configuration files).

All information provided in this document is subject to legal disclaimers © 2019 NXP Semiconductors. All rights reserved.
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Launch configuration files are different for each debug solution (LinkServer, P&E, SEGGER) and
contain the properties of the debug connection (SWD/JTAG, and various other configurations
etc.) and can also include a debug probe identifier for automatic debug probe matching and
selection.

If a project has not yet been debugged, for example a newly imported or created project, then
the project will not have a launch configuration associated with it.

When the user first tries to debug a project, MCUXpresso IDE will perform a Debug Probe
Discovery operation and present the user with a list of debug probes found. Note: The Debug
Solutions searched can be filtered from this dialogue as highlighted, removing options that are
not required will speed up this process.

e Probes discovered
Connect to target: MK64FN 1MOxxx12

1 probe found. Select the probe to use:

Available attached probes

Name Serial number/ID  Type Manufacturer  IDE Debug Mode
LPC-LINKZ CMSIS-DAP V5.311 IWFUATEW LinkServer NXP Semico... Non-Stop

Supported Probes (tick/untick to enable/disable)

MCUXpresso |IDE LinkServer (inc. CMSIS-DAP) probes
P&E Micro probes

SEGGER J-Link probes

Probe search options

Search again

Remember my selection (for this Launch configuration)

@ cancel | (TSN

Figure 5.1. Debug Probe Discovery

Once the debug probe is selected and the user clicks ‘OK’, the IDE will automatically create a
default launch configuration file for that debug probe (LinkServer launch configuration shown
below).
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{5 Project 32 |2, Periph !i}i Regist A% Faults = O
. B "1{9 .' -
» & Project Settings
» bl Includes
» 2 CMSIS
> (S accel
» (2 board
» (2 drivers
» (2 source
» (2 startup
» (2 utilities

25

i dor

[ [ frdmk64f_bubble LinkServer Debug.launch]

Figure 5.2. Launch Configuration Files

Note: a launch configuration will only be created for the currently selected build configuration.

For many debug operations, these files won’t require any attention and can essentially be
ignored. However, if changes are required, these files should not be edited manually, rather their
properties should be explored within the IDE.

The simplest way to do this is to click to expand the Project within the ‘Project Explorer’ pane,
then simply double click a launch configuration file to automatically open the launch configuration
Edit Configuration dialogue.

Note: This dialogue has a number of internal tabs, the Debugger tab (as shown below) contains
the Debug main settings. See also the

MCUXpresso IDE User Guide - All information provided in this document is subject to legal disclaimers © 2019 NXP Semiconductors. All rights reserved.

User Guide Rev. 11.0.0 — 23 May, 2019 22




NXP Semiconductors

MCUXpresso IDE User Guide

Edit Configuration

Modify configuration and continue.

Name: |MKGE4FN1
%5 GDB Debugg
LinkServer

bug

EoTOTeT

Debug Options

Debug Connection SWD ¥

LinkServer Options

~ Debug Connection
Settings for the debug connection

Attach only Reset on Connect

Reset script w
Connect seript  kinetisconnect.scp ﬂ

BootROM stall

Flash driver reset handling N Reset handling

Disconnect behavior cont ﬁ Semihosting support

= Advanced Settings
Advanced options

Memory checking Debug memory cache Enable range stepping

Debug level 2 Override core index

Wirespeed (Hz)

Additional options

Pre launch command

Figure 5.3. Launch Configuration

& GUI Flash Tool Other Symbols > Startup | 5 Source| [ Common *
! Y

Workspace... File System...

Workspace... File System...

on B
Revert Apply
cancel | (I

L

MCUXpresso IDE User Guide -

Some debug solutions support advanced operati
programmed parts) from this view.

ons (such as the recovering of badly

Note: Once a launch configuration file has been created, it will be used for the projects future
debug operations. If you wish to use the project with a different debug probe, then simply delete
the existing launch configuration and allow a new one to be automatically used on the next debug

operation.

Enhancement: Introduced in MCUXpresso IDE version 10.1.0 — to simplify this operation, a
probe discovery can be forced by holding the SHIFT key while launching a debug session
from the Quickstart panel. If the new debug connection is completed, a new project launch

configuration will be created replacing any existing

are available to force the use of

Tip

When exporting a project to share with ot

launch configurations. Alternatively, the
a particular debug solution.

hers, launch configurations should usually

be deleted before export (along with other IDE generated folders such as build

configuration folders (Debug/Release if present)).

For further information please see the section
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LinkServer Debug Connections

MCUXpresso IDE’s native debug connection (known as LinkServer) supports debug operation
through the following debug probes:

¢ LPC-Link2 with CMSIS-DAP firmware

e LPCXpresso V2/V3 Boards incorporating LPC-Link2 with CMSIS-DAP firmware

¢ CMSIS-DAP firmware installed onto on-board debug probe hardware (as shipped by default
on LPCXpresso MAX and CD boards)

« For more information on LPCXpresso boards see: http://www.nxp.com/lpcxpresso-boards
» Additional driver may be required:
« https://developer.mbed.org/handbook/Windows-serial-configuration

¢ CMSIS-DAP firmware installed onto on-board OpenSDA debug probe hardware (as shipped
by default on certain Kinetis FRDM and TWR boards)

* Known as DAP-Link and mBed CMSIS-DAP: http://www.nxp.com/opensda
« Additional driver may be required:
* https://developer.mbed.org/handbook/Windows-serial-configuration

e Other CMSIS-DAP probes such as Keil uLINK with CMSIS-DAP firmware: http://
www?2.keil.com/mdk5/ulink

¢ Legacy RedProbe+ and LPC-Link
« RDB1768 development board built-in debug connector (RDB-Link)
+ RDB4078 development board built-in debug connector

Note: MCUXpresso IDE will automatically try to softload the latest CMSIS-DAP firmware onto

LPC-Link2 or LPCXpresso V2/V3 boards. For this to occur, the DFU link on these boards must
be set correctly. Please refer to the boards documentation for details.

LinkServer Debug Operation

When the user first tries to debug a project, MCUXpresso IDE will perform a Debug Probe
Discovery operation and present the user with a list of debug probes found.

Note: To perform a debug operation within MCUXpresso IDE, select the project to debug within
the ‘Project Explorer’ view and then click Debug from the QuickStart View.

If more than one debug probe is presented, select the required probe. For LinkServer compatible
debug probes, you can select from Non-Stop (the default) or All-Stop IDE debug mode.

Non-Stop uses GDB’s “non-stop mode” and allows data to be read from the target while

an application is running. Currently this mechanism is used to support the
and features.
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Probes discovered
Connect to target: MK64FN1MOxxx12

1 probe found. Select the probe to use:

Available attached probes

Name Serial number/ID Type Manufacturer IDE Debug Mode
LPC-LINKZ CMSIS-DAP... IWFUATEW LinkServer NXP Semico..] Non-Stop

Non-Stop

Supported Probes (tick/untick to enable/disable}

@ MCUXpresso IDE LinkServer (inc. CMSIS-DAP) probes
P&E Micro probes

@ SEGGER J-Link probes

Probe search options

Search again

Remember my selection (for this Launch configuration)

r"Z) Cancel OK

L

Figure 5.4. Debug Probe Discovery Non-Stop

Click ‘OK’ to start the debug session. At this point, the projects launch configuration files will be
created. LinkServer Launch configuration files will contain the string ‘LinkServer’ and have an
LS icon.

Note: If “Remember my selection” is left ticked, then the probe details will be stored within the
launch configuration file, and this probe will be automatically selected on subsequent debug
operations for this project.

For a description of some common debugging operations using supported debug probes see
MCUXpresso IDE defaults to the selection of “Non-Stop” mode when a LinkServer probe
discovery operation is performed. This default can be changed from an MCUXpresso IDE

Preference via:

Preferences -> Debug Options (Misc)
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Debug Options (Miscellaneous) r Ay
»General com.crt.debugcommon v10.2.0.201804112303
BC/C++
» Help Debugger executable arm-none-eabi-gdb
* Install/Update Debugger timeout 10
> Java .
MCUXpresso Config Tools SWV Packet Timeout 0
'MCUXWESSU"DE Extended debug trace (DEBUG_TRACE)
gEp |
[ iebug Dptons thilscalaRaote) ] Stream all stub messages to Console
ST PTOS DTSCOVETY Show stub warnings as notes
Default Tool settings Show debug log when written to

General

J-Link Options
LinkServer Options
LPC-Link Options Always show JTAG selection dialog
LPC-Link2 SWO Trace
MCU settings

A ) ™ dad dabug

Paths and Directories [rﬂs
PEMicro Options Enable Non-Stop Mode ]
Quickstart Panel 'SWV Server Port 0
SDK Options
User Interface Enablement
Utilities

» Mylyn

» Run/Debug

» Team

» Terminal

Validation
XML Restore Defaults Apply

Display asynchronous error messages

Disable Auto-select device on multicore target

Show progress messages in log

Figure 5.5. LinkServer Non Stop Preference

For a given project, the Non-Stop mode option is stored within the project’s launch configuration.
For projects that already have launch configurations, this option can be changed from the GDB
Debugger tab as shown below.

[ Main (%5 GDB Debugger.,, (IS Linkserver Debugger € GUI Flash Tool | % Other Symbols| # Startup | 1 Source| (] Common
Debugger Options

[ Main |
GDB debugger: arm-none-eabi-gdb Browse..
GDB command file: Browse..

ith the startup operation of the debugger, for example "run®)

Non-stop mode (Note: Requires non-stop GDB)

Enable Reverse Debugging at startup using: ~ Software Reverse Debugging (detailed but siower) ﬁ
Farce thread list update on suspend
debug forked (Note: Requires Multi Process GDB)
Tracepoint mode: _Normal 2]

Figure 5.6. LinkServer Non Stop Control

5.5 LinkServer Troubleshooting

5.5.1 Debug Log

On occasion, it can be useful to explore the operations of a debug session in more detail. The
steps are logged into a console known as the Debug log. This log will be displayed when a Debug
operation begins, but by default, will be replaced by another view when execution starts. The
debug log is a standard log within the IDE’s Console view. To display this log, select the Console
and then click to view the various options (as below):

MCUXpresso IDE User Guide - All information provided in this document is subject to legal disclaimers © 2019 NXP Semiconductors. All rights reserved.

User Guide Rev. 11.0.0 — 23 May, 2019 26




NXP Semiconductors MCUXpresso IDE User Guide

r
i
o
1
0
o

:
\_

El Console = %

- 1 RedlinkServer
2 FreeRTOS Task Aware Debugger Console version 11.0.0 (201903291224)
& 3 CDT Global Build Console
£l 4 CDT Build Console [frdmk&4f_bubble]

+ (NXP Semiconductors) MCU Application] gdb traces
+ [B 6 frdmk64f_bubble Debug messages
7 frdmk64f_bubble LinkServer Debug [C/C++ (NXP Semiconductors) MCU Application] frdmk64f_bubble.axf

The debug log displays a large amount of information which can be useful in tracking down
issues.

In the example debug log below, you can see that an initial Connect Script file has been run.
Connect scripts are required for debugging certain parts and are automatically added to launch
configuration files by the IDE if required. Next, the hardware features of the MCU are captured
and displayed, this includes the number of breakpoints and watchpoints available along with
details of various hardware components indicating what debug features might be available, for
example Instruction Trace.

Further down in this log you will see the selection of a Flash driver (FTFE_4K), the identification
of the part being debugged (in this case a K64), the programming progress and the speed of the
Flash programming operation (in this case 89.86 KB/sec).

Tip

@ a line similar to flash variant ‘K 64 FTFE Generic 4K’ detected (1MB = 256*4K at
0x0) will be displayed for LinkServer Flash programming operations. The size of the
detected flash (in this example itis 1MB) and sector size (4KB) will be displayed here.
The sector size may be important since multiples of this size represent valid base
addresses for flash programming operations. For example, if the programming of
more than one image is required, the second image must begin on a 4KB boundary
beyond the end of any previously programmed image.

MCUXpr esso | DE RedlinkMilti Driver v11.0 (Mar 28 2019 12:22:05 - crt_enmu_cmredlink build 105)
Found part description in XM. file MK64F12_i nternal . xm
Reconnected to existing link server

Connecting to probe 1 core 0 (using server started externally) gave ' K
============= SCRI PT: ki neti sconnect.scp =============
Ki neti s Connect Scri pt

Connecting to Probe Index =1

This probe =1

This TAP = 0

This core = 0

Dpl D = 2BA01477

Assert NRESET

Reset pin state: 00

Power up Debug

MDM AP API D:  0x001C0000

MDM AP Syst em Reset/ Hol d Reset/ Debug Request

MDM AP Control : 0x0000001C

MDM AP St atus (Fl ash Ready) : 0x00000032

Part is not secured

MDM AP Control : 0x00000014

Rel ease NRESET

Reset pin state: 01

MDM AP Control (Debug Request): 0x00000004
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MDM AP St atus: 0x0001003A
MDM AP Core Hal ted
============= END SCRI PT
Probe Firnware: LPC-LINK2 CVSI S-DAP V5. 311 (NXP Senmi conduct or s)
Serial Nunmber: JQDYI 3CT

VID: PID: 1FC9: 0090

USB Pat h: USB_1f c9_0090_314000_f f 00

Using nenory fromcore O after searching for a good core

debug interface type = Cortex-M3/4 (DAP DP | D 2BA01477) over SWD TAP 0
processor type = Cortex-M4 (CPU | D 00000C24) on DAP AP 0

nunber of h/w breakpoints = 6

nunber of flash patches =2

nunber of h/w watchpoints = 4

Probe(0): Connected&Reset. DplD: 2BA01477. Cpul D 00000C24. |nfo: <None>

Debug protocol: SWD. RTCK: Disabl ed. Vector catch: Disabled.

Cont ent of CoreSi ght Debug ROV s):

RBASE EOOFF000: CI D B105100D PI D 04000BB4C4 ROM (type Ox1)

ROM 1 EOOOE000: CI D BLO5E00D PI D 04000BBOOC Gen SCS (type 0x0)

ROM 1 E0001000: CI D BLO5E00D PI D 04003BB002 Gen DWI (type 0x0)

ROM 1 E0002000: CI D BLO5E00D PI D 04002BB003 Gen FPB (type 0x0)

ROM 1 E0000000: CI D BLO5E00D PI D 04003BB001 Gen | TM (type 0x0)

ROM 1 E0040000: Cl D B105900D PI D 04000BB9A1 TPIU type Ox11 Trace Sink - TPIU
ROM 1 E0041000: Cl D B105900D PI D 04000BB925 ETM type 0x13 Trace Source - Core
ROM 1 E0042000: Cl D B105900D PI D 04003BB907 ETB type 0x21 Trace Sink - ETB
ROM 1 E0043000: Cl D B105900D PI D 04001BB908 CSTF type 0x12 Trace Link - Trace funnel/router
NXP: MK64FN1MDxxx12

DAP stride is 4096 bytes (1024 words)

Inspected v.2 On chip Kinetis Flash nmenory nodul e FTFE_4K. cf x

I mage ' Kinetis Sem Generic Mar 28 2019 12: 33: 34’

Openi ng flash driver FTFE 4K cf x

Sendi ng VECTRESET to run flash driver

Fl ash variant 'K 64 FTFE Generic 4K detected (1MB = 256*4K at 0x0)

Cl osing flash driver FTFE 4K cfx

Connect ed: was_reset=true. was_stopped=true

Cst
Cst
Cst
Cst

Awai ting tel net connection to port 3330 ...

GDB nonst op node enabl ed

Openi ng flash driver FTFE 4K cfx (already resident)

Sendi ng VECTRESET to run flash driver

Fl ash variant 'K 64 FTFE Generic 4K detected (1MB = 256*4K at 0x0)
Witing 25856 bytes to address 0x00000000 in Fl ash

00001000 done 15% (4096 out of 25856)

00002000 done 31% (8192 out of 25856)

00003000 done 47% (12288 out of 25856)

00004000 done 63% (16384 out of 25856)

00005000 done 79% (20480 out of 25856)

00006000 done 95% (24576 out of 25856)

00007000 done 100% (28672 out of 25856)

Erased/ Wote sector 0-6 with 25856 bytes in 28lnsec

Cl osing flash driver FTFE 4K cfx

Fl ash Wite Done

Fl ash Program Sunmary: 25856 bytes in 0.28 seconds (89.86 KB/ sec)
Starting execution using systemreset and halt target

St opped (Was Reset) [Reset from Unknown]

St opped: Breakpoint #1
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Flash Programming

Most debug sessions begin with the programming of Flash, followed by a reset of the MCU. Note:
If flash programming should fail then the debug operation will be aborted.

Below is a brief discussion of the most common low level flash operations:

1. Sector Erase: internally Flash devices are divided into a number of sectors (or blocks), where
a sector is the smallest size of Flash that can be erased in a single operation. A sector will be
larger than a page (see below). Sectors are usually the same size for the whole Flash device,
however this is not always the case. A sector base address will be aligned on a boundary that
is a multiple of its size. A sector erase is usually the first step in a flash programming sequence.

2. Page Program: internally Flash devices are divided into a number of pages, where a page is
the smallest size that can be programmed in a single operation. A page will be smaller than a
sector. A page base addresses will be aligned on a boundary that is a multiple of its size.

3. Mass Erase: a mass erase will reset all the bytes in Flash (usually to Oxff). Such an
operation may clear any internal low level structuring such as protection of Flash areas (from
programming).

The programming of an image (or data) comprises repeated operations of sector erase followed
by a set of program page operations; until the sector is fully programmed or there is no more
data to program.

One of the common problems when programming Kinetis parts relates to their use of Flash
configuration block at offset 0x400. For more information please see:

. Flash sector sizes on Kinetis MCUs range from 1KB to 8KB,
therefore the first Sector Erase performed may clear the value of this block to all OxFFs, if this is
not followed by a successful program operation and the part is reset, then it will likely report as
‘Secured’ and subsequent debugging will not be possible until the part is recovered.

Such an event can occur if a debug operation is accidently performed to the ‘wrong board’ so
a wrong Flash programmer is invoked.

Note: LinkServer mass erase operations will restore this Flash configuration block automatically
for Kinetis parts. However, if a Kinetis device is mass erased by sector, this mechanism will be
bypassed, therefore this operation should not be performed to Kinetis parts!

Should you need to recover a ‘locked’ part please see the section

LinkServer executables

LinkServer debug operations rely on 3 main debug executables.

e arm-none-eabi-gdb — this is a version of GDB built to target ARM based MCUs

e crt_emu_cm_redlink — this executable (known as the debug stub) communicates with GDB
and passes low level commands to the LinkServer executable (also known as Redlink server)

e redlinkserv — this is the LinkServer executable and takes stub operations and communicates
directly with the ARM Cortex debug hardware via the debug probe.

« rltool - utility sometime used by the IDE to directly communicate with redlinkserv

If a debug operation fails, or a crash occurs, it is possible that one or more of these processes
may fail to shut down correctly. Therefore, if the IDE has no active debug connection but is
experiencing problems making a new debug connection, ensure that none of these executables
is running. To simplify this process an IDE button % is provided to kill all low level debug
executables. Therefore should a debug operation fail or a crash occur, simply click this button
before starting a new debug operation.

All information provided in this document is subject to legal disclaimers © 2019 NXP Semiconductors. All rights reserved.

User Guide

Rev. 11.0.0 — 23 May, 2019 29



NXP Semiconductors MCUXpresso IDE User Guide

5.6

5.7

5.7.1

MCUXpresso IDE User Guide -

P&E Debug Connections

P&E Micro software and drivers are automatically installed when MCUXpresso IDE installs. There
is no need to perform any additional setup to use P&E Micro debug connections.

Currently we have tested using:

e Multilink Universal (FX)
¢ Cyclone Universal (FX) (USB and Ethernet)

¢ P&E firmware installed into on-board OpenSDA debug probe hardware (as shipped by default
on certain Kinetis FRDM and TWR boards)

Note: Some Kinetis boards ship with OpenSDA supporting P&E VCOM but with no debug
support. To update this firmware visit the OpenSDA Firmware Update pages linked at: Help ->
Additional Resources -> OpenSDA Firmware Updates

P&E Debug Operation

The process to debug via a P&E compatible debug probe is exactly the same as for a native
LinkServer (CMSIS-DAP) compatible debug probe. Simply select the project via the ‘Project
Explorer’ view then click Debug from the QuickStart panel and select the P&E debug probe from
the Probe Discovery Dialogue.

If more than one debug probe is presented, select the required probe and then click ‘OK’ to start
the debug session. At this point, the projects launch configuration files will be created. Note: P&E
Launch configuration files will contain the string ‘PE’.

MCUXpresso IDE stores the probe information, along with its serial number in the projects launch
configuration. This mechanism is used to match any attached probe when an existing launcher
configuration already exits.

To simplify debug operations, MCUXpresso IDE will automatically start P&E’'s GDB Server and
select and dynamically assign the various ports needed as required. This means that multiple
P&E debug connections can be started, terminated, restarted etc. all without the need for any
user connection configuration. These options can be controlled if required by editing the P&E
launch configuration file.

For more information see

Note: If the project already had a P&E launch configuration, this will be selected and used. If
they are no longer appropriate for the intended connection, simply delete the files and allow new
launch configuration files to be created.

Important Note: Low level debug operations via P&E debug probes are supported by P&E
software. This includes, Part Support handling, Flash Programming, and many other features.
If problems are encountered, P&E Micro maintain a range of support forums at http:/
www.pemicro.com/forums/

P&E Differences from LinkServer Debug

MCUXpresso IDE core technology is intended to provide a seamless environment for code
development and debug.

When used with P&E debug probes, the debug environment is provided by the P&E debug server.
This debug server does not 100% match the features provided by native LinkServer connections.
However basic debug operations will be very similar to LinkServer debug.

For a description of some common debugging operations using supported debug probes see

All information provided in this document is subject to legal disclaimers © 2019 NXP Semiconductors. All rights reserved.

User Guide

Rev. 11.0.0 — 23 May, 2019 30


http://www.pemicro.com/forums/
http://www.pemicro.com/forums/

NXP Semiconductors MCUXpresso IDE User Guide

5.7.2

5.8

5.8.1

MCUXpresso IDE User Guide -

Note: LinkServer advanced features such as Power Measurement will not be available via a
P&E debug connection. However, additional functionality maybe available using P&E supplied
plugins.

P&E Micro Software Updates

P&E Micro support within MCUXpresso IDE is via an Eclipse Plugin. The P&E update site is
automatically added to the list of Available Software Update sites.

To check whether an update is available, please select:
Help -> Check for Updates
Any available updates from P&E will then be listed for selection and installation.

Note: P&E Micro may provide news and additional information on their website, for details see
https://www.pemicro.com

SEGGER Debug Connections

SEGGER J-Link software and documentation pack is installed automatically with the
MCUXpresso IDE Installation for each host platform. No user setup is required to use the
SEGGER debug solution within MCUXpresso IDE.

Currently we have tested using:

¢ J-Link debug probes (USB and Ethernet)

¢ J-Link firmware installed into on-board OpenSDA debug probe hardware (as shipped by default
on certain Kinetis FRDM and TWR boards)

¢ J-Link firmware installed onto LPC-Link2 debug hardware and LPCXpresso V2/V3 boards
« for details see https://www.segger.com/Ipc-link-2.html
« also for firmware programming see http://www.nxp.com/LPCSCRYPT

SEGGER software installation

Unlike other debug solutions supplied with MCUXpresso IDE, the SEGGER software installation
is not integrated into the IDE installation, rather it is a separate SEGGER J-Link installation on
your host.

The installation location will be similar to:

On Wndows: C:./Program Files (x86)/SEGGER JLi nk_V630
On Mac: /Applications/ SEGGER/ JLi nk_V630
On Linux: /opt/SEGGER/ JLi nk

MCUXpressolDE automatically locates the required executable and it is remembered as a
Workspace preference. This can be viewed or edited within the MCUXpresso IDE preferences
as below.
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Figure 5.7. Segger Preferences

e e Preferences
J-Link Options. v rw

» General
FCiC++
»Help J-Link Server exacutable
¥ Install/Update
» Java

MCUXpresso Config T
¥MCUXpresso IDE

Debug Options (Ad'

SEGGER J-Link probe preferences
[Applications /SEGGER/JLink_V&30k/JLinkGDBServerCLExe Browse...

Enable discovering of SEGGER J-Link IP probes
Enable SEGGER J-Link user actions
J-Link Server: initial auto discover port 233

Debug Optians (Mic J-Link Server SWO: Initial auto discover port | 2332
Debug Probe Disco

J-Link Server Telnet: initial auto discover port 2333
Default Tool setting

General J-Link port auto discover retries attempts 100
J-Link Options Enable Instruction Trace service

LinkServer Options
LPC-Link Options
LPC-Link2 SWO Tre
MCU settings
Paths and Directori:
PEMicro Opticns
Quickstart Panel
SDK Options
User Interface Enat
Utilities

O s Restore Defaults Apply

@ Cancel
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Note: this preference also provides the option to enable scanning for SEGGER IP probes (when
a probe discovery operation is performed). By default, this option is disabled.

From time to time, SEGGER may release later versions of their software, which the user could
choose to manually install. For details see https://www.segger.com/downloads/jlink

MCUXpresso IDE will continue to use the SEGGER installation path as referenced in a projects
workspace unless the required executable cannot be found (for example, the referenced
installation has been deleted). If this occurs:

1. The IDE will automatically search for the latest installation it can find. If this is successful, the
Workspace preference will automatically be updated
2. If a SEGGER installation cannot be found, the user will be prompted to located an installation

To force a particular workspace to update to use a newer installation location simply click the
Restore Default button.

To permanently select a particular SEGGER installation version, the location of the SEGGER
GDB Server can be stored in an environment variable.

For example, under Windows you could set:

MCUX_SEGGER_SERVER="C: / Program Fi | es (x86)/ SEGGER/ JLi nk_V630k/j Li nkCGDBSer ver CL. exe"

This location will then be used, overriding any workspace preference that maybe set.
SEGGER software un-installation

If MCUXpresso IDE is uninstalled, it will not remove the SEGGER J-Link installation. If this is
required, then the user must manually uninstall the SEGGER J-Link tools.

Note: If for any reason MCUXpresso IDE cannot locate the SEGGER J-Link software, then the
IDE will prompt the user to either manually locate an installation or disable the further use of the
SEGGER debug solution.

SEGGER Debug Operation

The process to debug via a J-Link compatible debug probe is exactly the same as for a native
LinkServer (CMSIS-DAP) compatible debug probe. Simply select the project via the ‘Project
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Explorer’ view then click Debug from the QuickStart Panel and select the SEGGER Probe from
the Probe Discovery Dialogue.

If more than one debug probe is presented, select the required probe and then click ‘OK’ to start
the debug session. At this point, the projects launch configuration files will be created. Note:
SEGGER Launch configuration files will contain the string ‘JLink’.

To simplify debug operations, MCUXpresso IDE will automatically start SEGGER’s GDB Server
and select and dynamically assign the various ports needed as required. This means that multiple
SEGGER debug connections can be started, terminated, restarted etc. all without the need for
any user connection configuration. These options can be controlled if required by editing the
SEGGER launch configuration file.

In MCUXpresso IDE, SEGGER Debug operations default to using the SWD Target Interface.
When debugging certain multicore parts such as the LPC43xx Series, the JTAG Target Interface
must be used to access the internal Slave MCUs. To select JTAG as the Target Interface, simply
edit the SEGGER launch configuration file and select JTAG.

For more information see

Note: If the project already had a SEGGER launch configuration, this will be selected and used.
If an existing launch configuration file is no longer appropriate for the intended connection, simply
delete the files and allow new launch configuration files to be created.

Tip

@ Introduced in MCUXpresso IDE version 10.3.0. If Reset before running is set in
the Launch configuration, then a default intelligent reset will be used. This reset
automatically supports running from Flash or RAM. A specific reset type can
optionally be set from the free form text field if required, please consult SEGGER’s
documentation for available reset types.

Important Note: Low level debug operations via SEGGER debug probes are supported by
SEGGER software. This includes, Part Support handling, Flash Programming, and many other
features. If problems are encountered, SEGGER'’s provide a range of support forums at http://
forum.segger.com/

SEGGER Differences from LinkServer Debug

MCUXpresso IDE core technology is intended to provide a seamless environment for code
development and debug. When used with SEGGER debug probes, the debug environment is
provided by the SEGGER debug server. This debug server does not 100% match the features
provided by native LinkServer connections. However basic debug operations will be very similar
to LinkServer debug.

For a description of some common debugging operations using supported debug probes see
Note: LinkServer features such as Power Measurement will not be available via a SEGGER

debug connection. However, additional functionality maybe available using external SEGGER
supplied applications.

SEGGER Troubleshooting

When a debug operation to a SEGGER debug probe is performed, the SEGGER GDB server
is called with a set of arguments provided by the launch configuration file. The command and
resulting output is logged within the IDE SEGGER Debug Console. The console can be viewed
as below:
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SehELIR ™mB-= 8

1 RedlinkServer

2 FreeRTOS Task Aware Debugger Console version 11.0.0 (201903291224)
£ 3 CDT Global Build Console
£l 4 CDT Build Console [frdmk6&4f_bubble]

v B 5 JLinkServer JLink600102843 for frdmk64f_bubble

6 frdmk64f_bubble JLink Debug [GDB SEGGER Interface Debugging] gdb traces
7 frdmk64f_bubble JLink Debug [GDB SEGGER Interface Debugging] frdmk64f_bubble.axf

Figure 5.8. Segger Server

The command can be copied and called independently of the IDE to start a debug session and
explore connection issues.

Below is the shortened output of a successful debug session to a Kinetis K64 Board.

[ 02-4-2019 02: 24:50] Executing Server: /Applications/ SEGGER/ JLi nk_V644d/ JLi nkGDBSer ver CLExe /
-nosil ent -swoport 2332 -sel ect USB=600102843 -telnetport 2333 -singlerun -endian little /
-noir -speed auto -port 2331 -vd -device MKB64FNIMDxxx12 -if SWD -halt -reportuseraction
SEGCER J-Link GDB Server V6.44d Command Line Version

JLi nkARM dI | V6. 44d (DLL conpiled Mar 27 2019 17:10: 37)

Command |ine: -nosilent -swoport 2332 -sel ect USB=600102843 -tel netport 2333 -singlerun /

-endian little -noir -speed auto -port 2331 -vd -device MK64FNIMDxxx12 -if SWD -halt/
-reportuseraction

GDBInit file: none
GDB Server Listening port: 2331
SWO raw out put |istening port: 2332
Terminal 1/0 port: 2333
Accept renpte connection: yes
Generate logfile: of f
Verify downl oad: on
Init regs on start: of f
Si | ent node: of f
Singl e run node: on
Target connection timeout: 0 ns

------ J-Link related settings------

J-Link Host interface: UsB
J-Link script: none
J-Link settings file: none

Tar get devi ce: M<K64FNLIMDxxx12
Target interface: SWD

Target interface speed: auto

Target endi an: little

Connecting to J-Link...

J-Link is connected.

Devi ce "MK64FNLMDXXX12" sel ect ed.

Firmnare: J-Link V10 conpiled Mar 21 2019 15:43:57
Har dwar e: V10. 10

S/'N: 600102843
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Feature(s): RD, FlashBP, FlashDL, JFl ash, GDB

Checki ng target voltage...

Target voltage: 3.30 V

Li stening on TCP/IP port 2331

Connecting to target...InitTarget()

Found SWDP with | D 0x2BA01477

Scanning AP map to find all avail abl e APs

AP[ 2]: Stopped AP scan as end of AP nmap has been reached
AP[ 0] : AHB-AP (I DR 0x24770011)

AP[1]: JTAG AP (I DR 0x001C0000)

Iterating through AP map to find AHB-AP to use

AP[0]: Core found

AP[ 0] : AHB- AP ROM base: OxEOOFF000

CPUI D regi ster: 0x410FC241. |nplenenter code: 0x41 (ARM
Found Cortex-M4 rOpl, Little endian.

FPUnit: 6 code (BP) slots and 2 literal slots

Cor eSi ght conponent s:

ROMTbI [ 0] @ EOOFF000

I ni t Tar get ()
Found SWDP with | D 0x2BA01477

AP[0]: AHB-AP (IDR Not set)

Connected to target

Waiting for GDB connection...Connected to 127.0.0.1
Readi ng all registers

Read 4 bytes @ address 0x00005538 (Data = 0xB004BEAB)
Read 2 bytes @ address 0x00005538 (Data = OxBEAB)
Readi ng 64 bytes @ address 0x00005500

Recei ved nonitor conmand: reset

Reset: Halt core after reset via DEMCR VC_CORERESET.
Reset: Reset device via Al RCR SYSRESETREQ

Af t er Reset Tar get ()

Resetting target

Downl oadi ng 9808 bytes @ address Ox00003EA0 - Verified OK
Downl oadi ng 16 bytes @ address 0x000064F0 - Verified OK

Witing register (PC = 0x 1d4)

Read 4 bytes @ address 0x000001D4 (Data = 0xB672B510)
Readi ng all registers

Connected to 127.0.0.1

Readi ng all registers

Read 4 bytes @ address 0x000001D4 (Data = 0xB672B510)
Read 4 bytes @ address 0x000001D4 (Data = 0xB672B510)
Readi ng 64 bytes @ address 0x000007C0

Read 2 bytes @ address 0x000007CA (Data = 0xF107)
Recei ved nonitor conmand: sem hosting enabl e

Sem - hosting enabl ed (Handl e on BKPT)

Recei ved nonitor conmand: exec SetRestartOnd ose=1
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ROMTbI [0] [ 0] : EOOOE000, ClD: BLO5SE00D, PID: 000BBOOC SCS- M
ROMTbI [0] [1]: E0001000, CID: BL105E00D, PID: 003BB002 DA
ROMTbI [0] [2]: E0002000, CD: B105E00D, PID: 002BB003 FPB
ROMTbI [0] [ 3]: E0000000, CID: B105E00D, PID: 003BBOOL |TM
ROMTbI [0] [ 4] : E0040000, ClD: B105900D, PID: 000BBY9AL TPIU
ROMTbI [0] [5]: E0041000, CD: B105900D, PID: 000BB925 ETM
ROMTbI [0] [ 6]: E0042000, CD: B105900D, PID: 003BB907 ETB
ROMTbI [0] [ 7]: E0043000, CID: B105900D, PID: 001BB908 CSTF

AP nmap detection skipped. Manually configured AP map found.

Downl oadi ng 16032 bytes @ address 0x00000000 - Verified OK

J-Link: Flash downl oad: Bank O @ 0x00000000: Skipped. Contents al ready nmatch
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Execut ed Set RestartOnCl ose=1

Recei ved nonitor conmand: reset

Reset: Halt core after reset via DEMCR VC_CORERESET.
Reset: Reset device via Al RCR SYSRESETREQ

Af t er Reset Tar get ()

Resetting target

Setting breakpoint @address 0x000007CA, Size = 2, BPHandl e = 0x0001
Starting target CPU...

... Breakpoi nt reached @ address 0x000007CA

Readi ng all registers

Renovi ng breakpoi nt @ address 0x000007CA, Size = 2
Read 4 bytes @ address 0x000007CA (Data = 0x031CF107)
Read 4 bytes @ address 0x20000104 (Data = 0x00000000)

Note: If a SEGGER debug operation is not successful, the IDE will generate an error dialogue,
the 'Details' button can be clicked to display a copy of the SEGGER server log. One possible
reason for a SEGGER debug operation to fail is due to a Device hame mismatch. MCUXpresso
IDE will try to supply the expected Device name to SEGGER server, however on rare occasions
this may not be the name expected. The SEGGER launch configuration Device entry can be
populated via a drop down list or via a user supplied device name.

If required, additional server options can be set within the SEGGER launch configuration. For
example to capture logging information to a file, you can set the additional server option:

-log $(CWD)/ ny. | og

where $(CWD) represents the current working directory of the debug connection, i.e. the
dynamically created project build configuration folder.
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6. SDKs and Preinstalled Part Support Overview

To support a particular MCU (or family of MCUs) and any associated development boards, a
number of elements are required. These break down into:

e Startup code

» This code will handle specific features required by the MCU
* Memory Map knowledge

« The addresses and sizes and types of all memory regions
» Peripheral knowledge

 Detailed information allowing the MCUs peripherals registers to be viewed and edited
¢ Flash Drivers

« Routines to program the MCU'’s on and off chip Flash devices as efficiently as possible
* Debug capabilities

* Knowledge of the MCU debug interfaces and features (e.g. SWO, ETB)

« Example Code (this is not strictly required or a part support element)

» Code to demonstrate the features of the particular MCU and supporting drivers
Collectively, this data is known as Part Support, MCUXpresso IDE uses these data elements for
populating its wizards, and for built in intelligence features, such as the automatic generation of
linker scripts etc.

MCUXpresso IDE delivers its part support through an extensible scheme.

6.1 Preinstalled Part Support
Firstly the IDE installs with an enhanced version of the part support as provided with LPCXpresso
IDE v8.2.2. This provides support for the majority of LPC Cortex-M based parts ‘out of the box'.
This is known as preinstalled part support.
Example code for these preinstalled parts is provided by sophisticated LPCOpen packages (and
Code Bundles). Each of these contains code libraries to support the MCU features, LPCXpresso
boards (and some other popular ones), plus a large number of code examples and drivers.
Version of these are installed by default at:
<install dir>/ide/ Exanpl es/ LPCOpen
<install dir>/ide/Exanpl es/ CodeBundl es
Further information can be found at:
http://www.nxp.com/Ipcopen
https://www.nxp.com/LPC800-Code-Bundles
6.2 SDK Part Support
Secondly, MCUXpresso IDE’s part support can be extended using freely available MCUXpresso
SDK v2.x packages. These can be installed via a simple ‘drag and drop’ mechanism which will
then automatically enhance the IDE with new part and board knowledge (and usually a large
range of examples).
SDKs for MCUXpresso IDE can be generated and downloaded as required using the SDK Builder
on the MCUXpresso Tools website at:
http://mcuxpresso.nxp.com/
MCUXpresso IDE User Guide - All information provided in this document is subject to legal disclaimers © 2019 NXP Semiconductors. All rights reserved.
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SDK 2.x packages are used to add support for all Kinetis, iMX RT and newer LPC MCUSs.

Once an SDK has been installed, the included part support becomes available through the
New Project Wizard and also the SDK example import Wizard, and for use by

Important Note: Only SDKs built specifically for MCUXpresso IDE are compatible with
MCUXpresso IDE. SDKs created for any other toolchain will not work! Therefore, when
generating an SDK be sure that MCUXpresso IDE is specified as the Toolchain.

Differences in Preinstalled and SDK Part Handling

Since SDKs combine part (MCU) and board support into a single package, MCUXpresso IDE
is able to provide linkage between SDK installed MCUs and their related boards when creating
or importing projects.

For preinstalled parts, the board support libraries are provided within LPCOpen packages and
Code Bundles. It is the responsibility of the user to match an MCU with its related LPCOpen
board and chip library when creating or importing projects.

Creating and importing project using Preinstalled and SDK part support is described in the
following chapters.

Note: When exporting or sharing projects with Preinstalled part support, no special actions are

required, since other installations of MCUXpresso IDE will provide the required part support. For
sharing projects created from SDKs, please see

Viewing Preinstalled Part Support

When MCUXpresso IDE is installed, it will contain preinstalled part support for most LPC based
MCUs.

To explore the range of preinstalled MCUs simply click ‘New project’ in the QuickStart panel.
This will open a page similar to the image below:
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e ® SDK Wizard

| € Please select a target device or a board } 4 k / y

|
| . Board and/or Device selection page

~ SDKMCUS Available boards LA

MCUs from installed SDKs Please select an available board for your project,

Target

PNEV7462B LPCXpresso812-MAX LPCXpressoB12 LPC8NO4 Development Board

~ Preinstalled MCUs
MCUs from preinstalled LPC and generic
Cortex-M part suppert
Target
»LPC1102
*LPC112x
*LPC11AXX
»LPC11E6X
*LPC11Exx
FLPC11UBX LPCXpresso845-MAX LPCXpresso824-MAX LPCXpressoB02
#LPCT1Uxx
FLPCT1xx

\’“’“‘""“’ j s ETSGeEn D

Selected Device: SDKs for selected MCU

Target Core: Name SDK Version  Manifest Versior Location

‘ Description:

-@ Cancel

Figure 6.1. New Project Wizard

The list of preinstalled parts is presented on the bottom left of this window.

You will also see a range of related development boards indicating whether a matching LPCOpen
Library or Code Bundle is available.

For creating project with preinstalled part support please see:

If you intend to work on an MCU that is not available from the range of preinstalled parts, for
example a Kinetis MCU, then you must first extend the part support of MCUXpresso IDE by
installing the appropriate MCU SDK.

6.4 Obtaining and Installing an SDK

SDKs are installed and managed via the Installed SDKs view, which is located by default as the
first tab within the Consoles view. See item 3 for more information.

SDKs are free to download (login is required); MCUXpresso IDE offers a link to the SDK portal
(shown below) from the Installed SDK Console view. From this portal, required SDKs can
be downloaded onto the host machine. Alternatively, go to Help -> Additional Resources ->
MCUXpresso SDK Builder ... to open this portal in an external browser.
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@ - nxp.com = MCUXpresso IDE

- “ s @B G tiP MO RS
GP &R "1 = 0O @ Welcome | MCUXpresso SDK Builder 3

) bV

A
|
MCUXpresso SD K Bquer

|
|
! [ EE Select Development Board | | # Access My SDK Dashboard .
oaq 4 “2 =l [}

MCUXpresso IDE - Qt

Ciee ) Na project selected

OVERVIEW SOFTWARE AND TOOLS DEVELOPER RESOURCES

~ Create or impoert a project
(8 New project

. mport SDK example(s)

& Import project(s) from f

Getting started with MCUXpresso SDK is simple.

~ Bulld your project

» Debug your project

~ Miscellaneous Privacy Policy Terms of Use Contact © 2018 NXP Semicd! Lors. All rights reserved.

&) Installed SDKs £ I Properties [ Problem: Memor Debugger Console § Instruction Trace B0 Power Measurement T | SWO Trace Config # Termina

) Installed SDKs

Do you have a development board?

Start by clicking on Select Development Board to download a customized SDK for that specific platform.

Are you returning and seeking previously downloaded SDKs?

2 Quick Settings>>

| [ Build all projects [1
Toinstall an SDK, simply drag and drop an SDK (zip fileffolder) into the ‘Installed SDKs' view.

W workspace

Figure 6.2. SDK Import

Once downloaded, an SDK package(s) can be installed by simply dragging from the downloaded
location into the Installed SDKs view. Once released, you be prompted with a dialog asking you
to confirm the import — click OK. The SDK pagkage(s) will then be automatically installed into
MCUXpresso IDE part support repository.

Once complete the “Installed SDKs” view will update to show you the package(s) that you have
just installed.

(7 Installed SDKs 32 [] Properties &) Console (2! Problems [J Memory G Debugger Console @ Instruction Trace =D Power Measurement Tool [ SWO Trace Config @ &. C

0 Installed SDKs

To install an SDK, simply drag and drop an SDK (zip file/folder) into the 'Installed SDKs* vie\-l. [Common 'mcuxpresso’ folder] l

Name SDK Vi Manifest Version
2A‘0i1 835b25f48d 2018-06-121 3.3.0

@ £ SDK_2.x_EVK-MIMXRT1020

Location

(£, <Common>/SDK_2.4_EVK-MIMXRT1020.zip

SDK Details

11 SDK_2.x_EVKB-IMXRT1050 2.4.0 3.3.0 e /SDK_2.4-EVKB-IMXRT1050_max.zip Seisciad i CoNteRt
£ SDK_2.x_FRDM-K64F 242 3.3.0 = /SDK_2.4.2_FRDM-K64F

1 SDK_2.x_FRDM-KE15Z 2.4.1 3.3.0 ) /SDK_2.4_ FRDM-KE15Z.zip 'ns"'a['ds

@ i SDK 2.x LPCXpresso54618 24,1 3.3.0 ) /SDK_2.4.1_LPCXpresso54618.zip » B Devices

¥ s Compilers

» i Toolchains

(# Toolchain Settings
» i} Components

Figure 6.3. SDK Import View

By default, SDKs will install into a Common folder and will therefore be available to any
MCUXpresso IDE instance. Alternatively SDKs can be installed into the current Workspace so
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making their installation local to that Workspace. The selected install location is shown in the
SDK Window text as highlighted above. Also highlighted is the new version information string
(displayed in grey), this feature allows different SDK builds to be distinguishable. Please also
see for further information on SDK installation options.

SDK Notes:

e Released in parallel with MCUXpresso IDE version 11.0.0 are updated SDKs
(MCUXpressoSDK v2.6.x). These are indicated by their version 2.6.x and a manifest version
3.5.0 in the Installed SDK view. While older SDKs are still compatible with MCUXpresso IDE
version 11.0.0, it is recommended that users check and update to the latest available SDK
package.

« Installed SDK view tooltips display comprehensive version information

¢ MCUXpresso IDE can import an SDK as a zipped package or unzipped folder. Typically
importing as a zipped package is expected.

e The main consequence of leaving SDKs zipped is that you will not be able to create (or
import projects) into a workspace with linked references back to the SDK source files.

« When an SDK is imported via drag and drop, required files are copied and the original file/folder
is unaffected. The copied files are installed into a default location allowing imported SDKs to be
shared among different IDE instances/installations and workspaces. Data from imported SDKs
is populate wizards with available MCU and board information. In addition they are parsed to
generate part support and make example projects and drivers available etc.

« By default, SDKs (like workspaces) are located in user local storage, this means they will
only be available to the user who performed the installation. Please also see
for details of how a shared location could be used if needed.

¢ Once installed the part support provided by the SDKs is regenerated. This regeneration is
required because an MCUs part support may be specified (with different versions) within more
than one SDK. On rare occasions, it may be necessary to force a regeneration of SDK part
support, this can be done by clicking the Recreate and Reload button within the top right block
inside the Installed SDK view, or by right clicking within the view and selecting Recreate.

Installed SDKs Operations
Many operations are available from the Installed SDK view some from a right click menu options:
~ Import archive...

<> Import folder...
(= Open Default Location

| G sk Documentation > |
i SDK Info b
> Open Location
& Unzip archive
¥ Delete SDK

2.. Recreate

From here you can perform many actions such as view associated embedded SDK
documentation that would otherwise require the unzipping and exploration of the SDK structure.

The Installed SDKs display will show whether the SDKs are stored as zipped archives or regular

folders. MCUXpresso IDE offers the option to unzip an archive in place via a right click option
onto the selected SDK (as below).
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<> Import archive...
~ Import folder...
= Open Default Location

{0 SDK Documentation >
i SDKInfo [S
> Open Location

I & Unzip archive |

& Delete SDK

2. Recreate

Note: Unzipping an SDK may take some time and is generally not needed unless you wish to
make use of referenced files or perform many example imports (where some speed improvement
will be seen).

Once an SDK has been unzipped, its icon will be updated to reflect that it is now stored internally
as a folder.

Figure 6.4. SDK Unzipped

@ Installed SDKs 52 [T] Properties &) Console [*! Problems [ Memory G Debugger Console € Instruction Trace D Power Measurement Tool ) SWO Trace Config @ 2. [
@ Installed SDKs
To install an SDK, simply drag and drop an SDK (zip file/folder) into the 'Installed SDKs' view. [Common 'mcuxpresso’ folder]

Name SDK Version Manifest Version  Location

SDK Details
£ SDK_2.x EVK-MIMXRT1020  2.4.0 (1835b25f48d 2018-06-12) 3.3.0 (£, <Common>/SDK_2.4_EVK-MIMXRT1020.zip

4 SDK_2.x EVKB-IMXRT1050  2.4.0 3.3.0 /SDK_2.4-EVKB-IMXRT1050_max.zip Seecd SOX e
4 SDK_2.x_FROM-KB4F 242 33.0 JSDK_2.4.2_FRDM-KB4F

4 SDK_2.x_FROM-KE152 244 3.3.0 - ISDK_2.4_FRDM-KE15Z zip > Bl Boards

41 SDK_2.x_LPCXpresso54618 2441 3.3.0 ) /SDK_2.4.1_LPCXpresso54618.zip : Devices

» i3 Components
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Many other options are available such as examining SDK XML description files, and managing
the library of installed SDKs.

Tip

@ To edit (and save) SDK XML files, the SDK must first be unzipped and the following
preference changed: Preferences -> MCUXpresso IDE -> SDK Handling -> Misc,
uncheck the read only mode option. Once saved, changes will become permanent
for that SDK installation.

Finally, SDK part support automatically regenerates when a new SDK is installed. If a project is
imported and the expected part support is not available then select Recreate from the right click
menu option to force a recreation of the SDK part support.

Deleting an Installed SDK

If an SDK has been installed by the ‘Drag and Drop’ method, then a copy of the SDK will have
been installed into the Default Location. SDKs installed into this location can be deleted via a right
click option. Once an SDK has been deleted, then part support will automatically be recreated
for the remaining SDKs. Please see for more information.

Along side each installed SDK is a check box, if this is unchecked the SDK will be hidden
from MCUXpresso IDE until re-checked. If multiple SDKs are installed that contain shared part
support, then this feature may be useful to force the selection of part support from a particular
SDK. Please see for more information.

SDKs installed into non default locations must be manually deleted or hidden if they are no longer

required. Note: you may have to quit MCUXpresso IDE to delete these SDKs. Please see
for more information.
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6.4.2 Installed SDKs Features

You can explore each of the SDKs within the Installed SDKs view to examine content such as
Components, Memory Settings, included Examples etc.

({0 Installed SDKs &2 [ Properties Bl Console [*! Problems [J Memory &} Debugger Console € Instruction Trace ED Power Measurement Tool |5 SWO Trace Config @ 2. O = = <
@ Installed SDKs

Ta install an SDK, simply drag and drop an SDK (zip file/folder) into the 'Installed SDKs' view. [Common 'mcuxpresso’ folder]

Name SDK Version Manifest Version Location SDK Details

i SDK_2.x EVK-MIMXRT1020  2.4.0 (1835b25f48d 2018-06-12) 3.3.0 [, «Common>/SDK_2.4_EVK-MIMXRT1020.2ip

@ i SDK_2.x_EVKB-IMXRT 1050 2.4.0 3.3.0 ) JSDK_2.4-EVKB-IMXRT1060_max.zip Seibcted SOKC contsat.

@ SDK_2.x_FROM-KB4F 242 3.3.0 = JSDK_2.4.2_FRDM-K64F

B i SDK_2.x_FROM-KE15Z 2.4.1 330 & /SDK_2.4_FRDM-KE15Z.zip v [l Boards

i SDK_2.x LPCXpresso54618  2.4.1 3.3.0 G /SDK_2.4.1_LPCXpresso54618.zip TEVICMIMXRT 1020 19.0

» 3 Debug Configurations
¥ =5 Examples
» = cmsis_driver_example:
» = demo_apps
» £ driver_examples
lwip_examples
» E usb_examples
» 3 Memory Settings
» B Devices

000 o

[

Figure 6.5. SDK Explore

6.4.3 Advanced Use: SDK Importing and Configuration

SDK importing via drag and drop incorporates two features. Firstly the location where the SDK
will be copied, and secondly the automatic scanning of this location to create the required
Part Support. The behaviour can be explored and changed via a preference Preferences ->
MCUXpresso IDE -> SDK Handling -> Installation leading to the window below:
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Installation Le=E3 v
» i
gegeral Manage SDK usage within MCUXpresso IDE
> + 4
» Hf | SDK locations
eip
» Install/Update SDK Drag&Drop install location
» Java Workspace e Common 'mcuxpresso’ folder User defined folder

¥ Library Hover
MCUXpresso Config Tools
YMCUXpresso IDE
Debug Options (Advanced)
Debug Options (Miscellaneous)
Debug Probe Discovery
Default Tool settings
» Editor Awareness
General
J-Link Options
LinkServer Options
LPC-Link Options
MCU settings
Paths and Directories
PEMicro Options
Quickstart Panel
¥ SDK Handling

User defined folder

SDK search roots:

| /Users/NXP/mcuxpresso/02SDKPackages I
SETS, MCUXpress ackages

SDK refresh policy on startup

Refresh and recreate part info

Other options

Always unzip SDK zipped files when installing

Cumpcr}ents | Do not ask for unzipping SDK on import
Installation
Misc Do not ask for confirmation on SDK Drag and Drop install
SWO Trace Make missing SDK reference persistent
User Interface Enablement Do not ask user action for missing SDK reference in project
Utilities
Enable SDK/manifest versions switch (needs an IDE restart)
¥ Run/Debug
» Team Automatically delete wrongfincompatibie SDKs
¥ Terminal
Validation
B XML Restore Defaults Apply
Ei" Mg p/% Cancel Apply and Close

Figure 6.6. SDK Installation Preferences
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You can see in the above graphic that two search locations are present. The 02 path is the
default search path for MCUXpresso IDE version 11.0, earlier versions of MCUXpresso IDE
used the 01 path. This older path will only appear if the location actually contains installed SDKs
(typically installed via an earlier version of MCUXpresso IDE). The reason for these separate
paths is to allow users to have both the latest and older versions of MCUXpresso IDE installed
without presenting incompatible versions of SDK to older versions of the tools. Please see

for more information.

« Workspace

e Common (the default)
e User Defined

The default Common install location can be changed to either the currently selected Workspace
or a User Defined location. Once this is done, a new SDK Search Root path will automatically
be added to the seach roots list.

Note: while other search roots can be removed if desired, the currently selected drag and drop
location root cannot.

In addition, from this dialogue you can add new search paths to folders where you have stored
or plan to store SDK folders/zips. Those SDKs will appear in the Installed SDKs View along with
those from the default location when the Installed SDK view is refreshed.

The main differences between having SDKs in the default location(s) or leaving them in other
folders are:

All information provided in this document is subject to legal disclaimers © 2019 NXP Semiconductors. All rights reserved.

User Guide

Rev. 11.0.0 — 23 May, 2019 44



NXP Semiconductors MCUXpresso IDE User Guide

6.4.4

MCUXpresso IDE User Guide -

“Delete SDK” function is disabled when using non-default locations
 since these SDKs are not imported, they may be original files
The knowledge of the SDKs and their part support is per-workspace

The order of the SDKs in the SDK location list may be important on occasion: if you have multiple
SDKs for the same part in various locations, you can choose which to load by reordering. If
multiple SDK are found, a warning is displayed into the Installed SDK view.

Note: Only the default SDK location(s) is persistent between workspaces. Any other locations
must be created for each Workspace as required.

Also displayed in the dialogue (above) are a number of ‘checkbox’ options that are discussed
below:

Always Unzip SDK ... if checked, a zipped SDK will be unzipped on import.

Do not ask for unzipping .... if checked (default) the IDE will not prompt the user to consider
unzipping the SDK.

Do not ask for confirmation ... if checked, the IDE will import and SDK via drag and drop without
requesting user confirmation.

Make missing SDK reference persistent ... this setting controls the persistence setting when
the option below is checked.

Do not ask for User action ... see - if checked, this SDK association
setting will be made without prompting the user.

Enable SDK/manifest version... if multiple SDKs for the same part are installed, this option if
checked also allows an older SDK to be selected from within the Installed SDK view via a drop
down menu on the SDK Version

« also, some SDKs include older versions of the manifest (XML description), if checked, this
option allow an older manifest versions to be selected from within the Installed SDK view
via a drop down menu on the Manifest Version.

Automatically uninstall ... if checked an SDK found in drag and drop install location that is
incompatible with MCUXpresso IDE will be deleted.

Advanced Use: SDK Misc Options

Additional miscellaneous SDK preferences are also available. These checkbox options are
shown below:
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Preferences
Misc Qv v w

Debug Options (Misce
Debug Probe Discove
Default Tool settings
> Editor Awareness
FreeRTOS TAD
General
J-Link Options
LinkServer Options
LPC-Link Options
MCU settings
Paths and Directories
PEMicro Options
Quickstart Panel
¥SDK Handling
Components
Installation

SDK management misc options
Prioritize IDE supplied flash driver
Default SDK debug console to semihost on project creation/import
Include semihost hardfault handler by default on project creation/import
Enable SDK options check
Selected files from SDK View open in read-only mede

Open project main files after importing multiple SDK examples

SWO Trace
User Interface Enablel
Utilities

» Run/Debug

» Team

» Terminal

Restore Defaults

Apply

Cancel

Figure 6.7. SDK Preferences Misc
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Where:

Prioritize IDE supplied flash drivers ... typically LinkServer flash drivers are supplied as part
of the SDK part support for a particular MCU. However these LinkServer flash drivers are
usually duplicated within the IDE installation where newer versions might be found. This option,
checked by default causes the IDE supplied drivers to be used in preference to SDK supplied
flash drivers. Searching the IDE’s flash driver directory in preference to SDK dynamically part
support files also simplifies flash driver development

Default SDK debug console to semihost ... this option, checked by default, sets project defines
to select semihosting as the output format

Include semihost hardfault handler ... this option, checked by default, causes a minimal
hardfault handler to be included within new and imported projects. The purpose of this handler
is to send semihost operations to null when no debug tools are connected. Without such a
handler, any semihosted operation will halt the MCU when no debug tools are connected. This
is probably the most useful option for early project development, however this may clash with
any real hardfault handler.

Enable SDK options check ... this option, checked by default, allows the IDE to check an SDK
examples options on import and attempt to resolve any incompatible options found.

Selected files from SDK view ... this option, checked by default, forces any file opened from
the Installed SDK view to be opened in Read Only mode. This is to protect SDK files from
accidental corruption. Note: this option only applies to SDK that are imported unzipped.
Open Project main files ... when an example project is imported it will be opened within the
project explorer view and the source file containing the main function will be opened. This
option, unchecked by default, will allow this to occur if multiple files are imported at the same
time.

Important notes for SDK Users

Installing an SDK into MCUXpresso IDE adds to its default capabilities, but SDKs come in many
different configurations, and versions. The section below discusses some of the issues that users
may experience when working with SDKs.

Only SDKs created for MCUXpresso IDE can be used

If an error of the form MCUXpresso IDE was unable to load one or more SDKs is seen, the most
likely reason is that the SDK was not built for MCUXpresso IDE. Within the SDK Builder, verify
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that the Toolchain is set to MCUXpresso IDE. If necessary, reset the toolchain to MCUXpresso
IDE and rebuild the SDK.

SDK compatibility with earlier versions of MCUXpresso IDE

A new SDK version 2.6.0 has been released in parallel with MCUXpresso IDE version 11.0.0
however, this SDK format includes features that are not compatible with earlier versions of
MCUXpresso IDE. As a result, these new SDKs may fail to install or offer reduced featured when
used in older versions of MCUXpresso IDE.

To support users who might have both this and also older versions of MCUXpresso IDE installed
on their system, we have adopted a new default SDK installation location but also maintained
support for the default used by older versions (now effectively Read Only from version 10.1.0
onwards).

The result of this is that MCUXpresso IDE version 10.1.0 and later will automatically inherit any
SDKs installed into the (old) default location by previous versions of the IDE. While older versions
of the IDE will not ‘see’ any SDKs installed with MCUXpresso IDE version 10.1.0 or later.

Note: If there is no need to maintain compatibility with older versions of the IDE, it is
recommended that users migrate to using the latest SDKs where available.

Shared Part Support Handling

Each SDK package will contain part support for one or more MCUs, therefore it is possible
to have two (or more) SDK packages containing the same part support. For example, a user
might request a Tower K64 SDK and later a Freedom K64 SDK that both target the same
MK64FN1MOxxx12 MCU. If both SDKs are installed into the IDE, both sets of examples and
board drivers will be available, but the IDE will select the most up to date version of part support
specified within these SDKs. This means the various wizards and dialogues will only ever present
a single instance of an MCU, but may offer a variety of compatible boards and examples. Note: If
a board is selected (from one SDK) and part support is provided by another SDK, a message will
be displayed within the project wizard to show this has occurred but no user action is required.

If two SDKs with matching part support are installed, and the SDK providing part support later
deleted, then part support will automatically be used from the remaining SDK.

Finally, if a project created with one SDKs part support — for example Freedom K64, and then:
- that SDK is changed to another SDK with compatible part support — for example TWR K64 -
the project is shared with another user who has a different SDK that includes compatible part
support (perhaps an SDK that has only device support)

a dialogue similar to the one below will be generated for each project where this occurs:

@ Project SDK management
| The project 'MK84FN1MOxxx12_My Shared_Project' SDK 'SDK_2.x_FRDM-K64F' cannot be
found.

Please select a compatible SDK for chip ‘"MK64FN1MOxxx12' to use:

SDK_2.x_TWR-K64F120M [2.4.0] k& [ Make SDK persistent

Cancel | SN

Where the option to Make persistent will permanently change the project to be associated with
the selected SDK. If unticked, the IDE will accept the change as temporary and no data will be
written back to the project.
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6.5

6.5.1

MCUXpresso IDE User Guide -

Note: When this new association is made, the project will contain files from one SDK but be
associated with another. If the project is refreshed or the component management feature is
used, then incompatible code may be copied into the project.

Building a Fat SDK

An SDK can be generated for a selected part (processor type/MCU) or a board. If just a part is
selected, then the generated SDK will contain both part support and also board support data for
the closest matching development board.

Therefore, to obtain an SDK with both Freedom and Tower board support for say the Kinetis
MK®64... part, simply select the part and the board support will be added automatically.

If a partis chosen that has no directly matching board, say the Kinetis MK63... then the generated
SDK will contain:
e part support for the requested part i.e. MK63...

« part support for the recommended closest matching part that has an associated development
board i.e. MK64...

« board support packages for the above part i.e. Freedom and/or Tower MK64...
Uninstallation Considerations

MCUXpresso IDE allows SDKs to be installed and uninstalled as required (although for most
users there is little benefit in uninstalling an SDK). However, since the SDK provides part support
to the IDE, if an SDK is uninstalled, part support will also be removed. Any existing project built
using part support from an uninstalled SDK will no longer build or debug. Such a situation can
be remedied by re-installing the missing SDK. Note: if there is another SDK installed capable of
providing the ‘missing’ part support, then this will automatically be used.

Sharing Projects
Note: Also see below:

If a project built using part support from an SDK and is then exported — for example to share the
project with a colleague who also uses MCUXpresso IDE, then the colleague must also install
an SDK providing part support for the projects MCU.

Enhanced Project Sharing Features

Introduced in MCUXpresso IDE version 10.2.0 are a range of features designed to improve the
ease of project sharing. These features combine to streamline the sharing and collaboration
process.

Project Drag and Drop

In addition to the existing project import and export capabilities available from the Quickstart
panel, a new set of features has been introduced to ease the transfer of projects.

Previously, the import of a project required the browsing to a project location followed by an
import ...

« Projects can now be imported into a Workspace by simply dragging and dropping a folder (or
Zip) containing one or more projects into the Project Explorer view

» Projects can be copied from one IDE instance to another by simply dragging and dropping
from one Project Explorer view to another

« Projects can also be exported by dragging from the Project Explorer view onto a host filer
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« Warning: Care must be used here since the default Eclipse (Oxygen) behaviour is to
move files from the workspace rather than perform a copy. This behaviour can be
modified to copy on Mac via holding the Option Key, and on Windows via holding Ctrl.

6.5.2 Project Local SDK Part Support

One weakness of the SDK model of extending the capabilities of the IDE comes when sharing
projects with colleagues — since they must also have the same SDK installed to use this shared

project.

To avoid this problem, SDK projects (and examples) can be modified to contain a local copy of
the required SDK part support.

SDK project may be enhanced to contain local SDK part support

« SDK based projects can now import a cache of part knowledge from an installed SDK

» Simply right click on a project and select add SDK Part Support

» & Project Settings
» # Binaries
> k)l Includes
» B CMSIS
» (2 board

» (B drivers
» (2 source
» (2 startup
2 utilities
» (= Debug
» (= doc

v & MK64FN 1MOxxx12_My Shared_Project

E
New
Go Into

¥ (=5 MKBAFN TMOxxx12_My Shared_Project

¥ =i\ Project Part Support
¥ o SDK version 2.4.0 package for FRDM-K684F board
» il Boards

2

Open in New Window
Show in Local Terminal

= Copy

Paste
X Delete
Source >
Move...
Rename... F2

iy Import...
=5 Export...

Build Project

Clean Project

7 Refresh F5
Close Project

Close Unrelated Projects

Build Configurations >
Build Targets >
Index >
Validate

Run As >
Debug As >
Profile As >

Restore from Local History...
Launch Configurations
Smart update

» |y Compilers

» 441 Components
» £ Devices

» (2 Toolchain Settings
» & Toolchains

» ¢ Project Settings

» % Binaries

» kil Includes

> (2 CMSIS

» (2 board

» (S drivers

» (& source

> (2 startup

> (2 utilities

» (= Debug

» (=doc

SDK Management
Tools
B MCUXpresso Config Tools

Dl O e e Do Anal

YYRAY Y Y

f# Manage SDK Components
“» Refresh SDK Components
T Add SDK Part Support

Team
Compare With
Configure
Source

Properties 8l |

Figure 6.8. Add SDK Local Part Support

YYvYYE

¢ Such projects can then be used (in other users MCUXpresso IDEs version 10.2.0 or later)
without first downloading and installing the appropriate SDK

» In such cases, the project local part support will be visible as an installed SDK
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Name

(9 Installed SDKs 22 [7] Properties B Console [2] Problems [J Memory B3 Debugger Conscle € Instruction Trace &3 Power Measurement Tool 5] SWO Tra
@ Installed SDKs

To install an SDK, simply drag and drop an SDK (zip file/folder) into the 'Installed SDKs' view. [Common ‘mcuxpresso’ folder]

SDK Version Manifest Version Location

1 SDK_2.x_EVK-MIMXRT1020 2.4.0 3.3.0 @‘ /SDK_2.4_EVK-MIMXRT1020.zip
& 2 x EVKR-IMXRT1050 240 330 G JSDK 2 4-FVKR-IMXRT10580 max zin
| @ (=SDK_2.x_FRDM-K64F 242 3.3.0 (® <Workspace> /MK64FN1MOxxx12_Project_My_Shared_Project l
=3 X IM-KET5Z Z2.4.1 3.3.0 123 1SDK_Z.4 FRDOM-KETS5Z.zip

 SDK_2.x_LPCXpresso54618 2.41 3.3.0 [} /SDK_2.4.1_LPCXpresso54618.zip

Figure 6.9. View SDK Local Part Support

6.5.3

MCUXpresso IDE User Guide -

Note: this feature is not designed to replace the need for ultimately installing an SDK, since there
are implications in project size etc. rather it is intended as short term solution to decouple projects
from the requirement for an SDK.

Finally, local part support can be removed in the same way as it was added. Simply right click on
a project and select SDK Management -> Remove SDK Part Support. Once this has been done,
an appropriate SDK must be installed for the project to be used.

Project Local Support files

Supporting files required for debug such as flash drivers, LinkServer Connect and Reset scripts
will usually be found (automatically) either within an SDK or installed by default within the IDE.

However, on occasion, bespoke flashdrivers and/or scripts may be required. While these files
could be stored and referenced from various locations within the file system, to enhance project
sharing such files can now be included directly within a project and locally referenced.

To use script and flash driver files in this way, first they can simply be dragged into the local
Project structure:

¥ =5 MKBAFN 1MOxxx12_My Shared_Project <Debug >
» € Project Settings
» 1l Includes

2 CMSIS

2 board

2 drivers

2 source

= startup

= utilities

=doc

B MKBAFN1MOxxx12_My Shared_Project LinkServer Debug.launch

= my_connect.scp

= my_flash.cfx

¥ vV Yy Yy vy wyy

= my_reset.scp

LinkServer launch configurations can now be used to directly browse to local scripts (connect
or reset) as shown below:
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[ e ) Edit Configuration

Madify configuration and continue. ﬁv

Name: MKB4FN1MOxxx12_Project LinkServer Debug
% 6DB Debugger | LinkServer,Debugger ,, © GUI Flash Tool | % Other Symbols| b~ Startup | & Source ] Common | ™1
[® LinkServer Debugger

Debug Options

Debug Connection [SWD |7

LinkServer Options

= Debug Connection
Settings for the debug connection

Attach only | Reset on Connect

Reset script B workspace.. | File System...
[Cemecl script B workspace... ] R — LlL -
[ XuN ) Connect script
BootROM stall 1

~  Select the elements from the tree:

Flash driver reset handiing B reset nangiing | (= .settings
Disconnect behavior cont [ seminosting support | On ; > = CMSIS
¥ = Debug
= Advanced Settings | » (= board
Advanced options (=doc
Memory checking || Debug memory cache (3 Enable range stepping » (= drivers
Debuglevel |2 Override core index
Wirespeed (Hz) » (= part-support
> (= source
Additional options » (= startup
Pre launch command » (= utilities

@ | coea

Figure 6.10. Local Script file

Similarly a project local flash driver can be referenced by editing a projects memory configuration
and again browsing for the required flash driver within the project as below:
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Memory details (MK64FN1MOxxx12)*

Default LinkServer Flash Driver:

Default LinkServer Flash Driver Browse...

Type Name Alias  Location Size

=

Flash PROGRAM_FLASH Flash |0x0 0x10000Q FTFE akl.. | U
RAM SRAM_UPPER  RAM 0x20000000 0x30000

RAM SRAM_LOWER

RAM2 Ox1fff0O00 0x10000 &
RAM FLEX_RAM RAM3 Oy ganannnn avanna

MCUXpresso IDE
LinkServer flash driver

Add Flash Add RAM

Import... Merge...
i 9 Flash Driver

Flash driver | S{workspace_Joc:)/${ProiName)/MyFlash.cfx Browse project... Browse workspace...

@ @ LinkServer flash driver
—

Select the elements from the tree:

. A

B MyFlash.cfx
Board

(doc

¥ (= drivers

¥ [ part-support

» (= source

> (= startup

¥ = utilities

Selected flash driver: MyFlash.cfx

p

Figure 6.11. Local flash driver

See additionally

The features described above will rarely be required, but on the occasions where shared projects
have bespoke debug files, the above scheme should simplify the sharing and use of MCUXpresso
IDE projects.
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7. Creating New Projects using installed SDK Part
Support

For creating project using Preinstalled part support please see:

From the QuickStart Panel in the bottom left of the MCUXpresso IDE window there are two
options:

) Quickstart Panel 2 Variables Breakpoints =0

MCUXpresso IDE - Quickstart Panel

(_Uee | No project selected

~ Create or import a project

. New project...
- Import SDK example(s)...

DO PTOEC ST [TOTT e SyS e

~ Build your project

~ Debug your project ' E' ﬂ'

~ Miscellaneous

. MCUXpresso Config Tools>>
[E:? Quick Settings>>

e Build all projects []

Figure 7.1. SDK Projects

The first will invoke the New Project Wizard, that guides the user in creating new projects from
the installed SDKs (and also from preinstalled part support — which will be discussed in a later
chapter).

The second option invokes the Import SDK Example Wizard that guides the user to import SDK
example projects from installed SDKs.

This option will be explored in the next chapter.

Click New project to launch the New Project Wizard.

7.1 New Project Wizard

The New Project Wizard will begin by opening the “Board and/or device selection” page, this
page is populated with a range of features described below:
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[(D Creating project for device: MK64FN 1MOxxx12 with no board. ]4_ if i } : \ f _—

|
. Board and/or Device selection page

@JK MCUs Available boards *
s from installed SDKs

Please select an available board for your project.

NXP MKB4FN1MOxxx12
VK6
MKB4FNTMOxxx12
> LPC540xx

»LPC546xx - - E it w\?
»MIMXRT1050 FROM STBCAGNDL FROMIOMFT " — —
((sok SDK ) ( sok )

frdmk64f agm04 frdmk64f agmO1 evkbimxrt1050 om13588 evkbimxrt1050

aeinstaﬂed MCUs
s from preinstalled LPC and generic

Cortex-M part support

Target

P—
»LPC1102 (_SDK )
»LPC112x evkbimxrt1050 agmO1 FCXpresso812 LPC8NO4 Development Board
FLPCT1AxXX
»LPC11E6x
‘ »LPC11Exx
FLPC11UBx
»LPC11Uxx
»LPC11xx
‘ FLPCT TxxLV
Selected Device: MK64FN1TMOxxx12 with no board. SDKs for selected MCU
Target Core: cortex-méd Name SDK Version Manifest Versir Location
k B - (= i
Deseription: 4+ SDK_2.x_FRDM-KB4F  2.4.0 3.3.0 (% <Default Location>/SDK_2.x_FRD
K64_120: Kinetis® K64-120 MHz, 256KB SR} opdhtrollers
(MCUs) based on ARME@ Cortex®-M4 Core
@ BEEEE | conce
| &

Figure 7.2. New Project Wizard first page

1. Adisplay of all parts (MCUSs) installed via SDKs. Click to select the MCU and filter the available
matching boards. SDK part support can be hidden by clicking on the triangle (highlighted in
the blue oval)

2. A display of all preinstalled parts (these are all LPC or Generic M parts). Click to select the
MCU and filter the available matching boards (if any). Preinstalled part support can be hidden
by clicking on the triangle (highlighted in blue)

3. A display of all boards from both SDKs or matching LPCOpen packages. Click to select the
board and its associated MCU.

* Boards from SDK packages will have SDK superimposed onto their image.

4. Some description relating to the users selection

5. A display to show the matching SDK for a chosen MCU or Board. If more than one matching
SDK is installed, the user can select the SDK to use from this list

6. Any Warning, Error or Information related to the current selection

7. An input field to filter the available boards e.g. enter ‘64’ to see matching MK64... Freedom
or Tower boards available

8. 3 options: to Sort boards from A-Z, Z-A or clear any filter made through the input field or a
select click.

Note: Once a project has been created the selected board and/or MCU will be remembered and
selected the next time the wizard is entered. To remove this selection, click the clear filter button
(or any background white space).

This page provides a number of ways of quickly selecting the target for the project that you want
to create.
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In this description, we are going to create a project for a Freedom MK64xxx board (The required
SDK has already been imported).

First, to reduce the number of boards displayed, we can simply type ‘64’ into the filter (7). Now
only boards with MCUs matching ‘64’ will be displayed.

e o SDK Wizard
reating project for device: MKB64FN 1MOxxx 12 using board: FRDM-KB4F
Creating project for devi 6 0; 2 using board 6

|
. Board and/or Device selection page

~ SDK MCUs Available boards %1%

MCUs from installed SDKs Please select an available board for your project.

NXP MKG4FN1MOxxx12
YKEX
MKBAFN1MOxxx12 ]
FLPCEA0K
» LPC546xx
» MIMXRT1050

ROM B4~

Y28 1 SDK M-STEC-AGH L ( SDK

frdmkgaf frdmk64f mult2b frdmk64f om13588 framk64f agm04

~ Preinstalled MCUs
MCUs from preinstalled LPC and generic
Cortex-M part support

Target

»LPC1102
FLPC112x
»LPC11Axx
»LPC11EBx
‘ »LPCT1Exx
»LPC11U6x frdmk64f agm01
»LPC11Uxx
FLPCT1xx
‘ FLPCT1xxLV
Selected Device: MK64FN1MOxxx12 using board: FRDM-K64F SDKs for selected MCU
Target Core: cortax=md Name SDK Version Manifest Versior Location
Description:  SDK_2.x_FRDM-KE4F 2.4.0 3.3.0 (% <Default Location>/SDK_2.x_FRD
K64_120: Kinetis® K64-120 MHz, 256KB SRAM Microcontrollers
(MCUs) based on ARM® Cortex®-M4 Core
@ [ Next> ] Cancel

Figure 7.3. New Project Wizard selection

When the (SDK) board is selected, you can see highlighted in the above figure that the matching
MCU (part) and SDK are also selected automatically.

With a chosen board selected, now click ‘Next'...

7.1.1 SDK New Project Wizard: Basic Project Creation and Settings

The SDK New Project Wizard consists of two pages offering basic and advanced configuration
options. Each of these pages is preconfigured with default options (the default options offered
on the advanced page may be set based on chosen settings from the basic page).

Therefore, to create a simple ‘Hello World’ C project for the Freedom MK64... board we selected,
all that is required is simply click ‘Finish’.

Note: The project will be given a default name based on the MCU name. If this name matches a
project within the workspace e.g. the wizard has previously been used to generate a project with
the default name, then the error field will show a name clash and the ‘next’ and ‘finish’ buttons
will be ‘greyed out’. To change the new project’'s name; the blank ‘Project Name Suffix’ field can
be used to quickly create a unique name but retain the original prefix.
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This will create a project in the chosen workspace taking all the default Wizard options for our
board.

However, the wizard offers the flexibility to select/change many build, library and source code
options. These options and the components of this first Wizard page are described below.

@

[ AN ) SDK Wizard
1, The source from the SDK will be copied into the workspace. f 7
If you want to use linked files, please unzip the 'SDK_2.x_FRDM-KB4F' SDK.
. Configure the project
[Pmiect name: MKG64FN1MOxxx12_Project [ Project name suffix:
Use default location
Location:
Device Packages / Board roject Type roject Options
MKB4FN1MOVDC12 © Default board files © c Project C++ Project SDK Debug Console @ Semihast () UART
O MK64FNTMOVLL12 i Empty board files C Static Library C++ Static Library CMSIS-Core
MKB4FN1MOVLQ12 Copy sources
_ Import other files
Components = ﬁ‘ Y & {11
Add or remove SDK software components
‘Ouerating Systems WMSIS Drivers \ Ut.ilities: Middleware | Board Cdmponents | Abstraction Layer| Software Componenty Name Description Version|
¥ S Drivers
rivers Pade ADC16 Driver 2.0.2
i3 clock Clock Driver  2.1.0
Name Description & common COMMON Dri... 2.1.0
2 o ﬁ:}dspi DSPI Driver  2.2.1
o o & gpio GPIO Driver ~ 2.3.2
Bomp EMP Driver izc 12C Driver 2.0.9
Bemt CMT Driver i port PORT Driver  2.1.0
o o i rtc RTC Driver 2.2.0
fgere CRC Driver 2.01 ik sme e Db 2R
& dac DAC Driver 201 ol HARTRIWE SN2 10
4 dmamux DMAMUX Driver 2.0.2 " = Operating Systems
o & » £ Software Components
4 dspi_edma DSPI Driver 221 =i
41} dspi_freertos DSPI Driver 2.2.1
gt edma EDMA Driver 21.8
A enet ENET Driver 224
4} ewm EWM Driver 201

Figure 7.4. New Project Wizard basic SDK settings

O_ J

< Back Next > Cancel [ Finish ]

1.
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Project Name: The default project name prefix is automatically selected based on the part

selected on the previous screen

« Note: Due to restrictions in the length of filenames accepted by the Windows version of the
underlying GCC toolchain, it is recommended that the length of project names is kept to 56
characters or less. Otherwise you may see project build error messages regarding files not
being found, particularly during the link step.

. Project Suffix: An optional suffix to append to a project name can be entered here.
. Errors and Warnings: Any error or warning will be displayed here. The ‘Next’ option will not be

available until any error is handled. Errors may include such things as dependency problems or
for example, a project name may have been selected that matches an existing project name in
your workspace. The suffix field (2) allows a convenient way to create a unique project name.

. MCU Package: The device package can be selected from the range contained with the SDK.

The package relates to the actual device packaging and typically has no meaning for project
creation.

. Board files: This field allows the automatic selection of a default set of board support files, else

empty files will be created. If a part rather than a board had been selected on the previous
screen, these options will not be displayed.
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« If you intend to use board specific features such as output over UART, you should ensure
Default board files are selected.
6. Project Type: C or C++ projects or libraries can be selected. Selecting ‘C’ will automatically
select RedLib libraries, selecting C++ will select NewlibNano libraries. See

7. Project Options:

« Semihost: will cause the Semihosted variant of the chosen library to be selected. For C
projects this will default to be Redlib Semihost-nf. Semihosting allows IO operations such
as printf and scanf to be emulated by the debug environment.

« UART: will cause the the nohost variant of the chosen library to be selected. For C projects
this will default to be Redlb Nohost. 10 operations such as printf and scanf will occur via
UART (or emulated UART provided by the debug probe over USB)

¢ CMSIS-Core: will cause a CMSIS folder containing a variety of support code such as Clock
Setup, header files to be created. It is recommended to leave this options ticked

« Copy Sources: For zipped SDKs, this option will be ticked and greyed out. For unzipped
SDKs, projects can be created using linked references to the SDK sources.

8. Components:
¢ OS: This provides the option to pull in and link against Operating System resources such

as FreeRTOS.

« Driver: enables the selection of supporting driver software components to support the MCU
peripheral set.

« CMSIS Drivers: code and headers for standard arm hardware

« Utilities: a range of optional supporting utilities.

* For example select the debug_console to use SDK Debug Console handling of 10
» Selecting this option will cause the wizard to substitute the (SDK) PRINTF() macro for C
Library printf() within the generated code
» The debug console option relies on the debug probe communicating to the host via
VCOM over USB (LPC-Link2 and OpenSDA debug probes support this feature)

« Middleware: enables the selection of various middleware components

« Depending on the SDK selected, additional options may also appear

9. Each set of components support a filter and check boxes for selection. These icons allow
filters to be cleared, all check boxes to be set, all check boxes to be cleared.

10. Enable or Disable Component Selection Summary view: Since the selected software
components cannot be viewed together, an optional summary view can be selected via this
button. This setting will be remembered as a workspace preference.

11. Summary view of the software components selected for the project being created enabled
as enabled via the above option.

Finally, if there is no error condition displayed, ‘Finish’ can be selected to finish the wizard,
alternatively, select ‘Next’ to proceed to the Advanced options page (described next).

Important Note: Any components (OS, driver, utilities, middleware etc.) selected by default
within this wizard will be be available for use within the project. However the linker may remove
the components supporting functions from the generated image if they are not referenced from
within the users project code. Additionally, selecting a component will automatically select any
dependencies. Finally, please also note that this is an additive process, removing components
may leave unresolved dependencies resulting in a project that will not build.

Note: Some middleware components are not currently compatible with the New project wizard

functionality and so will be hidden. The recommended approach if such components are required

is to import an example including the component and then modify this as required. Please see
for details of how this might be done.

Note: By default, new project files are stored within the current MCUXpresso IDE workspace,
this is recommended since the workspace then contains both the sources and project
descriptions. However, the New Project Wizard allows a non default location to be specified if
required. To ensure that each project’s sources and local configuration are self contained when
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using non standard locations, the IDE will automatically create a sub directory inside the specified

location using the Project name prefix setting. The newly created project files will then be stored
within this location.

7.1.2 SDK New Project Wizard: Advanced Project Settings

The advanced configuration page will take certain default options based on settings from the

first wizard project page, for example a C project will pre-select Redlib libraries, where as a C+
+ project will pre-select NewlibNano.

[ JeN J SDK Wizard

. Advanced project settings

Mo
0

(' CiC++ Library Settings
Set library type (and hosting variant)  Rediib (semihost-nf) B

| Redlib: Use floating point version of printf

Redlib: Use character rather than string based printf J

Redirect SDK "PRINTF" to C library "printf” | Redirect printf/scanf to ITM
Include semihost HardFault handler Redirect printf/scanf to UART

(~ Hardware settings

Set Floating Pointtype  ppya (HardABI)
\

[~ MCU C Compiler ] ’

Language standard = Compiler default
\

[~ MCU Linker

L Link application to RAM
'/ﬂ!mury Eﬂﬂ |gural|nn Q
Memory details

Default LinkServer Flash Driver Browse...
Type Name Alias Location Size Driver —
Flash PROGRAM_FLASH Flash Ox0 0x100000 FTFE_4K.cfx hial
RAM SRAM_UPPER RAM 0x20000000 0x30000 .
RAM SRAM_LOWER RAM2 Ox1fff0000 0x10000 #
RAM FLEX_RAM RAM3 0x14000000 0x1000

Add Flash Add RAM Split Delete

\mport... Merge... Export... Generate... /

@ < Back cancel | (EEIEINEN

Figure 7.5. New Project Wizard advanced SDK settings

1. This panel allows the selection of library variants. See . Note: if
a C++ project was selected on the previous page, then the Redlib options will be Greyed out.

Redlib (none)
Redlib (nohost)
Redlib (semihost)
Redlib (nohost-nf)

+ Redlib (semihost-nf) 1
Redlib (semihost-mb)
Redlib (semihost-mb-nf)
NewlibNano (none)
NewlibNano (nohost)
NewlibNano (semihost)
Newlib (none)

Newlib (nohost)
Newlib (semihost)
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MCUXpresso IDE User Guide -

« Also, based on the selection, a number of options may be chosen to modify the capability
(and size) of printf support

¢ Redlib Floating Point printf: If this option is ticked, floating point support for printf will
automatically be linked in. This will allow printf to support the printing out of floating point
variables at the expense of larger library support code. Similarly for Newlib.

¢ Redlib use Character printf: selecting this option will avoid heap usage and reduce code
size but make printf operations slower.

2. This panel allows options to be set related to Input/Output. See

¢ Redirect SDK “PRINTF": many SDK examples use a PRINTF macro, selecting this option
causes redirection to C library 10 rather than options provided by the SDK debug console.

¢ Include Semihost Hardfault Handler: selected by default, this option when checked will add

a hardfault handler to the project sources. This handler is specifically written to deal with

the situation that will occur if a semihosted function such as printf is executed when no

debug tools are attached to support the operation. If this occurs, this handler will catch

the operation and safely return to the executing application. Uncheck this option if you do

not wish to use semihosted libraries or you intend to use your own hardfault handler. See
for more information.

* Redirect printf/scanf to ITM: causes a C file 'retarget_itm.c to be pulled into your project.
This then enables printf/scanf 1/0O to be sent over the SWO channel. The benefit of this is
that 1/0O operations can be performed with little performance penalty. Furthermore, these
routines do not require debugger support and for example could be used to generate logging
that would effectively go to Null unless debug tools were attached. Note: This feature is not
available on Cortex MO and MO+ parts.

« More information can be found in the MCUXpresso IDE SWO Trace Guide.

¢ Redirect printf/scanf to UART: Sets the define SDK_DEBUGCONSOLE_UART causing the
C libraries printf functions to re-direct to the SDKs debug console UART code.

3. Hardware Settings: from this drop down you can set options such as the type of floating point

support available/required. This will default to an appropriate value for your MCU.

None
FPv4 (SoftABI)
Set Floating Point type v Fpy4 (HardABI)

~ Hardware settings

. MCU C Compiler: from this drop down you can set various compiler options that can be set

for the GNU C/C++ compiler.

~ Hardware sotti GNU C89 (-std=gnu99)
GNU C11 (-std=gnu11)
Set Floating Point{ SO C90 / ANS| C89 (-std=c90)
ISO C99 (-std=c99)
~ MCUC Compili SO C11 (-std=c11)
GNU C90 (-std=gnu80)
Language standar¢ » Compiler default

. Link Application to RAM checkbox reflects or sets the option to force the linker to ignore any

defined flash regions and link the application to the first RAM region defined. This option is
a copy of the flag at Properties -> C/C++ Build -> Settings -> Managed Linker Script -> Link
application to RAM Note: This setting is only sensible for projects under development, since
debug control or a bootloader is required to load the code/data into RAM and simulate a
processor reset.

. Memory Configuration: This panel shows the Flash and RAM memory layout for the MCU

project being created. The pre-selected LinkServer Flash driver is also shown. Note: this Flash
driver will only be used for LinkServer (CMSIS-DAP) debug connections.

« From this dialogue, the project’s default memory setting may edited in place if required and
hence also the automatically generated linker scripts. See
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7.2 SDK Build Project

To build a project created by the SDK New Project Wizard, simply select the project in the ‘Project
Explorer’ view, then go to the ' QuickStart' Panel and click on the build button to build the
project. This will build the project for the default projects ‘Debug’ configuration.

Note: MCUXpresso IDE projects are created with two build configurations, Debug and Release
(more can be added if required). These differ in the default level of compiler optimization. Debug
projects default to None (-O0), and Release projects default to (-Os). For more information
on switching between build configurations, see

The build log will be displayed in the console view as below.

[ Installed SDKs [T Properties & Console 2 [ Problems [ Memory & Instruction Trace [ SWO Trace Config B2 Power Measurement Tool ELRE = s % ™MBE-r5-= B8
CDT Build Console [MKB84FN1MOxxx12_Project]

Building file: ../CMSIS/system_MKE4F12.c

Invoking: MCU € Compiler

arm-none-eabi-gec -DCR_INTEGER_PRINTF -DSDK_DEBUGCONSOLE-® -D__MCUXPRESSO -D__USE_CMSIS -DDEBUG -DSDK_OS_BAREMETAL -DFSL_RTOS_BM -DCPU_MKE4FNIM@VDC1Z -DCPU_MKGAFNIMAVDC1Z cmd -|
Finished building: ../startup/startup_mk64f12.c

Finished building: ../source/MKB4FN1MOxxx12_Project.c

Finished building: ../(MSIS/system_MK64F12.c

Building target: MK6AFNIMBxxx12_Project.axf
finwolking: MCU Linker
brm-none-eabi-gcc -nostdlib -Xlinker -Map="MK64FN1MBxxx12_Project.map" -Xlinker --gc-sections -Xlinker -print-memory-usage -mcpu=cortex-md -mfpu=Fpvd-sp-d16 -mfloat-abi=hard -m

Memory region Used Size Region Size %¥age Used
PROGRAM_FLASH: 8216 B 1 MB 9.78%
SRAM_UPPER: 8392 B 192 KB 4.27%
SRAM_LOWER: @ GB 64 KB 2.00%
FLEX_RAM: @ GB 4 KB 9.00%

Finished building target: MKE4FNIM@xxx12_Project.axf

make --no-print-directory post-build
Performing post-build steps
arm-none-eabi-size "MKG4FNIM@xxx12_Project.axf"; # arm-none-eabi-objcopy -v -0 binary "MKG4FNIMBxxx12_Project.axf" "MKE4FNIMBxxx12_Project.bin” ; # checksum -p MKB4FNIMBxxx12 -
kext data bss dec hex filename
8212 4 8388 16604 4@dc MKBAFNIMAxxx12_Project.axf

15:15:30 Build Finished (took 669ms}

Figure 7.6. New Project Wizard Build

The projects memory usage as highlighted above is shown below:

Menory region Used Size Region Size %ge Used

PROGRAM_FLASH: 8216 B 1M 0. 78%
SRAM_UPPER: 8392 B 192 KB 4.27%
SRAM_LOVER: 0GB 64 KB 0. 00%
FLEX_RAM 0GB 4 KB 0. 00%

Fi ni shed building target: MK64FN1M)xxx12_Proj ect . axf

By default, the application will build and link against the first Flash memory found within the
devices memory configuration. For most MCUs there will only be one Flash device available.
In this case our project requires 8216 bytes of Flash memory storage, 0.78% of the available
Flash storage.

RAM will be used for global variable, the heap and the stack. MCUXpresso IDE provides a flexible
scheme to reserve memory for Stack and Heap. The above example build has reserved 4KB
each for the stack and the heap. Please See

for detailed information.

Please also see for details of how to explore the composition of an
image in detail.
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8. Importing Example Projects (from installed SDKSs)

In addition to drivers and part support, SDKs also deliver many example projects for the target
MCU.

To import examples from an installed SDK, go to the QuickStart panel and select Import SDK
example(s).

Figure 8.1. SDK Example

) Quickstart Panel 2 Variables Breakpoints = =]

MCUXpresso IDE - Quickstart Panel
_me | No project selected

~ Create or import a project

proiect
B import SDK example(s)... ]

~ Build your project

~ Debug your project ' E' H'

8-

~ Miscellaneous

. MCUXpresso Config Tools>>
& Quick Settings>>

lo Build all projects []

MCUXpresso IDE User Guide -

This option invokes the Import SDK Example Wizard that guides the user to import SDK
example projects from installed SDKs.

Like the New Project wizard, this will initially launch a page allowing MCU/board selection.
However now, only SDK supported parts and boards will be presented.
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D L ] SDK Import Wizard
@ Importing project(s) for device: MK64FN1MOxxx12 using board: FROM-K64F } ’ l i 7
. Board and/or Device selection page

~ SDK MCUs Available boards L5

MCUs from installed SDKs Please select an available board for your project

NXP MKB4FN1MOx0c12
TK6x
MKBAFNTMOxxx 12

FLPC540xx
»LPC546xx
»MIMXRT1020
»MIMXRT1050

&

-
\_SDK )

FROWFESMULTZE FRONSTEC AGIE FROM KEaF
3

SDK )

SDK ) )

frdmk84f frdmk&4f mult2b frdmk64f om13588 frdmk8&4f agm04

frdmké41 agm01

Selected Device: MK64FN 1MOxxx 12 using board: FRDM-K64F SDKs for selected MCU

Name SDK Version  Manifest Versio Location
SDK_2.x_FRDM-KB4F 2.4.0 £2 <Default Location>/SDK_2.x_FH

Target Core: cortex-mé4
| Description:

K64_120: Kinetis® K64-120 MHz, 256KB SRAM Microcontrollers
{MCUs) based on ARM® Cortex®-M4 Core

@ [ re> UGS

Figure 8.2. SDK Example Board

8.1 SDK Example Import Wizard

Selection and filtering work in the same way as for the but please be
aware that examples are created for particular development boards, therefore a board must be
selected to move to the ‘Next’ page of the wizard.

8.1.1 SDK Example Import Wizard: Basic Selection

The SDK Example Import Wizard consists of two pages offering basic and advanced
configuration and selection options. The second configuration page is only available when a
single example is selected for import. This is because examples may set specific options, and
therefore changing settings globally is not sensible.

The first page offers all the available examples in various categories. These can be expanded to
view the underlying hierarchical structure. The various settings and options are explained below:
Note: The project will be given a default name based on the MCU name, Board name and
Example name. If this name matches a project within the workspace e.g. the wizard has
previously been use to generate an example with the default name, then the error field will show
a name clash and the ‘next’ and ‘finish’ buttons will be greyed out. To change the new example
name, the blank ‘Project Name Suffix’ field can be used to quickly create a unique name but
retain the original prefix e.g. add ‘1.

MCUXpresso IDE will create a project with common default settings for your chosen MCU and
board. However, the wizard offers the flexibility to select/change many build, library and source
code options. These options and the components of this first Wizard page are described below.
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[ NN ] SDK Import Wizard

€3 Please select one or more examples to import ] k | i /

. Import projects
[ Project name prefix: frdmk64f_ i [PrujecI name suffix: i

Use default location

Location:

[Proiect Type Project Options

SDK Debug Console * Semihost UART Example default

Copy sources

Import other files

[lexamples p d OEELICE)

Version
» £ aws_examples \‘
| » £ cmsis_driver_examples

» £ demo_apps

» = driver_examples

» = emwin_examples
» S lwip_examples

~| » = mmcau_examples

| » = multiprocessor_examples
~1 » E rtos_examples
~| » = se_hostlib_examples

|k = usb_examples /

< Back Cancel

Figure 8.3. SDK Example Selection

1. Project Name: A project name is automatically created with the form:
boardname_examplename

2. Project Suffix: An optional suffix to append to a project name can be entered here. This is
particularly useful if you are repeating an import of one or more projects since an entry here
can make all auto generated names unique for the current workspace...

3. Project Type: These will be set by the pre-set type of the example being imported. If more
than one example is imported, then these options will appear greyed out.

4. Project Options:

¢ ‘SDK Debug Console’: Once an example(s) has been selected, this option can be used to
control IO between semihost console, UART or the examples default setting.

e ‘Copy sources’: For unzipped SDKs, you can untick this option to create project containing
source links to the original SDK files. This option should only be unticked with care, since
editing linked example source will overwrite the original files!

« ‘Import other files’: By default, non source files such as graphics are filtered out during
import, check this box to import all files.

5. Examples Filter: Enter text into this field to find possible matches, for example enter ‘LED’ or
‘bubble’ to find examples present in many SDKs. This filter is case insensitive.

6. Examples: The example list broken into categories. Note: for some parts there will be many
potential examples to import

7. Various options (from left to right):
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¢ Opens a filer window to allow an example to be imported from an XML description. This is
intended as a developer feature and is described in more detail below.

¢ Clear any existing filter

¢ Select (tick) all Examples

¢ Clear all ticked examples

¢ Open the example structure
¢ Close the example structure

Finally, if there is no error condition displayed, ‘Finish’ can be selected to finish the wizard,
alternatively if only one example has been selected the option to select ‘Next’ to proceed to the
Advanced options page is available (described in the next section).

Note: SDKs may contain many examples, 146 is indicated for the FRDM MK64 SDK example
shown below. Importing many examples will take time ... Consider that each example may consist
of many files and associated description XML. A single example import may only take a few
seconds, but this time is repeated for each additional example. Furthermore, the operation of the
IDE maybe impacted by a large number of project in a single workspace, therefore it is suggested
that example imports be limited to sensible numbers.

Note: Due to restrictions in the length of flenames accepted by the Windows version of the
underlying GCC toolchain, it is recommended that the length of project names is kept to 56
characters or less. Otherwise you may see project build error messages regarding files not being
found, particularly during the link step.

Figure 8.4. SDK Example Selection Many

i, The source from the SDK will be copied into the workspace. z 7
If you want to use linked files, please unzip the 'SDK_2.x_FRDM-K64F' SDK. The advanced options page is disabled when either
. Import projects
Project name prefix: framk6af Project name suffix:
¥| Use default location
Location:
Project Type Project Options
C Project (' C++ Project | C Static Library () C++ Static Library SDK Debug Console () Semihost | | UART (= Example default
MCUXpresso IDE
You have selected '146' projects to import.
Import may take a considerable amount of time.
Examples 2 4 MK BE
———

3
3

Version

‘S cmsis_driver_examples
v'E dspi
= cmsis_dspi_edma_b2b_transfer_master
= cmsis_dspi_edma_b2b_transfer_slave
= cmsis_dspi_int_b2b_transfer_master
£ cmsis_dspi_int_b2b_transfer_slave
vE j2¢
= cmsis_i2c_edma_b2b_transfer_master
" emsis_i2c_edma_b2b._transfer_slave
5 cmsis_i2c_int_b2b_transfer_master
" cmsis_i2c_int_b2b_transfer_slave
cmsis_i2c_read_accel_value_transfer
vE uart

NENRRRFRRREERNE

3
@ < Back Cance

8.1.2

MCUXpresso IDE User Guide -

SDK Example Import Wizard: Advanced options

The advanced configuration page (shown below) will take certain default options based on the
examples selected; for example, a C project will pre-select Redlib libraries, whereas a C++ project
will pre-select NewlibNano.
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SDK Wizard
} N e/
. Advanced project settings
(it ey O
C/C++ Library Settings
Set library type (and hosting variant) = Rediib (semihost-nf) B

Redlib: Use floating point version of printf
Redlib: Use character rather than string based printf

Redirect SDK "

Include semihost HardFault handler

PRINTF" to C library "printf* Redirect printf/scanf to ITM

Redirect printf/scanf to UART

(~ Hardware settings

Set Floating Pointtype  £py4q (HardABI) “
"
(~ MCcuC Compiler

Language standard = Compiler default H
\

[~ MCU Linker

Link application to RAM p

Default LinkServer

Type
Flash
RAM
RAM
RAM

Add Flash

9
~Memory Conliguration Q
Memory details

\mport... Merge... Export... Generate... /

Flash Driver Browse...
Name Alias Location Size Driver ~
PROGRAM_FLASH Flash Ox0 0x100000 FTFE_4K.cfx x
SRAM_UPPER RAM 0x20000000 0x30000 i
SRAM_LOWER RAM2 Ox1fff0000 0x10000 w2
FLEX_RAM RAM3 0x14000000 0x1000

Add RAM Split Delete

«Q

Figure 8.5. New Project Wizard advanced SDK settings

< Back cancel I

8.1.3

MCUXpresso IDE User Guide -

These settings closely match those in SDK New Project Wizard description. Therefore see

for a description of these options. Note: Changing
these advanced options may prevent an example from building or executing.

SDK Example Import Wizard: Import from XML fragment

This option works in conjunction with the ‘Project Explorer’ -> Tools -> Generate Example XML
(and is also used to import project created by the MCUXpresso Config Tools Project Generator).

The functionality here is to merge existing sources within a selectable board package framework.

To create an XML “fragment” for an existing project in your workspace, right click on the project

in the ‘Project Explorer’ (or just in the ‘Project Explorer’ view with no project selected) and choose
Tools->Generate examples.xml file

The selected project or all the projects in the workspace (if no projects are selected) will be
converted into a fragment within a new folder created in the workspace itself:
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(5 Project Explorer 52 2. Peripherals+ i} Regi

(=]=]

¥ [=r boards
v (= frdmke4f
¥ (= dummy
¥ [ Category
> (> MKB4FN1MOxxx12_Project
[£] examples.xml
b =5 frdmk64f_demo_apps_bubble

To create a project from a fragment, click on “Import SDK examples...” in the QuickStart Panel
view:

Then select a board and then click on the button “Import from XML...” (highlighted below and
described in the previous section). You will see the examples definitions from the external
fragment in list of examples as shown and selected below.

. @ @ SDK Import Wizard
A r’ y
| () You have selected '1° projects to import. } L LE_I/
I . Import projects :
Project name prefix  fromusdf Project name suffix: yyy Iraqmsnﬂ

Usa default location

Location;

Project Typa Project Options

O C Project Capy sources

Examples @ vV R BB
| Mamo irnion

» = cmais_driver_examples

» = dema_apps

» = driver_examples

» 5 emwin_examples

¥ 5 mmcau_sxamples

r = multiprocessor_examples
» o ros_sxamples

¥ & dummy
a ¥ = Category
a MKBAFN 1MOxxx12_Project

@ < Back Next » Cancel [ Finish |

Select the external examples you want to re-create and click on “Finish”. The project(s) will be
created in the workspace.
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8.1.4 Importing Examples to non default locations

By default, imported example sources will be stored within the current MCUXpresso IDE
workspace, this is recommended since the workspace then contains both the sources and
project descriptions. However, the Import SDK Example Wizard allows a non default location
to be specified if required. To ensure that each project’s sources and local configuration are self
contained when using non standard locations, the IDE will automatically create a sub directory
inside the specified location using the Project name prefix setting. Single or multiple imported
projects will then be stored within this location.
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9. SDK Project Component Management

Projects and examples created from SDKs contain a number of software components such as
peripheral drivers and/or middleware. In previous versions of MCUXpresso IDE, the option to
add components was only available when creating a new project and not possible for imported
examples. Introduced in MCUXpresso IDE version 10.1.0 is the ability to easily add (or remove)
SDK components to a previously created or imported example project via a new Manage SDK
components wizard. To launch the Manage SDK Components wizard, simply select the chosen
project in the Project explorer view and then click the package icon as indicated below:

{5 Proje 82 % Perip iliiRegis fFault = O
¥ 125 MKBAFN 1MOxxx 12_Project ZDEBUg>
» €& Project Settings
» il Includes

» B CMSIS ® Manage SDK components for project MK64FN 1MOxxx12_Project

» (5 board ‘

» @ componeng !, Adding/removing components could potentially break your project. Please use this feature carefully. T

» (£ device ;quj
» (& drivers

» (2 source Available SDK components

» 8 startup

. Copy sources
> (2 utilities

» =doc Import other files

Components — Components selection summary
Add or remove SDK software components

Operating Systems |Drivers \, CMSIS Drivers | Utilities | Middleware | Board Components | Abstraction Layer | Software Components Name Description  Version
: " ¥ £ Drivers
ki e ade ADC16D... 2.0.2
&+ clock Clock Driver 2.1.0
Mame Description Version 4 common COMMON... 2.1.0
8 [Bade ADC18 Driver 202 Qi dspi DSPI Driver 2.2.1
e & 43+ gpio GPIO Driver 2.3.2
Hemp CMP Driver 2.0.1 -‘ﬁ;iZC 12C Driver  2.0.9
& emt . CMT Driver 202 Al port PORT Driver 2.1.0
B Click to add Brc RTC Driver 2.2.0
CRC Driver 2.0. itk sme SMC Driver 2.0.5
DAC Driver 2.0.1 A uart UART Driver 2.1.6
DMAMUX Driver 202 > £ Operating Systems
DSPI Driver 2.2.1 » £ Software Components
DSPI Driver 221 > £ Utilities
4 dspi_freertos DSPI Driver 221
+edma EDMA Driver 218
Ak enet ENET Driver 224
<k ewm EWM Driver 2.01
@ cancel | (ECTENNN

Figure 9.1. Manage SDK Components

Note: This powerful feature can add (or remove) SDK components and their dependencies at
a source file level, relying on meta data contained within the SDK. However the following points
should also be noted:

e The IDE can only maintain dependencies between SDK components. SDK component
functions referenced from user-created files or from sources such as an SDK example’s main()
function will not be taken into account when determining the safe removal of components.
Therefore, the IDE cannot always prevent users removing components that may actually be
required for a successful project build.

« Defined symbols will not be removed when components are removed, therefore users should
ensure only required symbols are present if components are removed. Failing to do this may
lead to project build failures.

Various SDK Component Management options are available from Preferences -> MCUXpresso
IDE -> SDK Handling -> Components .

9.1 SDK Project Component Management example

To demonstrate the use of this feature, the dac driver will be added to a project. To do this, launch
the Manage SDK components wizard, and click on the dac driver component then click ‘OK’.
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Next, a dialogue will be presented listing all of the source files required by this component — as

below.
2] [ ] SDK Component Management
' The following files will be added or updated if required:
Component source Project Path(s) Infio

v 4
L CH

v -E:;- dac drivers 2.0.1
v =i devices/MKB64F12/drivers drivers SRC

= fsl_dac.c
v =i devices/MKB4F12/drivers drivers C_INCLUDE
=| fsl_dac.h

v A
Y-

v Bcioct
¥
L e

v
v !
L 2

v i
L

Skip addfremove components confirmation in future

No [ Yes ]

Figure 9.2. SDK Component Management

Note: Many of these files may already be included within your project.

Click ‘Yes’ to add these source files to your project.

Important Note: Since your project may contain edited or entirely new versions of the required
source files, MCUXpresso IDE will perform a comparison between the new files to be included

and any existing files already within the selected project.

Should a source file difference be found, then a dialogue as below will be launched:
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Figure 9.3. SDK Component Management file difference

1 The file 'system_MKG4F12.¢c' already exists in your project but is different from the SDK
component file.

NOTE: 'system_MKG4F12.¢c' could belong to the selected component(s) or one of its
dependent components.

Please select from the following options:

Remember my decision.

Replace Keep existing Compare

From here you can choose from the following options:

* Replace click to overwrite the projects file from the SDK version.
« Keep Existing click to keep the existing project file unchanged.

e Compare click to compare the two files — this will launch the Eclipse file compare utility so the
new SDK file can be compared with the projects copy.

In this example, we will click ‘Compare’ ...

Below, you can see that a user project source modification has been found:

Figure 9.4. SDK Component Management file compare

e- @ Compare

C Compare

| [ Translation Unit

C Compare Viewer ~ bl [ Pt SN

|
Workspace: Workspace: [MKB4F...oject/CMSIS/system_MKB4F12.c | | fit SDK: devices/MK64F 12/system_MKB4F12.c
| 11 /7 A user code change has been made here
| | 7"'"7J |
1 =
114 -- Core clock
-t |
| || L6
117 uint32_t SystemCoreClock = DEFAULT_SYSTEM_CLOCK; 117 uint32_t SystemCoreClock = DEFAULT_SYSTEM_CLOCK;
118 118
R e L e
|| R SystemInit() 1. SystemInit()
121 rmmmmmmmmmmsemrmm T s e ————— 1 e e
a2z 122
123 wvoid SystemInit (void) { 123 void SystemInit (void) {
124 #1F ((__FPU_PRESENT == 1) && (__FPU_USED == 1)) |124 #1F ((__FPU_PRESENT == 1) && (__FPU_USED == 1))
P [lize  &PR-<rBAFR 1= FERIN o 40%3% | FUN oo 11%23) sl lize  CQFR-<FBAFR 1= FFRIN oo AB%3Y | £ oo 11%23) .

Left: 116 : 1, Right: 111 : 1, no diff

(';?) Cancel

The Compare utility allows any change to be examined and a decision made regarding which
code lines to choose or ignore. When the decisions have been made, click ‘Commit’ to use these
changes or ‘Cancel’ to leave the project file unchanged.

Finally please note the application build sizes before the addition:

Menory region Used Size Region Size %age Used
PROGRAM_FLASH: 13348 B 1 MB 1.27%
SRAM_UPPER: 8444 B 192 KB 4.29%
SRAM_LOVER: 0 & 64 KB 0. 00%
FLEX_RAM 0GB 4 KB 0. 00%
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9.2

Fi ni shed buil ding target: MG64FNLIM)xxx12_Proj ect . axf

Followed by the application sizes after the addition.

Menory regi on Used Size Region Size %age Used
PROGRAM_FLASH: 13348 B 1 MB 1.27%
SRAM_UPPER: 8444 B 192 KB 4.29%
SRAM_LOVNER: 0 &8 64 KB 0. 00%
FLEX_RAM 0 & 4 KB 0. 00%

Fi ni shed building target: MG64FNLM)xxx12_Proj ect . axf

These are exactly the same!

This is because although new source files have been added to the project, they will (probably)
not be referenced by any code in the project and hence no new functions or data will be included
in the final image. To make use of any new component, some of its new functionality must of
course be referenced.

Note: Some middleware components such as USB, are not compatible with the Add/Remove
component functionality and so will be hidden from the Add/Remove dialogue. The recommended
approach if such components are required is to import an example including the component and
modify as required. This restriction will be addressed in a future release.

Please also see for details of how to explore the composition of an
image in detail.

SDK Project Refresh

Using the above technology, Introduced in MCUXpresso IDE version 10.2.0 projects can be
refreshed with updated SDK components.

When new SDKs are released for a particular MCU/Board, many source files will be updated,
bugs fixed, features added etc. If an existing SDK is replaced within MCUXpresso IDE by such a
new SDK, any updated (or changed) source files or source file sections can optionally be added
to existing project using an identical mechanism as described above.

To used this feature, simply select a project in the project explorer view and click to Refresh SDK
Components as indicated below.

Figure 9.5. SDK Component Management Project Refresh

{7 Project E 23 | =, Peripher (il Register

(=]

» & frdmk64f_bubble

i I OO TR YU A PUPY W 1) Oy Tgag—"y
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The SDK Component Management wizard will guide you through the update process.
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10. Creating New Projects using Preinstalled Part Support

For Creating project using SDKs please see

To explore the range of preinstalled parts/MCUs simply click ‘New project’ in the QuickStart
panel. This will open a page similar to he figure below:

e ° SDK Wizard

| € Please select a target device or a board } . L i‘ 7

|
| . Board and/or Device selection page

~ SDKMCUs Available boards B’ g

MCUs from installed SDKs Please select an available board for your project.

Target

PNEV7462B LPCXpresso812-MAX LPCXpressoB12 LPC8NO4 Development Board

~ Preinstalled MCUs
MCUs from preinstalled LPC and generic
Cortex-M part support
Target
FLPC1102
FLPC112x
LPC11AXx
»LPC11E6x
#LPCT1Exx
FLPC11UBx LPCXpresso845-MAX LPCXpresso824-MAX LPCXpressoB802
#LPC11Uxx
FLPCT1xx

\’“’"”‘*“’ j s AR PUSDEE EE

Selected Device: SDKs for selected MCU

Target Core: Name SDK Version Manifest Versior Location

Description:

Cancel

Figure 10.1. New Project Wizard Preinstalled

The list of preinstalled parts is presented on the bottom left of this window.

You will also see a range of related development boards indicating whether a matching board
support library (LPCOpen or CodeBundles) is available.

For details of this page see:

10.1 New Project Wizard

This wizard page provides a number of ways of quickly selecting the target for the project that
you want to create.

In this description, we are going to create a project for an LPC4337 MCU. For this MCU an
LPCOpen library is available, so we can locate this MCU using the board filter. Note: Boards will
be displayed where either LPCOpen or CodeBundle projects exist.
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Note: LPCOpen is described in section

To reduce the number of boards displayed, we can simply type ‘4337’ into the filter so only boards
with MCUSs containing ‘4337’ will be displayed.

ece B SOK Wizard

Yy <
(@ Creating project for device: LPC4337 using board: LPCXpresso4337 i >
. Board and/or Device selection page

} SDK MCUs Available boards 1| &

Plagse select an available board for your project.
4337

LPCXpressod337
= Preinstalled MCUs
MCUs from preinstalled LPC and generic
Cortex-M part support
NXP LPC4337
LPC4325
LPC4325-M0
LPC4327
LPC4327-M0
LPC4330
LPC4330-MQ
LPC4333
LPC4333-MO

LPC4337

Selected Device: LPC4337 using board: LPCXpressod4337 SDKs for selected MCU

Target Core: cortex-m4 Name SDK Version Manifest Versior Location

Description: Multicore Cortex-M4/Cortex-MO based microcontroller, with up to 1MB
| Flash and 136K8 RAM

| @ BR[| cance

Figure 10.2. New Project Wizard selection for Preinstalled MCUs

When a board is selected as highlighted in the above figure, the matching MCU (part) is also
selected automatically.

Note: if no matching board is available, the required MCU can be selected from the list of
Preinstalled MCUs.

Note: Boards added to MCUXpresso IDE from SDKs will have an ‘SDK’ graphic superimposed
on the board image. Boards without the SDK graphic indicate that a matching LPCOpen package
(or Code bundle) is available for that board and associated MCU.

With a chosen board selected, now click ‘Next’ to launch the next level of wizards. These wizards

for Preinstalled MCUs are very similar to those featured in LPCXpresso IDE and are described
in the next section.

10.2 Creating a Project

MCUXpresso IDE includes many project templates to allow the rapid creation of correctly
configured projects for specific MCUs.
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This New Project wizard supports 2 types of projects:

¢ Those targeting LPCOpen libraries
« Standalone projects

In addition, certain MCUs like the LPC4337 support multiple cores internally, for these MCUs,
Multicore options will also be presented (as below):

[ =N ]
New project...
LPC43xx (Cortex-M4 basic) -> C Project (Semihosted)

. Wizard selection page.

Wizard
YLPC1800 / LPC4300
¥LPC43xx (Cortex-M4 basic
LPCOpen - C Project
LPCOpen - C Static Library Project
LPCOpen - C++ Project
PCOpen - atic Library Proje
C Project (Semihosted
C Static Library Project
C++ Project
C++ Static Library Project
¥LPC43xx Multicore M4
LPCOpen - C Project
L PCOpen - C++ Project
C Project
C Project (Semihosted)
C++ F’reject

@ [ Next - RGN

Figure 10.3. New project: wizard selection

You can now select the type of project that you wish to create (see below for details of Wizard
types).

In this case, we will show the steps in creating a simple C ‘Hello World’ example project.

10.2.1 Selecting the Wizard Type

For most MCU families MCUXpresso IDE provides wizards for two forms of project: LPCOpen
and non-LPCOpen. For more details on LPCOpen, see
. For both kinds, the main wizards available are:

C Project

¢ Creates a simple C project, with the min() routine consisting of an infinite wni1e(1) loop that
increments a counter.
« For LPCOpen projects, code will also be included to initialize the board and enable an LED.

C++ Project

¢ Creates a simple C++ project, with the nai n() routine consisting of an infinite wni1e(1) loop that
increments a counter.
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10.2.2

10.2.3
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« For LPCOpen projects, code will also be included to initialize the board and enable an LED.

C Static Library Project

¢ Creates a simple static library project, containing a source directory and, optionally, a directory
to contain include files. The project will also contain a “liblinks.xml” file, which can be used by
the smart update wizard on the context-sensitive menu to create links from application projects
to this library project. For more details, please see the FAQ at:

https://community.nxp.com/message/630594

C++ Static Library Project

¢ Creates a simple (C++) static library project, like that produced by the C Static Library Project
wizard, but with the tools set up to build C++ rather than C code.

The non-LPCOpen wizard families also include a further wizard:

Semihosting C Project

« Creates a simple “Hello World” project, with the mai n() routine containing a printf() call, which
will cause the text to be displayed within the Console View of MCUXpresso IDE. This is
implemented using “semihosting” functionality. See the section on for
more information.

Configuring the Project

Once you have selected the appropriate project wizard, you will be able to enter the name of
your new project, this must be unique for the current workspace.

Finally you will be presented with one or more “Options” pages that provide the ability to set
a number of project-specific options. The choices presented will depend upon which MCU you
are targeting and the specific wizard you selected, and may also change between versions of
MCUXpresso IDE. Note: if you have any doubts over any of the options, then we would normally
recommend leaving them set to their default values.

The following sections detail some of the options that you may see when running through a
wizard.

Wizard Options

The wizard will present a set of pages (that will vary based on the chosen MCU), many of these
pages will typically require no user change since the common default values are already preset.
The pages may include:

LPCOpen Library Project Selection

When creating an LPCOpen-based project, the first option page that you will see is the LPCOpen
library selection page.
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e
New project..

& Select an LPCOpen Chip library project within the current workspace
- Wizard properties page.

Select the LPCOpen Chip and {optienally) Board library project(s) that you want your new project to link against.

Selected library project(s) must be present in this workspace. If they are not, then click the

Import...
‘Import’ button to run the Import Wizard p

Select LPCOpen Libraries
LPCOpen Chip Library Project IpC_chip_43xx h Browse...

LPCOpen Board Library Project ﬂ Browse.

If a Board Library Project Is selected, then the cerresponding Chip Library Project must also be selected

('?) < Back Cancel

Figure 10.4. LPCOpen library selection

MCUXpresso IDE User Guide -

This page allows you to run an “Import wizard” to download the LPCOpen bundle for your target
MCU/board from http://www.nxp.com/Ipcopen and import it into your Workspace, if you have not
already done so.

You will then need to select the LPCOpen Chip library for your MCU using the Workspace
browser (and for some MCUs an appropriate value will also be available from the drop down next
to the Browse button). Note: the wizard will not allow you to continue until you have selected a
library project that exists within the Workspace.

Finally, you can optionally select the LPCOpen Board library for the board that your MCU is fitted
to, using the Workspace browser (and again, in some cases an appropriate value may also be
available from the drop down next to the Browse button). Although selection of a board library is
optional, it is recommended that you do this in most cases.

CMSIS-CORE Selection

For backwards compatibility reasons, the non-LPCOpen wizards for many parts provide the
ability to link a new project with a CMSIS-CORE library project. The CMSIS-CORE portion of
ARM’s Cortex Microcontroller Software Interface Standard (or CMSIS) provides a defined
way of accessing MCU peripheral registers, as well as code for initializing an MCU and accessing
various aspects of functionality of the Cortex CPU itself. MCUXpresso IDE typically provides
support for CMSIS through the provision of CMSIS library projects. CMSIS-CORE library projects
can be found in the Examples directory of your MCUXpresso IDE installation.

Generally, if you wish to use CMSIS-CORE library projects, you should use
OMBI S_CORE_<part fani | y> (these projects use components from ARM’s CMSIS v3.20 specification).
MCUXpresso IDE does in some cases provide libraries based on early versions of the CMSIS
specification with names such as cvsi svip3o_<partfani I y>, but these are not recommended for use
in new projects.

The CMSIS library option within MCUXpresso IDE allows you to select which (if any) CMSIS-
CORE library you want to link to from the project you are creating. Note: you will need to import
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the appropriate CMSIS-CORE library project into the workspace before the wizard will allow you
to continue.

For more information on CMSIS and its support in MCUXpresso IDE, please see the FAQ at:
https://community.nxp.com/message/630589

Note: The use of LPCOpen instead of CMSIS-CORE library projects is recommended in most
cases for new projects. (In fact LPCOpen actually builds on top of many aspects of CMSIS-
CORE.) For more details see

CMSIS DSP Library Selection

ARM’s Cortex Microcontroller Software Interface Standard (or CMSIS) specification also
provides a definition and implementation of a DSP library. MCUXpresso IDE provides prebuilt
library projects for the CMSIS DSP library for Cortex-M0/M0+, Cortex-M3 and Cortex-M4 parts,
although a source version of it is also provided within the MCUXpresso IDE Examples.

Note: The CMSIS DSP library can be used with both LPCOpen and non-LPCOpen projects.
Peripheral Driver Selection

For some parts, one or more peripheral driver library projects may be available for the target
MCU from within the Examples area of your MCUXpresso IDE installation. The non-LPCOpen
wizards allow you to create appropriate links to such library projects when creating a new project.
You will need to ensure that you have imported such libraries from the Examples before selecting
them in the wizard.

Note: The use of LPCOpen rather than these peripheral driver projects is recommended in most
cases for new projects.

Enable use of Floating Point Hardware

Certain MCUs may include a hardware floating point unit (for example NXP LPC32xx,
LPC407x_8x, and LPC43xx parts). This option will set appropriate build options so that code is
built to use the hardware floating point unit and will also cause startup code to enable the unit
to be included.

Code Read Protect

NXP’s Cortex based LPC MCUs provide a “Code Read Protect” (CRP) mechanism to prevent
certain types of access to internal Flash memory by external tools when a specific memory
location in the internal Flash contains a specific value. MCUXpresso IDE provides support
for setting this memory location. See the section on for more
information.

Enable use of rondivide Library

Certain NXP Cortex-M0 based MCUs, such as LPC11Axx, LPC11Exx, LPC11Uxx, and LPC12xx,
include optimized code in ROM to carry out divide operations. This option enables the use of
these Romdivide library functions. For more details see the FAQ at:
https://community.nxp.com/message/630743

Disable Watchdog

Unlike most MCUs, NXP’s LPC12xx MCUs enable the watchdog timer by default at reset. This
option disables that default behaviour. For more details, please see the FAQ at:

https://community.nxp.com/message/630654
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LPC1102 ISP Pin

The provision of a pin to trigger entry to NXP’s ISP bootloader at reset is not hardwired on the
LPC1102, unlike other NXP MCUs. This option allows the generation of default code for providing
an ISP pin. For more information, please see NXP’s application note, AN11015, “Adding ISP to
LPC1102 systems”.

Memory Configuration Editor

For certain MCUs such as the LPC18xx and LPC43xx, the wizard will present the option to edit
the target memory configuration. This is because these parts may make use of external SPIFI
Flash memory and hence this can be described here if required. For more information please
see: and also

Note: Memory configuration can of course also be edited after a project has been created.
Redlib Printf Options

The “Semihosting C Project” wizard for some parts provides two options for configuring the
implementation of printf family functions that will get pulled in from the Redlib C library:

¢ Use non-floating-point version of printf
« If your application does not pass floating point numbers to printf () family functions, you can
select a non-floating-point variant of printf. This will help to reduce the code size of your
application.
« For MCUs where the wizard does not provide this option, you can cause the same effect by
adding the symbol cr | NTEGER PRI NTF tO the project properties.

¢ Use character- rather than string-based printf

» By default printf() and puts() make use of maioc() to provide a temporary buffer on the
heap in order to generate the string to be displayed. Enable this option to switch to using
“character-by-character” versions of these functions (which do not require heap space). This
can be useful, for example, if you are retargeting printf() to write out over a UART — since
in this case it is pointless creating a temporary buffer to store the whole string, only to print
it out over the UART one character at a time.

« For MCUs where the wizard does not provide this option, you can cause the same effect by
adding the symbol cr_pri NTF_cHAR tO the project properties.

Note: if you only require the display of fixed strings, then using puts() rather than printf() will
noticeably reduce the code size of your application.

For more information see

Project Created

Having selected the appropriate options, you can then click on the Finish button, and the wizard
will create your project for you, together with appropriate startup code and a simple min. ¢ file.
Build options for the project will be configured appropriately for the MCU that you selected in
the project wizard.

You should then be able to build and debug your project, as described in Section 11.5 and
Chapter 12.
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11. Importing Example Projects (from the file system)

11.1
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MCUXpresso IDE supports two schemes for importing examples:

¢ From SDKs — using the QuickStart Panel -> Import SDK example(s). See

« From the filing system — using the QuickStart Panel -> Import project(s) from file System
« this option is discussed below:

Drag and Drop
@ Introduced in MCUXpresso IDE version 10.2, project(s) can be imported directly
into a workspace by simply dragging a folder (or zip) containing MCUXpresso IDE
projects onto the Project Explorer view. Note: this will import all projects within a
folder (or zip). Projects can also be exported by dragging directly from the Project
Explorer view onto a filer, or directly into another instance of the IDE. See
for more information.

Note: This option can also be used to import projects exported from MCUXpresso IDE. See

MCUXpresso IDE installs with a large number of example projects for preinstalled parts, that can
be imported directly into a workspace: These are located at:

<install _dir>/idel/ Exanpl es

and consist of:

¢ CMSIS-DSPLIB
 asuite of common signal processing functions for use on Cortex-M processor based devices.
CodeBundles for LPC800 family

« which consist of software examples to teach users how to program the peripherals at a basic
level.

FlashDrivers
« example projects to create Flash driver used by LinkServer
* Legacy
» arange of historic examples and drivers including CMSIS / Peripheral Driver Library
e LPCOpen
« High quality board and chip support libraries for LPC MCUs, plus example projects

Code Bundles for LPC800 Family Devices

The LPC800 Family of MCUs are ideal for customers who want to make the transition from 8
and 16-bit MCUs to the Cortex MO/MO+. For this purpose, we've created Code Bundles which
consist of software examples to teach users how to program the peripherals at a basic level. The
examples provide register level peripheral access, and direct correspondence to the memory
map in the MCU User Manual. Examples are concise and accurate explanations are provided
within any readme and source file comments. Code Bundles for LPC800 family devices are made
available at the time of the series product launch, ready for use with a range of tools including
MCUXpresso IDE.

More information on code bundles together with latest downloads can be found at:

https://www.nxp.com/LPC800-Code-Bundles
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11.2

11.3
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LPCOpen Software Drivers and Examples

Note: LPCOpen is no longer under active development, new MCU'’s from NXP are supported by
SDKs. Certain parts such as some members of the LPC54xxx families are available with both
LPCOpen and SDK support.

LPCOpen is an extensive collection of free software libraries (drivers and middleware) and
example programs that enable developers to create multifunctional products based on LPC
microcontrollers. Access to LPCOpen is free to all LPC developers.

Amongst the features of LPCOpen are:

¢ MCU peripheral device drivers with meaningful examples

* Common APIs across device families

« Commonly needed third party and open source software ports

¢ Support for Keil, IAR and LPCXpresso/MCUXpresso IDE toolchains

LPCOpen is thoroughly tested and maintained. The latest LPCOpen software now available
provides:

« MCU family-specific download package

¢ Support for USB ROM drivers

« Improved code organization and drivers (efficiency, features)

e Improved support for MCUXpresso IDE

CMSIS / Peripheral Driver Library / code bundle software packages are still available, from
within your install_dir/ide/Examples/Legacy folder. However, these should only be used for
existing development work. When starting a new evaluation or product development, we would
recommend the use of LPCOpen if available.

More information on LPCOpen together with package downloads can be found at:

http://www.nxp.com/Ipcopen

Importing an Example Project

To import an example project from the file system, locate the QuickStart panel and select ‘Import
projects from Filesystem’

All information provided in this document is subject to legal disclaimers © 2019 NXP Semiconductors. All rights reserved.

User Guide

Rev. 11.0.0 — 23 May, 2019 80


http://www.nxp.com/lpcopen

NXP Semiconductors

MCUXpresso IDE User Guide

() Quicks ®=Global (x=Variabl ®g Breakp &=

MCUXpresso IDE - Quickstart Panel

_oe | No project selected
~ Create or import a project

. New project...
/ . Import SDK example(s)...

Outine = O

® Import project(s) from file system...

~ Build your project

B’

~ Debug your project

~ Miscellaneous

L2
& Quick Settings>>

s
L=R =]

A

lo¢ Build all projects []

e
®-EH-HE-

Figure 11.1. Importing project(s)
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From here you can browse the file system.
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[ BaN ] Import project(s)

Import project(s) e
Select the examples archive file to import. / J

Projects are contained within archives (.zip) or are unpacked within a directery. Select your
project archive or root directory and press <Next>. On the next page, select those projects you
wish to import, and press <Finishz.

Project archives for LPCOpen and 'legacy’ examples are provided.

Project archive {zip)

Archive \ Browse...

Project directory (unpacked)

Root directory Browse...

LPCOpen

LPCOpen is the recommended code base for Cortex-M based NXP LPC Micracontrollers.

MCUXpresso IDE includes the LPCOpen packages which can be imported directly by pressing the Browse
button in the Project archive (zip) section, above, and navigating to the Examples/LPCOpen directory.

Alternatively, press the button below to Browse the nxp.com website for latest resources.

Browse LPCOpen resources on nxp.com...

t/?:' Cancel

Figure 11.2. Importing examples
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« Browse to locate Examples stored in zip archive files on your local system. These could
be archives that you have previously downloaded (for example LPCOpen packages from
http://www.nxp.com/Ipcopen or the supplied, but deprecated, sample code located within the
Examples/Legacy subdirectory of your MCUXpresso IDE installation).

« Browse to locate projects stored in directory form on your local system (for example, you can
use this to import projects from a different Workspace into the current Workspace).

« Browse LPCOpen resources to visit http://www.nxp.com/lpcopen and download an
appropriate LPCOpen package for your target MCU. This option will automatically open a web
browser onto a suitable links page.

To demonstrate how to use the Import Project(s) functionality, we will now import the LPCOpen
examples for the LPCXpresso4337 development board.

Importing Examples for the LPCXpresso4337 Development Board

First of all, assuming that you have not previously downloaded the appropriate LPCOpen
package, click on Browse LPCOpen Resources, which will open a web browser window. Click
on LPC4300 Series, and then locate NXP LPCXpresso04337, and then download 2.xx version
for LPCXpresso Toolchain (LPCOpen packages created for LPCXpresso IDE are compatible
with MCUXpresso IDE).

Note: LPCOpen Packages for the LPC4337 are preinstalled and located at:

<install _dir>/idel/ Exanpl es/ LPCOpen/. ..

Once the package has downloaded, return to the Import Project(s) dialog and click on the Browse
button next to Project archive (zip); then locate the LPCOpen LPCXpresso4337 package
archive previously downloaded. Select the archive, click Open and then click Next. You will then
be presented with a list of projects within the archive, as shown in Figure 11.3.
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Figure 11.3. Selecting projects to import

@ e Import project(s)
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Projects:
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I|pc_board_nxp_lpexpresso_4337 (lpe_board_nxp_lpcxpresso_4337) Deselect All
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1 lpc_chip_43xx (lpc_chip_43xx) Refresh
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LPCUSBIib_KeyboardHost (LPCUSBIib_KeyboardHost)
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i , |
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l
3
Working sets
Add project to working sets
Working sets:
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Select the projects you want to import and then click Finish. The examples will be imported into
your Workspace.

Note: generally, it is a good idea to leave all projects selected when doing an import from a zip
archive file of examples. This is certainly true the first time you import an example set, when you
will not necessarily be aware of any dependencies between projects. In most cases, an archive
of projects will contain one or more library projects, which are used by the actual application
projects within the examples. If you do not import these library projects, then the application
projects will fail to build.

Exporting Projects

MCUXpresso IDE provides the following export options from the QuickStart panel:

¢ Export project(s) to archive (zip)
« Export project(s) and references to archive (zip)

« choose this option to export project(s) and automatically also export referenced libraries
To export one or more projects, first select the project(s) in the Project Explorer then from the
QuickStart Panel -> Export project(s) to archive (zip). This will launch a filer window. Simply
select the destination and enter a name for the archive to be exported then click ‘OK’.

Also please see for information about dragging and
dropping projects.
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11.5 Building Projects

Building the projects in a workspace is a simple case of using the Quickstart Panel to “Build all
projects”. Alternatively, a single project can be selected in the ‘Project Explorer’ View and built.
Note: building a single project may also trigger a build of any associated or referenced project.

11.5.1 Build Configurations

By default, each project will be created with two different “build configurations”: Debug and
Release. Each build configuration will contain a distinct set of build options. Thus a Debug build
will typically compile its code with optimizations disabled ( - ) and Release will compile its code
optimizing for minimum code size ( -cs). The currently selected build configuration for a project
will be displayed after its name in the QuickStart Panel's Build/Clean/Debug options.

For more information on switching between build configurations, see

MCUXpresso IDE User Guide - All information provided in this document is subject to legal disclaimers © 2019 NXP Semiconductors. All rights reserved.

User Guide Rev. 11.0.0 — 23 May, 2019 84




NXP Semiconductors MCUXpresso IDE User Guide

12. Debugging a Project

12.1

12.1.1

MCUXpresso IDE User Guide -

This chapter describes many of the common debug features supported by the debug solutions
within MCUXpresso IDE. Please also refer to the chapter for
more details of the supported debug solutions and management of debug operations.

Debugging Overview

A debug operation requires a physical connection between the host computer and the target
MCU via a debug probe. The debug probe translates the high level commands provided by
MCUXpresso IDE into the appropriate low level operations supported on the target MCU.

This connection to the debug probe is usually made via USB to the host computer (although IP
probes from P&E and SEGGER are also supported). Some debug probes such as LPC-Link2
or SEGGER J-Link Plus are separate physical devices, however many LPCXpresso, Freedom,
Tower, EVK boards also incorporate a built in debug probe accessed by one of the development
boards USB connections.

Note: If a separate debug probe is used, you must ensure that the appropriate cables are used
to connect the debug probe to the target board, and that the target is correctly powered.

Typically, an on board debug probe connection will also provide power to the development board
and target MCU. In contrast, an external debug probe will not usually power the target, and
a second connection (often USB) will be required to provide power to the board and MCU.
Some external debug probes such as the LPC-Link2 can also provide power to the target board
— this is enabled by connecting the link JP2. For other debug probes, refer to their supplied
documentation.

External debug probes will usually provide superior features and performance compared to on-
board debug probes, however please note that LPCXpresso V2 and V3 boards incorporate a full
featured LPC-Link2 debug probe.

Note: Some LPCXpresso development boards have two USB connectors fitted. Make sure that
you have connected the lower connector marked DFU-Link. Many Freedom and Tower boards
also have two USB connectors fitted. Make sure that you have connected to the one marked
‘OpenSDA’ - this is usually (but not always) marked on the board. If in doubt, the debug processor
used on these designs is usually a Kinetis K20 MCU, it is approximately 6mm square. The USB
nearest this MCU will be the OpenSDA connection.

Debug Launch

To debug a project on your target MCU, simply highlight the appropriate project in the ‘Project
Explorer’, and then in the Quickstart Panel click on the large Debug, as in Figure 12.1,

alternatively click the blue bug icon F to perform the same action.
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Figure 12.1. Launching a debug session

) Quickstart Panel 23 Variables Breakpoints =

\_oe_ /] Project: evkmimxrt1060_iled_blinky [Debug]

~ Create or import a project

. New project...
)
Import SDK example(s)...
® Import project(s) from file system...

+ Build your project

4, Build
¢ Clean
~ Debug your project ' E' ﬂ'

[ ’K& Debug ]

¥ Miscellaneous

& Edit project settings

. MCUXpresso Canfig Tools>>

& Quick Settings>>

B Export project(s) to archive (zip)

J{B Export project(s) and references to archive (zip)
ay Build all projects [Debug]

12.1.2
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Note: The green bug icon should not be used because this invokes the standard Eclipse debug
operation and so skips certain essential MCUXpresso IDE debug steps.

For a newly created project a debug operation will perform a number of steps. By default, it will
first build the selected project and (assuming there are no build errors) launch a debug probe
discovery operation (see next section) to allow the user to select the required debug probe. A
launch configuration file will automatically be created with default options (per build configuration)
and will be associated with the project. Like a projects build configuration, launch configuration
files control what occurs each time a debug operation is performed. Please see the section

for more information.

Note: This default behaviour can be changed by editing the Workspace preference located at
Preferences -> Run/Debug -> Launching -> Build (if required) before launching. For individual
projects, the Main tab of the launch configuration allows the workspace preference to be
overridden.

By default, once a debug probe has been selected (and ‘OK’ clicked) the binary contents of
the .axf file will automatically be downloaded to the target via the debug probe connection.
Typically, projects are built to target MCU Flash memory, and in these cases, a suitable Flash
driver will automatically be selected to perform the Flash programming operation. Next a default
breakpoint will be set on the first instruction in nai n() , the application will be started (by performing
or simulating a processor reset), and code will be executed until the default breakpoint is hit. See
the section on for additional information.

Debug Probe Selection Dialog (Probe Discovery)

The first time you debug a project, the IDE will perform a probe discovery operation and display
the discovered Debug Probes for selection. This will show a dialogue listing all supported probes
that are attached to the host computer. In the example shown in Figure 12.2, a LinkServer (LPC-
Link2), a P&E Micro Multilink and also a J-Link (OpenSDA) probe have been found.
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Figure 12.2. Attached probes: debug emulator selection

e ® Probes discovered
Connect to target: MK64FN IMOxxx12

3 probes found. Select the probe to use:

Available attached probes

Name Serial number/ID Type Manufactur IDE Debug Mode
B8 LPC-LINK2 CMSIS-DAP V5.18 IWFUA1EW LinkServe NXP SemiNon-Stop
4 USB1 - Multilink Universal Rev PEM834663 usBe1 P&E Micrc All-Stop
ﬂ J-Link OpenSDA 621000000 use SEGGER All-Stop

Supported Probes {tick/untick to enable/disable)

MCUXpresso IDE LinkServer (inc. CMSIS-DAP) probes
P&E Micro probes

SEGGER J-Link probes

Probe search options

Search again

Remember my selection (for this Launch configuration)

®

Cancel

MCUXpresso IDE User Guide -

Note: if only one probe is found, it will be selected automatically, so simply click OK or hit return
to use the probe displayed.

MCUXpresso IDE supports unique debug probe association.

Debug probes can return an ID (Serial number) that is used to associate a particular debug
probe with a particular project. Some debug probes will always return the same ID, however
debug probes such as the LPC-Link2 will return a unique ID for each probe — in our example
IWFUAL1EW.

For any future debug sessions, the stored probe selection will be automatically used to match the
project being debugged with the previously used debug probe. This greatly simplifies the case
where multiple debug probes are being used.

However, if a debug operation is performed and the previously remembered debug probe cannot
be found, then a debug probe discovery operation will be performed from within the same family
e.g. LinkServer, P&E or SEGGER.

See also

Sometimes a probe discovery will find no debug probes and return a dialogue as below:
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[ BuN Probes discovered

Connect to target: LinkServer

€3 LinkServer not found.
This could be because it is disconnected, not powered, or already in use

Available attached probes

Name Serial number/ID Type Manufactur IDE Debug Mode

Supperted Probes {tick/untick to enable/disable)
MCUXpresso IDE LinkServer (inc. CMSIS-DAP) probes

Probe search options

Search for LinkServer again Search for any enabled probe

2) Cancel

Figure 12.3. LPC-Link2 no longer connected

12.1.3
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This might have been because you had forgotten to connect the probe, in which case simply
connect it to your computer and select Search again. If you are using a different debug probe
from the same family of debug probes, simply select the new probe and this will replace the
previously selected probe.

Notes:

« The “Remember my selection” option is enabled by default in the Debug Emulator Selection
Dialog, and will cause the selected probe to be stored in the launch configuration for the current
configuration (typically Debug or Release) of the current project. You can thus remove the
probe selection at any time by simply deleting the launch configuration.

« You will need to select a probe for each project that you debug within a Workspace (as well
as for each configuration within a project).

« If you wish to debug a project using a different family of debug probe(s), then the simplest
option is to delete the launch configuration files associated with the project and start a debug
operation. Please see the section "An Introduction to for more
information. Please also see

Controlling Execution

When you have started a debug session a default is set on the first instruction
in mai n(), the application is started (by simulating or performing a processor reset), and code is
executed until the default "breakpoint is hit.

Program execution can now be controlled using the common debug control buttons, as listed

in Table 12.1, which are displayed on the global toolbar. The call stack is shown in the Debug
View, as in Figure 12.4.
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> R DR i RBRR SIS » v th G

1 Debug £2

v [ frdmk64f_driver_examples_gpio_led_output LinkServer Debug [C/C++ (NXP Semiconductors) MCU Application]
v [ frdmk64f_driver_examples_gpio_led_output.axf [MKE4FN1MOxxx12 (cortex-m4)]
¥ o Thread #1 1 (Stopped) (Suspended : Signal : SIGINT:Interrupt)
= delay() at gpio_led_output.c:61 0x806
= main() at gpio_led_output.c:91 0x852
w arm-none-eabi-gdb (7.12.0.20161204)

Figure 12.4. Debug controls and Debug Call Stack

Table 12.1. Program execution controls

Button Description Keyboard Shortcut
& Restart program execution (from reset)

i Run/Resume the program F8

oo Pause Execution of the running program

Terminate the debug Session Ctrl + F2
B, Clean up debug

e ™) Run, Pause, Terminate all debug sessions

[ Step over a C/C++ line F6

5 Step into a function F5

L Return from a function F7
o m Step in, over, out all debug sessions

i Show disassembled instructions

Tip

@ Clean up debug will kill all debug processes associated with LinkServer, P&E and
SEGGER debug connections. This button can be used in the event of a debugging
crash to remove any failed processes that remain. Note: a warning will be issued
with the option to cancel before any action is performed since this action will kill all
connected debug sessions.

Note: The debug controls for ‘all’ debug sessions will perform identically to their single session
counterparts if only one debug session exists.

Note: Typically a user will only have a single active debug session. However if there is more
than one debug session, the active session can be chosen by clicking within the debug call stack
within the Debug view. All debug views will reflect the selected session.

Setting a breakpoint

To set a breakpoint, simply double-click on the left margin area of the line on which you wish to
set the breakpoint (before the line number).

Restarting the application

If you hit a breakpoint or pause execution and want to start execution of the application from the
beginning again, you can do this using the Restart button.

Stopping debugging
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To stop debugging just press the Terminate/Stop button. This action will disconnect
MCUXpresso IDE from the target (board). The subsequent behaviour is controllable by the

Pause debugging

Typically, debugging is paused due to the action of a or

since these will be set to observe the target when an event of interest has occurred. However,
the pause button can be used to pause the target at an instant of time.

To pause debugging

If you are debugging using the Debug Perspective, then to switch back to the C/C++

Perspective when you stop your debug session, just click on the C/C++ tab in the upper right
area of MCUXpresso IDE (as shown in Figure 4.2).

12.2 Launch Configurations
Launch Configuration files will be automatically created within the root directory of a project the
first time a debug operation is performed. They will typically be named:
{proj nane} {debug sol uti on}Debug. | aunch
{proj nane} {debug sol uti on}Rel ease. | aunch
A file will be created for the build variant being debugged, and is used to store the settings for
the debug connection for that build configuration.
Normally, there is no need to edit launch configurations, as the default settings created by the
IDE will be suitable. However, in some circumstances, you may need to manage them — typically
under direction from an FAQ. In such cases this can be done via the “Launch Configurations”
entry on the context sensitive menu available from the Project Explorer view...
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Figure 12.5. Create a Launch Configuration
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| B framkeaf_d s

» 4 Binaries New
» Glincludes G0 Into
»EECMSIS | 5nen in New Window
» Baccel
+ & board [2) Copy 8
+ (B drivers Pasta
v (B source
» [3 bubbl ¥ Delete ®
» &5 startup Source >
» S utiities | Move...
» (= Debug Rename... F2
¥ & dog x Import...
B framks4 o P launch
Wirdmked = Export... zlaunch
Build Project
Clean Project
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v
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Note: to view the contents or edit an existing launch configuration file, you can also simply double
click to open an edit view.

A number of options are available here:

Edit...

< Allows various debug settings to be modified
« Typically not required since the default options will be correct for most debug operations

Create new...

¢ Create a launch configurations for a particular debug solution, if they do not already exist.

« Normally you will not need this option as it is carried out automatically the first time that you
debug your project. However, if you want the flexibility to debug a project with different debug
solutions for example, LinkServer and SEGGER, then both sets of launch configurations
can be created. On the next debug operation, the user can select the launch configuration
to use for that session.

Create and edit new...

¢ Allows new launch configurations to be created and immediately opened for editing.

Delete...

< Allows the launch configurations for the selected project (or projects) to be deleted.

e This can be useful as it allows you to put the debug connection settings back to the default
after making modifications for some reason, or if you are moving your project to a new version
of the tools, and want to ensure that your debug settings are correct for this version of the tools.
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Delete JTAG Configuration...

¢ Allows the JTAG configuration files for the selected project (or projects) to be deleted. These
files are stored in the Debug/Release subdirectories.

12.2.1

Editing a Launch Configuration (LinkServer)

WARNING: - Modifying the default settings for a launch configuration can prevent a successful
debug connection from being made.

After selecting the “Edit...” or “Create and edit New” launch configuration menu entry, you will
then see a new dialog box pop up, which looks similar to the following...

Modify configuration and continue.

Name: |MKG4FN 1540

%5 GDB Debugg: Il

® LinkServer et
Debug Options

Debug Connection |SWD [¥

LinkServer Options

~ Debug Connection
Settings for the debug connection

Attach only Reset on Connect

Reset script

Connect script  Kinetisconnect.sep
BootROM stall

Flash driver reset handling

Disconnect behavior cont

~ Advanced Settings
Advanced options

Memory checking

Debuglevel |2

Wirespeed (Hz)

Additional options

Pre launch command

Figure 12.6. Edit a Launch Configuration

Edit Configuration

aeQebug

k& Reset handiing

| < < |

B seminosting support

Overr

Debug memory cache [ Enable range stepping

ide core

index

Wo

€ GUI Flash Tool | %5 Other Symbols| i Startup | & Source| ] Common | ™1

rkspace. .

Workspace...

On

Revert

Cancel

L3

File System..

File System...

Apply

Most settings that you may need to modify can be found in the Debugger tab, in the Target
configuration sub-tab (as shown in the above screenshot).

Some examples of modifications that you may need to make in particular circumstances are:

¢ Changing the initial

remove it completely.

on debug startup
* When the debugger starts, it automatically sets an initial (temporary) breakpoint on the first
statement in main(). If desired, you can change where this initial breakpoint is set, or even

* Modifying the Debugger connect behaviour
 via a Connect Script e.g. kinetisconnect.scp

¢ Connecting to a target via JTAG rather than SWD

« if supported by the target, you can edit the Debug type
¢ Connecting to a running target
« set Attach only to True (see also

MCUXpresso IDE User Guide -
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Tip

@ Introduced in MCUXpresso IDE version 10.3.0, multiple launch configurations are
supported for each build configuration. Multiple launch configurations may be
created using standard Eclipse functionality — for example from the main menus,
select Run -> Debug Configurations and double click on the C/C+ entry. Alternatively
you can clone an existing launch configuration. Once this has been done, a debug
operation will present the user will a list of available launch configurations. Simply
double click the required launch configuration to start the debug session.

12.3 Common Debug Operations and Launch Configurations

Where possible MCUXpresso IDE attempts to provide a common debug experience regardless
of the debug solution being used. However some debug tasks require launch configuration
modifications and these will be different for each debug solution. In this section, some common
debug operations are discussed for each debug solution.

12.3.1 Debug Quickstart Shortcuts

Introduced in MCUXpresso IDE version 10.2 are Quickstart debug shortcuts. These buttons
request actions only from their respective debug solutions.

) Quickstart Panel 2 Variables Breakpoints )

. MCUXpresso IDE - Quickstart Panel
e || Project: evkmimxrt1060_iled_blinky [Debug]

~ Create or import a project

B New project...

2
@ Import SDK example(s)...

% import project{s) from file system...

~ Build your project

& Build

& Clean

~ Debug your project

A Debug + Debug using LinkServer probes (CTRL+SHIF T+ALT+L)
Attach to a running target using LinkServer (CTRL+ALT+L)
Program flash action using LinkServer

Erase flash action using LinkServer
® Edit project settings r

. MCUXpresso Config Tools>>

2 Quick Settings>>

& Export project(s) to archive (zip)

,gE Export project(s) and references to archive (zip)

~ Miscellaneous

o Build all projects [Debug]

Figure 12.7. Debug Shortcuts (LinkServer shown)

Each button provides the same 4 options for each debug solution:

Debug (default) : make a Debug connection to the chosen debug probe. A launch configuration
will be created if not present. The attach mode will be set to False. Note: a normal debug
operation will inherit a launch configurations attach setting, whereas this operation will force
attach mode to False. If a launch configuration already exists, its attach setting will be set to
False, no other changes will be made.

Attach : make an Attach connection to a LinkServer compatible debug probe. A launch
configuration will be created if not present. The attach mode will be set to True. The launch

configuration will be given a A decorator to show that Attach is the set configuration. # button.
If a launch configuration already exists, its attach setting will be set to True, no other changes
will be made.
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12.3.2

Program Flash : perform the launch configuration Program action, by default this will program the
‘project’ into flash. The selected project will be built if required and a default launch configuration
will be created if one is not present.

Erase Flash : perform the launch configuration Erase action, by default this will erase the flash
memory via a mass erase. A default launch configuration will be created if one is not present.

Note: the selected action will be remembered for subsequent shortcut uses, the tooltip will show
the action to be performed.

©

Connecting to a running Target (attach)

Tip

If an attach operation is performed, the created launch configuration will have Attach
setto True. Therefore any subsequent debug operations will be in Attach Mode, until
either the launch configuration is edited to set Attach to false, or the Debug short cut
is used again to force the attach mode to false.

A typical debug session will begin by downloading code to Flash and then debugging from main()
onwards. However, to explore an already running system a debug connection (attach) can be
made to the target MCU without affecting the code execution (at least until the user chooses to
halt the MCU!).

Note: Source level debug of a running target is only possible if the sources of the project to be
attached exactly match the binary code running on the target.

Important Note: Please be sure to read and understand the section on
and also the implications in the related section on

LinkServer

Edit the project launch configuration by double clicking on the launch config file, select the
Debugger tab and Target configuration view, then set the ‘Attach only’ setting to True as below:

Name:  evkmimxrt1060_iled_blinky LinkServer Debug

E Main [%+ cDB Debuggef |[E] LinkServer Debugger € GUI Flash Tool | &= Startup 2 Source

»
1

LinkServer Debugger

Debug Options

Debug Connection SWD ¥

LinkServer Options

~ Debug Connection
Settings for the debug connection

Attach only || Reset on Connect

File System...

Reset script ﬂ Workspace...

Connect script ﬂ Workspace... File System...

BootROM stall

Flash driver reset handling h Reset handling

Disconnect behavior cont

OB

K Semihosting support | On

Figure 12.8. Debug Launch Attach Mode
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When a debug connection is made, the target will continue running until it is paused. However,
if the IDE Debug Mode is set to Non-Stop (the default) then Global variables values can be
explored and displayed.
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Other operations such as ITM console 10 will also function. See the LinkServer SWO Trace
Guide for further information.

P&E

Edit the project launch configuration by double clicking on the launch config file, select the Startup
tab, then set the ‘Attach to a running target’ check box as below:

® @ Edit Configuration

Modify configuration and continue. ﬁ\

Name: MKB4FN1MOxxx12_Project PE Debug

[] Main [ %5 Debugger | € GUI Flash Tod
Semihosting Settings

% Source | [T] Common

Enable semihosting  Console routed to: Telnet GDB client
Enable Telnet console Telnet Port: 51794
Load Symbois and Executable

Load symbols
I o Use project binary: MK6&4FN1MOxxx12_Project.axf

! Use file:

Symbols offset (hex):
Load executable
° Use project binary: MKB4FN1MOxxx12_Project.axf
Use file:

Executable offset (hex):

Runtime Options

[ Attach to Running Target ] Run on reset
Set PC (absolute hex address or symbol): Set breakpoint at: | main

GDB run commands:

Figure 12.9. Debug Launch Attach mode P&E

When a debug connection is made, the target will continue running until it is paused.

SEGGER JLink

Edit the project launch configuration by double clicking on the launch config file, select the
Debugger tab, then set the ‘Attach to a running target’ check box as below:

MCUXpresso IDE User Guide - All information provided in this document is subject to legal disclaimers © 2019 NXP Semiconductors. All rights reserved.

User Guide Rev. 11.0.0 — 23 May, 2019 95




NXP Semiconductors

MCUXpresso IDE User Guide

® Edit Configuration

Modify configuration and continue.

i, By using attach mode any 'monitor reset’ command will be ignored. ]@L

Project JLink Debug
& GUI Flash Tool| @ Startup | &~ Source | ] Common

JLink Interface Settings

JLink Interface ©Quss P
Device MKGAFNTMOxxx12 b
Target Interface SWD H
Speed adaptive @auto  fixed

GDB Server Settings

Server startup and port selection () auto manual

GDB Server Port
SWO Port
Telnet Port
Endianess little w
Disconnect behaviour Run ﬁ
Power Target Enable Semihosting
GDE Client Settings
Halt target on startup Initialize CPU registers

GDB Client Port

Additional Options

silent Verify [ Single run]  Attach to a running target

Request hardware breakpoint for stop on startup symboljaddress

Reset before running
Seript Browse

Select RTOS plugin

Figure 12.10. Debug Launch Attach Segger

When a debug connection is made, the target will continue running until it is paused.

12.3.3 Controlling the initial Breakpoint (on main)

When the debugger starts, it automatically sets an initial (temporary) breakpoint on the first
statement in main(). If desired, you can change where this initial breakpoint is set, or even remove
it completely. One common requirement is to debug an application from startup. The entry point
(startup) in an standard example application can be identified by a symbol called ResetISR, a
breakpoint can be set on this symbol to halt execution at the first instruction within an application.

LinkServer

To debug from the start of the image, edit the project launch configuration by double clicking on
the launch config file, select the Debugger tab, replace main with ResetISR
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=] Main 3"{# GDB Debugger LinkServer Debugger @ GUI Flash Tool .ﬁ Other Symb@ Source ™

Initialization Commands
Reset and Delay (seconds):

Halt

set non-stop on

set pagination off

set mi-async

set rematetimeaut GOOO0

Load Image and Symbols

Load image

© Use project binary: MKBA4FN1MOxxx12_Project.axf
Use file:

Image offset (hex):

Load symbols

© Use project binary: MKG4FN1MOxxx12_Project.axf

Use file:

Symbols offset (hex):

Run Commands

Set program counter at (hex);

Set breakpoint at:
Request hardware breakpoint

Figure 12.11. Debug Launch ResetISR

When a debug connection is made, the target should halt at this symbol.
To disable the initial breakpoint, uncheck the option ‘Stop on startup at...". To restore the original

behaviour, replace the symbol ResetISR with main, and check the option ‘Stop on startup at...".
Alternatively, you could delete the launch configuration and allow the IDE to create a new one.

P&E

Edit the project launch configuration by double clicking on the launch config file, select the Startup
tab, replace main with ResetISR

=] Main 7,‘; Debugger | € GUI Flash T_ouma ] Common

Semihasting Settings
Enable semihosting Console routed to: Telnet GDB client
Enable Telnet console Telnet Port: 51794

Load Symbols and Executable

Load symbols
O Use project binary: MKE64FN1MOxxx12_Project.axf

Use file:

Symbols offset (hex}:
Load executable
© Use project binary: MKE4FN1MOx00(12_Project.axf

Use file:
Executable offset (hex):
Runtime Options

Attach to Running Target 4 Run on reset
Set PC (absolute hex address or symbol): Set breakpoint af:

GDB run commands:

Figure 12.12. Debug Launch ResetISR P&E

When a debug connection is made, the target should halt at this symbol.
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To disable the initial breakpoint, uncheck the option ‘Set breakpoint at...". To restore the original
behaviour, replace the symbol ResetISR with main, and check the option ‘Set breakpoint at...".
Alternatively, you could delete the launch configuration and allow the IDE to create a new one.

SEGGER JLink

Edit the project launch configuration by double clicking on the launch config file, select the Startup
tab, replace main with ResetISR

Figure 12.13. Debug Launch ResetISR Segger

|1 Main |35 Debugger | € GUI Flash T Source | [C] Common
Initlalization Commands

Reset and Delay (seconds): |3
Halt
monitor reset

Load Image and Symbols

@ Load image

© Use project binary: MKB4FN1MOxxx12_Project.axf
Use file:

Image offset (hex):

Load symbols

o Use project binary: MKB4FN1MOxxx12_Project.axf
Use file:

Symbals offset (hex):

Run Commands

Set program counter at (hex):

Set breakpoint at; ResetISR
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MCUXpresso IDE User Guide -

When a debug connection is made, the target should halt at this symbol.
To disable the initial breakpoint, uncheck the option ‘Set breakpoint at...". To restore the original

behaviour, replace the symbol ResetISR with main, and check the option ‘Set breakpoint at...".
Alternatively, you could delete the launch configuration and allow the IDE to create a new one.

Debugging Pre-loaded binaries (Add Symbols)

In a typical debug scenario, a project is built, programmed into flash and debugged. However,
a common requirement may be to debug via a bootloader, or debug additional code preloaded
(into flash) generated by another project(s).

For a good debug experience, symbolic information (and source) for additional project code is
must be made available to the debug environment.

Symbolic information from additional projects can now easily be added via the Other Symbols
tab on a projects launch configuration as shown below.
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Modify configuration and continue.

Edit Configuration

Name: MyApp_LinkServer Debud

[£) Main |35 GDB Debugger LinkServer Debuggef 3% Other Symbols

€ GUI Flash Tool | #= Startup | i Source | ] Common

>

Load symbols: S{workspace_loc:/ .axf)

© Use addresses from file
" Use load address (hex):

Workspace...

File System...

Figure 12.14. Debug Launch Additional Symbols

To add symbolic information from other projects, simply browse to their .axf files and either use
either the default address or set a new base address for the image data. Use the + button to

add further symbolic information.

12.3.5 Disconnect Behaviour

Once the user has completed a debug session, the debugger connection can be terminated via
the IDE’s Terminate button! The exact behaviour of the target will depend on the particular debug

solution.

LinkServer

For LinkServer, the launch configuration contains a set of options to control what the target should
do when terminated. The default option is for the target to continue running from the current PC
value, however this can be changed by selecting a new setting within the launch configuration.
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Name: evkmimxrt1060_iled_blinky LinkServer Debug
[ Main [%5 GDB Debuggel [T LinkServer Debugger | € GUI Flash Tool| & Startup | & Source

»
i

LinkServer Debugger

Debug Options

Debug Connection SWD ¥

LinkServer Options

~ Debug Connection
Settings for the debug connection

Attach only [ | Reset on Connect

Reset script ﬂ Workspace... File System...
Connect script E Workspace... File System...
BootROM stall
Flash driver reset handling E Reset handling ﬁ
— B
nochange
stop
v cont
run_cont

Figure 12.15. Debug Launch Disconnect Mode
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Where:

* nochange - will leave the target in its current state

« stop - will leave the target in debug state i.e. halted

¢ cont - the default, will either start the image from its current PC value or leave it running
e run cont - will reset the target and let it run

P&E

The Terminate button will force the target to halt. Alternatively, for P&E debug the IDE supports
another option — to disconnect and force the target to run. This can be achieved via the IDE’s

disconnect ** button.
SEGGER JLink

The target will Run on disconnect by default. The launch configuration option, Disconnect
behaviour can be changed to Halt causing the target to halt on disconnect.

Project Flash Programming

Introduced in MCUXpresso IDE version 10.2.0 — launch configuration dialogues now contain
a GUI Flash Tool tab. This along with the and

provide access to the flash programming capabilities each of the supported
debug solutions.

For each debug solution, the options will vary slightly but the presentation is broadly the same
as shown below. These options are self describing.
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[5] Main [35- Debugger] /= GUI

GUI Flash™TSS
Program e& into flash Debug/MKG4FN1MOxxx12_Project.axf

Target: MKGAF
J Main %5 Debugger > Startup - Source| [[] Common
"""Q‘, o GUI Flash ™50
g et flesly Program file into flash: Debug/MK64FN1MOxxx12_Project.axf
Erase| Ra

Opti @
e Target: MK64j %ﬂ 2
Select the options tg

Format 1o use forpy  Taraet Opeltions

ormattouseTorB  select the target flash [ 5] Main [%5 Debugger (5 Sourt [ common

Base podess Programi, Erase| GUI Flash Tool

Reset target on Fmgram file into 6 Debug/MK64FNIMOxxx12_Project.axf

Actions
Select the action &

© Erase, blank | Ter9et weaww%@

General Options Program and| Target Ope
Flash programming tool Verify Only Select tfe & flash operation to perform
Preview command p_.p’h&vase Resurrect locked Kinetis device
Options
m Select the options| AELio0s

Reset targatl] Select the action to perform

> Startup | &> Source | ] Common

© Program Program (mass erase first)

Verify only Check file areas blank

General Options Options
Flash programming 16} Select the options to apply

Preview comman Format to use for programming @ axf ) bin

Base address

1

Reset target on completion

General Options
Flash programming tool options
Preview command [ Clear console

Figure 12.16. Debug Launch Flash Programming
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To perform the selected operation, simply click the Run button.

Important Note: By default, a launch configuration will be created with Program as the default
Program action, and Mass Erase as the default Erase action. When settings are changed by the
user they will be stored within that project’s launch configuration and will remain until manually
changed (or the launch configuration is deleted). When are used, they
will action the current settings within the selected projects launch configuration (or if none exists,
create a new default launch configuration) - therefore if the Program action is set to Verify, a
Verify will be performed as the Program action.

Breakpoints

When viewing source (or disassembly) during a debug session, you can toggle breakpoints by
simply clicking/double clicking in the left most side of the source view, typically shown as a light
blue column. This is also where the breakpoint symbol is shown when one is set. This can be
done when the target is paused or running.

Breakpoints (and Watchpoints) are also displayed, and can be deleted or disabled in the
Breakpoints View. If you are using the “Develop” perspective, then by default it will be in the
bottom left of the MCUXpressolDE window tabbed with the Quickstart and other views

If you have closed the Breakpoint view at some point, then you can re-open it using the “Window
-> Show view” menu or ‘Window -> Perspective -> Reset Perspective".

Breakpoint Types

At a basic level there are 2 types of breakpoints:

e Hardware: these are limited in quantity but can be set on ROM (Flash) or RAM. These
breakpoints are provided by the debug hardware built into to the CPU.

e Software: these are implemented by a software instruction BKPT and can in normal
circumstances only be placed on addresses within RAM (since the underlying code must be
changed). These breakpoints can be applied in any quantity and are invisibly placed (and
removed) by the debugger.
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Usually the debugger will automatically decide the best breakpoint to use for a particular memory
type or circumstance and this is invisible to the user.

Simplistically, software breakpoints will be placed in RAM and Hardware breakpoints are placed
in ROM (Flash).

Tip

@ On some systems, a bootloader may copy code from ROM into RAM for execution
— if a symbol within this code is breakpointed — such as main(), then the debugger
may select a software breakpoint since it knows that main() will reside in RAM.
A problem can arise if the software breakpoint is set by the debugger before the
bootloader has relocated the code. If this occurs, any software breakpoint will be
overridden by the relocated code. Introduced in MCUXpresso IDE version 10.2.0 is
support for - to ensure this problem does not arise in this
case, MCUXpresso IDE will force a hardware breakpoint onto main(). This will not
be overridden since this breakpoint type makes no changes to memory.

Breakpoints Resources

When debugging code running from Flash memory, the debugger is limited on how many
breakpoints it can set at any time by the number of hardware breakpoint units provided by the
ARM CPU within the MCU.

Note: Code located in RAM can use a different breakpoint mechanism offering the capability of
essentially unlimited breakpoints.

Typically, the number of hardware breakpoints/watchpoints that can be set are as follows:

Cortex- M)/ M+ (LPC) - 4 breakpoints, 2 watchpoints
Cortex- M)/ M+ (Kinetis) - 2 breakpoints, 1 watchpoints
Cortex-M3/ Md/ M/ - 6 breakpoints, 4 watchpoints

ARM does provide a level of implementation flexibilty, so always consult your MCU
documentation.

If you try to set too many breakpoints/watchpoints when debugging, then the precise behaviour
will depend on the debug solution you are using. For LinkServer an error of the form below will
be generated.

15: Target error from Set break/watch
Unabl e to set an execution break - no resource avail able.

To fix the problem, simply remove the excess breakpoint(s).

Also remember that a breakpoint will be (temporarily) required for the initial breakpoint set by
default on the function main() when you initially debug your application. A breakpoint may also
be required (temporarily) when single stepping code.

Note: When the target is paused, any number breakpoints may be set within the source or
disassembly views of the IDE, however only when the target is Resumed (Run) will the low level
debug hardware attempt to set the required breakpoints. Therefore it is possible to request many
more breakpoints that are supported by the target MCU leading to the error described above.

Skip All Breakpoints

You can use the “Skip all breakpoints” button ® in the Breakpoints view (or on the main toolbar)
to temporarily disable all breakpoints. This can be particularly useful on parts with only a few
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breakpoints available, particularly when you want to reload your image, which will typically cause
the default breakpoint on main() to be temporarily set again automatically by the tools.

12.5 Watchpoints

Watchpoints are Breakpoints for Data and are often referred to as Data Breakpoints. Watchpoints
are a powerful aid to debugging and work by allowing the monitoring of global variables,
peripheral accesses, stack depth etc. The number of watchpoints that can be set varies with the
MCU family and implementation.

Watchpoints are implemented using watchpoints units which are data comparators within the
debug architecture of an MCU/CPU and sit close to the processor core. When configured they
will monitor the processor’s address lines and other signals for the specific event of interest. This
hardware is able to monitor data accesses performed by the CPU and force it to halt when a
particular data event has occurred.

The method for setting Watchpoints is rather more hidden within the IDE than some other
debugging features. One of the easiest ways to set a Watchpoint is to use the Outline View,
which by default this will be located within the IDE Quickstart panel.

From this view you can locate global and static variables then simply select Toggle Watchpoints.

) Quickst )= Global (x Variabl ©g Breakp EE Outline 82 = O

BV ok ¥

= LPC8Bxx.h

= cr_section_macros.h

= stdio.h

' giobs :Itl S Open Declaration Fa

o o Open Call Hierarchy AN H

Open Include Browser L Eel
Refactor >
Declarations >
References >

Smart update >
Utilities >

Figure 12.17. Toggle Watchpoint

Once set, they will appear within the Breakpoint pane alongside any breakpoints that have been
set.

Watchpoints can be configured to halt the CPU on a Read (or Load), Write (or Store), or
both. Since watchpoints ‘watch’ accesses to memory, they are suitable for tracking accesses to
global or static variables, and any data accesses to memory including those to memory mapped
peripherals.

Note : To easily distinguish between Breakpoints and Watchpoints within the Breakpoint view,
you can choose to group entries by Breakpoint type. From within the Breakpoints view, click the
Eclipse Down Arrow Icon Menu, then you can select to Group By Breakpoint Types as shown
below:
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) Quic ®=Glo -Vari 0= Outl % Bre | = O 67 * @brief main routine for hlinky example

coooQe

& s @\
v &5 C/C++ Line Breakpoints
~a systick.c [line: 62]

@ systick.c [line: 79

¥ gu C/C++ Watchpaints

& systick.c [expression: ‘counter1’] €0 Add Event Breakpoint (C/C++)...
i i ! ; & Ti n ~iodic P *

# systick.c [expression: ‘counter2'] €% Add Watchpoint (C/C++)... ! Timer at a periodic rate */

= 68 ¥ @return Function should not exit.
] 69 */
ayout >

@ Add Line Breakpoint (C/C++)...
@' Add Function Breakpoint {C/C++)...

lock / TICKRATE_HZ1);:
«.» Show Full Paths

 Group By > @ 1 Breakpoints
oo Select Default Working Set...
Deselect Default Working Set é 3 Breakpoint ering Sets
Working Sets... | 4 Files
B == 5 Projects
Installed SDKs [ Properties B Cor = 6 Resource Working Sets

nerinh svstick |inkSarver Dehiua [CIC++ (NX % 7 Advanced...

Figure 12.18. Watchpoints View
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As you can see from the above graphic, the option to set a Watchpoint is also available directly
from the Breakpoint view. When set from here, you will be offered an unpopulated dialogue —
simply entering an address will cause a watchpoint to be created, monitoring accesses to that
location.

Another place to set Watchpoints within the IDE is from the context sensitive menu within a
Memory view.

Note: Watchpoint resources are shared with other debug features, in particular an SWO Data
Watch item will require a dedicated watchpoint unit to monitor the value.

Note: Due to the way watchpoints are implemented, any monitored access will be performed
by the CPU before a halts occurs (unlike instruction breakpoints — which halt the CPU before
the underlying instruction executes). When a watchpoint is hit you will see some ‘skid’ beyond
the instruction that performed the watched data access. If the instruction after the data access
changes program flow (e.g. a branch or function return), then the IDE may not show the
instruction or statement that caused the CPU to halt.

Note: Application initialisation performed by the C library may write to monitored memory
locations, therefore you may see your application halting during startup if watchpoints have been
set on initialised global data.

Using Watchpoints to monitor stack depth
Watchpoints provide a very simply way of monitoring stack depth when an application is running.

Stacks on ARM based processors use a Full Descending scheme and so have the potential to
descend into areas of memory used for other purposes (typically holding global data or the heap).
Establishing the maximum depth of an applications stack can be a challenge especially since any
memory corruption due to excessive stack use may not be immediately apparent. Watchpoints
may be used to monitor and trap the stack exceeding a particular depth during execution enabling
positive reassurance that the true stack depth is understood.

The graphic below shows the use of the breakpoint view feature Add Watchpoint (C/C++) ...
where an address has been selected to watch for the Stack reaching 0x10007D00.
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[ NaN ) Broperties for C/C++ Watchpaint
Common Common - - v
Class: C/C++ Watchpoint

Expression to watch: | Ox10007D00
Range:

Read

Write
Enabled
Condition:
Ignore count: 0
@ cancel | (CTHEN |

Figure 12.19. Watchpoint on Stack Depth
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Registers

The Register view, by default located next to the Project Explorer view, will display the internal
ARM CPU registers when the core is halted i.e. when there is an active debug connection but
the target is paused. The contents of the registers view will vary depending on the nature of the
ARM CPU inside the MCU being debugged, however the base register set will be available for
all MCUs.

The Register list as displayed is made up from, the Basic Register set (Core Registers), Fault
and Status Registers, Pseudo Registers, and finally Floating point Registers (for Cortex M4/M7
etc.). Since the register set for many MCUs is large, individual register groups can now be hidden
if required to reduce screen usage.

Note: For many debug tasks, the values of the CPU registers will be of little concern, however
when debugging at the disassembly level (and single stepping), these values can be a powerful
debugging aid. For an in depth understanding of the ARM register set for the CPU within your
NXP MCU, please consult the documentation available from ARM.

Tip
@ Even when operating in LinkServer None Stop mode, registers cannot be read or
written when the target is executing and the register display may appear blank.

Basic Register set (Core Registers)

The basic register set comprises the CPU’s 16 32 bit core registers (rO — r15), plus the program
status register, certain registers have a special function:

¢ r13 — SP Stack Pointer, this holds the address of the last entry on the stack

¢ rl4 — LR Link Register, this holds the return address for a BL (branch with link) instruction

¢ r15 — PC Program Counter, this holds the address of the instruction (to be) executed

e Xpsr — program status register, this combines the Application (APSR), Interrupt (IPSR) and
Execution (EPSR) program status registers, reflecting the state of the CPU

« flags — set by certain instructions performing arithmetic operations (contained within the APSR)

The register set (for a Cortex M4 CPU) is displayed below:
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i) Project Explorer 2. Peripherals+ il Registers 52 |4 Faults X Symbol Viewer =l
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itk OxfFFFFiff Argument/Scratch Register 1
i 0xbff00000 Argument/Scratch Register 2
iiir2 ox1 Argument/Scratch Register 3
Hith < ox1 Argument/Scratch Register 4
ilra OxbffO0000 Variable Register 1
Wi rs Oxc0180000 Variable Register 2
ol 0x0 Variable Register 3
iitr7 0x2002ffb0 Variable Register 4
Air8 0x0 Variable Register 5
i Ox0 Variable Register 6
Wir1o 0x0 Variable Register 7
Mir1l ox0 Variable Register 8
12 0x7fa1cO00 Intra-Procedure-Call Scratch Register
Wil SR 0x2002ffb0 Stack Pointer (r13)
it lr Oxad3 Link Register (r14)
D 0xa78 | Program Counter (r15)
b il xpsr 0x81000000 tus Register
B Tpscr O0x0 t Status Control Register
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Figure 12.20. Registers View

Note: in this graphic the floating point registers have been hidden

Four blocks of registers are highlighted within the graphic

 registers rO —r15 and the xpsr (the components of this are shown below in the status registers)

« status registers apsr ipsr and epsr, these registers together combine to form the xpsr

« certain bit fields such as the CPU flags are expressed alpha-numerically in this view

¢ Cycles is a memory mapped register that increments for each core clock tick. CycleDelta is a
pseudo register that records the cycles since the last pause (see more below).

 details view displays the selected register in various formats

When paused, all of these registers can be read (or written). The ability to write values to the
registers set is a powerful debug feature but should be used with care.

CycleDelta

CycleDelta holds the number of core clock ticks that have occurred since the last time the
CPU was paused. For example, if you run from the default breakpoint on main to a breakpoint,
cycledelta will contain the number of clock ticks that occurred while executing this section of code.
If a step is performed, the cycledelta will be the number of clock ticks for code being stepped. If
stepping at the instruction level, this value will often be 1 because many instructions will execute

within a single clock cycle.
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Vectpc

In previous versions of MCUXpresso IDE the pseudo register VectPC was used to display a
value when the CPU has experienced a Hard Fault. This functionality has been replaced by the

Faults

During application development, errors within a program or algorithm may lead to a CPU fault
(Hard Fault). These faults include:

» usage fault — such as a divide by zero

¢ bus fault — such as abort triggered by a memory controller

*« mem manage — such as a fault triggered by a memory protection unit

Such errors can be difficult to locate, so to aid the debugging of such problems MCUXpresso
IDE version 10.3.0 introduced a new Faults view.

If a fault occurs, the new Faults view will automatically appear and the CPU will halt (LinkServer).
The view offers a set of features including identifying the nature of the fault, the location (link) of
the code that caused the fault, the location (link) of the function that called the ‘fault’ function.

Note: for non LinkServer debug probes, a fault may leave the application running within the

default fault handler (usually implemented as a while(1)), hence a pause might be necessary to
see that a fault has occurred.
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| Peripherals+ Registers 't; Faults &2 Symbol View = O

roject Ex

o

1+ Active faults @ main.c [line 195]

( Hard Fault (HFSR)

Indicates a forced hard fault, generated by escalation of a fault with
4% FORCED (30) configurable priority that cannot be handled, either because of priority
\ or because it is disabled

[ Usage Fault (UFSR)
4 DIVBYZERO (9) Divide by zero
.

/I:autt Status Registers

Name Value Description

XPSR 0x61000003 Exception Status Register

CFSR 0x02000000 Configurable fault Status Register
UFSR 0x0200 User fault Status Register

HFSR 0x40000000 Hard fault Status Register

DFSR 0x00000000 Debug fault Status Register
AFSR 0x00000000 Auxiliary fault Status Register

.

b

@ckeﬂ Registers (LR/JEXC_RETURN=0xffffff{9)

Name Value Description

RO 0x00000018B

R1 Ox1FFFO1B8

R2 Ox1FFFO1B8

R3 0x00000000

R12 0x00000011

LR 0x00000513 = main()

PC 0x0000261E = DivideByZero()
PSR 0x61000000

Q Ox1FFFO1 CO/

Figure 12.21. Faults View major features
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This view will be titled with the source file and line number that caused the error. The view
contains the following features:

1. The Fault that occured — in this example a Usage Fault of type Divide by Zero

« certain faults may need to be enabled within the CPU, for example Divide by Zero is enabled
in the Cortex M4 Configuration and Control register

. The Action that was taken — in this example a Hard Fault was generated
. Links to the source of the fault function and its caller function, located from stacked registers
. values of the registers automatically stacked on entry to the fault handler
. fault status registers that may offer further information
. additional options including:
¢ button to cause disassembly to be opened in parallel with sources (3)
« button to copy the fault details to the clip board
« button to display all fault registers and descriptions rather than the

O WDN

In some circumstances, a hard fault might be caused early on during the initialisation of the
system before the breakpoint on main() is hit. This may mean that the fault is triggered before
the debugger can take action to display the faults view. If this happens, try setting a breakpoint in
the startup code — this might then allow your code to load without the hard fault being triggered.
You should then be able to single step / run until the cause of the hard fault is hit. You will then
see Faults View displayed.
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Tip

@ if a repeated fault occurs that is difficult to debug, instruction trace could be enabled
(when supported by the MCU) and the captured trace dumped when the fault is
trapped. Looking back at the captured instructions should help find the reason for the
fault condition. Please see the MCUXpresso IDE Instruction Trace guide for more
information.

Note: Typically a Fault on an embedded system will be fatal, however this view will also assist
for users developing and testing fault handlers for recoverable fault situations.

Peripherals

Peripherals is a generic term referring to both core peripherals, for example the System Timer
(SysTick) and SOC/MCU peripherals such as an ADC or UART. In both instances these hardware
blocks are exposed within the MCUs address space (known as memory mapped peripherals)
and so can be interrogated by accesses to their specific memory locations.

MCUXpresso IDE’s debug support (whether built in or provided by an SDK) includes knowledge
of an MCU'’s peripheral set, this is available via the Peripherals tab within the Project Explorer
pane (once a debug connection is made).

Highlighted in the view below are two peripherals that have been selected for detailed display.
Also highlighted are the device memory regions, if these memory regions are selected a standard
hex memory display will be created. Memory regions are not peripherals in the normal sense but
are included here so their memory space can be easily displayed.
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= &, ASYNCSYSCON 0x40080000 Asynchronous system configuration

1| =.CRC 0x1c010000 CRC engine
2, CT32B0 0x400b4000 Standard counter/ftimer O

= 2 CT32B1 0x400b8000 Standard counter/timer 1

= &, CT32B2 0x40004000 Standard counter/timer 2

W 7, CT32B3 0x40008000 Standard counterftimer 3
2. CT32B4 0x4000c000 Standard counter/timer 4

o 2. DCR 0xe000edf0 Debug Core Registers (v7M)

T DMA 0x1c004000 DMA controller

¥ 2 GINTO 0x40010000 Group GPIO input interrupt 0
2 GINT1 0x40014000 Group GPIO input interrupt 1

= = GPIO 0x1c000000 General Purpose I/0O

- 2 12C0 0x40084000 12C-bus interface O

L 2121 0x40098000 I12C-bus interface 1

| B12c2 0x4009c000 12C-bus interface 2

= 2 INPUTMUX 0x40050000 Input multiplexing

= 2, I0CON 0x4001c000 1/O pin configuration

L ZIT™ 0xe0000000 Instrumentation Trace Macrocell

T E MAILBOX 0x1c02c000 Mailbax

T E MPU 0xe000ed90 MPU (v7M)

T EMRT 0x40074000 Multi-Rate Timer

¥ 2 NVIC Oxe000e000 NVIC Control/Status Regsiters (v7M)
L PINT 0x40018000 Pin interrupt and pattern match en...

= ZRIT 0x40070000 Repetitive Interrupt Timer

- 2 RTC 0x4003c000 Real-Time Clock

L 2, SCTO 0x1c018000 State Configurable Timer/PWM O
2, SPI0 0x400a4000 SPI0

AN 0x40028000 SPI1

(v . svscon 0x40000000 System configuration )

T USARTO Ox20084000 USARTO
& USART1 0x40088000 USART1

Tl E USART2 0x4008c000 USART2

Tl . USART3 0x40080000 USART3

L Z UTICK 0x40020000 Micro-tick timer
2, VFIFO 0x1c038000 System FIFO for Serial Peripherals

WWDT 0x40038000 Windowed Watchdog Timer
MFlash256 0x0 Flash: size=0x40000 (256k)
Ram0_64 0x2000000 RAM: size=0x10000 (64k)
[{ZRam1_32 0x2010000 RAM: size=0x8000 (32k)
EIRam2_8 0x3400000 RAM: size=0x2000 (8k)

=)

Figure 12.22. Peripherals View

From this view each peripheral is listed along with its base address and brief description. If
selected from the associated check box, a detailed memory view will be launched. This view
exposes the inner peripheral registers and offers bit field enumerations to greatly simplify both
reading existing configurations and setting new values.
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0 Memory 2 i me b R TR = T Al
Monitors 2= 3¢ ¥ [SYSCON: 0x40000000 [LPC54102J256] 5% . 2= New Renderings...

% ADCO[LPC54102J256] "| Register Address Value

@ SYSCON [LPC54102J2586] » i ASYNCAPBCTRL 0x40000020 Ox0
» il SYSRSTSTAT 0x40000040 0x0
b 1 PRESETCTRLO 0x40000044 0x0
» i PRESETCTRLY 0x40000048 0x0
B i PRESETCTRLSETO 0x4000004c <writeonly>
» Y PRESETCTRLSET1 0x40000050 <writeonly>
» i PRESETCTRLCLRO 0x40000054 <writeonly>
* N PRESETCTRLCLR1 0x40000058 <writeoniy>
» 1ili PIOPORCAPO 0x4000005¢ 0xf9e33fff
» i PIOPORCAP1 0x40000060 Ox3ffff
» 418 PIORESCAPO 0x400000868 0x79e33fff
» 1i8i PIORESCAP1 0x4000006c Ox3ffff
¥ 0ibi MAINCLKSELA 0x40000080 0x0

oo SEL [1:0] IRC OSCILLATOR v

» i1 MAINCLKSELB 0x40000084 IRC_OSCILLATOR
>3 ADCCLKSEL 0x4000008¢c CLKIN
# i1 CLKOUTSELA 0x40000084 WATCHDOG_OSCILLATOR
> i CLKOUTSELB 0x40000088 RESERVED
b SYSPLLCLKSEL 0x400000a0 0x0
> i3 AHBCLKCTRLO 0x400000c0 0x211b
i AHBCLKCTRL 0x400000cd 0x0
b it AHBCLKCTRLSETO 0x400000cB <writeonly>
b S AHBCLKCTRLSET1 0x400000cc <writeonly>
F it AHBCLKCTRLCLRO 0x400000d0 <writeoniy>
15 AHBCLKCTRLCLRY 0x400000d4 <writeonly>
ki SYSTICKCLKDIV 0x400000e0 0x0

Figure 12.23. Peripheral Register view

12.8.1
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Important Note: When an MCU powers up, many peripherals will be unavailable because they
are unpowered/not clocked. Attempting to access a peripheral in this state will result in failure, and
the detailed peripheral view will simply display their base address in red. Certain peripherals may
be partially available, unavailable sections will again display in red. Entries that have changed,
will display in yellow.

Tip

Even when operating in LinkServer None Stop mode, peripherals can not be read or
written when the target is executing. The main peripheral display may appear blank
when the target is executing regardless of LinkServer mode.

Warning: It is strongly advised that only peripherals that are well understood are accessed
in this manner since attempting to view certain peripherals can break a debug connection or
perform other unexpected actions. MCUXpresso IDE’s debug features cannot offer protection
from such occurrences.

Peripheral Filters

Introduced in MCUXpresso IDE version 10.2.0 is the ability to filter the displayed peripheral view.
Peripherals may contain a large humber of internal registers, and these registers may contain
many fields, to reduce screen clutter and to help locate peripheral registers (and fields) of interest,
one or more filters can be applied.

To create a filter, right click inside the peripheral rendering and select Edit Filters. This will launch
a dialogue as below.
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Figure 12.24. Peripherals Filter

MCUXpresso IDE

Filter
| Hide registers/fields not containing the filter string m

Filters configurations
| Regular Expression ) Contains
Case sensitive
Filters

| | Text Fiel

d
PERIF itt! Register M
Field

Add Filter Remove Selected Filters

Cancel oK

12.9

MCUXpresso IDE User Guide -

For each piece of text to match, you can select whether the filter applies to Register Names or
Field names. To restore the view, right click inside the peripheral rendering and select Remove
all filters.

Global and Live Global Variables

Global and Static variables are stored within system RAM memory and can therefore be
accessed by the debug chain (read and potentially written) while a application is both paused
and running.

Note: ARM processor inside the NXP MCU utilises a load store architecture, this means that a
global variable must be read (loaded) from memory and then written back by the processor (if
changed). The value of the variable displayed will correspond to the value in memory and this
may potentially be different from the value held by the processor. Modern MCUs execute millions
of instructions every second, so any variable observed while an application is running may have
been changed many times from the value displayed in the view, therefore take care that this is
understood before attempting to change a variable value within the Global variable view.

This view can be populated from a selection of a projects global variables. Simply click the “Add
global” button to launch a dialogue:
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Quickstar ©J= Clobal Va 3

Variable

Figure 12.25. Add Global Variables

Variables Breakpo

*Adn global variables "

tine = O

e T
i =

This will then display a list of the global variables available in the image being debugged. Select
the ones of interest via their checkboxes and click OK :

Select symbols.

Name

_Ciob
_end_of_heap
__heaps
_num_Ciob_streams
_Vectors
errno
Flash_Config

"I g_accel_address

| g_MasterHandle
g_pfnVectors

~ g_xAngle
g_xDuty
g_xtalOFreg
g_xtal32Freq
g_yAngle
g_yDuty

Figure 12.26. Global Variable Selector

~ Aoaress
0x2000007¢
0x20000130
0x20000134
0x00006670
0x00000000
0x20000138
0x00000400
0x00005874
0x20000014
0x00000000
0x2000003c
0x20000040
0x20000044
0x20000048
0x2000003e
0x20000042

B

180

408
16

40
408

[CR Y

Select All

Cancel

Deselect All

Note: to simplify the selection of a variable, this dialogue supports the option to filter (highlighted)

and sorts on each column.

Once selected, the chosen variables will be remembered for that occurrence of the dialogue.

For all supported debug chains there is now the capability to view global variable values when the
debug target (MCU) is running. When this feature is used, these are known as " Live Variables".

For variables to be “Live™:

« the target must be running
« the enable/disable (run) button clicked (as shown highlighted below)

Once done, the display will update at the frequency selected (selectable from 500 ms to 10 s).
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) Quickstart Panel ()= Global Variables 83 ()= Variables 9 Breakpoints 5= Outline = 0

X & @ 1000 o 4B I =
Value Address

variable Type

v (#®array uint32_t [4] 0x20000018 <array> 0%20000018
09=array[0] uint32_t 1 0x20000018
oa-array[1] uint32_t 85 0x2000001¢
co=array[2] uint32_t 10 0x20000020
-=array[3) uint32_t 7 0x20000024

9:g_xAngle volatile int16_t 25 0x20000120
©9:g_yAngle volatile int16_t 1 0x20000122

5 Add new expression

Figure 12.27. Global Variable Display

Introduced in MCUXpresso IDE version 10.2.0 is the ability to enter an expression (using
standard C notation) or symbol. The expression will be evaluated and the address displayed in
the Address column.

Quickstart Panel ®)= Global Variables 23 Variables Sreakpoints Outline =0
R4 Q1000 sl=ls =
variable Type Value Address
b (Barray uint32_t [4] 0x20000018 <array> 0x20000018
=g_xAngle volatile int16_t 86 0x20000120
gle volatile int16_t 3 0x20000122
uint32_t 103 0x20000018

o 32_t *) 0x20000018

Figure 12.28. Global Variable Display Expression

Live Variables like normal Globals can also be edited in place. Simply click on the variable value
and edit the contents. During the edit operation, the display will not update. This mechanism
provides a powerful way of interacting with a running target without impacting on any other aspect
of system performance.

Note: If you wish to have some global variables ‘Live’ and others not, then this can be achieved
by spawning a second Globals display via the ‘New View’' button and populating this without
enabling the ‘run’ feature for that view.

The usefulness of Live Variables reduces as the number of Globals monitored increases, and
ultimately there will be a limit as to how many variables can be updated at the selected frequency.
However, complex list of variables can be monitored if required. For example:
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) Quickstart Pa - Global Variabl 82 (X)-=Variablas ®s Breakpoints EE Outline = O3
Variable Type p.
©)=_random_j <data variable, no debug info> 25
©9=_random_k <data variable, no debug info> 2
©=b _Bool frue
e-f float 62.9931755
®=d double -0.88162727834732613
»p void * 0x20000130 <bi_a>
=i volatile int 5
®=] int 3
=k int 3
¥ (®=uni_a double [5] 0x20000108 <uni_a>
6d=uni_a[0] double 0.64644408768343009
©9=uni_a[1] double 0.52534067329267975
69-uni_af2] double 0
6d=uni_a[3] double 0
(d=uni_a[4] double -0.69493926395426475
¥ (®bia float [3][3] 0x20000130 <bi_a>
¥ (=bi_a[0] float [3] 0x20000130 <bi_a>
69-bi_a[0][0] float 77.4734955
©9=bi_a[0][1] float 92.8390503
©4-bi_a[0][2] float 46.7962074
v (®bi_a[1) float [3] 0x2000013c <bi_a+12>
©9-bi_a[1][0] float 63.3472824
69=bi_a[1][1] float 95.4246292
©9-bi_a[1)[2] float 30.6657524
» (®bi_a[2] float [3) 0x20000148 <bi_a+24>
> (#=s example char [15] 0x20000154 <s_example>
v ®s ex1 struct Struct_example {--}
> (= name char [5] 0x20000168 <s_ex1>
=5 | int 3

Figure 12.29. Global Variable Display Complex

12.10 Live Global Variable Graphing

Introduced in MCUXpresso IDE version 10.2.0 is the capturing of live variable values over time.
This data can be displayed as raw values (which can be exported) or plotted as graphs directly

MCUXpresso IDE User Guide -

within the IDE.

To select a plot type, right click within the Globals view and choose one of the options:

View Memory
Number Format >
Find... ®BF

Launch Conf‘lgurating
Smart update

Utilities

#, Cast To Type...

1 Trace global variables
v/ 2 Plot global variables
3 Number Formats Viewer

r

=[] Display As Array...
Restore Original Type

%Y Watch

* Trace Global Variables will sample values of the selected variables at the variable update
frequency. These values can be viewed within the panel or exported as tsv data.

« Plot Global Variables will sample and plot values of the selected variables at the variable
update frequency. These graphs can be viewed within the panel or saved as png.

* Number Format Viewer will display the selected variable values in various bases

Variables can only be sampled if they have first been added to the Global Variable panel as
discussed in the previous section. The selection of variables to plot is simply made by clicking
to highlight the variable of interest.

Tip
multiple variables can be selected by normal host multiple selection scheme e.qg.
ctrl/cmd click
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Note: Once a variable has been selected, the timebase (uptime) will begin and variables values
will be sampled and displayed. If additional variables are selected, their values will join the
display at the current uptime. If a variable is unselected its values will no longer be sampled and
displayed. If however, it is selected again within the same debug session, it will be displayed
along with any previously captured values. During any period it was not selected its values will
show as zero.

Tip

@ If the display is paused, data will still be captured but the new values will not be
displayed, this can help detailed viewing of the data. Once un-paused, the captured
data will be added to the display.

Note: If the target is paused, time (x-axis) will continue to advance although the display will not
update until the target is resumed.

12.10.1 Live Global Variable Graphing details

In the example below, two variables have been added to the Global variable view and both have
been selected.

() Quickstart Panel (4= Global Variables £ (*)- Variables ®g Breakpoints o= Outline = 0
X & 01000 O B e v
Variable Type Value Address
G-yvar volatile int32_t -263 0x2000000¢

©:=loop uint32_t 227 0x20000010
== Add new expression

Details =

Plot of "yvar* from project 'frdmk64f_led_blinky" O } ; I

/\\ /\/Q\/\\/\

DOGOO 00200 00:40.0 CI'IOOO O'IEOD 01:40.0 02000 02:20.0 DZ&DO OBDGO

Uptime [mm:ss.S)

yvar

Plot of 'loop’ from project “frdmk64f_led_blinky*

T T T T T T T T T T
00:00.0 00:20.0 00:40.0 01:00.0 01:20.0 01:40.0 02:00.0 02:20.0 02:40.0 03:00.0
Uptime [mm:ss.5]

Figure 12.30. Global Variable Graphing major features

The highlighted features are discussed below:

1. Selected variables for graphing. Click to select, ctrl/cmd click to add additional variables. The
selected values will be remembered between debug sessions

¢ Once selected the variable will exist in the internal database of values and will remain until
the debug session is terminated (even if it is later unselected)

2. Save: Click to save the display as a png. The size of the png will be proportional to the size of
the global view. Therefore, for more detail, increase the size of the global view before saving
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¢ Other graphic formats are also supported. Note: in addition a tsv file containing the captured
data will also be saved

3. Pause: Click to pause the graph display updated. Variables values will still be captured but
the screen will not update

¢ This may be useful if a portion of the display needs to be viewed in detail

4. Multiple/Single Graphs: Click to toggle the display between separate graphs for each variable
and all variables plotted on a single graph

« when more than one variable is displayed on a single graph, the Y axis will display as hex
values

5. Show Data Statistics: Click to add display of min, max, average information for each plotted
variable.

6. Clear all Data Statistics: Click to clear existing data from the Data Statistics values
7. Click onto the graph to view the actual variable value at that point
« it may help to pause the update to explore variable values

Below, is a view of two variables on a single graph with data statistics enabled.

Variable min max avg
yvar -369.0 359.0 359.0
loop 0.0 369.0 17956

Details B 0] =3
Plot of selected variables from project "frdmkG&4f_lad_blinky"
| f1 I\ A I\
300 | J [ o [
200 i -1 = {1 I

1004 e [--#4 §-211 i/ 1-=t1

¥ axis
o
L

-100 4| e ey R B

=200 -~ - -4 i | |
i \

3004 |/ \ |-

T T T T T T
00:30.0 01:00.0 01:30.0 02:00.0 02:30.0 03:00.0
Uptime [mm:ss.S]

—_— var = loop

Figure 12.31. Multiple Global Variable Graph

Within a graph view there are a range of features that can be explored. Right click within the
graph to display the menu as below:
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Figure 12.32. Multiple Global Variable Options

Details & 00 =B

Plot of selected variables from project ‘frdmk&4f_led_blinky”

300
200454 |V T il If | s i|
Adjust Axis Range > | || Jr
100 E
Zoom In > | I
- Zoom Out » i 4F'°
i [
d Save As... l |
| || 'R
-1001:1| Properties... | Il | |
e | |
200 4 X_Axls u_nlt L | k|
Time Window = T
Reset 11l
-300 1
Plot settings ('yvar') S
Piot settings ('loop') N L

T T T T T T
00:00.0 01:00.0 02:00.0 03:00.0 04:00.0 05:00.0 vowww vrwww voewww w00 10:00.0
Uptime [mm:ss.5]

— v —— loop

MCUXpresso IDE User Guide -

Most options are self explanatory, however the Time Window option is discussed below:

Time Window offers 3 options; Small, Medium (default) and Wide. This setting controls the
number of samples that can be captured and displayed - where Smallis 100, Medium is 1000, and
Wide is 10000. If these samples were expressed as an amount of time, 1000 samples captured
at a frequency of 1 sample per second (default) would ultimately display a window spanning
1000 seconds.

Once the selected number of samples have been captured, the oldest samples will be discarded
as new samples are taken, and the display will scroll horizontally.

Also consider, due to the physical limitations of a monitor, 1000 samples will require roughly 1/2
the horizontal pixels available on a 1080p display to render without loss, so the Wide option will
only be of benefit if used in conjunction with zoom or a large screen.

Note: the Trace option will always capture up to 10000 samples per variable.

Finally, if you wish to explore the graph in more detail, you can simply drag within the display
to zoom into the view as below:
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Details (& =B
Plot of salected variables from project “frdmk641_led_blinky'
4 . " |/
. / ; | ||
150 A f A 1 /
| A | /1 Il
| / | /] '
| ¥ / | £ R
i | F | |
g | Y | S|
100 4 ;_,. | -1 / { | f/ |
| / I / |
/ | | / / |
@ | | / | I h |
/ | / | |
b \ | \ / |
Bo | I | | Y,
| | \
/ | / |
| [* | |
/ v |
| |
|
0 | | | |
| | | |
| | | | |
| |

|

T T T T T T T T

02:50.0 03:00.0 03:10.0 03:20.0 03:30.0 03:40.0 03:50.0 04:00.0 04:10.0 04:20.0
Uptime [mm:ss.5]

— v = lap

Figure 12.33. Multiple Global Variable Zoom

It is recommended that the display is paused for detailed exploration of this sort.

Note: Due to the way this feature is implemented, unsigned variables can plot as signed types
A workaround for this would be to switch to plotting as hex numbers.

12.11 Heap and Stack View

Located by default in the MCUXpresso IDE Develop perspective, along with the Memory view
at the bottom right of the perspective.

One of the common issues within embedded system development is allocating the appropriate
memory for heap and stack usage. New in MCUXpresso IDE version 11.0.0 is the ability to
monitor heap and stack usage within their allocated regions of memory. The new Heap and Stack
Usage view allows the monitoring of heap usage in real time (while an application is running).

However. since the value of the Stack is held within a processor register, Stack usage can only
be updated when the application is paused.

The Heap and Stack view displays usage with respect to the configured heap and stack sizes as

set within the Projects Properties at: C/C++Build -> Settings -> Manager Linker Script -> Heap
and Stack placement

[J Memory )= Heap & Stack Usage 2 Q

Type Usage (%) Used Free Last Used Address Address Range

Heap B1IB8% 1.26KB 2.74KB 0x2000062c  0x20000120 - 0x20001120
stack [ 335K8 6648 0x2002f298  0x2002f000 - 0x20030000

A
1™ 8

Figure 12.34. Heap and Stack View

This view will automatically update when the target is paused. To enable updating of the heap
usage when the debug target is running, click the Run icon at the top of the view to enable or

disable updates to the view. The frequency of the updates can be set between 500ms and 10
seconds.

MCUXpresso IDE User Guide - All information provided in this document is subject to legal disclaimers © 2019 NXP Semiconductors. All rights reserved.
User Guide Rev. 11.0.0 — 23 May, 2019 119




NXP Semiconductors

MCUXpresso IDE User Guide

Tip

Although real time monitoring of the stack is not possible, a watchpoint could be used

to force a target halt when an access to a particular stack depth is performed. Please
see further details in the section on

The symbols used to generate this view are created by the Managed Linker Script mechanism.
However, other symbols can be substituted if required via the workspace preferences as show

below:

v C/C++ Build
Build Variables
Environment
Logging
MCU settings
Settings
Toel Chain Editor
»C/C++ General
MCUXpresso Config Too
Project Natures
Project References
Run/Debug Settings
Task Tags
» Validation

A Build steps

¥ & MCU C Compiler

#Dialect

% Preprocessor
#Includes

(# Optimization
# Debugging

2 Warnings
(#Miscellaneous
2 Architecture

¥ 83 MCU Assembler

(# General

Build Artifact  |ms Binary Parsers @ Error Parsers

Last used address of the heap | _end_of_heap
First address of the heap _pvHeapStart

Maximum extent of heap _pvHeapLimit

(& Architecture & Headers
¥ 5 MCU Linker
# General
(# Libraries
(# Miscellaneous
(*2Shared Library Settings
(2 Architecture
(#Managed Linker Script
(¥ Multicore

Figure 12.35. Heap and Stack View Symbols

12.12 Additional Debug Features
12.12.1 Local Variables

Situated alongside the Quickstart panel, the local variable view displays the local variables in
scope when the target is paused. Typically, local variables are held within processor registers
and so are cannot be accessed when the processor is running. From this view registers can be
viewed and their values edited if required.

Quickstart Panel )= Variables 23 Breakpoints ol
Clziel - i
Name Type Value
» (= fxosHandle fxos_handle_t L.}
» (# sensorData fxos_data_t 3
» (= config fxos_config_t {.}
J=sensorRange uint8_t 11001*
(x)-dataScale uint8_t 4 004"
(9:=xData int16_t -537
(9-yData int16_t -37
6= uint8_t 11001"
(d-array_addr_size uint8_t 4 '\004'
)-result status_t 0

Figure 12.36. Local Variables View

12.12.2 Disassembly view

The Disassembly view allows an application’s code to be viewed at the assembler level (as
generated by the compiler).
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The view can be enabled (if required) via the Instruction Stepping button within a debug
stack view. This button has two functions, in that it both spawns the view and also switches
stepping mode from source level to assembler level. Assembler level stepping is typically used
in conjunction with the Registers view to examine the detailed behaviour of short pieces of code.

Stepping mode can be returned to source level by re-clicking this button.

45 Debug 2 = = |
¥ B frdmké4f_bubble LinkServer Debug [C/C++ (NXP Semiconductors) MCU Application]
¥ [ frdmk64f_bubble.axf [MKE4FN1MOxxx12 (cortex-mé)]
¥ Thread #1 1 (Suspended : Breakpoint)
= main() at bubble.c:364 Oxaae
s arm-none-eabi-gdb (8.2.50.20181213)

Figure 12.37. Disassembly Enable

Once enabled, the disassembly view will display the low level assembler instructions usually
from the current PC.

2= Disassembly £ [Enler location here ﬁ BN Al Km]fa M EEENE
0000Pa9%a: strh r2, [r3, #0]
359 if (g_yAngle < ANGLE_LOWER_BOUND)

00000a9c: dr r3, [pc, #92] ; (@xafc <main+824>)
00080a9%e: ldrh r3, [r3, #0]

000002a0: sxth r3, r3

00080aa: uxth r3, r3

00080aad: cmp r3, #4

00000aab: bhi.n  @xaae <main+746>

361 g_yDuty = @;

00000aas: ldr r3, [pc, #88] 1 (@xbe4 <main+832>)

00000aaa: movs r2, #0

P0ABaaC! strh r2, [r3, #0] =
2364 PRINTF("x= %2d y = %2d\r\n", g_xAngle, g_yAngle);
» 00000aae: dr r3, [pc, #72] ; (@xaf8 <main+820>)

00000ab0: 1drh r3, [r3, %]

00000ab2: sxth r3, r3

00000ab4: mov ri, r3

00000ab6 : dr r3, [pc, #68] ; (@xafc <main+824>)

00800ab8: ldrh r3, [r3, #8]

P0@B0aba: sxth r3, r3

00080abc: mov [ SR |

[:LLLEELTH ldr re, [pc, #72] + (@xb08 <main+836>)

oeevace: bl 8x3c94 < printfs

Figure 12.38. Disassembly View

The view has a number of features including:

¢ Setting a new address to view
< Refreshing the view contents (this might be useful if the underlying code may have changed)

The linking and unlinking from the current debug session (PC)
¢ The intermixing of source code lines with their related assembler instructions
« the usefulness of this feature decreases as compiler optimisation increases

12.12.3 Memory view

Stacked by default in the MCUXpresso IDE Develop perspective, along with the Heap and Stack
view. The memory view allows debug target memory to be explored in a traditional manner. The
view can be populated with target memory regions via the or by entering
required address values.
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0 Memory 2 g e [ o |

Monitors l & * % | J. & New Renderings...

b 0x00000080 20030000 000001D5 00800251 00004778

@ Ox0
& 0x20000000 0x20000010 POORD255 000ROZ57 00ORO259 00200000
] 00000258
0x00000030 00000250 00000000 0080R25F 00LEO261
® @ 8. Monitor Memory 84395 000G430D BOBR4IAS 008043AD
P43B5 000043BD 000043C5 000043CD
Enter address or expression to monitor: B43D5 000@43DD 0OAR43ES 0B0AB43ED

i P43F5 000043FD 0004405 0ORE44ED
” 84415 00600441D 00004425 00ERA42D
04435 0000443D 00004445 000E444D
04455 0000445D 00004465 00OBA46D
04475 00004470 00004485 0000448D
@ Cancel “ B4495 20004490 DOAB44AS 0D0A44AD
000044BD D00V44C5 @00R44CD
00004400 D0OBOEB1 BOOAILES

Figure 12.39. memory View

Note: Although it is technically possible to populate this view while the target is running, this
mode of operation is not currently supported. Particular memory of interest can be monitored live
via Global variable expressions if required.
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13. Configuring a Project

13.1

When a project is imported or generated using a wizard, there are many configuration options
available at creation time. However, once a project has been created or if a project is shared by
other means, then there still may be a requirement to make changes.

The range of possible project changes is almost infinate but below we will discuss a number of
common changes that may be required and the potential ramifications that may be encountered.
Note that many of these changes can be started from a projects

Note: This section only discusses a few of the common changes that may be made. Please also
see the sections on , ,

and the additional Config Tool documentation for a more comprehensive
description of the options available.

Changing the MCU (and associated SDK)

All projects are associated with a particular MCU at creation time. The target MCU determines
the project memory layout, startup code, LinkServer flash driver, libraries, supporting sources,
launch configuration options etc. etc. so changing a project’'s assiciated MCU should not be
undertaken unless you have a total grasp of the consequence of this change.

Therefore rather than changing a project’s associated MCU, it is strongly recommended
that instead a new project is generated for the desired MCU and this new project is edited
as required.

However, on occasion it may be expedient to reset a projects MCU (and associated SDK) and
this can be achieved as follows. From the project virtual nodes, select Edit MCU.

Figure 13.1. Edit MCU

v € Project Settings
¥ =i Associated SDK
o name = 'SDK_2.x_FRDM-KG64F'
o version ='2.4.2'

¢ Edit MCU
¢ Change Package 3

o]
o processor = ‘cortex-m4’
> 318 Memory
» @ Options

MCUXpresso IDE User Guide -

You will then be presented with the MCU Setting dialogue (as below)
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SDK MCUs Preinstalled MCUs

MCUs from installed SDKs MCUs from preinstalled LPC and generic

NXP MKG4FN1MOwcx1 2 Cortex-M part support

P K32WO0x2S Target
YKBx »LPC1102
MKB4FN1TMOxxx12 FLPC112x
PKE1X FLPC11AXX
P KW3x »LPC11EBx
FLPC5411x BLPC11Exx
b LPC546xx FLPC11UBx
» MIMXRT1020 FLPC11Uxx
» MIMXRT1050 FLPC11xx
» MIMXRT1064 PLPC1 1xxLV
[N NaTak Relalal
Target architecture: cortex-md

Preserve memory conﬁguration]

Figure 13.2. Select MCU

From here, an alternative MCU can be selected but note, there are two check boxes that must
be set as required before this is done:

* Preserve Memory Configuration — it set (the default) the original project memory settings will
be preserved, otherwise the MCU setting for the chosen MCU will replace the original settings

« Preserve Project Configuration — if not set (the default) the new MCUs configurations (such as
Cortex Architecture) will replace the original settings

When the new MCU is selected, a warning dialogue as below will be generated:

%] MCUXpresso IDE =32

' C ) Changing selected MCU to a different one will modify project settings and may
prevent successfull project building and debugging.
Are you sure?

Figure 13.3. Select MCU Warning

Project changes will only be made if Yes is selected.

13.2 Changing the MCU (SDK) package type

MCUs are commonly available in a range of package types. Different packages may impact the
options available on the MCU external pins, for example the number of GPIO lines. MCUXpresso
IDE makes no use of this package type however it is signigicant to the included “MCUXpresso
Config Tools"#configtools .

As shown in the previous section, from the project virtual nodes, select Edit MCU.
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v ©& Project Settings
» =) Associated SDK
» = Libraries (and semihosting)

LY EEe—" ]
+#: Change Package MKB4FNT1MOVDC12
o processor = 'cortex-m4' v MK64FNTMOVLL12
» 181 Memory MKB4FN1MOVLQ12
» [ Options MKB4FN1MOVMD12
» +& Binaries MKB64FN1MOCAJ12

Figure 13.4. Edit Package

then select Change Package and choose the package required.

13.3 Changes available via QuickStart Quick Settings

MCUXpresso IDE provides quick access to a range of project settings via the QuickStart Panel
as shown below:

* Miscellaneous
& Edit project settings
. MCUXpresso Config Tools>>

& Quick Sett 1  Defined symbols [frdmk64f_bubble Debug]

{& Export prg & Undefined symbols [frdmk64f_bubble Debug]
‘[? ek 3 g Include paths [frdmk64f_bubble Debug]

i Budichen pr4 i Library search paths [frdmk&4f_bubble Debug]
5 & Libraries [frdmk64f_bubble Debug]

6

7

8

(&2 SDK Debug Console >
(2 Set Floating Point type >
(2 Set library/header type >

Figure 13.5. Quick Settings

Note: These settings apply to the selected project’s selected build configuration only and simplify
access to commonly used settings nhormally accessed from Properties -> C/C++ Build -> Settings
Also note Quick Settings changes may be made to multiple projects if more than one project is
selected (where their settings are compatible).

Tip
@ New in MCUXpresso IDE version 11.0.0, the current setting for Debug Console,
Floating Point and Library type is shown

. Defined symbols — select to edit the (-D) symbols

. Undefined symbols — select to edit the (-U) symbols

. Include paths — select to edit the (-I) the include paths

. Library search paths — select to edit the (-L) the library

. Libraries — select to edit the (-I) the linker libraries search

. SDK Debug Console — select the SDK Debug Console’s PRINTF output to be via UART or
to redirect via the C libraries printf function

OOk, WDN PR
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« selecting printf will increase the size of the project binary compared to UART output

« for semihosted printf output to be generated, the project must be linked against a suitable
library

« for more information see the section on

7. Set Floating Point type — select to switch between the available Floating Point options
« for more information see the section on

8. Set Library/Header type — select to switch the current C/C++ Library
« for more information see the section on
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14. MCUXpresso Config Tools

This chapter provides an introduction to the features of the MCUXpresso Config Tools installed
by default with MCUXpresso IDE. The Config Tools present new perspectives in addition to the

IDE’s Develop and Debug perspectives.

8 workspace - Welcome page - MCUXpresso IDE
Ele Edit Navigate Search Project ConfigTools Pins Run Window Help

- | G | tramkB2f_cmsis_i2c_edma_b2b_tri v | # | A B Update Code ~ ‘Functional Group | BOARD.InitPins

»e ®~-Q Q- = v
£ Pins 22 & Peripheral Signals = 5 B Package QeQao
SIB8I0 wiw| elele| ¥ o |ype fiter text
Pin  Pinname Label Identifier GPIO  FTM Pl LPUART 4
1 PTEO SPIPCST  LPUARTITX
2 PTET SPISCKL.]  LPUARTIRX
3 PTE2 SPI1_SOUTL.] LPUART1 CT.
4 T PTES SPI1_PCS2(.]  LPUARTI RT. o
s Vsss L = s cun o
6 |VDDIOES U fieo o rur
7 ] PTE4 SPI1_SIN LPUART3_TX V0S| fs e s
8  PTES/SPI PTES FIM3.CHO  SPIIPCSO  LPUART3RX s oo o =
9 PTES FTM3.CH1  SPIPCS3  LPUART3.CT. e s o sy
10 PTE7  FIM3.CH2  SPR.SCK  LPUART3RT. . o s s
n R PTES  FIM3CH3  SPI2.SOUT — — — —
12 PTE)  FTM3.CH4  SPI2PCST - o - -
13 10/ PTE10 FTM3_CHS SPI2_SIN — — — —
14 PTEN PTETT FTM3.CH6  SPI2.PCSO
15 |VDDIO €17
V16 vss23
17 |USBODP. MKB2FN256VLL15 - LQFP 100 package
18 |USBO.OM
/19 \vourss
20 |VREGIN i
< >
£ Routed Pins
type filter text
Routed Pins for BOARDInitP... | 2 |© @ = v
Peripheral Signal  Routeto  label Identfier Direction  GPIOinitialstate GPIOinterrupt Slewrate Open drain Drive strength Pull select Pull enable Passive filter
Bl pusrs Rx LPUART4_RX na Input n/a na Fast Disabled  Low Pulldown  Disabled  Disabled
87 LPUARTA TX LPUART4 TX na Not Specified n/a na Fast Disabled  Low Pulldown  Disabled  Disabled

<

frdmk82f_cmsis_i2c_edma_b2b_transfer_master

- o X

Quick Access| | &8 | % @l ¢ OB
=5
v Configuration - General Info
~  Configuration - HW Info
Processor: MKB2FN25610015
Part number: MK82FN256VLL15
Core: Cortex-M4F
SDK Version: ksdk2_0
v Project

~ Pins
ool for pin routing configuration, including pin
inctional roperties, power rails, and

fumctional/electial prope:

run-time configurations.
@ a

“  Generated code
[ Update code enabled

~ Functional groups
® BO/ ns &

=5~ Othertools

(an\ (D) .

 Problems i BlY =0
Digital filt

na
nfa

ype filter text
Level Issue

+ Warning Peripheral LPUART4 is not i

Warning Peripheral 120 is not iniial.

+ Warning Peripheral ADCO is not iiti

Origin
Pins:BOARD_InitPin
Pins12C0_InitPins

Pins12C0_DeinitPins

Y _workspace

Figure 14.1. Config Tools Showing Pins Perspective

Please refer to the MCUXpresso IDE Config Tools User Manual for detailed information.

14.1 Using the Config Tools

MCUXpresso IDE includes the following Config Tools:

¢ Pins Tool

« allows you to configure pin routing and generates ‘pin_mux.c & .h’ source files

Clocks Tool

« allows you to configure system clocks and generates ‘clock_config.c & .h’ source files
Peripherals Tool

« allows you to configure other peripherals and generates ‘peripherals.c & .h’ source files
Device Configuration Tool

« allows you to configure the initialization of memory interfaces of your device and generate
dcd.d and dcd.h source files in C array or binary format

TEE Tool

« allows you to configure security policies of memory areas, bus masters, and peripherals, in
order to isolate and safeguard sensitive areas of your application and generate tzm_config.c
& .h source files.

MCUXpresso Config Tools can be used to review or modify the configuration of SDK example
projects or new projects based on SDK 2.x. To open the tool, simply right click on the project in
Project Explorer and select the appropriate Open command:

MCUXpresso IDE User Guide -
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Figure 14.2. Config Tools Launch

v Validate

MCUXpresso Config Tools

B Open Pins

' %" Run C/C++ Code Analysis 11 Open Clocks

| Team > ¥ Open Peripherals

j  Compare With l [ Open Device Configuration
Configure >
Source [ 3 # Open Tools Overview

14.1.1

14.1.2

14.1.3

14.1.4

14.1.5

MCUXpresso IDE User Guide -

If the project does not contains any configuration file (.mex) yet, it is automatically created by
importing the existing source files (from YAML comments from pin_mux.c, clock_config.c and/or
peripherals.c). If there are no source files in the project, a default configuration is created. The
configuration is stored in the root of project folder with “.mex” file extension.

Tool Perspectives

Each tool is displayed in separate perspective. Once the configuration is opened, you can switch
between perspectives to review/modify configuration of each tool — using the toolbar on the upper
right part of the IDE window:

Quick Access|:| B | X %= @& 10| ¢ O B

If your workspace contains multiple projects, please be aware that the MCUXpresso Config Tools
only support one configuration to be opened at a time and that configuration must be opened
explicitly for each project using the Open command from the popup menu. Switching perspectives
does not switch the selected configuration.

Pins Tool ®

The Pins Tool allows you to display and configure the pins of the MCU. Basic configuration can
be done in either of these views Pins, Peripheral Signals or Package. More advanced settings
(pin electrical features) can be adjusted in Routed Pins view.

Clocks Tool @)

The Clocks Tool allows you to display and modify clock sources and outputs settings in Table
view. More advanced settings can be adjusted via Diagram view and Details view. Global settings
of the clocking environment such as run modes, MCG modes and SCG modes can be modified
via main application toolbar.

Peripherals Tool ®

You can use the Peripherals tool to configure initialization of selected peripherals and generate
code for them. In the Peripherals view, select the peripheral to configure and confirm addition
of the configuration component. Then you can select the mode of the peripheral and configure
the settings within the settings editor.

Device Configuration Tool
Device Configuration tool allows you to configure the initialization of memory interfaces of your

device. Use the Device Configuration Data (DCD) view to create different types of commands
and specify their sequence, define their address, values, sizes, and polls.
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14.1.6

14.1.7

14.1.8

MCUXpresso IDE User Guide -

TEE Tool ©

In the Trusted Execution Environment, or TEE tool, you can configure security policies of memory
areas, bus masters, and peripherals, in order to isolate and safeguard sensitive areas of your
application. You can set security policies of different parts of your application in the Security
access configuration and its sub-views, and review these policies in the Memory map and Access
overview views. Use the User Memory Regions view to create a convenient overview of memory
regions and their security levels.

Generate Code

To update sources in the project, simply hit “Update Code” button on the toolbar. The command
opens dialog with list of files that will be re-generated and allows to select which tools will generate
the code.

Alternatively, it is also possible to export select source file by hitting export button in the Sources
view.

SDK Components
Generated code uses the API of the SDK components to configure peripherals. SDK components

missing in the IDE project are reported in problems view. It is possible to add component into
IDE project by right click on the reported problem and selecting the proposed quick fix.
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15. The GUI Flash Tool

Introduced in MCUXpresso IDE version 10.2.0, the rearchitected GUI Flash tool provides flash
programming capabilities for all supported debug solutions.

As well as implementing seamless programming of Flash when starting a debug session,
MCUXpresso IDE enables the Flash programming capabilities of the supported debug solutions
to be accessed directly, both via the GUI and from the command line (which might be useful for
performing small production runs).

These flash programming capabilities can be accessed from three distinct places with the IDE.

Firstly, the most feature capable (advanced) variant is launched via the IDE button (and will be
described in this section) :

B L A% 0O Qri

GUI Flash Tool

Clicking this will launch a dialogue similar to:

Figure 15.1. GUI Flash Tool

[ oK ) GUI Flash Tool

GUI Flash Tool for:
MCUXpresso IDE LinkServer (inc. CMSIS-DAP) probes
Program file into flash: MK6E4FN1MOxxx12_Project.axf

Target: MK64FN1MOxxx12

Probe Options
Probe specific options

Connect script kinetisconnect.scp B | workspace... File System...
Reset Handling Default E
Flash Reset Handiing  Default B

Use JTAG Interface || Reset the target on connection

Target Operations
Select the target flash operation to perform

lmmse Resurrect locked Kinetis device l

Actions
Select the action to perform

© Program Program (mass erase first)
Verify only Check file areas blank
Options

Select the options to apply

File to program I J AKBAFN 1MOxxx12_Project/D 1MOxxx12_Project.axf l Workspace... File System...

Format to use for programming @ axf  bin
Base address

Reset target on completion

General Options
Flash programming tool options

Additional options

Repeat on completion [ | Preview command [ Clear console

MCUXpresso IDE User Guide -

Note: This dialogue will vary subtly for each debug solution.

Secondly, project launch configurations now contain a GUI Flash Tool Tab providing project
specific flash operations. Please see for more information.

Finally, the QuickStart panel Debug Shortcuts provide easy access for simple project flash
programming. Please see for more information.
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15.1 The Advanced GUI Flash Tool

The operations below are supported for each debug solution.

1. Programming an .axf or .bin file into flash
2. Flash Mass Erase
3. Various debug solution specific features

When launched, each debug solution will present a dialogue similar to the LinkServer variant —
described below:

[ BN ) GUI Flash Tool

GUI Flash Tool for:
MCUXpresso IDE LinkServer (inc. CMSIS-DAP) probes
Program file into flash: MK64FN1MOxxx12_Project.axf

Target: MK64FN1MOxxx12

Probe Options
Probe specific options

Connect script kinetisconnect.scp @ ﬂ Workspace... File System...
Resel Handling Default O E
Flash Reset Handling Default O B

Use JTAG Interface Reset the target on connection

Target Operations
elect the target llash operation to perform ( )

IWTBSE | Resurrect locked Kinetis device

Actions
Select the action to perform

© Program Program (mass erase first)
Verify only Check file areas blank
Options
Select the options to apply
File to program I S(workspace,\oc);MK64sN1M0m12,praiecuoenungKeaFmrmxmz,Projecl.axlﬁ Workspace... File System...

Format to use for programming| .

Base address

Reset target on completion

General Options
3Sh programming 100! options
Additional options .
Repeat on completion Clear console

cancel (TN

Figure 15.2. GUI Flash Tool major features

Note: Probe options (highlighted above) will be different for each debug solution, where as Target
and General Options (also highlighted) will be broadly similar.

Tip

@ A project must first be selected before the Advanced GUI Flash Tool can be
launched. The device and other project configurations (such as flash driver) will be
inherited from this selected project. The advanced GUI Flash tool will not create or
use information within project associated launch configurations.

1. Connect Script: The device default connect script will be automatically selected. A different
connect script can be selected if required using the Workspace or File System shortcut
buttons.

2. Reset Handling: The device default reset handling can be overridden from the selection:
Default, SYSRESETREQ, VECTRESET, SOFT
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3. Flash Reset Handling: The flash drivers default reset handling can be overridden from the
selection: Default, SYSRESETREQ, VECTRESET, SOFT

4. Program/Erase/Resurrect locked Kinetis Device

* Program view (displayed) should be selected to program an application of binary into flash.
Only the Program options will be described below.

« Erase view should be selected for options to erase a flash device to its blank state
« offers options to Mass erase, Erase by sector, Check blank (to verify a blank flash).

< generally flashes do not need to be erased, since program operations automatically erase
sections of the flash as required. However on occasion it can be useful to erase a flash
most often because the image in flash is causing problems.

» Erase by sector is not recommended for Kinetis parts since this will leave the device fully
erased and therefore in a locked state — should this occur, use the option below ...

* Resurrect locked Kinetis device view should be selected to recover a locked device.
5. Programming actions:

* Program: the default action will program the selected application or binary erasing only the
required sections of the flash device.

« Program (mass erase first): will erase the whole device before program the selected
application or binary. This will ensure that any previous flash contents are erased.

« Verify only: this option will compare the contents of flash with the selected application or
binary. Note: most flash programming operations are verified at the programming stage.
Flash contents are not changed.

¢ Check file area blank: this can be used to verify that a program operation will not overwrite
any data already programmed into flash. Flash contents are not changed.

6. File selection: if the selected project contains a built .axf file, then this will automatically be
selected. Alternatively a different file can be selected using the Workspace and File System
shortcut buttons.

7. Format: these radio buttons will be preset by the File to Program type. However, if an .axf file
is selected, clicking bin will automatically generate a .bin from the selected .axf.

« for file types containing no base address information, such as .bin, a base address must
be specified.

8. Preview command: select this option to be presented with a preview programming command
to be issued and a script that can perform this action independently of the IDE (see below)

« the previewed command can be edited if required, changes will be reflected within the script

« various shell script flavours can be selected, and finally the script can be copied to the
clipboard with a single click

Finally, click Run to execute the flash programming operation, a dialogue displaying the success
of the operation will be displayed once the program operation has completed.

15.1.1 Advanced GUI Flash Tool command Preview
As discussed in point 8 above, the GUI Flash Tool can optionally display the command to be
issued — allowing the opportunity of editing the command before execution.
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® e Program file into flash: MKE64FN1MOxxx12_Project.axf

1 Command to be executed...

crt_emu_cm_redlink --flash-load-exec "/Users/nxp/Documents/MCUXpressolDE_10.2.0/workspace/
MKGB4AFN1MOxxx12_Project/Debug/MKEAFN1MOxxx12_Project.axf" -g --debug 2 --vendor NXP -p
MKB4FN1MOxxx12 --ConnectScript kinetisconnect.scp -ProbeHandle=1 -Corelndex=0 -x /Users/nxp/
mcuxpresso/01/.mcuxpressoide_packages_support/MKE64FN 1MOxxx12_support --flash-dir /Users/nxp/
mecuxpresso/01/.mcuxpressoide_packages_support/MK64FN1MOxxx12_support/Flash

Command to use In a script

MCUX_WORKSPACE_LOC=/Users/nxp/Documents/MCUXpressolDE_10.2.0/workspace
MCUX_FLASH_DIR=/Users/nxp/mcuxpresso/01/.mcuxpressoide_packages_support/MKB4FN1MOxxx12_supp
ort/Flash
MCUX_IDE_DIR=/Applications/MCUXpressolDE_10.2.0_740/ide
MCUX_IDE_BIN=$MCUX_IDE_DIR/bin =
SMCUX_IDE_BIN/crt_emu_cm_redlink --flash-load-exec El~
"/Users/nxp/Documents/MCUXpressolDE_10.2.0/workspace/MKB4FN1MOxxx12_Project/Debug ™ === * ===
xxx12_Project.axf" -p MK64FN1M0Oxxx 12 --ConnectScript kinetisconnect.scp -x C Shell
/Users/nxp/mcuxpresso/01/.mcuxpressoide_packages_support/MK84FN1MOxxx12_support --fl ¥ Bourne Shell
/Users/nxp/mcuxpresso/01/.mcuxpressoide_packages_support/MKB4FN1MOxxx12_support/Fla ~ Powershell
Command Shell

Canicel e

Figure 15.3. GUI Flash Tool Command Preview

In addition to displaying the command to be issued, the dialogue also contains a script that can
be issued independently of the IDE to perform the flash programming operation. Changes the
command to be executed will also be reflected within the script.

Notes

¢ The script will setup the local environment to be independent of your local shells configuration.
However components of MCUXpresso IDE are of course referenced so the script can only be
used if MCUXpresso IDE is installed and any referenced workspace files are present.

« Debug probes may install drivers when first seen by a host, this driver installation may take
some time to complete.

*« MCUXpresso IDE is able to maintain connection to multiple debug probes, while the IDE can
dynamically maintain knowledge of connected probes, any generated command line will be
a snhapshot of a given instance. Therefore it is essential that only a single debug probe is
connected if the command script is to be captured for re-use.

e Typically, LPC-Link2 or LPCXpresso V2 and V3 boards have debug probe firmware soft loaded
automatically by the IDE when a debug operation is first performed. Therefore to use these
debug probes from the command line they must either have their firmware softloaded or
have probe firmware programmed into the Flash. Probe firmware can be soft-loaded from the
command line by use of scripts boot_link1 for LPC-Link and boot_link2 for LPC-Link2, these
are located at mcuxpresso_install_dir/ide/bin. To program debug probe firmware into the Flash
memory of an LPC-Link2 debug probe, please see: http://www.nxp.com/LPCSCRYPT

15.1.2 Advanced GUI Flash Tool logged Output

When a GUI Flash Tool operation is performed, the low level output will be logged into the debug
log. A snippet of a LinkServer successful program operation is shown below:
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Loadi ng ' MK64FN1MDxxx12_Proj ect . axf' ELF 0x00000000 | en 0x3CF8
Openi ng flash driver FTFE 4K cfx (already resident)

Sendi ng VECTRESET to run flash driver

Witing 15608 bytes to address 0x00000000 in Fl ash

1of 1 ( 0) Witing pages 0-3 at 0x00000000 with 15608 bytes
( 0) at 00000000: O bytes - 0/15608

( 26) at 00000000: 4096 bytes - 4096/ 15608

( 52) at 00001000: 4096 bytes - 8192/ 15608

( 78) at 00002000: 4096 bytes - 12288/ 15608

(100) at 00003000: 4096 bytes - 16384/ 15608

Erased/ Wote page 0-3 with 15608 bytes in 693nsec

Cl osing flash driver FTFE 4K cfx

(100) Finished witing Flash successfully.

Fl ash Wite Done

Loaded O0x3CF8 bytes in 1081ns (about 14kB/s)

Reset target (system

Starting execution using systemreset

Advanced GUI Flash Tool Programming an arbitrary Binary

The GUI Flash tool will usually be used to program a binary generated from a Project’s .axf file.
However on occasion, it might be required to program a binary (or .axf) file generated elsewhere.
This can be achieved by generating a project with the required memory/chip combination and
simply dropping the .bin file into this project. When the GUI Flash tool is invoked, the user can
browse for the required binary file and program this in the usual way.
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16. LinkServer Flash Support

16.1
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Note: Quad SPI (QSPI) and SPIFI are used interchangeably within this section. The term SPIFI
(SPI Flash Interface) is commonly used to reference LPC use of QSPI.

Please refer to the section on for details of the LinkServer debug solution.

MCUXpresso IDE’s LinkServer based debug connections makes use of a RAM loadable Flash
driver mechanism. Such a Flash driver contains the knowledge required to program the internal
Flash on a particular MCU (or potentially, family of MCUs). This knowledge may be either
hardwired into the driver, or some of it may be determined by the driver as it starts up (typically
known as a ‘generic’ Flash driver).

At the time a debug connection is started by MCUXpresso IDE, the LinkServer debug session
running on the host will typically download a Flash driver into RAM on the target MCU. It will
then communicate with the downloaded Flash driver via the debug probe in order to program the
required code and data into the Flash memory.

In addition, the loadable Flash driver mechanism also provides the ability to support Flash drivers
which can be used to program external Flash memory (for instance via the SPIFI Flash memory
interface on LPC18x, LPC40xx, LPC43xx and LPC5460x families). The sources for some of
these drivers is provided in the Examples/Flashdrivers subdirectory within the MCUXpresso IDE
installation directory.

LinkServer Flash drivers have a .cfx file extension. For Preinstalled MCUs, the Flash driver
used for each part/family will be located in the /bin/Flash subdirectory of the MCUXpresso IDE
installation. For SDK installed MCUs, the Flash driver will generally be supplied within the SDK,
although copies may also provided in the /bin/Flash subdirectory.

Important Note: LinkServer flash drivers are fully integrated into the MCUXpresso IDE Managed
Linkerscript build mechanism and specified within SDK metadata. Other debug solutions invoke
MCU specific flash programming strategies based on their debug implementation’s knowledge
of the MCU being debugged.

Default vs Per-Region Flash Drivers

By default, for legacy reasons, Preinstalled MCUs are configured to use what is called a ‘Default’
Flash driver. This means that this Flash driver will be used for all Flash memory blocks that are
defined for that MCU (i.e. as displayed in the Memory Configuration Editor).

For most users, there is never any need to change the automatically selected Flash driver for
the MCU being programmed.

However, MCUXpresso IDE also supports the creation and programming of projects that span
multiple Flash devices. In order to allow this to work, Flash drivers can also be specified per
memory region.

For example, this allows a project based on an LPC43xx device with internal Flash to also make
use of an external SPIFI Flash device. This is achieved by removing the default Flash driver from
the memory configuration and instead explicitly specifying the Flash driver to use for each Flash
memory block (per-region Flash drivers). A typical use case could be to create an application
to run from the MCU'’s internal Flash that makes use of static constant data (e.g. for graphics)
stored in external SPIFI device. An example memory configuration is shown below:
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Figure 16.1. Per Region Drivers

‘@ MCUXpresso IDE

Memory configuration editor
Edit configuration for LPC4337 m
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Default flash driver Browse...

Type Name Alias Location Size Driver -
Flash MFlashA512 Flash O0x1a000000 Ox80000] LPC18x7_43x7_2x512_BootA.c v
Flash MFlashB512 Flash2 Ox1b000000 O0x80000] LPC18x7_43x7_2x512_BootA.c
Flash Flash_SPIFI Flash3 Ox14000000 O0x10000@ LPC18_43_SPIFI_GENERIC.cfx
RAM RamLoc3Z RAM  Ox10000000 OxBO0O
RAM RamLoc40 RAM2 Ox10080000 0xa000
RAM RamAHB32 RAM3 0x20000000 0x8000
RAM RamAHB16 RAM4 Ox20008000 0x4000

!'_E |

Add Flash Add RAM Split Delete

Import... Merge... Export... Generate...
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16.2

16.2.1
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Note: SDK installed MCUs always use Per-Region Flash drivers.

Advanced Flash Drivers

Most wizard generated projects or projects imported from SDKs (or LPCOpen) will be pre-
configured with an appropriate LinkServer flash driver for the target flash device. As a result,
in many cases users need to pay little attention to the actual flash driver being used. However,
for MCUs supporting complex flash strategies or external flash devices, the situation is more
complex. This section discusses these situations but note, even in these cases, the flash driver
may be automatically selected and so require no user attention.

LPC18xx / LPC43xx Internal Flash Drivers

A number of LPC18/43 parts provide dual banks of internal Flash, with bank A starting at address
0x1A000000, and bank B starting at address 0x1B000000.

* LPC18x3/LPC43x3 : Flash = 2x 256KB (512 KB total)
* LPC18x5/ LPC43x5 : Flash = 2x 384KB (768 KB total)
* LPC18x7/ LPC43x7 : Flash = 2x 512KB ( 1 MB total)

When you create a new project using the New Project Wizard for one of these
parts, an appropriate default Flash driver (from LPC18x3 43x3 2x256 BootA.cfx /
LPC18x5_43x5 2x384 BootA.cfx /LPC18x7_43x7_2x512 BootA.cfx) will be selected which
after programming the part will also configure it to boot from Bank A Flash.

If you wish to boot from Bank B Flash instead, then you will need to manually configure the
project to use the corresponding “BootB” Flash driver ( LPC18x3_43x3_2x256_BootB.cfx /
LPC18x5_43x5_2x384_BootB.cfx / LPC18x7_43x7_2x512_BootB.cfx). This can be done by
selecting the appropriate driver file in the “Flash driver” field of the Memory Configuration Editor.
Note: you will also need to delete Flash Bank A from the list of available memories (or at least
reorder so that Flash Bank B is first).
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16.2.2

LPC SPIFI QSPI Flash Drivers

A number of parts provide support for external SPIFI Flash, sometimes in addition to internal
Flash. Programming these Flash memories provides a number of challenges because the size
of memory (if present) is unknown, and the actual memory device is also unknown. These issues
are handled using Generic Drivers which can interrogate the memory device to find its size and
programming requirements.

At the time of writing, these LPC devices comprise:

Table 16.1. SPIFI details

LPC Part SPIFI Address Bootable Flash Driver
LPC18xx/LPC43xx  0x14000000 Yes LPC18 43 SPIFI_GENERIC.cfx
LPC40xx 0x28000000 No LPC40xx_SPIFI_GENERIC.cfx
LPC5460x 0x10000000 No LPC5460x_SPIFI_GENERIC.cfx
LPC540xx 0x10000000 Yes LPC540xx_SPIFI_GENERIC.cfx
During a programming operation, the Flash driver will interrogate the SPIFI Flash device to
identify its configuration. If the device is recognised, its size and name will be reported in the
MCUXpresso IDE Debug log - as below:
I nspected v.2 External Flash Device on SPI using SPIFI lib LPC18_43_SPI Fl _GENERI C. cf x
I mage ' LPC18/43 Generic SPIFI Mar 7 2017 13:14:25'
Opening flash driver LPC18_43_SPI FI _GENERI C. cf x
flash variant ' MX25L8035E detected (1MB = 16*64K at 0x14000000)
Note: Although the Flash driver reports the size and location of the SPIFI device, the IDE’s view
of the world is determined by the project memory configuration settings. It remains the users
responsibility to ensure these setting match the actual device in use.
Flash devices supported by our LPC SPIFI Flash Drivers
Below is a list of SPIFI Flash devices supported by our supplied Generic SPIFI Flash drivers.
Note: additional devices which identify as one of the devices below are also expected to work.
However if a device is not supported by our supplied Flash Drivers, sources to generate these
drivers are supplied in the Examples/Flashdrivers subdirectory within the MCUXpresso IDE
installation directory. Users may thus add support for new SPIFI devices if needed.
GD25@2C
MIr25Q.128AB
MI25Q612A
MIr25Q@56A
N25Q256
N25Q128
N25Q64
N25@B2
PMR25LQD32C
MX25L1606E
MX25L1635E
MX25L3235E
MX25R6435F
MX25L6435E
MX25L12835E
MX25V8035F
MX25L8035E
S25FL016K
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S25FL032P
S25FL064P
S25FL129P 64kSec
S25FL129P 256kSec
S25FL164K
S25FL256S 64kSec
S25FL256S 256k Sec
S25FL512S
V25Q40CV
V25Q@82FV
VR5Q64FV
V25Q128FV
VW5Q@56FV_Unt est ed
V25Q80BV

I.MX RT QSPI and Hyper Flash Drivers

I.MX.RT MCUs support external flash via a QSPI/Hyperbus interface, a range of LinkServer flash
drivers supporting devices fitted to EVK development boards are included with MCUXpresso IDE
(as described below).

Note: these drivers are also supplied in source project form so they may be used as a base
for development of drivers for other external flash parts. These driver projects can be found at
Examples/Flashdrivers/NXP/IMXRT

Table 16.2. Flash details

iMX RT Part

i.MX RT 1050
i.MX RT 1050
i.MX RT 1050
i.MX RT 1020

Flash Driver
MIMXRT1050-EVK_S26KS512S.cfx
MIMXRT1050-EVK_1S25WP064A.cfx
MIMXRT1050-EcoXiP_ATXP032.cfx
MIMXRT1020-EVK _1S25LP064.cfx

Bootable
Yes
Yes
Yes
Yes

Base Address
0x6000000
0x6000000
0x6000000
0x6000000

16.2.4
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When used with the approriate SDK for your development board, the correct driver will
be automatically selected

Important Note: For an application to Boot and execute in place (XIP) from these flash devices
(post reset), a correct header for the specific device MUST be programmed into the flash (as
part of the Project). SDK examples will build to include an appropriate header automatically
however, MCUXpresso IDE will not prevent users programming projects without headers into
these devices. If this occurs the application will not boot and susequent flash programming
operations may fail.

Should this occur, the recommended recovery procedure is to change the boards boot strategy
(via DIP switches) to prevent booting from QSPI or hyperflash. Power cycle the board and then

perform a Mass Erase of the flash. Next, reprogram with an image that has appropriate header,
restore the boot strategy and power cycle again.

©

Flash Drivers using SFDP protocol (LPC and iMX RT)

Tip
In addition, these drivers are complemented by a range of self configuring drivers
supporting all current iMX RT EVK boards , please see

for more information on the drivers and this methodology.

As discussed above, the programming these Flash memories provides a number of challenges
because the size of memory (if present) is unknown, and the actual memory device is also
unknown
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LinkServer Generic flash drivers attempted to solve this problem by recognising specific devices
(via their JEDEC ID) and then setting their sizes and programming parameters accordingly.
However, this mechanism only works if the device is recognised by the flash driver, and in
consequence will fail if any device is not recognised.

This issue, combined with the sheer volume of devices available has forced a different approach
to be taken. Fortunately, modern flash devices typically contain a data block describing their
properties including device size, low level structure and programming details etc. These data
blocks and their use are collectively known as Serial Flash Discovery Protocol or SFDP. The
standard for these blocks are described by JEDEC JESD216 standard(s).

Introduced in MCUXpresso IDE version 10.2.0 are a range of Generic flash drivers built to self
configure via SFDP data and these have been extended for later MCUXpresso IDE versions.
The current list of supported SFDP drivers is shown below:

Table 16.3. SFDP Flash details

Part Base Address Bootable Flash Driver
LPC18xx/LPC43xx  0x1400000 Yes LPC18 43 SPIFI_SFDP.cfx
LPC546xx 0x1000000 No LPC546xx_SPIFI_SFDP.cfx
LPC540xx 0x1000000 Yes LPC540xx_SPIFI_SFDP.cfx
i.MX RT 1064 0x7000000 Yes MIMXRT1064.cfx
i.MX RT 1060 0x6000000 Yes MIMXRT1060_SFDP_HYPERFLASH.cfx
i.MX RT 1060 0x6000000 Yes MIMXRT1060_SFDP_QSPI.cfx
i.MX RT 1050 0x6000000 Yes MIMXRT1050_SFDP_HYPERFLASH.cfx
i.MX RT 1050 0x6000000 Yes MIMXRT1050_SFDP_QSPI.cfx
i.MX RT 1020 0x6000000 Yes MIMXRT1020_SFDP_QSPI.cfx
Important Note: for some iIMX RT parts, the current SDKs reference the device specific flash
driver rather than the SFDP version. However you can modify your project to use the SFDP
version if required. Flashdrivers cannot detect whether QSPI or Hyperflash is fitted on a board,
therefore it is the responsibility of the user to ensure the correct driver is used.
Note: The iIMX RT 1064 MCU incorporates a flash device within the MCU package itself however,
the flash driver still uses the SFDP mechanism to detect the device and hence is listed in the
table above.
QSPI SFDP issues and Limitations
Some (usually older) QSPI parts do not support the SFDP mechanism and therefore will not be
programmable via this protocol. However since some of these QSPI devices are fitted to NXP
(LPC) manufactured development boards, some basic assumptions are made by these drivers
if SFDP data is not found. In such a case, the device and its size will be assumed to be 1MB and
some standard programming mechanisms will be used. This scheme should ensure that NXP
LPC development boards with QSPI can be used with this driver type.
Note: this information is correct at the time of writing and only applies to LPC Drivers — future
development of these drivers may change their capabilities.
Flash programming log
When programming code or data into flash, a portion of the debug log will display the flash
programming operations (as below):
I nspected v.2 External Flash Device on SPlI using SFDP JEDEC | D LPC18_43_SPI FI _SFDP. cfx —(1)
I mage ' LPC1843_JEDEC_SFDP May 1 2018 15:32: 05'
Opening flash driver LPC18_43_SPI Fl _SFDP. Cf X = === mmmm i (2)
Sendi ng VECTRESET to run flash driver
flash variant ' JEDEC SFDP_EF4014' detected (1MB = 16*64K at 0x14000000) ---------------- (3)
Closing flash driver LPC18_43_SPIFI _SFDP. cf x
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NXP: LPCA43S37

Connected: was_reset=true. was_stopped=fal se
Awai ting telnet connection to port 3330 ...
GDB nonst op node enabl ed

Opening flash driver LPC18_43_SPI FI _SFDP.cfx (already resident) ------------------------ (4)
Sendi ng VECTRESET to run flash driver

Witing 1046900 bytes to address 0x14000000 in Flash ------------commmmm oo (5)
Erased/ Wote page 0-15 with 1046900 bytes in 7548nMBeC --------------------------------- (6)

Cl osing flash driver LPC18_43_SPI Fl _SFDP. cf x

Fl ash Wite Done

Fl ash Program Sunmary: 1046900 bytes in 7.55 seconds (135.45 KB/seC) ------------------- (7)
St opped: Breakpoint #1

Note: when accessing unknown flash devices, the driver will be called twice. First to identify the
device and secondly to perform the required programming. In a situation where multiple devices
are being programmed, the flash driver(s) may be (re)loaded for each use.

Where:

1. SFDP JEDEC ID is the method used to access the flash and LPC18_43_SPIFI_SFDP.cfx is
the flash driver used

2. the driver named above is loaded and initialised (this step will setup clocks, pin muxing, and
perform some investigation of the connected device)
3. the driver returns a string JEDEC_SFDP indicating that SFDP data was found and successfully
read
« the devices JEDEC ID was read as EF4014, in this case corresponding to a Winbond
25Q80DVSIG (as fitted to the LPC-Link2 board used in Target mode)

 the devices size was read as 1MB divided up into 16 64KB Sectors/Blocks — these blocks
are the erase size that will be used for programming and so any operation to program this
flash must start on an address aligned to this 64KB size

4. the driver is opened a second time (without reloading since it remains from the previous call)

5. the project that referenced this driver requested that 1046900 bytes of data were written to
the address starting 0x14000000, as set within the projects memory configuration

6. the write operation is performed via 16 page writes

« Note: this flash driver (like many LinkServer drivers) uses a virtual page size that is much
larger than the actual flash device page size to optimise driver operation

7. finally, a summary of the operation is printed showing the flash programming performance

Note: If the driver fails to find SFDP data, it will attempt to program the device with standard
routines. If this occurs, the size will be assumed to be 1MB and the flash variant will be reported
as ID rather than SFDP as shown below:

flash variant ' JEDEC | D EF4014' detected (1MB = 16*64K at 0x14000000)

On occasion, some devices that report the same JEDEC ID will actually be different, in this
particular case the device is a very similar Winbond 25Q80BVSIG i.e. ..BV rather than ..DV

QSPI Programming and Booting

When dealing with external flash, it is important to understand the difference between the
flash programming operation performed by the flash driver and the subsequent use of the
flash for executing code and/or providing data. Essentially the flash drivers responsibility ends
with a successful program operation, after this point, correct operation of the MCU/SPI flash
combination lies elsewhere.

Thus, once the MCU is reset (or power cycled), the responsibility for the devices configuration and
operation lie entirely outside of MCUXpresso IDE and instead lie with one or all of the following:
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« development board/MCU boot settings
» these may be DIP switches or Jumpers providing inputs to the MCU boot flow, alternatively
these could be OTP bits programmed within the MCU
« MCU’s BootROMs ability to understand and setup the device
* BootROMSs on devices such as the LPC1800 and LPC4300 have inbuilt understanding of
certain QSPI devices allowing them to be configured for boot. However, this boot process
may fail with some QSPI flash despite the fact that it has been correctly programmed

* BootROMSs on devices such as the LPC540xx and RT10xx rely on correct header (XIP)
information being programmed (as part of the Application) into the QSPI flash itself. If this
data is incorrect (or not present), the boot/reset will fail.

¢ Devices that incorporate both internal boot flash and external SPIFI/QSPI flash such as the
LPC546xx typically place the responsibilities for QSPI configuration to the users application,
where this might include

e Setup of pinmuxing
* QSPI/SPIFI clock setup
 Flash interface initialisation
* QSPI initialisation (this may be QSPI device specific)
* including setup of appropriate waitstates for QSPI operation at the selected QSPI clock

frequency
16.3 Kinetis Flash Drivers

Kinetis MCUs make use of a range of generic drivers, which are supplied as part of the SDK
part support package. When a project is created or imported, the appropriate Flash driver is
automatically selected and associated with the project.
Kinetis Flash drivers generally follow a simple naming convention i.e. FTFx_nK_xx where:
¢ FTFx is the Flash module name of the MCU, where x can take the value E, A or L
¢ nK represents the Flash sector size the Flash device supports, where n can take the value

1,2,4,8

» a sector size is the smallest amount of Flash that can be erased on that device
* XX represents an optional additional characters for special case drivers e.g. __ Tiny for use on

parts with a small quantity of RAM

« an further optional _D suffix is used to show the driver is written to target Data Flash rather

than the more common Program Flash

So for example a K64F MCU'’s Flash driver will be called FTFE_4K, because the K64F MCU
uses the FTFE Flash module type and support a 4KB Flash sector size.
When a debug session is started that programs data into Flash memory, the IDE’s debug log
file will report the Flash driver used and parameters it has read from the MCU. Below we can
see the driver identified a K64 part and the size of the internal Flash available. It also reports the
programming speed achieved when programming this device. These logs can be useful when
problems are encountered.
Note: when the Flash driver starts up, it will interrogate the MCU and report a number of data
items. However, due to the nature of internal registers with the MCU, these may not exactly
match the MCU being debugged.

Inspected v.2 On chip Kinetis Flash nmenory nodul e FTFE_4K. cf x

I mage ' Kinetis Sem Generic Feb 17 2017 17:24:02'

Openi ng flash driver FTFE_4K. cf x

Sendi ng VECTRESET to run flash driver

Fl ash variant 'K 64 FTFE Generic 4K detected (1MB = 256*4K at 0x0)

Cl osing flash driver FTFE_4K. cfx

Connect ed: was_reset=true. was_stopped=true

MCUXpresso IDE User Guide - All information provided in this document is subject to legal disclaimers © 2019 NXP Semiconductors. All rights reserved.
User Guide Rev. 11.0.0 — 23 May, 2019 141



NXP Semiconductors MCUXpresso IDE User Guide

16.4

16.5

16.6

16.6.1

MCUXpresso IDE User Guide -

Awai ting telnet connection to port 3330 ..

GDB nonst op node enabl ed

Openi ng flash driver FTFE 4K cfx (already resident)

Sendi ng VECTRESET to run flash driver

Fl ash variant 'K 64 FTFE Generic 4K detected (1MB = 256*4K at 0x0)
Witing 25856 bytes to address 0x00000000 in Fl ash

00001000 done 15% (4096 out of 25856)

00002000 done 31% (8192 out of 25856)

00003000 done 47% (12288 out of 25856)

00004000 done 63% (16384 out of 25856)

00005000 done 79% (20480 out of 25856)

00006000 done 95% (24576 out of 25856)

00007000 done 100% (28672 out of 25856)

Erased/ Wote sector 0-6 with 25856 bytes in 301lnsec

Cl osing flash driver FTFE 4K cfx

Fl ash Wite Done

Fl ash Program Sunmary: 25856 bytes in 0.30 seconds (83.89 KB/sec)

Flash drivers for a number of Kinetis MCUs are listed below:

K64F FTFE_4K (1MB)

K22F FTFA 2K (512KB)
KL43 FTFA_1K (256KB)
KL27 FTFA_1K (64KB)
K40  FTFL_2K (256KB)

Configuring projects to span multiple Flash Devices

https://community.nxp.com/thread/388979

The LinkServer GUI Flash Programmer

The LinkServer GUI Flash Programmer has been replaced by the debug solution independent

The LinkServer Command Line Flash Programmer

While the information below is still current, for most users this functionality has been replaced
by features within the

Command Line Programming

Flash programming is usually invoked automatically when a debug session is launched from
within MCUXpresso IDE, but flash programming operations can also be accessed directly using
a command line utility (also known as the LinkServer debug stub). This can be useful for things
like programming the Flash for devices with limited production runs.

The MCUXpresso IDE Flash programming utility is located at:

<install _dir>/ide/bin/

To run a Flash programming operation from the command line, the correct Flash utility stub for
your part should be called with appropriate options. For boards containing Cortex-M MCUs the
utility is called crt_emu_cm_redlink.

For example:
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crt_emu_cmredlink -p LPC11U68 --flash-1oad "LPC11U68_App. axf"

will load the AXF file LPC11U68_App.axf into Flash on an LPC11U68.

Note: typically, LPC-Link2 or LPCXpresso V2 and V3 boards have debug probe firmware soft
loaded automatically by the IDE when a debug operation is first performed. Therefore to use
these debug probes from the command line they must either have their firmware softloaded or
have probe firmware programmed into the Flash. Probe firmware can be soft-loaded from the
command line by use of scripts boot_link1 for LPC-Link and boot_link2 for LPC-Link2, these
are located at mcuxpresso_install_dir/ide/bin. To program debug probe firmware into the Flash
memory of an LPC-Link2 debug probe, please see: http://www.nxp.com/LPCSCRYPT

Programming an image into Flash

In the simplest case the Flash programming utility takes the following options if the file to be
flashed is an AXF (or ELF) file:

crt_emu_cmredlink -p target --flash-load "filename" [--flash-driver "flashdriver"]

it is also possible to flash binary files using:

crt_emu_cmredlink -p target --flash-l1oad "fil ename" --1oad-base base_address [--flash-driver /

"flashdriver"]

Where:

e crt_emu_cm_redlink is the name of the Flash utility

 target is the target chip name. For example LPC1343, LPC1114/301, LPC1768 etc. (see
‘Finding Correct Parameters...” below)

» --flash-load can actually be one of a few different options. Use:

» --flash-load to write the file to Flash,

» --flash-load-exec to write it to Flash and then cause it to start running,

« --flash-mass-load to erase the Flash and then write the file to the Flash, and

» --flash-mass-load-exec to erase the Flash, write the file to Flash and then cause it to start
running.

« filename is the file to Flash program. It may be an executable (axf) or a binary (bin) file. If using
a binary file, the base_address also must be specified. Using enclosing quotes is optional
unless the name includes unusual characters or spaces.

« base_address is the address where the binary file will be written. It can be specified as a hex
value with a leading Ox.

If you are using Flash memory that is external to the main chip you will need to specify an
appropriate Flash driver that supports the device. This usually takes the name of a .cfx file held
in a default location. In unusual circumstances it is possible to specify an absolute file system
name of a file. Using enclosing quotes is optional unless the name includes unusual characters
or spaces (see ‘Finding Correct Parameters...” below).

WARNING: When crt_emu_cm_redlink Flash drivers program data that they believe will form
the start of an execute-in-place image they determine where the image’s vector table is and
automatically inserts a checksum of the initial few vectors, as required in many LPC parts. This
may not be the value held in that location by the file from which the Flash was programmed. This
means that if the content of the Flash were to be compared against the file a difference at that
specific location may be found.

WARNING: Flash is programmed in sectors. The sizes and distributions of Flash sectors is
determined by the Flash device used. Data is programmed in separate contiguous blocks — there
may be many contiguous blocks of data specified in an EFL (.AXF) file but there is only one in
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a binary file. When a contiguous data block is programmed into Flash data preceding the block
start in its Flash sector is preserved. Data following data in the block in the final sector, however
is erased.

Programming Flash with SDK Part Support

The above method works for parts supported with preinstalled part support. If SDK part support
is required, then additional options must be passed to the utility.

« sdk_parts_directory - the place where the utility can find SDK part information; and
¢ sdk_flash_directory - the place where the utility can find Flash drivers provided by the SDK.

These are supplied to the utility by adding the following two options

-x "sdk_parts_directory" --flash-dir "sdk_flash_directory"

on to the command line already described. For example:

crt_emu_cmredlink -p LPC54018 --flash-1oad "LPC54018_app. axf" \
-x ~/ mcuxpresso/ 01/ . ncuxpr essoi de_packages_support/LPC54018_support \
--flash-dir ~/ ncuxpresso/ 01/ . ncuxpressoi de_packages_support/LPC54018_support/Fl ash

Since this is quite a lot to type you might wish to put the location of your SDK support directory
into an environment variable as follows:

Windows:

set DIR_SDK ...\ ntuxpresso\01\. ncuxpressoi de_packages_support\LPC54018_support
crt_emu_cmredlink -p LPC54018 --flash-load "LPC54018_app. axf" -x %O R_SDK% \
--flash-dir %Ol R_SDK% Fl ash

MacOS or Linux:

export DI R_SDK="~/.ntuxpresso/ 01/. ncuxpressoi de_packages_support/LPC54018_support "
crt_emu_cmredlink -p LPC54018 --flash-load "LPC54018_app. axf" -x $DI R_SDK \
--flash-dir $DI R _SDK/ Fl ash

Use “Finding Correct Parameters from MCUXpresso IDE”, below, to determine what values you
require for these options.

Programming Flash taking MCUXpresso IDE project Memory edits into Account

MCUXpresso IDE allows the user to modify the default definition of the memory areas (including
the specification of different named Flash regions) used in a hardware using the Edit... button
found in the project’s properties at C/C++Build -> MCU Settings under the heading “Memory
details”. The editor can create multiple named Flash regions.

In order to use these updates to the project’s part information the utility must use the directory
where MCUXpresso IDE stores the project’s products for whatever configuration has been
modified (typically the configuration will be called ‘Debug’) as the source of its part information.

To find the location of this directory in MCUXpresso expand the project in the Project Editor view,
select the directory with the required configuration name (e.g. ‘Debug’), right click on it to bring
up its properties and see the ‘Resource’ heading.

Supply this directory name as the sdk_parts_directory to the utility by adding the options:

-x "sdk_parts_directory"
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Even if the part is supported by an SDK this will be the correct option to use for -x.
Programming Flash for complex debug connections

Some boards or chips occasionally need additional steps to occur before a stable debug
connection can be established. Such debug connections are set up by small BASIC like programs
called Connect Scripts. A good indication as to whether your chip or board normally requires a
connect script can be discovered when “Finding Correct Parameters from MCUXpresso IDE” (see
below).

Connect scripts are distributed within the product and do not normally need to be written from
scratch.

If a connect script is required it can be supplied by adding the following option to the command
line already described:

--connectscript "connectscript”

If you are using --flash-load-exec rather than --flash-load you may also find that the part that you
are using requires its own “reset script” to replace the standard means of starting the execution of
the flashed image. Again you may discover whether one is necessary as below. When required
it can be supplied by adding the following option to the command line:

--resetscript "resetscript"

(As usual the quotes are required only if the script file name contains a space or other unprintable
character.)

Finding the correct parameters from MCUXpresso IDE

Note: A simple way of finding the correct command and options is to use the GUI Flash
Programmer described above, the completion dialog shows the exact command line invoked by
the GUI. On this line the IDE will have chosen the correct

* target name

» adefault Flash driver, flashdriver

e a connect script to be run, if needed

e areset script to be run, if needed with --flash-load-exec

« an sdk_parts_directory where XML information about the part being used (if it is provided via
an SDK) can be found

¢ an sdk_flash_directory where flash drivers supporting the part being used (if it is provided via
an SDK) can be found

Note: that the details will only appear and be relevant only if a project supporting the relevant
chip or board is selected in the project explorer view.

For example the command line produced might be:

crt_emu_cmredlink "/Wrkspace/frdnk64f_driver_exanpl es_blinky.axf" -g --debug 2 --vendor NXP \
-p MK64FN1MDxxx12 - ProbeHandl e=1 - Corel ndex=0 -- Connect Scri pt ki netisconnect.scp -x \
/ User s/ nxp/ ncuxpr esso/ 01/ . ntuxpr essoi de_packages_suppor t / MK6B4AFNLMDxxx12_support --flash-dir \

/ User s/ nxp/ ncuxpr esso/ 01/ . ntuxpr essoi de_packages_support / MK64FNLMDxxx12_support/ Fl ash

Looking at this the target name follows -p; the flashdriver follows --flash-driver; a connectscript
follows --connectscript; a resetscript follows --resetscript; any sdk_flash_directory is provided
following --flash-dir and any sdk_parts_directory is provided following -x.

If the target does not require a connect script or reset script the relevant options will not appear.
If the project is not based on an SDK -x and --flash-dir do not appear.
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Dealing with Errors during Flash operations

If your board requires a connect script to be run in order to provide a stable environment for Flash
drivers you may see errors when you undertake a Flash operation without using it. You can use
‘Finding Correct Parameters from MCUXpresso IDE’, above, to check whether a connect script
is required.

On some boards it is possible to run an image which is incompatible with the Flash driver (which
crt_emu_cm_redlink runs on the target to help it manipulate a Flash device). This incompatibility
is likely to show in the form of programming errors signalled as the operation progresses. Often
they are due to unmaskable exceptions (such as watchdog timers) being used by the previous
image that interfere with a Flash driver's operation.

There are a number of ways to address this situation:

e Does your board support In System Processing (ISP) Reset? Using it will usually reset the
hardware and stop in the Boot ROM, thus ensuring a stable environment for Flash drivers. If
present it can usually be activated with one or more on-board switches. You may have to refer
to the board’s documentation.

¢ Use the --vc option with crt_emu_cm_redlink. This option causes a reset when the utility’s
connection to the board’s debug port is established. Most chips will be left having executed
part of the Boot ROM and usually the resulting state is suitable for running a Flash driver.
(There are exceptions however.)

¢ Erase the contents of Flash (see below) or program a (e.g. small) image that ensures no non-
maskable exceptions are involved. Naturally these solutions have the problem that they are as
likely to fail (and for the same reason) as the programming operation. It is sometimes the case
that an incompatible image will allow the Flash drivers to operate for a short period in which
there is a chance that one of these ‘solutions’ can be used.

Validating the Content of Flash

The Flash programming utility can validate the content of Flash programmed as an AXF (or ELF)
file:

crt_emu_cmredlink -p target --flash-verify "filenane" [--flash-driver "flashdriver"]

it is also possible to verify binary files using:

crt_emu_cmredlink -p target --flash-verify "filenane" --I|oad-base base_address \

[--flash-driver "flashdriver"]

Where target and Flash driver have the same meaning as above.

For example:

crt_emu_cmredlink -p LPC11U68 --flash-verify "LPC11U68_App. axf"

Note: the issues described in ‘Dealing with Errors During Flash Operation’ still apply when
executing this command.

Erasing the Flash

The Flash programming utility can also delete the content of Flash. To do so it takes the following
options:

crt_emu_cmredlink -p target --flash-mass-erase [--flash-driver "flashdriver"]

Where target and Flash driver have the same meaning as above.
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For example:

crt_emu_cmredlink -p LPC11U68 --fl ash-nass-erase

Note: the issues described in ‘Dealing with Errors During Flash Operation’ still apply when
executing this command.)

Validating that Flash has been Erased

The Flash programming utility can validate that the content of Flash has been erased:

crt_emu_cmredlink -p target --flash-check --area flash " [--flash-driver "flashdriver"]

For example:

crt_emu_cmredlink -p LPC11U68 --fl ash-check --area flash

It is also possible to check that just the specific areas that would have been programmed by a
given AXF or binary file are blank.

crt_emu_cmredlink -p target --flash-check-file "filename" [--flash-driver "flashdriver"]

it is also possible to verify binary files using:

crt_emu_cmredlink -p target --flash-check-file "filename" --1oad-base base_address \
[--flash-driver "flashdriver"]

Where target and Flash driver have the same meaning as above.

For example:

crt_emu_cmredlink -p LPC11U68 --flash-check-file "LPC11U68_App. axf"

Note: the issues described in ‘Dealing with Errors During Flash Operation’ still apply when
executing this command.)

Examples

To load the binary executable file app.bin at location 0 on an LPC54113J128 target using LPC-
Link2, use the following command line:

crt_emu_cmredlink -p LPC54113J128 --1o0ad-base 0 --flash-1oad-exec app.bin

To load the executable file app.axf and start it executing on an LPC1768 target using LPC-Link2,
use:

crt_emu_cmredlink -p LPC1768 --flash-1o0ad-exec "app. axf"

To erase Flash, program the executable app.axf into an LPC18S37 board, which has no internal
Flash but supports external Flash on the board, and then run it:

crt_emu_cmredlink -p LPC18S37 --flash-nmass-1oad-exec "app.axf" --flash-driver \
LPC18x7_43x7_2x512_Boot A. cf x
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To erase then program app.axf into a Kinetis MK64FN1MOxxx12, which is supported through an
SDK, and requirings a connect script (on MacOS/Linux):

crt_emu_cmredlink -p MK64FNIM)xxx12 --fl ash-nmass-1oad "app.axf" \
--connectscript kinetisconnect.scp \
-x ~/ mcuxpresso/ 01/ . ntuxpr essoi de_packages_support/ MK64FNLIMOxxx12_support \
--flash-dir ~/ ncuxpresso/ 01/ . ncuxpressoi de_packages_support/ MK64FN1IM)xxx12_support/ Fl ash

To delete the Flash on an LPC1343:

crt_emu_cmredlink -p LPC1343 --flash-nass-erase

To delete the Flash on an LPC54113J128 using vector catch to ensure that the currently booted
code does not interfere with the Flash driver:

crt_emu_cmredlink -p LPC54113J128 --fl ash-erase --vc

To check that the Flash is blank on an LPC54018 which is supported by an SDK and which
has modified its memory layout stored in the MCUXpresso SDK example project held at ~/ws/
Ipcxpresso54018 driver_examples_gpio_gpio_led_output:

crt_emu_cmredlink -p LPC54018 --flash-check -x \
~/ ws/ | pcxpresso54018_dri ver _exanpl es_gpi o_gpi o_| ed_out put/ Debug \
--flash-dir ~/ ncuxpresso/ 01/ . ncuxpressoi de_packages_support/LPC54018_support/Fl ash
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MCUXpresso IDE ships with three different C/C++ library families. This provides the maximum
possible flexibility in balancing code size and library functionality.

Overview of Redlib, Newlib and NewlibNano

¢ Redlib Our own (non-GNU) ISO C90 standard C library, with some C99 extensions.
* Newlib GNU C/C++ library
« NewlibNano a version of the GNU C/C++ library optimized for embedded.

By default, MCUXpresso IDE will use Redlib for C projects, NewlibNano for SDK C++ projects,
and Newlib for C++ projects for preinstalled MCUs.

Newlib provides complete C99 and C++ library support at the expense of a larger (in some cases,
much larger) code size in your application.

NewlibNano was produced as part of ARM's “GNU Tools for ARM Embedded Processors”
initiative in order to provide a version of Newlib focused on code size. Using NewlibNano can
help dramatically reduce the size of your application compared to using the standard version of
Newlib — for both C and C++ projects.

If you need a smaller application size and don’t need the additional functionality of the C99 or C+
+ libraries, we recommend the use of Redlib, which can often produce much smaller applications.

Redlib extensions to C90

Although Redlib is basically a C90 standard C library, it does implement a number of extensions,
including some from the C99 specification. These include:

 Single precision math functions

» Single precision implementations of some of the math.h functions such as sinf() and cosf()
are provided.

« stdbool.h
* An implementation of the C99 stdbool.h header is provided.
* itoa
« itoa() is non-standard library function which is provided in many other toolchains to convert

an integer to a string. To ease porting, an implementation of this function is provided,
accessible via stdlib.h. More details can be found later in this chapter.

Newlib vs NewlibNano

Differences between Newlib and NewlibNano include:

* NewlibNano is optimized for size.

e The printf and scanf family of routines have been re-implemented in NewlibNano to remove
a direct dependency on the floating-point input/output handling code. Projects that need to
handle floating-point values using these functions must now explicitly request the feature
during linking.

e The printf and scanf family of routines in NewlibNano support only conversion specifiers
defined in C89 standard. This provides a good balance between small memory footprint and
full feature formatted input/output.

¢ NewlibNano removes the now redundant integer-only implementations of the printf/scanf
family of routines (iprintf/iscanf, etc). These functions now alias the standard routines.

* In NewlibNano, only unwritten buffered data is flushed on exit. Open streams are not closed.

* In NewlibNano, the dynamic memory allocator has been re-implemented
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17.2 Library Variants

Each C library family is provided in a number of different variants : None, Nohost and Nohost-nf,
Semihost and Semihost-nf (Redlib only). These variants each provide a different set of ‘stubs’
that form the very bottom of the C library and include certain low-level functions used by other
functions in the library.

Each variant has a differing set of these stubs, and hence provides differing levels of functionality:

¢ Semihost(-mb)
 This library variant provides implementation of all functions, including file I/0. The file 1/O will
be directed through the debugger and will be performed on the host system (semihosting).
For example, printf/scanf will use the debugger console window and fread/fwrite will operate
on files on the host system. Note: emulated 1/O is relatively slow and can only be used when
debugging.
¢ Semihost(-mb)-nf (no files)
« Redlib only. Similar to Semihost, but only provides support for the 3 standard built-in streams
— stdin, stdout, stderr. This reduces the memory overhead required for the data structures
used by streams, but means that the user application cannot open and use files, though
generally this is not a problem for embedded applications.
* Nohost and Nohost-nf
 This library variant provides the string and memory handling functions and some file-based
I/O functions. However, it assumes that you have no debugging host system, thus any file
I/0 will do nothing. However, it is possible for the user to provide their own implementations
of some of these 1/O functions, for example to redirect output to the UART.
* None
* This has literally no stub and has the smallest memory footprint. It excludes low-level
functions for all file-based 1/0 and some string and memory handling functions.

Note: -mb library variants are not selected by default during any wizard project creation however
they may optionally be selected for enhanced semihost performance with the penalty of slightly
larger RAM usage. Please see for additional information.

In many embedded microcontroller applications it is possible to use the None variant by careful
use of the C library, for instance avoiding calls to printf().

If you are using the wrong library variant, then you will see build errors of the form:

* Linker error "Undefined reference to ‘xxx

For example for a project linking against Redlib(None) but using printf() :

MCUXpresso IDE User Guide -

..libcr_c.a(fpprintf.o):

In function “printf':

fpprintf.c:(.text.printf+0x38):
fpprintf.c:(.text.printf+0x4c):

undefined reference to
undefined reference to

t__sys_wite'
*__Ciob'

...libcr_c.a(_deferredl azyseek.0): In function *__ flsbuf':

...libcr_c.a(alloc.0): In function *_Csys_alloc':
alloc.c:(.text._Csys_all oc+Oxe): undefined reference to ~__sys_wite'
alloc.c:(.text._Csys_alloc+0x12): undefined reference to ~__sys_appexit'
...libcr_c.a(fseek.0): In function "fseek':

fseek.c:(.text.fseek+0x16): undefined reference to ~__sys_istty’
fseek.c:(.text.fseek+0x3a): undefined reference to ~__sys_flen'

_deferredl azyseek.c: (.text.__flsbuf+0x88): undefined reference to *~__sys_istty’
..libcr_c.a(_witebuf.o): In function *~_COwitebuf':
_writebuf.c:(.text._OCwitebuf+0x16): undefined reference to ~__sys_flen'
_writebuf.c:(.text._Owitebuf+0x26): undefined reference to *__sys_seek’
_writebuf.c:(.text._Owitebuf+0x3c): undefined reference to ~__sys_wite'

Or if linking against NewlibNano(None):
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...libc_nano.a(lib_a-witer.o): In function ~_wite_r":
witer.c:(.text._wite_r+0x10): undefined reference to "~_wite'
...libc_nano.a(lib_a-closer.o): In function “_close_r":
closer.c:(.text._close_r+0xc): undefined reference to " _cl ose'
...libc_nano.a(lib_a-lseekr.o0): In function "~_lseek_r":

| seekr.c: (.text._| seek_r+0x10): undefined reference to *_I seek’
...libc_nano.a(lib_a-readr.o): In function *_read_r"':

readr.c: (.text._read_r+0x10): undefined reference to "_read
...libc_nano.a(lib_a-fstatr.o): In function ~_fstat_r":
fstatr.c:(.text._fstat_r+0xe): undefined reference to ~_fstat'
...libc_nano.a(lib_a-isattyr.o): In function *~_isatty_r':
isattyr.c:(.text._isatty_r+0xc): undefined reference to *_isatty'

In such cases, simply change the library hosting being used (as described below), or remove the
call to the triggering C library function.

Switching the selected C library

Normally the library variant used by a project is set up when the project is first created by the
New Project Wizard. However it is quite simple to switch the selected C library between Redlib,
Newlib and NewlibNano, as well as switching the library variant in use.

To switch, highlight the project in the Project Explorer view and go to:
Quickstart -> Quick Settings -> Set library/header type

and select the required library and variant.

Manually Switching
Alternatively, you can make the required changes to your project properties manually as follows...

When switching between Newlib(Nano) and Redlib libraries you must also switch the headers
(since the 2 libraries use different header files). To do this:

1. Select the project in Project Explorer

2. Right-click and select Properties

3. Expand C/C++ Build and select Settings

4. In the Tools settings tab, select Miscellaneous under MCU C Compiler. Note: Redlib is not
available for C++ projects

5. In Library headers, select Newlib or Redlib
. In the Tools setting tab, select Architecture & Headers under MCU Assembler
7. In Library headers, select Newlib or Redlib

»

Repeat the above sequence for all Build Configurations (typically Debug and Release).

To then change the libraries actually being linked with (assuming you are using Managed linker
scripts):

. Select the project in Project Explorer

. Right-click and select Properties

. Expand C/C++ Build and select Settings

. In the Tools settings tab, select Managed Linker Script under MCU Linker

. In the Library drop-down, select the Newlib, NewlibNano or Redlib library variant that you
require (None, Nohost, Semihost, Semihost-nf).

a s wDN PP

Again repeat the above sequence for all Build Configurations (typically Debug and Release).
Note: Redlib is not available for C++ projects.
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What is Semihosting?

Semihosting is a term to describe application 10 via the debug probe. For this to operate, library
code and debug support are required.

Background to Semihosting

When creating a new embedded application, it can sometimes be useful during the early stages
of development to be able to output debug status messages to indicate what is happening as
your application executes.

Traditionally, this might be done by piping the messages over a serial cable connected to a

MCUXpresso IDE offers an alternative to this
scheme, called semihosting. Semihosting provides a mechanism for code running on the target
board to use the facilities of the PC running the IDE. The most common example of this is for the
strings passed to a printf being displayed in the IDE’s console view.

The term “semihosting” was originally termed by ARM in the early 1990s, and basically indicates
that part of the functionality is carried out by the host (the PC with the debug tools running on
it), and partly by the target (your board). The original intention was to provide I/O in a target
environment where no real peripheral-based I/0O was available at all.

Semihosting Implementation

The way it is actually implemented by the tools depends upon which target CPU you are running
on. With Cortex-M based MCUs, the bottom level of the C library contains a special BKPT
instruction. The execution of this is trapped by the debug tools which determine what operation
is being requested — in the case of a printf, for example, this will effectively be a “write character
to stdout”. The debug tools will then read the character from the memory of the target board —
and display it in the console window within the IDE.

Semihosting also provides support for a number of other I/O operations (though this relies upon
your debug probe also supporting them)... For example it provides the ability for scanf to read its
input from the IDE console. It also allows file operations, such that fopen can open a file on your
PC'’s hard drive, and fscanf can then be used to read from that file.

Semihosting Performance

It is fair to say that the semihosting mechanism does not provide a high performance 1/0O system.
Each time a semihosting operation takes place, the processor is basically stopped whilst the data
transfer takes place. The time this takes depends somewhat on the target CPU, the debug probe
being used, the PC hardware and the PC operating system. But it takes a definite period of time,
which may make your code appear to run more slowly.

In MCUXpresso IDE version 10.2.0 semihosting performance has been enhanced to deliver
roughly double the speed when compared with the previous IDE release. Furthermore, a new
MB library variant is been supplied that delivers a significant further improvement in performance
when combined with LinkServer debug connections. This library along new LinkServer debug
support provides the added benefit of no impact on code execution performance.

Important notes about using Semihosting

When you have linked with the semihosting library, your application will no longer work
standalone — it will only work when connected to the debugger.

Semihosting operations cause the CPU to drop into “debug state”, which means that for the
duration of the data transfer between the target and the host PC no code (including interrupts) will
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get executed on the target. Thus if your application uses interrupts, then it is normally advisable to
avoid the use of semihosting whilst interrupts are active — and certainly within interrupt handlers
themselves. If you still need to use printf, then you can retarget the bottom level of the C library to
use an alternative communication channel, such as a UART or the Cortex-M CPU’s ITM channel.

Semihosted printf and Debugging

Semihosting is common to all supported debug solutions so the implications of this mechanism
should be understood:

Projects linked against semihosting libraries that perform semihosted operations e.g. printf, can
not execute without a debugger connected. This is because semihosted operations make use of
a BreakPoint instruction that is intercepted by the debug tools to trigger the desired behaviour
(typically the printf string appearing within the IDE console). Without a debug connection, these
BreakPoint instructions will not be trapped and a Hard Fault exception will occur. By default, the
supplied Hard Fault handler implementation will be an infinite loop. Therefore if an ‘attach’ is
performed to such a target, the user will observe the code running within the hard fault handler. To
avoid this occurring, ensure that the project makes no use of semihosted operations via sending
output to a UART, using the ITM feature, commenting out semihosted operations etc.

In consequence, if for example a user had created an LED blinky application that also performed
semihosted printf operations, then without a debug connection the blinky would stop when the
first printf was executed.

Introduced in MCUXpresso IDE version 10.1.0: New projects and newly imported SDK example
projects will automatically include a semihost hardfault handler (as can be seen in the image
below). The purpose of this handler is to prevent the problem described above. Now, if a
semihosted operation is performed without debug tools attached, the new semihost hardfault
handler will be entered. The handler will check to see if a semihosted operation cause it to be
entered and if so, simply return.

v =5 MKL28751 2xxx7_Project

» #4 Binaries

F hil Includes

» 2 CMSIS

bk £ board

v [ source
b [£] MKL2BZ51 2xxx7_Project.c
b [ mtb.c
» |c] semihost_hardfault.c

b 2 startup

In consequence, if the user creates an LED blinky application that also performs semihosted
printf operations, then without a debug connection the blinky will continue regardless of any printf
operation that may occur.

This functionality can be disabled if required by either simply deleting the handler file, or by
defining a symbol:

__SEM HOST_HARDFAULT_DI SABLE

Note: Previously created projects imported into MCUXpresso IDE (such as LPCOpen projects),
will not inherit this feature.

Introduced in MCUXpresso IDE version 10.2.0: The inclusion of the hardfault handler can be

controlled via a preference preferences -> MCUXpresso IDE -> SDK Options -> Include semihost
hardfault handler ..., where the default is to include.
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Redlib Semihost MB

@ Introduced in MCUXpresso IDE version 10.2.0: is the optional Redlib Semihost
MB library variant. This library provides enhanced semihosting performance from
LinkServer debug connections (other debug solutions will perform as before) with
the added benefit of no impact on code execution performance. There is a small
penalty of slightly larger code and data sizes compared to other Redlib Semihost
libraries. This optional library is recommended for users needing high semihosting
performance and/or have slow debug probe performance.

Semihosting Specification

The semihosting mechanism used within MCUXpresso IDE is based on the specification
contained in the following document available from ARM’s website... => ARM Developer Suite
(ADS) v1.2 Debug Target Guide, Chapter 5. Semihosting

Use of printf

By default, the output from printf() (and puts()) will be displayed in the debugger console via the
semihosting mechanism. This provides a very easy way of getting basic status information out
from your application running on your target.

For printf() to work like this, you must ensure that you are linking with a “semihost” or “semihost-
nf” library variant.

Note: If you only require the display of fixed strings, then using puts() rather than printf() will
noticeably reduce the code size of your application.

Redlib printf Variants

Redlib provides the following two variants of printf. Many of the MCUXpresso New project wizards
provide options to select which of these to use when you create a new project.

Character vs String output

By default printf() and puts() functions will output the generated string at once, so that a single
semihosted operation can output the string to the console of the debugger. Note: these versions
of printf() /puts() make use of malloc() to provide a temporary buffer on the heap in order to
generate the string to be displayed.

It is possible to switch to using “character-by-character” versions of these functions (which do
not require heap space) by specifying the build define “CR_PRINTF_CHAR” (which should be
set at the project level). This can be useful, for example, if you are retargeting printf() to write
out over a UART (as detailed below)- as in this case it is pointless creating a temporary buffer to
store the whole string, only to then print it out over the UART one character at a time

Integer only vs full printf (including floating point)

The printf() routine incorporated into Redlib is much smaller than that in Newlib. Thus if code
size is an issue, then always try to use Redlib if possible. In addition, if your application does
not pass floating point numbers to printf, you can also select a “integer only” (non-floating point
compatible) variant of printf. This will reduce code size further.

To enable the “integer only” printf from Redlib, define the symbol “CR_INTEGER_PRINTF” (at
the project level). This is done by default for projects created from the SDK new project wizard.

NewlibNano printf Variants
By default, NewlibNano uses non-floating point variants of the printf and scanf family of functions,

which can help to dramatically reduce the size of your image if only integer values are used by
such functions.
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If your codebase does require floating point variants of printf/scanf, then these can be enabled
by going to:

Project -> Properties -> C/C++ Build -> Settings -> MCU Linker -> Managed Linker Script and
selecting the " Enable printf/scanf float" tick box.

Newlib printf variants

Newlib provides an “iprintf” function which implements integer only printf.

Printf when using LPCOpen

If you are building your application against LPCOpen, you may find that printf output does not
get displayed in MCUXpresso IDE’s debug console by default. This is due to many LPCOpen
board library projects by default redirecting printf to a UART output.

If you want to direct printf output to the debug console instead, then you will need to modify your
projects so that:

1. Your main application project is linked against the “semihost” variant of the C library, and
2. You disable the LPCOpen board library’s redirection of printf output by either:
« locating the source file board.c within the LPCOpen board library and comment out the line:
#include retarget.h, or
« locating the file board.h and enable the line: #define DEBUG_SEMIHOSTING

Printf when using SDK

The MCUXpresso SDK codebase provides its own printf style functionality through the macro
PRINTF. This is set up in the header file fs|_debug_console.h such that it can either point to the
printf function provided by the C library itself, or can be directly to the SDK function pseudo-printf
function : DbgConsole_Printf() . This will typically cause the output to be sent out via a UART
(which may be connected to an on-board debug probe which will sent it back to the host over a
USB VCOM channel). This is controlled by the macro SDK_DEBUGCONSOLE thus:

* |If SDK_DEBUGCONSOLE ==
* PRINTF is directed to C library printf()
e |f SDK_DEBUGCONSOLE ==
¢ PRINTF is directed to SDK DbgConsole_Printf()

The Advanced page of the SDK new project wizard and Import SDK examples wizard offer
the option to configure a project so that PRINTF is directed to C library printf() by setting
SDK_DEBUGCONSOLE appropriately.

In addition, if PRINTF is being directed to the C library printf(), then if
SDK_DEBUGCONSOLE_UART is also defined, then printf output will still be directed to the
UART. Again the Advanced page of the SDK new project wizard and Import SDK examples
wizard offer an option to control this.

Retargeting printf/scanf

By default, the printf function outputs text to the debug console using the “semihosting”
mechanism.

In some circumstances, this output mechanism may not be suitable for your application. Instead,
you may want printf to output via an alternative communication channel such as a UART or — on
Cortex-M3/M4 — the ITM channel of SWO Trace. In such cases you can retarget the appropriate
portion of the bottom level of the library.

The section “How to use ITM Printf” below provides an example of how this can be done.
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Note: when retargeting these functions, you can typically link against the “nohost” variant of the
C Library, rather than the “semihost” one.

Redlib

To retarget Redlib’s printf(), you need to provide your own implementations of the function
__sys_write():

int __sys wite(int iFileHandl e, char *pcBuffer, int ilLength)

Function returns number of unwritten bytes if error, otherwise 0 for success

Similarly if you want to retarget scanf(), you need to provide your own implementations of the
function __sys_readc():

int _ sys_readc(void)

Function returns character read
Note: these two functions effectively map directly onto the underlying “semihosting” operations.
Newlib / NewlibNano

To retarget printf(), you will need to provide your own implementation of the Newlib system
function _write():

int _wite(int iFileHandl e, char *pcBuffer, int ilLength)

Function returns number of unwritten bytes if error, otherwise 0 for success

To retarget scanf, you will need to provide your own implementation of the Newlib system function
_read():

int _read(int iFileHandl e, char *pcBuffer, int ilLength)

Function returns number of characters read, stored in pcBuffer

More information on the Newlib system calls can be found at: https://sourceware.org/newlib/
libc.html#Syscalls

How to use ITM Printf

ITM Printf is a scheme to achieve application 10 via a debug probe without the usual semihosting
penalties.

ITM Overview

As part of the Cortex-M3/M4 SWO Trace functionality available when using an LPC-Link2 (with
NXP’s CMSIS-DAP firmware), MCUXpresso IDE provides the ability to make use of the ITM :
The Instrumentation Trace Macrocell (ITM) block provides a mechanism for sending data from
your target to the debugger via the SWO trade stream. This communication is achieved through
a memory-mapped register interface. Data written to any of 32 stimulus registers is forwarded to
the SWO stream. Unlike other SWO functionality, using the ITM stimulus ports requires changes
to your code and so should not be considered non-intrusive.

Printf operations can be carried out directly by writing to the ITM stimulus port. However the
stimulus port is output only. And therefore scanf functionality is achieved via a special global
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variable, which allows the debugger to send characters from the console to the target (using
the trace interface). The debugger writes data to the global variable named ITM_RxBuffer to be
picked up by scanf.

Note: MCUXpresso IDE currently only supports ITM via stimulus port 0.

Note: For more information on SWO Trace, please see the MCUXpresso IDE LinkServer SWO
Trace Guide.

ITM printf with SDK

The Advanced page of the SDK new project wizard and Import SDK examples wizard offer the
option to configure a project so as to redirect printf/scanf to ITM. Selecting this option will cause
the file retarget_itm.c to be generated in your project to carry out the redirection.

ITM printf with LPCOpen

To use this functionality with an LPCOpen project you need to: Include the file retarget_itm.c in
your project — available from the Examples subdirectory of your IDE installation Ensure you are
using a semihost, semihost-nf, or nohost C library variant. Then simply add calls to printf and
scanf to your code.

If you just linking against the LPCOpen Chip library, then this is all you need to do. However if you
are also linking against an LPCOpen board library then you will likely see build errors of the form:

../srclretarget.h:224: nmultiple definition of ~__sys_wite'

../srclretarget.h:240: nmultiple definition of ~__sys_readc’

locating the file board.h and enable the line: #define DEBUG_SEMIHOSTING, or locating
the source file board.c within the LPCOpen board library and comment out the line: #include
"retarget.h"

itoa() and uitoa()

itoa() is non-standard library function which is provided in many other toolchain to convert an
integer to a string.

Redlib

To ease porting, MCUXpresso IDE provides two variants of this function in the Redlib C library....

char * itoa(int value, char *vstring, unsigned int base);
char * uitoa(unsigned int value, char *vstring, unsigned int base);

which can be accessed via the system header....

#i ncl ude <stdlib. h>

itoa() converts an integer value to a null-terminated string using the specified base and stores
the result in the array pointed to by the vstring parameter. Base can take any value between 2
and 16; where 2 = binary, 8 = octal, 10 = decimal and 16 = hexadecimal.

If base is 10 and the value is negative, then the resulting string is preceded with a minus sign (-).
With any other base, value is always considered unsigned. The return value to the function is a
pointer to the resulting null-terminated string, the same as parameter vstring.

uitoa() is similar but treats the input value as unsigned in all cases.
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Note: the caller is responsible for reserving space for the output character array — the
recommended length is 33, which is long enough to contain any possible value regardless of
the base used.

Example invocations

char vstring [33]

itoa (value,vstring, 10); // convert to deci na
itoa (value,vstring, 16); // convert to hexadeci ma
itoa (value,vstring,8);; // convert to octa

Standards compliance

As noted above, itoa() / uitoa() are not standard C library functions. A standard-compliant
alternative for some cases may be to use sprintf() - though this is likely to cause an increase in
the size of your application image:

sprintf(vstring,"%l",value); // convert to decinal
sprintf(vstring,"%",value); // convert to hexadeci ma
sprintf(vstring,"%",value); // convert to octal

Newlib/NewlibNano

Newlib and NewlibNano now also provide similar functionality though with slightly different
naming - itoa() and utoa().

Libraries and linker scripts

When using the managed linker script mechanism, as described in the chapter “Memory
configuration and Linker Script Generation”, then the appropriate settings to link against the
required library family and variant will be handled automatically.

However if you are not using the managed linker script mechanism, then you will need to define
which library files to use in your linker script. To do this, add one of the following entries before
the SECTION line in your linker script:

Redlib (None), add

* [C project only]: GROUP (libcr_c.a libcr_eabihelpers.a)

Redlib (Nohost), add

* [C projects only]: GROUP (libcr_nohost.a libcr_c.a libcr_eabihelpers.a)
Redlib (Semihost-nf), add

* [C projects only]: GROUP (libcr_semihost_nf.a libcr_c.a libcr_eabihelpers.a)
Redlib (Semihost), add

* [C projects only]: GROUP (libcr_semihost.a libcr_c.a libcr_eabihelpers.a)

NewlibNano (None), add

 [C projects]: GROUP (libgcc.a libc_nano.a libm.a libcr_newlib_none.a)

e [C++ projects]: GROUP (libgcc.a libc_nano.a libstdc++_nano.a libm.a libcr_newlib_none.a)

NewlibNano (Nohost), add

* [C projects]: GROUP (libgcc.a libc_nano.a libm.a libcr_newlib_nohost.a)

o [C++ projects]: GROUP (libgcc.a libc_nano.a libstdc++_nano.a libm.a
libcr_newlib_nohost.a)

NewlibNano (Semihost), add

¢ [C projects]: GROUP (libgcc.a libc_nano.a libm.a libcr_newlib_semihost.a)

o [C++ projects]: GROUP (libgcc.a libc_nano.a libstdc++_nano.a libm.a
libcr_newlib_semihost.a)
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¢ Newlib (None), add
* [C projects]: GROUP (libgcc.a libc.a libm.a libcr_newlib_none.a)
e [C++ projects]: GROUP (libgcc.a libc.a libstdc++.a libm.a libcr_newlib_none.a)
¢ Newlib (Nohost), add
* [C projects]: GROUP (libgcc.a libc.a libm.a libcr_newlib_nohost.a)
e [C++ projects]: GROUP (libgcc.a libc.a libstdc++.a libm.a libcr_newlib_nohost.a)
¢ Newlib (Semihost), add
* [C projects]: GROUP (libgcc.a libc.a libm.a libcr_newlib_semihost.a)
e [C++ projects]: GROUP (libgcc.a libc.a libstdc++.a libm.a libcr_newlib_semihost.a)

In addition, if using NewlibNano, then tick box method of enabling printf/scanf floating point
support in the Linker pages of Project Properties will also not be available. In such cases, you
can enabling floating point support manually by going to:

Project Properties -> C/C++ Build -> Settings -> MCU Linker -> Miscellaneous
and entering -u _printf_float and/or -u _scanf_float into the “Linker flags” box.

A further alternative is to put an explicit reference to the required support function into your project
codebase itself. One way to do this is to add a statement such as:

asm (“.global _printf_float”);

to one (or more) of the C source files in your project.
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18. Memory Configuration and Linker Scripts

18.1

Introduction

A key part of the core technology within MCUXpresso IDE is the principle of a default defined
memory map for each MCU. For devices with internal Flash, this will also specify a Flash driver
to be used to program that Flash memory (for use with LinkServer “native” debug probes).

For preinstalled MCUs, the definition of the memory map is contained within the MCU part
knowledge that is built into the product. For MCUs installed into MCUXpresso IDE from an SDK,
the definition of the memory map is loaded from the manifest file within the SDK structure.

But in both cases, the defined memory map is used by MCUXpresso IDE to drive the “managed
linker script” mechanism. This auto-generates a linker script to place the code and data from
your project appropriately in memory, as well as being made available to the debugger.

A project’s memory map can be viewed and modified by the user to add, remove (split/join) or
reorder blocks using the in place Memory Configuration Editor. For example, if a project targets
an MCU that supports external Flash (e.g. SPIFI), then it's memory map can be easily extended
to define the SPIFI memory region (base and size). In addition, an appropriate Flash driver can
be associated with the newly defined region.

Figure 18.1. Memory Configuration

Memory details (MK64FN1MOxxx12)*

Default LinkServer Flash Driver:

Default LinkServer Flash Driver Browse...
Type Name Alias Location Size Driver —
Flash PROGRAM_FLASH Flash Ox0 0x100000 FTFE_4K.cfx k'

RAM  SRAM_UPPER RAM 0x20000000 0x30000

RAM  SRAM_LOWER RAM2  Ox1fff0000 0x10000 s

RAM FLEX_RAM RAM3  0x14000000 0x1000
Add Flash Add RAM Split Delete
Import... Merge... Export... Generate..

Refresh MCU Cache
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Introduced in MCUXpresso IDE version 10.3.0 Memory configurations can be edited directly
in place rather than requiring a separate Edit to launch a separate dialogue. In place editing of
memory configurations is incorporated within all project wizards and project properties views.

Managed Linker Script Overview

By default, the use of “managed linker scripts” is enabled for projects. This mechanism allows
MCUXpresso IDE to automatically create a script for each build configuration that is suitable
for the MCU selected for the project and the C libraries being used. It will create (and at times
modify) three linker script files for each build configuration of your project:

<pr oj name>_<bui | dconfig>_lib.ld
<pr oj nane>_<bui | dconfi g>_nmem | d
<pr oj name>_<bui | dconfi g>.1d

This set of hierarchical files are used to define the C libraries being used, the memory map of
the system and the way your code and data is placed into the memory map. These files will be
located in the build configuration subdirectories of your project (typically — Debug and Release).
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Figure 18.2. Project Explorer Debug folder Linker Scripts
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The managed linker script mechanism also automatically takes into account memory map
changes made in the Memory Configuration Editor as well as other configuration changes, such
as C/C++ library settings.

See also the section on

How are Managed Linker Scripts Generated?

MCUXpresso IDE passes a set of parameters into the linker script generator (based on the
“FreeMarker” scripting engine) to create an appropriate linker script for your project. This
generator uses a set of conditionally parsed template files, each of which control different aspects
of the generated linker script.

It is possible to modify certain aspects of the generated linker script by providing one or more
modified template files locally within linkscripts folder of project directory structure. Any such
templates that you provide locally will then override the default ones built into MCUXpresso IDE.
A full set of the default linker templates (.Idt) files are provided inside \Wizards\linker subdirectory
of your IDE install.
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18.4

Default Image Layout

Code and initial values of initialised data items are placed into first bank of Flash (as show in
memory configuration editor). During startup, MCUXpresso IDE startup code copies the data into
the first bank of RAM (as show in memory configuration editor), and zero initializes the BSS data
directly after this in memory. This process uses a global section table generated into the image
from the linker script.

Other RAM blocks can also have data items placed into them under user control and the startup
code will also initialise these automatically. See later in this chapter for more details.

Figure 18.3. Default Memory Layout
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Note: The above memory layout is simply the default used by the IDE’s managed linker script
mechanism. There are a number of mechanisms that can be used to modify the layout according
to the requirements of your actual project — such as simply editing the order of the RAM banks
in the Memory Configuration Editor. These various methods are described later in this chapter.

The default memory layout will also locate the heap and stack in the first RAM bank, such that:

« the heap is located directly after the BSS data, growing upwards through memory
« the stack located at the end of the first RAM bank, growing down towards the heap

Again this heap and stack placement is a default and it is very easy to modify the locations for
a particular project, as will be described later in this chapter.

Note: When you import a project, you may find that the defaults have already been modified.
Check the Project Properties to confirm the exact details.

Examining the layout of the generated image

Looking at the size of the AXF file generated by building your project on disk does not provide any
information as to how much Flash/RAM space your application will occupy when downloaded

All information provided in this document is subject to legal disclaimers © 2019 NXP Semiconductors. All rights reserved.

User Guide

Rev. 11.0.0 — 23 May, 2019 162



NXP Semiconductors MCUXpresso IDE User Guide

to your MCU. The AXF file contains a lot more information than just the binary code of
your application, for example the debug data used to provide source level information when
debugging, that is never downloaded to your MCU.

18.5.1 Linker --print-memory-usage
MCUXpresso IDE projects use the --print-memory-usage option on the link step of a build to
display memory usage information in the build console of the following form:
Menory region Used Size Region Size %age Used
PROGRAM FLASH: 25960 B 1 M8 2.48%
SRAM_UPPER: 8472 B 192 KB 4.31%
SRAM LOVER: (e 64 KB 0. 00%
FLEX_RAM (e 4 KB 0. 00%
Fi ni shed building target: frdnk64f_bubbl e. axf
The memory regions displayed here will match up to the memory banks displayed in the memory
configuration editor when the managed linker script mechanism is being used.
By default, the application will build and link against the first Flash memory found within the MCU’s
memory configuration. For most MCUs there will only be one Flash device available. In this case
our project requires 25960 bytes of Flash memory storage, 2.48% of the available Flash storage.
RAM will be used for global variable, the heap and the stack. MCUXpresso IDE provides a flexible
scheme to reserve memory for Stack and Heap. This build has reserved 4KB each for the stack
and the heap contributing 8KB to the overall 8472 bytes reported.
If using the 'LPCXpresso style' of heap and stack placement (described later in this chapter), the
RAM consumption provided by this feature is only that of your global data. It will not include any
memory consumed by your stack and heap when your application is actually executing.
Note: projectimported into MCUXpresso IDE may not have been created with this option. To add
this, right click on the project and select C/C++ Build ->Settings -> MCU Linker -> Miscellaneous
then click ‘+’ and add --print-memory-usage
18.5.2 arm-none-eabi-size
In addition, a post-build step will normally invoke the arm-none-eabi-size utility to provide this
information in a slightly different form....
t ext dat a bss dec hex fil enane
2624 524 32 3180 c6e LPCXpr essol1768_systi ck_twi nkl e. axf
¢ text - shows the code and read-only data in your application (in decimal)
« data - shows the read-write data in your application (in decimal)
* bss - show the zero initialized (‘bss’ and ‘common’) data in your application (in decimal)
e dec - total of ‘text’ + ‘data’ + ‘bss’ (in decimal)
¢ hex - hexadecimal equivalent of 'dec’
Typically:
« the Flash consumption of your application will then be text + data
« the RAM consumption of your application will then be data + bss
Again if using the 'LPCXpresso style' of heap and stack placement (described later in this
chapter), the RAM consumption will not include any memory allocated for your stack and heap
when your application is actually executing.
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18.6

You can also manually run the arm-none-eabi-size utility on both your final application image, or
on individual object files within your build directory by right clicking on the file in Project Explorer
and selecting the Binary Utilities -> Size option.

Linker Map Files

The linker option “-map” option, which is enabled by default by the project wizard when a new
project is created, allows you to analyse in more detail the contents of your application image.
When you do a build, this will cause a file called projectname.map to be created in the Debug (or
Release) subdirectory, which can be loaded into the editor view. This contains a large amount
of information, including:

¢ A list of archive members (library objects) included with details

¢ Alist of discarded input sections (because they are unused and the linker option --gc-sections
is enabled).

« The location, size and type of all code, data and bss items that have been placed in the image

Image Info (Information)

New in MCUXpresso IDE version 11.0.0 is an additional Image Info view providing tools for
detailed analysis of an image structure and memory footprint. This view supersedes the Symbol
browser provided by earlier versions of the IDE.

The Image Info view is stacked by default in the MCUXpresso IDE Develop perspective, along
with Problems and/or Console views.

The tool bar icons for this view are shown and detailed below:

(7 Installed SDKs (] Properties |2/ Problems [ Console| i Image Info £2 | 49 Terminal G Debugger Console b )
Use one of the available load options to start analyzing a build artj /
o

Memory Usage Memory Contents | Call Graph L L =
= Csr

Region

Figure 18.4. Image Info Toolbar

I 4 Eﬁ] B~

Start address Ugage (%)

00000600

MCUXpresso IDE User Guide -

Where:

1. Loads the build artifact (.axf) associated with the currently selected project for analysis. This
is simplest option to follow to populate this view.

« alternatively, an image, object or static library can be dragged onto this view

* once loaded, the selected artifact name and build information (plus warnings if any) is
displayed as a title to the view

« if more than one project (or file) is selected and more than one Image Info view is open
within the IDE, then the additional views will also be populated from the selection

« this icon will be greyed out if the selected project’s current build configuration has not been
built

2. Browse to a build artifact containing symbolic information
3. Reload information from the currently loaded build artifact
« this may be required when a project is rebuilt from changed sources
4. Open the Map file associated with with the currently selected build artifact
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18.6.1

« this file will open up within the editor view where helps
navigation
5. Open the Linker Script (.Id file) associated with the currently selected build artifact
« this file will open up with the editor view where helps

navigation and understanding
6. Enable/Disable C++ name mangling
« this uses the c++filt binutils application to demangle C++ symbols from the view
« all (mangled) items from the view will be affected — not only the current selection
7. Toggle between sizes in bytes and larger units (KB, MB etc.)

8. Click to compare with contents from another (new) Image Info view using the standard Eclipse
compare utility

¢ to use this feature, create a second Image Info view and load with another image, object
etc. click compare in both views

9. Copy highlighted information to the clip board
« copied information is held in .tsv format with the table headers added to the selection

Tip
@ These options are also available from a right click menu within the Image Info view

Also highlighted is the searchffilter button, this can be used to switch between the highlighting
of lines containing an entered search item and only displaying matching lines. This feature can
be useful to remove clutter from large groups of items.

Note: information from highlighted lines is shown in the Properties view

The Image Information view (usually) consists of 3 sub views offering — Memory Usage, Memory
Contents and (static) Call Graph information.

Memory Usage

The Memory Usage view shows how much memory (Flash and RAM) is used by the associated
build artifact.

\Memory Usage Memory Contents | Call Graph

Region

€ PROGRAM_FLASH Ox0 0x100000 1MB 998.65 KB 25.35 KB 2.48%
ofe! SRAM_UPPER 0x20000000 0x20030000 192 KB 183.73 KB 8.27 KB 4.31%
i1 SRAM_LOWER 0x1fff0000 0x20000000 64 KB 64 KB 0B 0.00%
it FLEX_RAM 0x14000000 0x14001000 4 KB 4KB 0B 0.00%

Figure 18.5. Image Info Mem Usage

Start address End address Size Free Used Usage (%)

MCUXpresso IDE User Guide -

The memory regions displayed will be the same as the selected project’s build artifact (typically
a project’s generated elf (.axf) file. The detailed information is broadly the same as that provided
by the Linker --print-memory-usage switch however, this view can be used to easily compare
memory usage from one build to another following code changes, improvements, different build
configurations etc.

Note: The Memory Usage tab will not be displayed in the following situations:

¢ A not-yet-linked file (*.0) was processed
e A static library (*.a) was processed

¢ A build artifact from outside the current workspace was processed — memory regions cannot
be obtained in this case
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18.6.2 Memory Contents

The Memory Contents view provides a detailed view of the contents of each memory region. The
image below shows various linker sections distributed within the memory regions.

Memory Usage |Memory Contents| Call Graph|
| Name Run address Load address Size Type
¥ € PROGRAM_FLASH 0x0 1MB memory region
| rEtex ox0 25.34 KB section
> Iz data 0x20000000 0x6568 168 section
| i .data_RAM2 0x1fff0000 0x6568 08 section
i .data_RAM3 0x14000000 0x6568 08 section
| > eaBSt 0x0 0B section
it SRAM_UPPER 0x20000000 192 KB memory region
| > .data 0x20000000 0x6568 168 section
> I bss 0x20000010 2648 section
| > & .uninit RESERVED 0x20000000 0B section
> 1 .noinit 0x20000118 08 section
| > heap 0x20000118 aK8 section
= .heap2stackfill 0x20001118 ak8 section
‘ > & .stack 0x2002f000 0B section
> I *ABS® 0x0 08 section

Figure 18.6. Image Info Mem Contents

Double clicking or pressing the Enter key on any selected symbol will open its definition.

€| startup_mk64f12.c 22

6= __attribute__ ((used,section(" Flash[c fig")}) comst struct {
77 unsigned int wordl;
unsigned int word2;
unsigned int word3;
unsigned int word4;
} F'Lash Coan.g = {GxFFFFFFFF BxFFFFFFFF exFFFFFFFF BxFFFFFFFE}

Memory Usage Memory Contents Call Graph

Name Run address Load address Size Type
» DMA7_DriverlIRQHandler Ox262 2B weak function
— - s — 0B global
> _Flash _Confi 0x400 16 8B global object
o CLACLI SOMICIS CAIN MsAan no Jato)

Figure 18.7. Image Info Mem Symbol linkage

Note: If a symbol cannot be found within the sources, for example the symbol is within a C library
function, a message will be displayed in the Eclipse’s status bar.

Selecting multiple lines within this view will total their memory usage.

[3 items selected, totalling 6 / Ox6 bytes (6 B) ]

‘ Memory Usage W Call Graph |

| Name i Run address Load address S‘\ze
‘ @ errno 0x2000010c
| cogxAngle 00000 |0x20000110 —_
l _ -gyangle 10x20000112 __
» g_xDuty 0x20000114

\—!m_ 0x20000116 —_

Figure 18.8. Image Info Mem Size

18.6.3 Call Graph

The Call Graph tab shows the static stack cost for the selected build artifact as generated via
the -fstack-usage compiler option. The generation of Stack Usage information is now a default
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option within MCUXpresso IDE version 11.0.0 but can be controlled via the Workspace project

property shown below:

Settings i i
¥ Resource
Builders . . oo - -
Configuration: = Debug [ Active ] Manage Configurations...
C/C++ Bulld 2 g B
Build variables
Environment
Logging . W #Build steps Build Artifact  |sw Binary Parsers @ Error Parsers
MCU settings
Settings ¥ ¥ MCU C Compiler Other flags -¢ -ffunction-sections -fdata-sections -ffreestanding -
Tool Chain Editor 2 Dialect
» C/C++ General E G Verbose (-v)
MCUXpresso Config Too ®includes Support ANSI programs (-ansi)

Project Natures
Project References
Run/Debug Settings
Task Tags

» Validation

(% Optimization
(% Debugging
(% Warnings
£ Miscellaneous
(2 Architecture

| v By MCU Assembler

Figure 18.9. Image Info Call Graph Enable

Position Independent Code (-fPIC)
Library headers = Redlib (Auto)

Generate Stack Usage Info (-fstack-usage)

This option enables the generation

of .su (stack usage) files by the compiler and these are

consumed (along with other information) to populate the Call Graph view. Note: the generation
of these additional files has minimal impact on project build times.

If a project has been built and loaded, the call graph information for the selected build
configuration will be available. Below is a truncated view of a call graph display, expanded and
highlighted to display the main() function.

Memory Usage | Memory Contents |Call Graph,

Function Depth Location Type Local Cost Full Cost Comment
¥ @ ResetlSR 17 startup_mk64£12.c:461 static 8B & 256 B
» @ Systeminit 1 system_MK64F12.c:130 static 8B 128
v main 16 ? /2488 No available stack cost information (library...
¥ & main 15 bubble.c:244 static 728 /4, 248 B
| v - BOARDnitPins 11 lpinmuxc:77 ____ |static 88 _____Jaz8 |
CLOCK_EnableClock ¢} fsl_clock.h:692 static 248 248
PORT_SetPinMux 0 fsl_port.h:371 static 248 248
BOARD_InitDebugConsale 13 board.c:43 static 168 176 B

""" i s 27
0 startup_mk64f12.c:436
> 9 board.c:104
» © BOARD_Accel_12C_Receive 9 beard.c:111
4]

P = exception handlers

Figure 18.10. Image Info Call Graph

static 0B
static 408 1688
static 328 160B
? 408 No available stack cost information (library...

In this view, the columns have the following meaning:

¢ Function: displays the function name
¢ Depth: displays the maximum call depth
« where N means the function has at least 1 child with a depth of N-1

+ and 0 means there are no child functions

 Location: function location within the source (file:line)

« this will be empty if no source is found

e Type: show static or dynamic allocation type
¢ Local Cost: shows the number of bytes allocation by the function itself
¢ Full Cost: shows the number of bytes allocation by the function itself plus that of the deepest

child function

« Comment: shows additional information such as recursive calls

Within the view, symbols are coloured to indicated meaning:

MCUXpresso IDE User Guide -
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Memory Usage Memory Contents |Call Graph

Function Depth Location Type Local Cost Full Cost Comment

PR 16 ? 4, 248B No available stack cost information (library
¥ = main 15 bble.c:260 static 728 & 2488
# _aeabi_d2iz (o] ? 0B No available stack cost information (library
¥ ™ecursivefunc 1 bubble.c:98 static 168 &16B
457 L, Ruanle.c00. il 168 0B Recursive call found, the cost will not cons
i OV > main tic 168 PTe-

O # __aeabi_d2iz

O ¥ @ recursivefunc
44 recursivefunc

Figure 18.11. Image Info Call Graph Display Types

18.7

MCUXpresso IDE User Guide -

1. A symbol in black can be double clicked to open the associated source code
2. A symbol in gray has no associated source information
« this might indicate an assembly or library symbol

3. A symbol with circular arrows indicates it has a recursive call and so its stack costs cannot
be added to teh fill cost

4. exception handlers in grey (not show) will group any root symbol with a Handler suffix

Finally, if for an reason Call Graph information may be limited or stale, clear self describing
warnings will be displayed.

Enhanced Syntax Highlighting

New in MCUXpresso IDE version 11.0.0 is additional editor capability delivering Enhanced
Syntax Highlighting for GNU Linker Script .Id files (also Linker Script template and .map files).
The primary goal of these enhancements is to simplify the exploration of these files and also ease
the manual creation of Linker Script files for situations where MCUXpresso IDE’s auto generated
linker script mechanism cannot support the required configuration.

The new editor will be invoked automatically by double clicking on .Id, .Idt or .map file within the
project explorer view.
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i Project Explor 82 . Peripherals+ iii Registers % Fau
5% @9
v == frdmk64f_bubble
» € Project Settings
i 4;-?' Binaries
¥ ) Includes
» B2 CMSIS
» 2 accel
2 board
2 component
2 device
B drivers
2 source
Esrc
(= startup
(£ utilities
= Debug
» (= accel
» (= board
» (= component
» (= device
» (=drivers
» (= source
» = startup
» = utilities

4 V¥ ¥y Y Y YYVYY

S frdmk64f_bubble_Debug_library.ld

S frdmk64f_bubble_Debug_memory.ld

S frdmk64f_bubble_Debug.ld
frdmk64f_bubble.map

Figure 18.12. Project Build Configuration Files

Note: these files are automatically generated by the
for the selected build configuration when a project is built

Once a file is opened as below, a number of features are available.
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4 frdmk64f_bubble_Debug.ld 22

'.-l/x
GENERATED FILE - DO NOT EDIT
Copyright (c) 2008 - 2013 Code Red Technologies Ltd,
Copyright 2015, 2818 NXP
(c) NXP Semiconductors 2013-2019
Generated linker script file for MKG64FN1M@xxx12
Created from linkscript.ldt by FMCreatelinkLibraries
Using Freemarker v2.3.23

=W
*

L A I S

-

INCLUDE] " frdmk64f_bubble_Debug_library.1d"
INCLUDE] " frdmk64f_bubble_Debug_memory. ld"

ENTRY({ResetISR)
= SECTIONS
{

/% MAIN TEXT SECTION =/
.text : ALIGN(B)
{

288

FILL(BXTf)

__vectors_start__ = ABSOLUTE(.) ;
KEEP

/* Global Section Table */

. = ALIGN(4) ;
__section_table_start = .;
__data_section_table = .;
LONG(LOADADDR(.data));

LONG
LONG

LONG(
LONG(

LONG(
LONG(

ADDR(.data));
SIZEOF(.data));

LONG(LOADADDR (. data_RAM2) );

ADDR(.data_RAM2));
SIZEOF(.data_RAM2));

LONG (LOADADDR (. data_RAM3) );

ADDR(.data_RAM3));
SIZEOF(.data_RAM3));

__data_section_table_end = .;

39 __bss_section_table = .;

LONG(
41 LONG(
42 LONG(
43 LONG(
14 LONG(
LONG(

ADDR(.bss));
SIZEOF(.bss));

ADDR(.bss_RAMZ));
SIZEOF(.bss_RAMZ));

ADDR(.bss_RAM3) ) ;
SIZEOF (.bss_RAM3));

__bss_section_table_end = .;
__section_table_end = . ;
/* End of Global Section Table %/

Figure 18.13. Linker Description file

MCUXpresso IDE v11.0.@_alpha [Build 2495] [2019-85-15] on 19-May-2019 15:54:07

Include files and Symbols source (as highlighted) can be opened in a new editor view via CTRL

+ Click (CMD + Click for Mac) on their filename.

The Editor also provides context aware code completion accessible by pressing CTRL + SPACE.

17+ SECTIONS
19 /% MAIN TEXT SECTION =/
ALIGN(8)

20 .text :
21 {

=
LO "'=PROVIDE

L = PROVIDE_HIDDEN
L0:=quap

| QHORT

Lg

Figure 18.14. Auto Completion

MCUXpresso IDE User Guide -

The editor also provides error checking — validating that any changes are in accordance with

the linker script syntax.
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17 SECTIONS
18 {
19 /% MAIN TEXT SECTION %/
20= .text : ALIGN(B)
37 i
22
0 23 FILL(@xff)
pais —V —STart__ = ABSOLUTE(.) ;
25 KEEP( )
26 /* Global Section Table =/

Figure 18.15. Error Checking Syntax

Furthermore, INCLUDE paths are verified and any error shown as below.

- F FLUAYTESSU LULC VIL.U.Y_dlipild [DULW £93J] LZY%
10/

L; INCLUDE "frdmk64f_bubble_Debug_library.1d"

|
17 ENTRY(ResetISR)

Figure 18.16. Error Checking Files

Error markers will be shown on the navigation bar and in the title of the editor window.

The Outline view displays an outline of the file that is currently open in the editor area.

MCUXpresso IDE User Guide - All information provided in this document is subject to legal disclaimers © 2019 NXP Semiconductors. All rights reserved.

User Guide Rev. 11.0.0 — 23 May, 2019

171



NXP Semiconductors

MCUXpresso IDE User Guide

SN W

oo~

10

at

[

B L L W L L L L W W
O 6o =l 5 LN e L R

&4 frdmk641_bubble_Debug.ld &

Figure 18.17. Linker Description Outline association Id

/*
* GENERATED FILE - DO NOT EDIT
* Copyright (c) 2888 - 2013 Code Red Technologies Ltd,
# Copyright 2015, 2018 NXP
* (c) NXP Semiconductors 2013-2019 5= Outline £3
* Generated linker script file for MKG64FNIM@xxx¥
% Created from linkscript.ldt by FMCreateLinkLiff Y '=frdmk64f bubble Debug
* Using Freemarker v2.3.23 U frdmk64f_bubble_Debug_library.ld
:/MCUXpressu IDE v11.0.0 alpha [Build 2495] [203 L frdmk64f_bubble_Debug_memory.Id
= ResetISR
INCLUDE "frdmk&4f_bubble_Debug_library.ld" v EISECTIONS
INCLUDE "frdmk64f_bubble_Debug_memory. ld » ©.text
> =@ .text
ENTRY (ResetISR) » = .ARM.extab
SECTIONS ] *exidaqtart
{ » & . ARM.exidx
/% MAIN TEXT SECTION */ = _exidx_end
+.:text + ALIGN(8) . _etext
FILL(@xff) » ©.m_usb_data
__vectors_start__ = ABSOLUTE(.) ; » = .data_RAM2
KEER (et AsE vertac)) » ©.data RAM3
/% Global Section Table */ i
. = ALIGN(4) ; » & .uninit_RESERVED
7:e:t:inn7:§blei5;:rt =.; » ©.data
__data_section_table = .;
LONG(LOADADDR (. data) ) ; > ©.bss RAM2
LONG( ADDR(.data)); » ©.bss_RAM3
LONG( SIZEOF(.data)); » ®.bss
LONG (LOADADDR(.data_RAM2)); init RAM?2
LONG{  ADDR(.data_RAMZ)); . S.ncinit. RAM
LONG( SIZEOF(.data_RAM2)); » ®.noinit_RAM3
LONG(LOADADDR( . data_RAM3)); » © .noinit
LONG( ADDR(.data_RAM3)); .
LONG( SIZEOF(.data_RAM3)); | _HeapSize
__data_section_table_end = .; » =.heap
__bss_section_table = .; StackSi
TONG(~  ADDR(.bss}); S
LONG( SIZEOF(.bss)): » © .heap2stackfill
LONG( ADDR(.bss_RAM2) ) ; » ©.stack
LONG( SIZEOF(.bss_RAM2)); i
LONG( ADDR(.bss_RAM3) ) ; = _‘\mage_start
LONG( SIZEOF(.bss_RAM3)); = _jmage_end
E b.ﬁ,Liqcmmtauls¢nd,.z4..;*1 = _image_size

This is particularly useful for navigations through complex auto generated .map files
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[ frdmk64f_bubble.map &2

30

LU B W N

=)

10

|
= /Applications/MCUXpressoIDE_11|

7= /Applications/MCUXpressoIDE_11|

/Applications/MCUXpressoIDE_11,

i
/Applications/MCUXpressoIDE_11|

/hppluatiuns/ﬂcuxpressoIDE_llj
58 /Applications/MCUXpressuIDEﬁlli
: hhppli(atinnslMCUXpressoIDE_ll‘\
/Appllcations/MCHXpressnIDEAlli‘
hhppli:ationslMCuXpressoIDE_l]:

1
/Applications/MCUXpressoIDE_11|

1= Archive member included to satisfy reference by file (symbol)
/Applications/MCUXpressoIDE_11.0.0_2495_alpha/ide/p ggéns/gom.n{(p:mcuxpresso.too‘.s.li

- /Applications/MCUXpressoIDE_11, o= Outline £

rdmk64f_bubble

9= /Applications/MCUXpressoIDE_11,  * ©Discarded input sections
‘

v ﬁMemory configuration
CJPROGRAM_FLASH
ISRAM_UPPER
LJSRAM_LOWER
LIFLEX_RAM
O*default*

|
17= /Applications/MCUXpressoIDE 11y i=|inker script and memory map

» (=LOAD DIRECTIVES
» ® SYMBOLS

/Applications/MCUXpressoIDE_11, v = SECTIONS
text (Address: 0x0000000000000000; Size: 0x74e8)
-glue_7 (Address: OxO0000000000074e8; Size: Ox0)
.glue_7t (Address: 0x00000000000074e8; Size: 0x0)
~vfp11_veneer (Address: 0x00000000000074e8; Size: 0x0)
v4_bx (Address: 0x00000000000074e8; Size: 0x0)

.iplt (Address: Ox00000000000074e8; Size: 0x0)

.rel.dyn (Address: 0x0000000000007 4e8; Size: 0x0)

EEEES

-ARM .extab
ARM.exidx
.m_usb_data

EEEEEE

-

Figure 18.18. Map file Outline association map

v
» B Archive members

.data_RAM2 (Address: 0x000000001fff0000; Size: Ox0)
.data_RAM3 (Address: 0x0000000014000000; Size: 0x0)
.uninit RESERVED (Address: 0x0000000020000000; Size: 0x0)
.data (Address: 0x0000000020000000; Size: 0x10)

.igot.plt (Address: Ox0000000020000010; Size: 0x0)

=0

MCUXpresso IDE User Guide -
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Right clicking within the outline view will allow the opening of related source files.

Finally, if required, colours used for syntax highlighting can be configured Preferences ->
MCUXpresso IDE -> Editor Awareness as below.
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e 8 Preferences

Syntax Coloring S v w

*General
FCiC++
*Help
*Install/Update
¥ Java
» Library Hover
MCUXpresso Config Tools
TMCUXpresso IDE
Debug Options (Advanced)
Debug Options (Miscellaneous)
Debug Probe Discovery
Default Tool settings
¥ Editor Awarenass
¥ GNU Linker Script

Token Styles

Comment

Default

Input section

Keyword

Memory region
Punctuation character
Section

String

Symbal

Color | |

Background [

Style

Bold
Strike through

Italic

Underline

Change...

Fant Menlo-regular-12

¥Linker Script Template
Syntax Coloring

¥Map File
Syntax Coloring

General

J-Link Options
LinkServer Opticns
LPC-Link Options
MCU settings

Paths and Directories
PEMicro Options

Restore Defaults

) g 175 Cancel

= &

Figure 18.19. Editor Awareness Syntax Highlighting Preferences

18.8

18.8.1
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Other Options affecting the Generated Image

LPC MCUs — Code Read Protection

Most of NXP’s LPC Cortex-M based MCUs which have internal Flash memory contain “Code
Read Protection” (CRP) support. This mechanism uses one of a number of known values being
placed in a specific location in Flash memory to provide a number of levels of protection. When
the MCU boots, this specific location in Flash memory is read and depending upon its value, the
MCU may prevent access to the Flash memory by external devices. This location is typically at
0x2FC though for LPC18xx/43xx parts with internal Flash, the CRP location is at an offset of
0x2FC from the start of the Flash bank being used.

CRP : Preinstalled MCUs

Support for setting up the CRP memory location is provided via a combination of the Project
Wizard, a header file and a number of macros. This support allows specific values to be easily
placed into the CRP memory location, based on the user’s requirements.

The New Project wizard contains an option to allow linker support for placing a CRP word to be
enabled when you create a new project. This is typically enabled by default. This wizard option
actually then controls the “Enable CRP” checkbox of the Project Properties linker Target tab.

In addition, the wizard will create a file, ‘crp.c’ which defines the ‘CRP_WORD’ variable which will
contain the required CRP value. A set of possible values are provided by the NXP/crp.h header
file that this then includes. Thus for example ‘crp.c’ will typically contain:

#i ncl ude <NXP/crp. h>
__CRP const unsigned int CRP_WORD = CRP_NO CRP ;

which is then placed at the correct location in Flash by the linker script generated by the managed
linker script mechanism:
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. = 0x000002FC ;
KEEP(* (. crp))

Note: the value CRP_NO_CRP ensures that the Flash memory is fully accessible. When you
reach the stage of your project where you want to protect your image, you will need to modify
the CRP word to contain an appropriate value.

Important Note: You should take particular care when modifying the value placed in the CRP
word, as some CRP settings can disable some or all means of access to your MCU (including
debug). Before making use of CRP, you are strongly advised to refer to the User Manual for the
LPC MCU that you are using.

CRP : MCUs installed by Importing an SDK

The support for CRP in LPC parts imported into MCUXpresso IDE from an SDK, is generally
similar to the Preinstalled MCUs. However rather than having a separate crp.c file, the
CRP_WORD variable definition is generally found within the startup code.

Kinetis MCUs — Flash Config Blocks

Kinetis MCUs provides an alternative means of protecting the user’s image in Flash using the
Flash Configuration Block. The Flash Configuration Field is generally located at addresses
0x400-0x40F and unlike the LPC CRP mechanism only specific values give access, whereas
any other values are likely to lock the part.

The value of the Flash Configuration block for a project is provided by the following structure
which will be found in the startup code:

_attribute__ ((used,section(".FlashConfig"))) const struct {
unsi gned int wordi;
unsi gned int word2;
unsi gned int word3;
unsi gned i nt word4;

} Flash_Config = {OxFFFFFFFF, OXFFFFFFFF, OxFFFFFFFF, OxFFFFFFFE};

which is then placed appropriately by the linker script generated by the managed linker script
mechanism.

/* Kinetis Flash Configuration data */

. = 0x400 ;

PROVI DE(__FLASH CONFI G START__ = .) ;

KEEP(* (. Fl ashConfi g))

PROVI DE(__FLASH CONFIGEND = .) ;

ASSERT(! (__FLASH CONFI G START __ == _ FLASH CONFI G END ),
"Li nker Flash Config Support Enabl ed, but no .Fl ashConfig
section provided within application");

/* End of Kinetis Flash Configuration data */

Important Note: The support for placing the Flash Configuration Block can be disabled by
unticking a checkbox of the Project Properties linker Target tab. However this is generally not
advisable as it is very likely to result in a locked MCU.
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» C/C++ General

[ ] Properties for MKG4FN1MOxxx12_Project
Settings Le=1" .-
» Resource
Builders % A : = P 2
Configuration: = Debug [ Active ] Manage Coenfigurations...
vC/C++ Build v = -~

Build Variables
Environment

Logging ¥ | #Build steps Build Artifact | Binary Parsers @ Error Parsers
MCU settings
Settings ¥ i3 MCU C Compiler Manage linker script

Tool Chain Editor

i
(% Dialect

Linker script

MCUXpresso Config Too
Project Natures

Project References
Run/Debug Settings
Task Tags

(Eincludes Script path
(2 Optimization
# Debugging
(& Warnings
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Figure 18.20. Linker Settings
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Placement of USB Data

For MCUs where part support is imported from an SDK, the managed linker script mechanism
supports the automatic placement of USB global data (as used by the SDK USB Drivers),
including for parts with dedicated USB_RAM (small or large variants).

Plain Load Image

The LPC540xx family provides no built-in flash, but rather offers a quad SPI Flash Interface
(SPIFI) so that external flash can be used. The most straight forward way of using external flash
is that the image is built to be programmed into the external flash and executed directly from the
same location (XIP — eXecute In Place).

However the LPC540xx boot rom also offers an alternative way of using the external flash — such
that the application is programmed into the flash, but the boot rom will relocate it into a bank of
the onboard SRAM for execution. Generally it is expected that the SRAMX bank (at address 0x0)
will be used for this. An application that runs in this manner is known as a “plain load image”.

MCUXpresso IDE’s managed linker script mechanism offers a simple way of configuring an
application project so that it will build as a plain load image. This can be controlled for a particular
build configuration via:
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Project -> Properties -> C/C++ Build -> Settings -> Tools Settings -> MCU Linker -> Managed
Linker Script

¥ i MCU Assembler Link application to RAM

i) ) N =

QG"”?‘Q' Plain load image SRAMX i
(*2 Architecture & Headers ,

L ﬁ:' MCU Linker H Generate an image suitable for relocating by a Style ﬁ
ﬁﬁ? General bootloader from its load address in Flash to an
(® Libraries g execute address in RAM - such aslthu "plain

load image” on the LPCEA0xx devices
Region Location Size
Heap Default Post Data Default
Stack Default End Default

(# Miscellaneous

(% Shared Library Settings
(& Architecture

[ Managed Linker Script
& Multicore

Figure 18.21. Plain Load Image

Please see also the shortcuts.

Enabling the “Plain load image” option will:

1. Modify the generated linker script so that the main code section is located so that it will be
programmed into flash, but expect to be copied into specified RAM bank by the boot rom
before being executed

2. Modify the startup code, using symbols provided from the generated linker script, so that the
appropriate data is placed into the image so that the boot rom know that it needs to relocate
the image from flash into RAM.

Note 1: This functionality requires the application project to be based on the LPC540xx part
support from SDK v2.4.0 (or later).

Note 2: The size of the application image (including the initialised global data) must be less than
the size of the RAM bank that the code will execute from.

Note 3: LPC540xx supports plain load images being executed from either address 0x0 or address
0x20000000. However if the RAM at 0x20000000 is used then the debugger will not be able to
stop on the default breakpoint on main(). This is because a hardware breakpoint needs to be
used (as the copying of the code from flash into RAM by the boot rom would overwrite a software
breakpoint), but the Cortex-M4 cannot set a hardware breakpoint this high in the memory map.

18.8.5 Link Application to RAM

The MCUXpresso IDE managed linker mechanism defaults to placing the code and initialised
data values to first Flash region listed within a projects memory configuration as discussed in the
section.

On occasion, it can be useful to debug a project directly from RAM since this offers some benefits
such as avoiding the flash programming element of the debug session etc. Linking to RAM could
be achieved by deleting the Flash memory regions from the projects memory configuration and
rebuilding the application — however this is not the most convenient approach!

Therefore MCUXpresso IDE offers the option to tell the managed linker script mechanism to
simply ignore any flash regions listed in the projects memory configuration via a simple checkbox
at:

Project -> Properties -> C/C++ Build -> Settings -> Tools Settings -> MCU Linker -> Managed
Linker Script

MCUXpresso IDE User Guide - All information provided in this document is subject to legal disclaimers © 2019 NXP Semiconductors. All rights reserved.

User Guide Rev. 11.0.0 — 23 May, 2019 177




NXP Semiconductors MCUXpresso IDE User Guide

¥ 5 MCU Assembler

18.9

18.10

MCUXpresso IDE User Guide -

(EGeneral Link application to RAM
(2 Architecture & Headers R
¥ B3 MCU Linker Link all sections to RAM (i.e. ignore Flash)
2 General
(B Libraries Heap and Stack placement = MCUXpresso Style ﬁ
kj'\ijiscaHanlenus . Stack offset 0
(#2Shared Library Settings
g#\rchi!ecture Region Location Size
(¥:Managed Linker Script Heap Default Post Data Default
(2 Multicore Stack Default End Ox4
Figure 18.22. Link to RAM
Please see also the shortcuts.

With this option is set, the application will instead link to the first RAM region listed within the
projects memory configuration.

There are two important considerations when developing with RAM based projects:

1. They require support from the debug environment to be run and so may not execute in the
exactly the same manner as a true application running from an MCU reset. Please see the
section for more information. Please note: if you are
using debug solutions other than LinkServer, additional user setup may be required.

2. Unlike project running from Flash, global variable load and execute addresses will by default
be the same. The consequence of this is that global variables values will persist at their
current value if an application is restarted. Therefore this is not recommended, and instead a
restart should be achieved by terminating and restarting the whole debug session. See also:

Note: Some MCU/development boards make use of SDRAM. These memories are typically
initialised by the MCU BootROM during reset and this initialisation may require user supplied
configuration data to be programmed into flash. Therefore you must ensure that any SDRAM
regions are correctly initialised before they are used for RAM based debug operations.

Modifying the Generated Linker Script / Memory Layout

The linker script generated by the managed linker script mechanism will be suitable for use,
as is, for many applications. However in some circumstances you may need to make changes.
MCUXpresso IDE provides a number of mechanisms to allow you to do this whilst still being able
to use the managed linker script mechanism. These include:

¢ Changing the layout and order of memory using the Memory Configuration Editor
¢ Changing the size and location of the stack and heap using the Heap and Stack Editor

« Decorating the definitions of variables and functions in your source code with macros from the
cr_section_macros.h to cause them to be placed into different memory blocks

« Providing project specific versions of FreeMarker linker script templates to change particular
aspects of how the managed linker script mechanism creates the final linker script

The following sections describe these in more detail.

Using the Memory Configuration Editor
The Memory Configuration Editor is accessed via the MCU settings dialog, which can be found at
Project Properties -> C/C++ Build -> MCU settings

This lists the memory details for the selected MCU, and will, by default, display the memory
regions that have been defined by MCUXpresso IDE itself (from installed or SDK part support).
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Figure 18.23. LPC4337... default memory regions

18.10.1 Editing a Memory Configuration

In the example below, we will show how the default memory configuration for an LPC4337... can
be changed.

Introduced in MCUXpresso IDE version 10.3.0, the memory configuration can simply be edited
in place to create the desired memory map.
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Default LinkServer Flash Driver LPC18x7_43x7_2x512_BootA.cfx Browse...
Type Name Alias Location Size Driver —
Flash MFlashA512 Flash 0x1a000000 0x80000 L
Flash MFlashB512 Flash2  0x1b000000 0x80000 B
RAM RamLoc32 RAM 0x10000000 0x8000 -
RAM RamLoc40 RAM2 0x10080000 Oxa000

RAM RamAHB32 RAM3 0x20000000 0x8000

RAM RamAHB16 RAM4 0x20008000 0x4000

RAM RamAHB_ETB16 RAMS 0x2000c000 0x4000

Add Flash Add RAM Split Delete

Import... Merge... Export... Generate...

Figure 18.24. Memory configuration editor

Known blocks of memory, with their type, base location, and size are displayed. Entries can be
created, deleted, etc by using the provided buttons.

For simplicity, the additional memory regions are given sequential aliases, starting from 2, so
RAM2, RAMS etc (as well as using their “formal” region name — for example RamAHB32).

Table 18.1. Memory editor controls

Button
Add Flash
Add RAM
Split

Join
Delete
Import

Merge

Export
Up / Down

Generate
Driver

Browse(Flash driver)

Details

Add a new memory block of the appropriate type.

Add a new memory block of the appropriate type.

Split the selected memory block into two equal halves.

Join the selected memory block with the following block (if the two are contiguous).
Delete the selected memory block.

Import a memory configuration that has been exported from another project,
overwriting the existing configuration.

Import a partial memory configuration from a file, merging it with the existing memory
configuration. This allows you, for example, to add an external Flash bank definition
to an existing project.

Export a memory configuration for use in another project.

Reorder memory blocks. This is important: if there is no Flash block, then code will
be placed in the first RAM block, and data will be placed in the block following the
one used for the code (regardless of whether the code block was RAM or Flash).
Generates local part support for the selected MCU.

Highlighted in blue, shows the selection of a per-Flash region Flash driver. Click
this field to see a drop down of all available drivers. Please see:

Select the appropriate driver for programming the Flash memory specified in
the memory configuration. For more information please see the section on

MCUXpresso IDE User Guide -

The name, location, and size of this new region can be edited in place. Note: When entering
the size of the region, you can enter full values in decimal or in hex (by prefixing with ox), or by
specifying the size in kilobytes or megabytes. For example:

e To enter a region size of 32KB, enter 32768, 0x8000 OF 32k.
e To enter a region size of 1MB, enter 0x100000 Of 1m

Note: Memory regions must be located on four-byte boundaries, and be a multiple of four bytes

in size.
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The screenshot below shows the dialog after the “Add Flash” button has been clicked. Use
the highlighted up/down buttons to move this region to be top in the list. This action forces the
MCUXpresso IDE’s managed linker script mechanism to link against this new flash region.

Default LinkServer Flash Driver LPC18x7_43x7_2x512_BootA.cfx

Browse...

Type Name Alias Location Size Driver

Flash  MFlashA512 Flash 0x1a000000 0x80000

Fl FlashB512 Flash2 1

| Flash Flash_00 Flash3 Ox1b080000 0x400 |

RAM  RamlLoc32 RAM 0x10000000 0Ox8000

RAM  RamlLoc40 RAM2 0x10080000 0xa000

RAM  RamAHB32 RAM3 0x20000000 0x8000

RAM  RamAHB16 RAM4 0x20008000 0x4000

RAM RamAHB_ETB16 RAMS 0x2000c000 0x4000
Add Flash Add RAM Split Delete
Import... Merge... Export... Generate...

Figure 18.25. Effect of Add Flash

@

Tip

Once a change has been made, ensure a mouse click is made outside any
changed cell, this action will force the change to be recognised by Eclipse

Figure 18.26. U

Default LinkServer Flash Driver

Type

[Flash _ISPIFLIMB _____Flash __|0x14000000

Name

Allas

Browse...

Driver

LPC18_43_SPIFI_SFDP.cfx i

Size

0x100000

Location

Flash  MFlashA512 Flash2 0x1a000000 Ox80000 |LPC18x7_43x7_2x512 B... =
Flash MFlashB512 Flash3  0x1b000000 0x80000 {LPC18x7_43x7_2x512_B... |
RAM  RamLoc32 RAM 0x10000000 0x8000
RAM  RamLoc40Q RAM2 0x10080000 0xa000
RAM  RamAHB32 RAM3 0x20000000 0x8000
RAM  RamAHB16 RAM4 0x20008000 0x4000
RAM  RamAHB_ETB16 RAMS5 0x2000c000 0x4000
Add Flash Add RAM Split Delete
Import... Merge... Export... Generate...

pdated MCU settings
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Here you can see that the new region has been named SPIFI_1MB, its base address set to
0x14000000, its size to 1MB and the default Flash driver has been deleted and an SFDP SPIFI
driver selected for the newly created SPIFI_1MB region.

MCUXpresso IDE provides extended support for the creation and programming of projects that
span multiple Flash devices. In addition to a single default Flash driver, per region Flash drivers
can also be specified (as above). Using this scheme projects can be created that span Flash
regions and can be programmed in a single ‘debug’ operation.

Note: Once the memory details have been modified, the selected MCU as displayed on the
“Status Bar” (at the bottom of the IDE window) will be displayed with an asterisk (*) next to it.
This provides an indication that the MCU memory configuration settings for the selected project
have been modified.
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18.10.2

18.10.3

18.10.4

18.11

Device specific vs Default Flash Drivers

When a project is configured to use additional Flash devices via the Memory Configuration Editor,
the Flash driver to be used for programming that Flash device has to be specified in the Driver
column. Typically for a SPIFI device, this should be:

LPC18_43_SPIFI_GENERIC.cfx (for LPC18/LPC43 series MCUs)
LPC40xx_SPIFI_GENERIC.cfx (for LPC407x/8x MCUS)
LPC5460x_SPIFI_GENERIC.cfx (for LPC5460x MCUS).
« LPC540xx_SPIFI_GENERIC.cfx (for LPC540xx MCUSs).

For further information please also see the section on

Restoring a Memory Configuration

To restore the memory configuration of a project back to the default settings, simply reselect the
MCU type, or use the “Restore Defaults” button, on the MCU Settings properties page.

Copying Memory Configurations

Memory configurations can be exported for import into another project. Use the Export and Import
buttons for this purpose.

Global Data Placement

By default, global data items are located at run time in the ‘default’ memory region (i.e. the first
RAM block displayed in the memory configuration area).

However, MCUXpresso IDE version 10.2 introduced a mechanism to the Managed Linker Script
mechanism to allow the user to specify a specific memory region to be used for the global data,
without the need to change the order of the RAM blocks in the memory configuration editor.

This can be done via the Managed Linker Script page of Project Properties:

Figure 18.27. MCUXpresso IDE Global Data Placement

¥ &) MCU Linker Plain load image

(B General

B Libraries Heap and Stack placement = MCUXpresso Style ﬂ

#Miscellaneous Stack offset 0

(#2Shared Library Settings

g?Architecture Region Location Size

% Managed Linker Script Heap Default Post Data Default

(5 Multicore Stack Default End Default

¥ B MCU Debugger
#Debug
& Miscellaneous =
[ Global data placement Default <] ]

Extra linker script input sections 4 K

Input section description Region Section Type
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To change the memory region to be used, simply use the drop down box to select the memory
region you wish to locate the global data.

Note: the above placement of global data applies to global data items that are not explicitly placed
elsewhere in the memory map see:
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18.12 Modifying heap/stack placement

MCUXpresso IDE provides two models of heap/stack placement. The first of these is the
“LPCXpresso Style”, which is the mechanism provided by the previous generation LPCXpresso
IDE. This is the default model used for projects created for Preinstalled MCUs. The second model

is the “MCUXpresso style”. This is the default model used for projects created for MCUs imported
from SDKs.

The heap/stack placement model being used for a particular project/build configuration can be
modified by right clicking on the project and selecting:

Project Properties -> C/C++ Build -> Settings -> MCU Linker -> Managed Linker Scripts

Build Variables
Environment
Legging
MCU settings
Settings
Tool Chain Editor
» C/C++ General
MCUXpresso Config Too
Project Natures
Project References
Run/Debug Settings
Task Tags
» Validation

X # Build steps

¥ 3 MCU C Compiler
(2 Dialect
(2 Preprocessor
(EIncludes
(# Optimization
# Debugging
(# Warnings
(2 Miscellaneous
(& Architecture
¥ i MCU Assembler
(= General
(£ Architecture & Headers
¥ 3 MCU Linker
(¥ General
(£ Libraries
2 Miscellaneous
(2 Shared Library Settings
(2 Architecture
£ Managed Linker Script

[ NN ] Properties for MK64FN1MOxxx12_Project
Settings Le=1" .
» Resource
Builders > A . |~ : .
2 M Confi t
vC/C++ Build Configuration: = Debug [ Active ] H anage Configurations.

Build Artifact

) Binary Parsers @ Error Parsers

Manage linker script

Linker script
Script path
Enable automatic placement of Flash Configuration field in image

Library Redlib (semihost-nf) ﬂ

Link application to RAM

Plain load image SRAM_UPPER

Heap and Stack placement [ MCUXpresso Style

Stack offset 0

Region
Default

Location

Heap Post Data

(& Multicore Stack Default End

v 15 MCU Debugger
(#2Debug

# Miscellaneous

Size
Default
Default

Global data placement Default

Extra linker script input sections

Input section description Region Section Type

Restore Defaults Apply

©) Cangel

Figure 18.28. MCUXpresso IDE Linker Settings

In the dialogue above, highlights show the managed linker script option along with the selection
of the MCUXpresso Style scheme.

18.12.1 MCUXpresso style Heap and Stack

By default the heap and stack are placed in the “default” memory region (i.e. the first RAM block
displayed in the memory configuration area), with the heap placed after the application’s data
and the stack rooted at the top of this block.

MCUXpresso IDE User Guide -

User Guide

All information provided in this document is subject to legal disclaimers

Rev. 11.0.0 — 23 May, 2019

© 2019 NXP Semiconductors. All rights reserved.

183




NXP Semiconductors MCUXpresso IDE User Guide

However, using the Heap and Stack editor in Project Properties, it is very simple to individually
change the stack and heap locations (both the memory block used, and the location within that
block), and also the size of the memory to be used by each of them.

Region

e Default : Place into first RAM bank as shown in Memory Configuration Editor
« List of memory regions, and aliases, as show in Memory Configuration Editor

Location

e Start : Place at start of specified RAM bank.
e Post Data : Place after any data in specified RAM bank. Default for heap.
* End : Place at end of specified RAM bank. Default for stack.

Size

e Default: 1/16th of the memory region size, up to a maximum of 4KB (and a minimum of
128bytes). Hovering the cursor over the field will show the current value that will be used.

¢ Value : Specify exact required size. Must be a multiple of 4. Note: When entering the size of
the region, you can enter full values in decimal or in hex (by prefixing with 0x), or by specifying
the size in Kilobytes (or Megabytes). For example:
* To enter a size of 32KB, enter 32768, 0x8000 or 32k.
« Avalue of 0 can be entered to prevent any heap use by an application.

* Note: For semihosted printf to operate without any heap space, you must enable the
“character only” version. For Redlib, define the symbol “CR_PRINTF_CHAR” (at the
project level) and remove other semhosting defines such as CR_INTEGER_PRINTF.
Character only semihosted printf is significantly slower than the default version and may
display differently depending on your debug solution.

Note: The MCUXpresso style of setting heap and stack has the advantage over the LPCXpresso
style described below in that the memory allocated for heap/stack usage is also taken into
account in the image size information displayed in the Build console when your project is built.

18.12.2 LPCXpresso style Heap and Stack
By default the heap and stack are still placed in the “default” memory region (i.e. the first RAM
block displayed in the memory configuration area), with the heap placed after the application’s
data and the stack rooted at the top of this block.
To relocate the stack or heap, or provide a maximum extent of the heap, then the linker “--defsym”
option can be used to define one or more of the following symbols:
__user_stack_top
__user_heap_base
_pvHeapLim t
To do this, use the MCU Linker -> Miscellaneous -> Other Options box in Project Properties.
For example:
--defsym=__user_stack_top=__top_RAM?2
¢ Locate the stack at the top of the second RAM bank (as listed in the memory configuration
editor)
¢ Note: The symbol _ top RAM2 is defined in the project by the managed linker script
mechanism at:
<proj nane>_<bui | dconfig> nmem | d
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18.12.3

--defsym=__user_heap_base=__end_bss_RAM2
¢ Locate the start of the heap in the second RAM bank, after any data that has been placed there
--defsym=_pvHeapLimit=__end_bss_RAM2+0x8000

¢ Locate the end of the heap in the second RAM bank, offset by 32KB from the end of any data
that has been placed there

--defsym=_pvHeapLimit=0x10004000

¢ Locate the end of the heap at the absolute address 0x10004000

Reserving RAM for IAP Flash Programming

The IAP Flash programming routines available in NXP’s LPC MCUs generally make use of some
of the onchip RAM when executed. For example on the LPC1343 the top 32 bytes of onchip RAM
are used. Thus if you are calling the IAP routines from your own application, you need to ensure
that this memory is not used by your main application — which typically means by the stack.

However, with the managed linker script mechanism, it is easy to modify the start position of the
stack (remember that stacks grow down) to avoid this clash with the IAP routines. To do this go to:

Project Properties -> C/C++ Build -> Settings -> MCU Linker -> Manager Linker Script

and modify the value in the “Stack Offset” field from 0 to 32. This will work whether you are using
LPCXpresso style or MCUXpresso style of heap/stack placement.

) MCU Linker Plain load image SRAM_UPPER
(% General _
&2
= Libraries Heap and Stack placement  MCUXpresso Style ﬂ
(%2 Miscellaneous Stack offsat §|32 I
(%2 Shared Library Settings = =

é‘? Architecture Region Location Size

(%2 Managed Linker Script Heap Default Post Data Default

(5 Multicore Stack Default End Default

¥ £ MCU Debugger

(2 Debug

(#=Miscellaneous =
Global data placement Default ﬁ
Extra linker script input sections & K
Input section description Region Section Type

Figure 18.29. MCUXpresso IDE Linker Reserve Stack Space

18.12.4
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The value you enter in this field must be a multiple of 4.

You are also advised to check the documentation for the actual MCU that you are using to confirm
the amount of memory required by the IAP routines.

Stack Checking

Although, as described above, it is possible to define a size of memory to be used for the stack,
Cortex-M CPUs have no support for hardware stack checking. Thus if you want to automatically
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detect if the stack exceeds the memory set aside for it — other mechanisms must be used. For
example:

« ldentify a suitable memory region (or portion of one) that will fault for accesses below the
regions base address, then locate the stack as desired within this region and watch for a
possible fault

« Include code that sets the stack to a known value, and periodically checks whether the lowest
address has been overwritten

« When debugging, set a watchpoint on the lowest address the stack is allowed to reach
« Use the Memory Protection Unit (MPU) to detect overflow, on parts which implement one

18.12.5 Heap Checking

By default, the heap used by the malloc() family of routines grows upwards from the end of the
user data in RAM up towards the stack — a “one region memory model”.
When a new block of memory is requested, the memory allocation function _sbrk() will make a
call to the following function to check for heap overflow:

unsi gned __check_heap_overflow (void * new end_of _heap)
This should return:
e 1 - If the heap will overflow
¢ 0 - If the heap is still OK
If 1 is returned, Redlib’s malloc() will set errno to ENOMEM and return a null pointer to the caller
The default version of __check_heap_overflow() builtinto MCUXpresso IDE supplied C libraries
carry out no checking unless the symbol “_pvHeapLimit” has been created in your image, to mark
the end location of the heap.
This symbol will have been created automatically if you are using the MCUXpresso style of heap
and stack placement described earlier in this chapter. Or alternatively if using the LPCXpresso
style of heap and stack placements, you can use the --defsym option to set this.
If you wish to use a different means of heap overflow checking, then you can find a reference
implementation of __check_heap_overflow() in the file _cr_check_heap.c that can be found
in the Examples subdirectory of your IDE installation.
This file also provides functionality to allow simple heap overflow checking to be done by
looking to see if the heap has reached the current location of the stack point, which of course
assumes that the heap and stack are in the same region. This check is not enabled by default
implementation within the C library as it can break in some circumstances — for example when
the heap is being managed by an RTOS.

18.12.6 Checking the Heap from your Application

The symbol __end_of_heap indicates the current end of the heap and can be used by user code
to track heap usage. For instance:

extern unsigned int __end_of _heap;

end_of _heap = __end_of _heap;

nmyBuf f ptr=(ui nt 32_t*) mal | oc(20*si zeof (uint32_t));

new_end_of _heap = __end_of _heap;
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However it should be noted that the location this points to includes any last block that has been
free’d. In other words it effectively provides the maximal extent of the the heap so far, not the
end of the currently “active” last block.

Thus in some cases, if you check __end_of heap before calling malloc(), then again afterwards,
it is possible that the value will not change if the heap request can be fulfilled using the free'd
last block i.e. there is no need to extend the heap further. In certain cases, __end_of heap can
reduce, for example if a block at the end of the heap is freed and a smaller block is subsequently
allocated.

Placement of specific code/data Iltems

It is possible to make changes to the placement of specific code/data items within the final image
without modifying the FreeMarker linker script templates. Such placement can be controlled via
macros provided in an MCUXpresso IDE supplied header file which can be pulled into your
project using:

#i ncl ude <cr_section_nacros. h>

Alternatively Introduced in MCUXpresso IDE version 10.2, the managed linker script
mechanism now also provides a means of placing arbitrarily named code or data sections into a
specified memory region of the generated image and is described in the next section. (See also

Placing code and data into different Memory Regions

Unlike the macros provided by cr_section_macros.h (described later), this method does not
require any change to the source code declaring the affected code/data (which basically rename
the generated code/data sections to match the memory region name). And in many cases it can
avoid the need to provide project local FreeMarker linker script templates (described later in this
chapter).

To place the code or data, you simply need to add the details of the section nhame, the memory
region to place it in, and the type of the code/data, as per the below screenshot(s):

¥ B MCU Linker

( General Heap and Stack placement = MCUXpresso Style ﬂ

:“’ Libraries Stack offset 0

l';gi ;L:::lc:al.nii?:rs Settings Reden i i

:g’—?.ﬂrchitecture % . Heap Default Post Data Default

lgiwlaneged Linker Script Stack Default End Default

o

(= Multicore

v i) MCU Debugger

(#Debug =
Global data placement Default w
Extra linker script input sections & )
Input section description Region Section Type
*(NonCacheable.init) SRAM_DTC data
*(NonCacheable) SRAM_DTC .bss

Figure 18.30. Adding an Extra Linker Section
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which will modify the generated linker script to contain the sections specified in the appropriate
region:
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/* Main DATA section (SRAM_DTC) */
.data : ALIGN(4)
{

FILL(@xfF)

_data = . ;

*(wvtable)

*(NonCacheable . init)

. = ALIGN(4) ;
_edata = . ;
} > SRAM_DTC AT>BOARD_FLASH

R OV W S S N A A oY o o o o

/* MAIN BSS SECTION */
.bss : ALIGN(4)
{

*(NonCacheable)

*(COMMON)

. = ALIGN(4) ;

_ebss = .;

PROVIDE(end = .);
} > SRAM_DTC

Figure 18.31. Extra Linker Section Script

The second example graphic shows both the placement of a constant data table and also the
powerful technigue of specifying a project source folder and placing the entire contents of that
folder (flash2’s .text sections) into a chosen flash device. Using this scheme the user can drag
and drop source files within the project structure to choose which location will be used for their
linkage and so their flash storage.

Extra linker script input sections & %
Input section description Region Section Type
*(.big_const_data_table) ELASH2 .rodata
*flash2/*(.text*) FLASH2 Jtext

Figure 18.32. Adding an Extra Linker 2 Section

Note: that the format of the “input section description” is as detailed in the GNU Linker
documentation, which can be found within the IDE’s built-in help system :

Help -> Help Contents -> Tools (Compilers, Debugger, Utilities) -> GNU Linker -> Linker Scripts
-> SECTIONS Command -> Input Section Description

or directly in the online GNU documentation at:
https://sourceware.org/binutils/docs/ld/Input-Section-Basics.html

Also, this functionality only allows you to add sections to the linker script, not to remove something
that the managed linker script already puts in. Thus if you need to remove part of the generated
linker script’s contents — then you will still need to modify the underlying FreeMarker linker script
templates.

Finally, remember that the GNU linker script mechanism functions such that the first match
encountered for a section will win (not the best match found). Thus this mechanism is just a
request, not a guarantee. Always check the generated linker script and the map file output by
the link step to confirm the expected placement of sections. In some problem cases, you may
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be able to force the required placement by use of an EXCLUDE in one memory region, as well
as the section in the required region.

Placing data into different RAM blocks using Macros

Many MCUs provide more than one bank of RAM. By default the managed linker script
mechanism will place all of the application data and bss (as well as the heap and stack) into
the first bank of RAM.

However it is also possible to place specific data or bss items into any of the defined banks for the
target MCU, as displayed in the Memory Configuration Editor, by decorating their definitions in
your source code with macros from the cr_section_macros.h MCUXpresso IDE supplied header
file

For simplicity, the additional memory regions are named sequentially, starting from 2, so RAM2,
RAM3 etc (as well as using their “formal” region name — for example RamAHB32).

For example, the LPC1768 has a second bank of RAM at address 0x2007c000. The managed
linker script mechanism creates a data (and equivalent bss) load section for this region thus:

.data_RAM2 : ALI G\N(4)
{
FI LL(Oxff)
*(. dat a. $RAMR*)
* (. dat a. $RamAHB32*)
} > RamAHB32 AT>MFl ash512

To place data into this section, you can use the _ DATA macro, thus:

/] create an unitialised 1k buffer in RAM2
__DATA(RAMR) char data_buffer[1024];

Or the _ BSS macro:

/] create a zero-init buffer in RAM2
__BSS(RAMR) char bss_buffer[128];

In some cases you might need a finer level of granularity than just placing a variable into a specific
memory bank, and rather need to place it at a specific address. In such a case you could then
edit the predefined memory layout for your particular project using the “Memory Configuration
Editor” to divide up (and rename) the existing banks of RAM. This then allows you to provide a
specific named block of RAM into which to place the variable that you need at a specific address,
again by using the attribute macros provided by the “cr_section_macros.h” header file.

Noinit Memory Sections

Normally global variables in an application will end up in either a “.data” (initialized) or
“.bss” (zero-initialized) data section within your linked application. Then when your application
starts executing, the startup code will automatically copy the initial values of “.data” sections from
Flash to RAM, and zero-initialize “.bss” data sections directly in RAM.

MCUXpresso IDE’s managed linker script mechanism also supports the use of “.noinit” data
within your application. Such data is similar to “.bss” except that it will not get zero-initialized
during startup.

Note: Great care must be taken when using “.noinit” data such that your application code makes
no assumptions about the initial value of such data. This normally means that your application
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code will need to explicitly set up such data before using it — otherwise the initial value of such
a global variable will basically be random (i.e. it will depend upon the value that happens to be
in RAM when your system powers up).

One common example of using such .noinit data items is in defining the frame buffer stored in
SDRAM in applications which use an onchip LCD controller (for example NXP LPC178x and
LPC408x parts).

Making global variables Noinit

The linker script generated by the MCUXpresso IDE managed linker script mechanism will
contain a section for each RAM memory block to contain “.noinit” items, as well as the “.data”
and “.bss” items. Note: For a particular RAM memory block, all “.data” items will be placed first,
followed by “.bss” items, and then “.noinit” items.

However, normally for a particular RAM memory block where you are going to be put “.noinit”
items, you would actually be making all of the data placed into that RAM “.noinit”.

The “cr_section_macros.h” header file then defines macros which can be used to place global
variables into the appropriate “.noinit” section. First of all include this header file:

#i ncl ude <cr_section_nacros. h>

The _ NOINIT macro can then be used thus:

/] create a 128 byte noinit buffer in RAM2
__NO NIT(RAM2) char noinit_buffer[128];

And if you want “.noinit” items placed into the default RAM bank, then you can use the
__NOINIT_DEF macro thus:

/] create a noinit integer variable in the main bl ock of RAM
__NO NIT_DEF int noinit_var ;

18.13.4 Placing code/rodata into different FLASH Blocks
Most MCUs only have one bank of Flash memory. But with some parts more than one bank may
be available — and in such cases, by default, the managed linker script mechanism will still place
all of the application code and rodata (consts) into the first bank of Flash (as displayed in the
Memory Configuration Editor).
For example:
¢ most of the LPC18 and LPC43xx parts containing internal Flash (such as LPC1857 and
LPC4357) actually provide dual banks of Flash.
« some MCUs have the ability to access external Flash (typically SPIFI) as well as their built-in
internal Flash (e.g. LPC18xx, LPC40xx, LPC43xx, LPC546xx).
However it is also possible to place specific functions or rodata items into the second
(or even third) bank of Flash. This placement is controlled via macros provided in the
"cr_section_macros.h" header file.
For simplicity, the additional Flash region can be referenced as Flash2 (as well as using its
“formal” region name — for example MFlashB512 — which will vary depending upon part).
First of all include this header file:
#i ncl ude <cr_section_nacros. h>
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Then, for example, to place a rodata item into this section, you can use the __ RODATA macro,
thus:

__RODATA(Fl ash2) const int roarray[] = {10, 20, 30, 40, 50};

Or to place a function into it you can use __ TEXT macro:

__TEXT(Fl ash2) void systick_delay(uint32_t del ayTicks) {

In addition, the _ RODATA_EXT and _ TEXT_EXT macros can be used to place functions/
rodata into a more specifically named section, for example:

__ TEXT_EXT(Fl ash2, systi ck_del ay) void systick_del ay(uint32_t del ayTi cks) {

will be placed into the section “.text.$Flash2.systick_delay” rather than “.text.$Flash2”.

18.13.5 Placing specific functions into RAM Blocks

In most modern MCUSs with built-in Flash memory, code is normally executed directly from Flash
memory. Various techniques, such as prefetch buffering are used to ensure that code will execute
with minimal or zero wait states, even a higher clock frequencies. Please see the documentation
for the MCU that you are using for more details.
However it is also possible to place specific functions into any of the defined banks of RAM for
the target MCU, as displayed in:
Project -> Properties -> C/C++ Build -> MCU settings
and sometimes there can be advantages in relocating small, time critical functions so that they
run out of RAM instead of Flash.
For simplicity, the additional memory regions are named sequentially, starting from 2, (as well
as using their “formal” region name — for example RamAHB32). So for a device with 3 RAM
regions, alias names RAM, RAM2 and RAMS3 will be available.
This placement is controlled via macros provided in a header file which can be pulled into your
project using:

#i ncl ude <cr_section_nacros. h>
The macro __RAMFUNC can be used to locate a function into a specific RAM region.
For example, to place a function into the main RAM region, use:

__RAMFUNC(RAM) void fooRAMvoid) {...
To place a function into the RAM2 region, use:

__RAMFUNC( RAMR) voi d fooRAM2(void) {...
Alternatively, RAM can be selected by formal name (as listed in the memory configuration editor),
for example:
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__RAMFUNC( RamAHB32) voi d Handl erRAMvoid) {...

In order to initialize RAM based code (and data) into specified RAM banks, the managed linker
script mechanism will create a “Global Section Table” in your image, directly after the vector
table. This contains the addresses and lengths of each of the data (and bss) sections, so that the
startup code can then perform the necessary initialization (copy code/data from Flash to RAM) .

Long branch veneers and Debugging

Due to the distance in the memory map between Flash memory and RAM, you will typically
require a “long branch veneer” between the function in RAM and the calling function in Flash. The
linker can automatically generate such a veneer for direct function calls, or you can effectively
generate your own by using a call via a function pointer.

One point to note is that debugging code with a linker generated veneer can sometimes cause
problems. This veneer will not have any source level debug information associated with it, so that
if you try to step in to a call to your code in RAM, typically the debugger will step over it instead.

You can work around this by single stepping at the instruction level, setting a breakpoint in your
RAM code, or by changing the function call from a direct one to a call via a function pointer.

Reducing Code Size when support for LPC CRP or Kinetis Flash
Config Block is Enabled

One of the consequences of the way that LPC CRP and Kinetis Flash Configuration Blocks work
is that the memory between the CPU’s vector table and the CRP word/ Flash Config Block is
often left largely unused. This can typically increases the size of the application image by several
hundred bytes (depending upon the MCU being used).

However this unused space can easily be reclaimed by choosing one or more functions to be
placed into this unused memory. To do this, you simply need to decorate their definitions with
the macro __ AFTER_VECTORS which is supplied in the “cr_section_macros.h” header file

Obviously in order to do this effectively, you need to identify functions which will occupy as much
of this unused memory as possible. The best way to do this is to look at the linker map file.

MCUXpresso IDE startup code already uses this macro to place the various initialization functions
and default exception handlers that it contains into this space, thus reducing the ‘default’ unused
space. But you can also place additional functions there by decorating their definitions with the
macro, for example

__AFTER VECTORS voi d nyStartupFunction(void);

Note: you will get a link error if the _ AFTER_VECTORS space grows beyond the CRP/Flash
Configuration Block (when this support is enabled):

nyproj _Debug. | d: 98 cannot nove |ocation counter backwards (from 00000334
to 000002f c)

collect2: Id returned 1 exit status

make: *** [nyproj.axf] Error 1

In this case, you will need to remove the _ AFTER_VECTORS macro from the definition of one
or more of your functions.

FreeMarker Linker Script Templates

By default, MCUXpresso IDE projects use a managed linker script mechanism which
automatically generates a linker script file without user intervention — allowing the project code
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and data to be laid out in memory based on the IDE’s knowledge of the memory layout of the
target MCU.

However sometimes the linker script generated in this way may not provide exactly the memory
layout required. MCUXpresso IDE therefore provides a highly flexible and powerful linker script
template mechanism to allow the user to change the content of the linker script generated by
the managed linker script mechanism

Basics

FreeMarker is a template engine: a generic tool to generate text output (HTML web pages, e-
mails, configuration files, source code, etc.) based on templates and changing data. Built into
MCUXpresso IDE are a set of templates that are processed by the FreeMarker template engine
to create the linker script. Templates are written in the FreeMarker Template Language (FTL),
which is a simple, specialized language, not a full-blown programming language like PHP. Full
documentation for FreeMarker can be found at http://freemarker.org/docs/index.html .

MCUXpresso IDE automatically invokes FreeMarker, passing it a data model that describes
the memory layout of the target together with a ‘root’ template that is processed to create the
linker script. This root template, #includes further ‘component’ templates. This structure allows
a linker script to be broken down into various components, and allows a user to provide their
own templates for a component, instead of having to (re-)write the whole template. For example,
component templates are provided for text, data and bss sections, allowing the user to provide a
different implementations as necessary, but leaving the other parts of the linker script untouched.

MCUXpresso IDE Project

Target System User
Definition Templates Templates

Freemarker
Template engine

Linker script

Reference

FreeMarker reads input files, copying text and processing FreeMarker directives and ‘variables’,
and writes an output file. As used by the MCUXpresso IDE managed linker script mechanism,
the input files describe the various components of a linker script which, together with variables
defined by the IDE, are used to generate a complete linker script. Any of the component template
input files may be overridden by providing a local version in the project.

The component template input files are provided as a hierarchy, shown below, where each file
#includes those files nested below. This allows for individual components of the linker script to be
overridden without having to supply the entire linker script, increasing flexibility, while maintaining
the benefits of Managed Linker Scripts.
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Linker script template hierarchy

linkscript.ldt (top level)

user.ldt (an empty file designed to be overridden by users that is included in linkscript, memory
and library templates)

user_linkscript.ldt (an empty file designed to be overridden by users that is included in
linkscript only)

linkscript_common.ldt (root for main content)

header.ldt (the header for scripts)

« listvars.ldt (a script to output a list of all predefined variables available to the template)
includes.Idt (includes the memory and library scripts)
section_top.ldt (top of the linker script SECTION directive)
text_section.ldt (text sections for each secondary Flash)

» text_section_multicore.ldt (text sections for multicore targets)
 extrasections_text.ldt ( )

« text.Idt (for inserting *text)

« extrasections_rodata.ldt ( )

* rodata.ldt (for inserting rodata)

boot_hdr.Idt (allows placement of optional header before main code section)
e boot_hdr_partfamily.ldt

main_text_section.ldt (the primary text section)

« global_section_table.ldt (the global section table)

« crp.ldt (the CRP information)

» extrasections_text.ldt ( )

* main_text.ldt (for inserting *text)

« extrasections_rodata.ldt ( )
¢ main_rodata.ldt (read-only data)

e cpp_info.ldt (additional C++ requirements)

exdata.ldt (the exdata sections)

end_text.Idt (end of text marker)

usb_ram_section.Idt (placement of SDK USB data structures)
stack_heap_sdk_start.ldt (placement of MCUXpresso style heap/stack)
data_section.ldt (data sections for secondary ram)

» data_section_multicore.ldt (data sections for multicore targets)

+ extrasections_data.ldt ( )

 data.ldt (for inserting *data)

mtb_default_section.ldt (special section for MTB (cortex-m0+ targets)
uninit_reserved_section.Idt (uninitialised data)

main_data_section.ldt primary data section)

* extrasections_data.ldt ( )

* main_data.ldt (for inserting *data)

bss_section.ldt (secondary bss sections)
» extrasections_bss.ldt ( )
* bss.Idt (for inserting *bss)

main_bss_section.Idt primary bss section)
» extrasections_bss.Idt ( )
* main_bss.ldt (for inserting *bss)

. .. . i
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» extrasections_noninit.ldt ( )

* noinit_noload_section.ldt (no-load data)
» stack_heap_sdk_postdata.ldt (placement of MCUXpresso style heap/stack)
e stack_heap_sdk_end.ldt (placement of MCUXpresso style heap/stack)
¢ stack_heap.ldt (define the stack and heap)
¢ checksum.Idt (create the LPC checksum)
* image_size.ldt (provide basic symbols giving location and size of image)
¢ symbols.Idt (provide additional symbols needed to built image)
* symbols_partfamily.ldt

e section_tail.ldt (immediately before the send of linker SECTION directive)

library.ldt (the standard libraries used in the application)

« user.ldt (an empty file designed to be overridden by users that is included in linkscript, memory
and library templates)

e user_library.ldt (an empty file designed to be overridden by users that is included in library only)

memory.ldt (the memory map)

« user.ldt (an empty file designed to be overridden by users that is included in linkscript, memory
and library templates)

e user_memory.ldt (an empty file designed to be overridden by users that is included in memory
only)

Linker script search paths

Whenever a linker script template is used, MCUXpresso IDE will search in the following locations,
in the order shown:

e project/linkscripts

« the searchPath global variable

« The searchPath can be setin a script by using the syntax <#global searchPath="c:/windows/
path;d:/another/windows/path”>

» each directory to search is separated by a semicolon ;'

¢ mcuxpresso_install_dir/ide/Data/Linkscripts

* linker templates can be placed in this directory to override the default templates for an entire
installation

* MCUXpresso IDE internally provided templates (not directly visible to users)

Thus, a project can simply override any template by simply creating a linkscript directory within
the project and placing the appropriate template in there. Using the special syntax “super@” an
overridden template can reference a file from the next level of the search path

e.g. <#include “super@user.ldt">

Linker script templates

Copies of the default linker script templates used within MCUXpresso IDE can be found in the
Wizards/linker directory within the MCUXpresso IDE install. These can be used as the basis of
any project local scripts you wish to write.

Predefined variables (macros)
List (sequence) variables (used in #list)

libraries]]
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list of the libraries to be included in the “lib” script
» for example (Redlib nohost)

libraries[0]=libcr_c.a
l'ibraries[1]=libcr_eabi hel pers.a

configMemory(] list of each memory region defined in the memory map for the project. Each
entry has the following fields defined

name — the name of the memory region

alias — the alias of the memory region

location — the base address of the memory

size — the size of the memory region

sizek — the printable size of the memory region in k or M
mcuPattern

defaultRAM — boolean indicating if this is the default RAM region
defaultFlash — boolean indication if this is the default Flash region
RAM — boolean indicating if this is RAM

Flash — boolean indicating if this is Flash

for example:

confi gMenory[ 0] = name=MFl ashA512 al i as=Fl ash | ocati on=0x1a000000
si ze=0x80000 si zek=512K byt es ntuPattern=Fl ash fl ash=true RAM-fal se
def aul t Fl ash=true defaul t RAM=f al se

confi gMenory[ 2] = name=RanlLoc32 al i as=RAM | ocat i on=0x10000000
si ze=0x8000 si zek=32K byt es ntuPattern=RAM f| ash=f al se RAM=true
def aul t Fl ash=f al se def aul t RAM=t r ue

Slaves ] list of the Slaves in a Multicore project. This variable is only defined in Multicore projects.
Each entry has the following fields defined

name — name of the Slave

enabled — boolean indicating if this Slave is enabled

objPath — path to the object file for the Slave image

linkSection — name of the section this Slave is to be linked in
runtimeSection

textSection — name of the text section

textSectionNormalized — normalized name of the text section
dataStartSymbol — name of the Symbol defining the start of the data
dataEndSymbol — name of the Symbol defining the end of the data

for example:

sl aves[ 0] = nane=MDAPP obj ect Pat h=${ wor kspace_| oc: / MCB4357_Bl i nky_Dual M)/ Debug
/ MCB4357_Bl i nky_Dual M. axf. o}l i nkSecti on=Fl ash2 runti neSecti on= text Secti on=
.core_nDapp textSectionNormalized=_core_nmDappdata Start Synbol =__start_data

dat aEndSynbol =__end_dat a enabl ed=true; </ notextil e>

Simple variables include:

CODE - name of the memory region to place the default code (text) section
CRP_ADDRESS - location of the Code Read Protect value
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« DATA — name of the memory region to place the default data section
e LINK_TO_RAM - value of the “Link to RAM” linker option

« STACK_OFFSET - value of the Stack Offset linker option

¢ FLASHnN — defined for each FLASH memory

* RAMnN - defined for each RAM memory

« basename — internal name of the process

¢ bss_align — alignment for .bss sections

 buildConfig — the name of the configuration being built

« chipFamily — the chip family

« chipName — name of the target chip

« data_align — alignment for .data section

« date — date string

« heap_symbol — name of the symbol used to define the heap

¢ isCppProject — boolean indicating if this is a C++ project

« isSlave —boolean indicating if this target is a slave — true iff is a slave core in a multicore system
e library_include — name of the library include file

¢ libtype — C library type

¢ memory_include — name of the memory include file

« mtb_supported — boolean indicating if mtb is supported for this target
« numCores — number of cores in this target

¢ procName — the name of the target processor

e project — the name of the project

* script — name of the script file

« slaveName — is the name of the slave (only present for slaves)

e stack_section — the name of the section where the stack is to be placed
« start_symbol — the name of the start symbol (entry point)

¢ scriptType — the type of script being generated (one of “script”, “memory”, or “library”)
e text align — alignment for .text section

¢ version — product version string

e workspace_loc — workspace directory

e year — the year (extracted from the date)

Extended variables
Two ‘extended’ variables are available:

environment

« The environment variable makes the host Operating System environment variables available.
For example, the Path variable is available as ${environment[“Path]}.

Note Environment variables are case sensitive.

systemProperties

« The Java system properties are available through the systemProperties variable. For example
the “0s.name” system property is available as ${systemProperties[*0s.name”]}. Note: System
properties are case sensitive.

Outputting variables
A list of all predefined variables and their values can be output to the generated linker script

by setting the Preference: MCUXpresso IDE -> Default Tool settings -> ... and list predefined
variables in the script
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A list of extended variables and their values can be output to the generated linker script by
creating a linkscripts/user.ldt file in the project with the content

<#assign |istvarsext=true>

(This is likely to be used less often, hence the slightly longer winded method of specifying the
option)

18.15 FreeMarker Linker Script Template Examples
The use of FreeMarker linker script templates allows more wide ranging changes to be made to
the generated link script than is possible using the cr_section_macros.h macros. The following
examples provide some examples of this.
18.15.1 Relocating code from FLASH to RAM
If you have specific functions in your code base that you wish to place into a particular block
of RAM, then the simplest way to do this is to decorate the function definition using the macro
__ RAMFUNC described earlier in this chapter.
However once you want to relocate more than a few functions, or when you don'’t have direct
access to the source code, this becomes impractical. In such case the use of FreeMarker linker
script templates will be a better approach. The following sections provide a number of such
examples.
Relocating particular objects into RAM
In some cases, it may be required to relocate all of the functions (and rodata) from a given object
file in your project into RAM. This can be achieved by providing three linker script template files
into a linkscripts folder within your project. For example if it was required that all code/rodata
from the files foo.c and bar.c were relocated into RAM, then this could be achieved using the
following linker script templates:
mai n_text.|dt
*( EXCLUDE_FI LE(*fo00.0 *bar.o) .text*)
mai n_r odat a. | dt
*( EXCLUDE_FI LE(*f 0o. 0 *bar.o0) .rodata)
*( EXCLUDE_FI LE(*f00. 0 *bar.0) .rodata.*)
*( EXCLUDE_FI LE(*f 00. 0 *bar.o0) .constdata)
*( EXCLUDE_FI LE(*f00. 0 *bar.o0) .constdata.*)
. = ALIGN(${text_align});
mai n_dat a. | dt
*fo0o.0(.text*)
*foo.0(.rodata .rodata.* .constdata .constdata.*)
*bar. o(.text*)
*bar.o(.rodata .rodata.* .constdata .constdata.*)
. = ALIGN(${text_align});
*(.data*)
What each of these EXCLUDE_FILE lines (in main_text.Idt and main_rodata.ldt) is doing in
pulling in all of the sections of a particular type (for example .text), except for the ones from the
named object files. Then in main_data.ldt, we specify explicitly that the text and rodata sections
should be pulled in from the named object files. Note: that with the GNU linker, LD, the first
MCUXpresso IDE User Guide - All information provided in this document is subject to legal disclaimers © 2019 NXP Semiconductors. All rights reserved.
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match found in the final generated linker script is always used, which is why the EXCLUDE_FILE
keyword is used in the first two template files.

Note: EXCLUDE_FILE only acts on the closest input section specified, which is why we have
4 separate EXCLUDE_FILE lines in the main_rodata.ldt file rather than just a single combined
EXCLUDE_LINE.

Once you have built your project using the above linker script template files, then you can check
the generated .Id file to see the actual linker script produced, together with the linker map file to
confirm where the code and rodata have been placed.

Relocating particular libraries into RAM

In some cases, it may be required to relocate all of the functions (and rodata) from a given library
in your project into RAM. One example of this might be if you are using a flashless LPC43xx
MCU with an external SPIFI Flash device being used to store and execute your main code from,
but you need to actually update some data that you are also storing in the SPIFI Flash. In this
case, the code used to update the SPIFI Flash cannot run from SPIFI Flash.

This can be achieved by providing three linker script template files into a linkscripts folder
within your project. For example if it was required that all code/rodata from the library
MYLIBRARYPROJ were relocated into RAM, then this could be achieved using the following
linker script templates:

mai n_t ext.|dt
* (EXCLUDE_FI LE(*1 i bMYLI BRARYPRQJ. a:) .text*)

mai n_r odat a. | dt
* (EXCLUDE_FI LE(*I i bMYLI BRARYPRQJ. a:) . rodat a)
* (EXCLUDE_FI LE(*I i bMYLI BRARYPRQJ. a:) .rodata.*)
* ( EXCLUDE_FI LE(*I i bMYLI BRARYPRQU. a:) .constdata)
* ( EXCLUDE_FI LE(*I i bMYLI BRARYPRQJ. a:) .constdata.*)
. = ALIGN(${text_align});

mai n_dat a. | dt
*1 i bMYLI BRARYPRQJ. a: (. t ext *)
*| i bMYLI BRARYPRQJ. a: (.rodata .rodata.* .constdata .constdata.*)
. = ALIGN(${text_align});
*(.data*)

Relocating majority of an application into RAM

In some situations, you may wish to run the bulk of your application code from RAM — typically

just leaving startup code and the vector table in Flash. This can be achieved by providing three

linker script template files into a linkscripts folder within your project:

mai n_text.|dt
*startup_*.o (.text.*)
*(.text. main)
*(.text.__nmain)

mai n_r odat a. | dt
*startup_*.o (.rodata .rodata.* .constdata .constdata.*)
. = ALIGN(${text_align});

mai n_dat a. | dt
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*(.text*)

*(.rodata .rodata.* .constdata .constdata.*)
. = ALIGN(${text_align});

*(.data*)

The above linker template scripts will cause the main body of the code to be relocated into the
main (first) RAM bank of the target MCU, which by default will also contain data/bss, as well as
the stack and heap.

Important Note: The code that performs this relocation is executed early within the reset handler
(within startup_xx file). However, there is the potential for other critical functions to be called
before this relocation is performed, for example Systeminit() may be called first to perform
essential operations such as enabling RAM!

Any function that is called before the relocation is performed must not itself be relocated! For the
specific case above, the following changes to main_text.Idt and main_rodata.ldt are required:

mai n_t ext. | dt
*startup_*.o (.text.*)
*system*.o (.text.*)
*(.text. main)
*(.text.__main)

mai n_r odat a. | dt

*startup_*.o (.rodata .rodata.* .constdata .constdata.*)
*system *.o0 (.rodata .rodata.* .constdata .constdata.*)
. = ALIGN(${text_align});

Finally, If the MCU being targeted has more than one RAM bank, then the main body of the code
could be relocated into another RAM bank instead. For example, if you wanted to relocate the
code into the second RAM bank, then this could be done by providing the following data.ldt file
instead of the main_data.ldt above:

dat a. | dt

<#if menory.al i as=="RAM2" >

*(.text*)

*(.rodata .rodata.* .constdata .constdata.*)
. = ALIGN(${text_align});

</ #if>

*(.data. $${menory. al i as}*)

*(.data. $${menory. nane}*)

Note: memory.alias value is taken from the Alias column of the Memory Configuration Editor.

Configuring projects to span multiple Flash Devices

Most MCUSs only have one bank of Flash memory. But with some parts more than one bank may
be available — and in such cases, by default, the managed linker script mechanism will still place
all of the application code and rodata (consts) into the first bank of Flash (as displayed in the
Memory Configuration Editor)..

For example

« most of the LPC18 and LPC43xx parts containing internal Flash (such as LPC1857 and
LPC4357) actually provide dual banks of Flash.

* some MCUs have the ability to access external Flash (typically SPIFI) as well as their built-in
internal Flash (e.g. LPC18xx, LPC40xx, LPC43xx, LPC546xx).
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The macros provided in the “cr_section_macros.h” header file provide some ability to control the
placement of specific functions or rodata items into the second (or even third) bank of Flash.
However the use of FreeMarker linkers script templates allow this to be done in a much more
powerful and flexible way.

One typical use case for this is a project which stores its main code and data in internal Flash,
but additional rodata (for example graphics data for displaying on an LCD) in the external SPIFI
Flash.

For instance, consider an example project where such rodata is all contained in a set of specific
files, which we therefore want to place into the external Flash device. One very simple way to do
this is to place such source files into a separate source folder within your project. You can then
supply linker script templates to place the code and rodata from these files into the appropriate
Flash.

For example, for a project using the LPC4337 with two internal Flash banks, plus external SPIFI
Flash, if the source folder used for this purpose were called ‘spifidata’, then placing the following
files into a linkscripts directory within your project would have the desired effect:

text.ldt
<#i f menory. al i as=="Fl ash3">
*spifidatal/ *(.text*)
</ #if>
*(.text_${nenory.alias}*) /* for conpatibility with previous rel eases */
*(.text_${nenory.nane}*) /* for conpatibility with previous rel eases */
*(.text.$${nenory. al i as}*)
*(.text.$${nenory. name}*)

rodata. | dt

<#i f menory. al i as=="Fl ash3">
*spi fidatal/*(.rodata*)

</ #if>

*(rodat a. $${ menory. al i as}*)
*(rodat a. $${ menory. nane} *)

Note: the check of the memory.alias being Flash3 is to prevent the code/rodata items from ending
up in the BankB Flash bank (which is Flash2 by default).

Disabling Managed Linker Scripts

It is possible to disable the managed linker script mechanism if required and provide your own
linker scripts, but this is not recommended for most users. In most circumstance, the facilities
provided by the managed linker script mechanism, and its underlying FreeMarker template
mechanism should allow you to avoid the need for writing your own linker scripts. But if you do
wish to do this, then untick the appropriate option at:

Properties -> C/C++ Build -> Settings -> MCU Linker -> Managed Linker Script

And then in the field Script Path provide the name and path (relative to the current build directory)
of your own, manually maintained linker script.

In such cases you can either create your own linker script from scratch, or you can use the
managed linker scripts as a starting point. One very important point though is that you are advised
not to simply modify the managed linker scripts in place, but instead to copy them to another
location and modify them there. This will prevent any chance of the tools accidentally overwriting
them if at some point in the future you turn the managed make script mechanism back on.

Note: if your linker script includes additional files (as the managed linker scripts do), then you
will also need to include the relative path information in the include inside the top level script file.
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For more details of writing your own linker scripts, please see the GNU Linker (Id) documentation:
Help -> Help Contents -> Tools (Compilers, Debugger, Utilities) -> GNU Linker

There is also a good introduction to linker scripts available in Building Bare-Metal ARM Systems
with GNU: Part 3 at:

http://www.embedded.com/design/mcus-processors-and-socs/4026080/Building-Bare-Metal-
ARM-Systems-with-GNU-Part-3

See also the section on to review editor assistance when
manually creating Linker Scripts.
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Introduction

Multicore MCUs can be designed in many ways, however within MCUXpresso IDE there is an
underlying expectation that one core (the Master) will control the execution (or at least the startup)
of code running on other (Slave) core(s).

Multicore application projects as described below consists of two (or more) linked projects —
one project containing the Master code and the other project(s) containing the Slave code. The
‘Master’ project contains a link to the ‘Slave’ project which will cause the output image from the
‘Slave’ to be included into the ‘Master’ image when the Master project is built. Building the Master
project will trigger the Slave project to be built first.

After a power-on or Reset, the Master core boots and is then responsible for booting the Slave
core. However, this relationship only applies to the booting process; after boot, your application
may treat either of the cores as the Master or the Slave.

For this concept to work, the memory configurations of these related projects must
be carefully managed to avoid unintended overlap or contention. One way this can be
achieved is by linking the Slave application to execute entirely from a RAM location
unused by the Master. Our automatic linkerscript generation will then locate the Slave
code within the Master’s generated image, this code will be relocated to the correct RAM
location by the Master projects initialisation code at run time.

In practice, the Master project’s memory configuration will be the same as for asingle core
project, where as the Slave project’s memory configuration will be set to use a ‘spare’ or
dedicated Slave RAM region. In addition, a shared region may be used for communication
between the CPUs

Note: MCUs supporting dedicated Flash regions for each core can also be supported by this
scheme, in such cases the Slave project would simply be linked to the Slave’s Flash location.

To complete the story ... the Master project is debugged first, which will lead to the combined
image being programmed into Flash and the Master code executed. The Master’s initialisation
code will (in addition to other things) copy the Slave code into RAM (if appropriate) and then stop
on Main. When the Slave project is debugged, the launch configuration will automatically be set
to ‘Attach’ by the IDE since there is no need for this code to be programmed/downloaded by the
debugger. When the Master application is resumed, it will release the Slave and both projects
can be debugged as required.

Important Note: Multicore MCUs may offer significant flexibility in how they can be used. The
mechanism described above (as used in example projects) is not necessarily the only way (or
even the best way) for a user’'s multicore projects to be configured. However, it has been chosen
as the simplest and safest way to demonstrate the concepts and issues involved.

MCUXpresso IDE allows for the easy creation of “linked” projects that support the targeting of
Multicore MCUs.

The rest of this chapter will describe the use of the LPC5411x multicore MCU, however the
concepts discussed will be the same (or similar) for other multicore MCUs such as the LPC43xx
and LPC5410x.

Creating a Master / Slave project Pair (using an SDK)

The example described below is based around the LPC5411x multicore MCU using the
LPCXpresso54114 SDK.

All information provided in this document is subject to legal disclaimers © 2019 NXP Semiconductors. All rights reserved.

User Guide

Rev. 11.0.0 — 23 May, 2019 203



NXP Semiconductors MCUXpresso IDE User Guide

19.2.1

Note: Be sure to have installed the LPCXpresso54114 SDK into MCUXpresso IDE if you wish
to follow this example.

Creating the MO Slave project

As discussed above, the Master projects configuration will need to reference the Slave project,
therefore the Slave project should be created first.

Launch the New Project Wizard and select the LPCXpresso54114 SDK board. Entering 54114
into the boards filter will reduce the number of boards to help selection, then click Next.

[ DK Wizard

(D) Creating project for device: LPC541141256 using board: LPCXpresso54114 ] . l f "

. Board and/or Device selection page

+ SDK MCUs Available boards &
PrCosTromTStalied SDKs Please select an available board for your project,
NXP LPC54114)256 Supported boards for device: LPC54114J256

a4 LPCodllx
LPC54114)256

¥ Preinstalled MCUs

Selected Device: LPC34114)256 using board: LPCXpresso34114 SDKs for selected MCU
Target Core: multicore device with cores: cortex-mé certex-m0plus Name SDK Version Manifest Ve... Location
Description: The LPC5411x are ARM Cortex-M4 based microcentrellers for embedded £ SDK_2x | PCXpresso54114 230 320 @‘ <Default Location>/A\SDK 2.0 LPC)
applications.

3\ r ('SD;\
Vb it )

pcpresso54114 om13588

Ipoxpresso54114

Figure 19.1. New Project Wizard SDK MultiCore MO
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From the next wizard page, select the cmOplus Core, and see that the MOSLAVE is selected
in the core options. Also note that the Project will automatically be given the suffix MOSLAVE.
Drivers, utilities etc. can be selected at this stage for the Slave project if required.
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[ NN ] SDK Wizard
1, The source from the SOK will be copied into the workspace, } : L i 7
If you want to use linked files, please unzip the 'SDK_2.x_LPCXpresso54114' SDK. |
. Configure the project
Project name: LDCS«H 14J256_Project Project name suffix:
Use default location
Location:
Device Packages Board Project Type Project Options
© LPC54114J256BD64 © Default board files © C Project C++ Project SDK Debug Console € Semihost UART
LPC54114J258UK49 Empty board files C Static Library C++ Static Library CMSIS-Core
Import other files
Cores
cmd (cmd) g
[o cmOplus (cmOplus) MOSLAVE B l
os & @B 3@ driver 4 M % @ B CMSiSdriver 5 ] % [F B utilities 4 ¥ % H 5 middleware 2% BE |
Name Version Name Version Name Version Name Version Name version
<+ baremetal 1.0.0 ffrade 2.2.0 » = Device <l assert 1.0.0 » S Multicore
/] -&i} & » = Security
& <44 debug_console_s! 1.0.0
Gctimer 2,01 <& notifier 1.0.0
Grdma 2,00 <t shell 1.00
lgt dmic 2.0.0 <2 virtual_com 1.0.0
g} dmic_dma 2.0.0
{gHflashiap 2,00
)
-b;ﬂexcumm_iZs 2.01
& flexcomm_i2s.d 2,01
¥ fmeas 2.0.0
“kgint 2.0.0
&
@i2e 203
aiize dma 2.0.3
(?\) < Back m Cancel
Figure 19.2. New Project Wizard SDK MO Slave

Next, the MO Slave memory configuration needs to be set.

Note: the MCUXpresso IDEs managed linker script mechanism will default to link code to the first
Flash region in this view (if one exists) and use the first RAM region for data, heap and stack..

To force our project to link to a private area of RAM, we must ensure that the Flash region is
removed and the chosen RAM bank is at the top of the list of memory regions. Note here that
the SDK we are using has presented the RAM regions in a non sequential order. In this example

we will configure the memory so that the MO Slave project links to the RAM region starting at
address 0x20010000 (the first region).
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Tuoe

. Advanced project settings

= CIC++ Library Settings
Set library type (and hosting variant)  Rediib (semihost-nf) H

Redlib: Use floating point version of printf
Redlib: Use character rather than string based printf

Redirect SDK "PRINTF" to C library "printf*
Include semihost HardFault handler Redirect printf/scanf to UART

~ MCU C Compiler
Language standard  Compiler default ”
~ MCU Linker
Link application to RAM

~ Memory Configuration

Memory details

Default LinkServer Flash Driver

SDK Wizard

==

Browse...

Name Aliz Location Driver

| Flash

PROGRAM_FLASH Flash 0x0 0x40000 LPC5411x _256K.cfx l s

RAM
RAM
RAM
RAM

AddFlash  Add RAM Spiit

Import... Merge... Export..

Figure 19.3. New Project Wizard SDK MO Slave Memory

SRAM1 RAM [[ex20010000 Jox10000 .
SRAMO RAM2 X 0x10000 kS
SRAMX RAM3 0x4000000 0x8000
SRAM2 RAMA4 0x20020000 0x8000

< Back cancel | (I

19.2.2
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From this wizard, select the PROGRAM_FLASH and click Delete to remove the region. Ensure

that the top RAM region has the base address (location) 0x20010000, then click Finish to
complete the creation of the Slave project.

Tip
@ Memory regions can be reordered by selecting a region and using the up/down
arrows to move the selected region.

Creating the M4 Master project

To create the Master project, launch the New Project Wizard and again select the
LPCXpresso54114 SDK board and click Next. This time, select the cm4 Core, and click the
MASTER check box, this configures the wizard to create a Multicore project. Note that the
Project will automatically be given the suffix MASTER.

Drivers, utilities etc. can be selected at this stage for the Master project if required.
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*) The source from the SDK will be copied into the workspace.
If you want to use linked files, please unzip the 'SDK_2.x_LPCXpresso54114' SDK.

' Configure the project

Project name: LPCSM 14J256_Project

Use default location

Location:
Device Packages Board
O LPC54114J256B064 © Default board files
LPC54114J256UK49 Empty board files
Cores
I cmOplus (cmOplus) MOSLAVE B
0s & @B driver g2 ¥ % B
Name = Version Name : Version
i baremetal 1.0.0 & adc 220
2 o
2 &
-@;climer 2,01
& dma 2,00
i dmic 2,00
L dmic_dma 2.0.0
4 flashiap 2,00
i flexcomm_izs  2.0.1
4 flexcomm_i2s_d 2.0.1
i fmeas 200
L gint 2,00
o o
fize 203
ii2c dma 2.03

SDK Wizard

Name
» = Device

Figure 19.4. New Project Wizard SDK M4 Master

CMSIS_driver /;

Project name suffix] MASTER

v R

Project Type

© ¢ Project
C Static Library

B =

Vversion

C++ Project SDK Debug Console @) Semihost | UART
C++ Static Library CMSIS-Core
Import other files
utilities 4 W % ® 5 middieware 2% BB
Name Version Name Version
G assert 1.0.0 » £ Multicore
0 » £ Security
4 debug_console_s 1.0.0
44 notifier 1.0.0
& shell 1.0.0
A virtual_com 1.0.0
<Back [ Nexts ] Cancel

Project Options

=

Next, the M4 Master's memory configuration needs to be set. Typically we might leave the
memory setting unaltered, however the SDK we are using presents the RAM regions in a non
sequential way. In this example we wish to select the RAM region at 0x20000000 for the Master
projects data and the Flash at 0x0 for the Master projects code (and also a copy of the Slave
projects code)

Note: MCUXpresso IDEs managed linker script mechanism will default to link code to the first
Flash region in this view (if one exists) and use the first RAM region for data, heap and stack.
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. Advanced project settings

~ [C/C++ Library Settings

Set library type (and hosting variant)

Redlib: Use floating point version of printf

Redlib: Use character rather than string based printf

Redirect SDK "PRINTF" to C library "printf"
Include semihost HardFault handler

~ Hardware settings

Set Floating Point type  Fpy4 (HardABI)

~ MCU C Compiler

Language standard =~ Compiler default

~ MCU Linker
Link application to RAM

~ Memory Configuration

Memory details

Redlib (semihost-nf)

Redirect printfjscanf to ITM
Redirect printf/scanf to UART

Default LinkServer Flash Driver Browse...
Type Name Alias Locatien Size Driver .
Flash Elash 0x0 0x40000 LPC5411x_256K.cfx .
RAM SRAM1 RAM 0x20010000 0x10000 ] =
RAM AMO RAM2 0x20000000 0x10000 o
RAM SRAMX RAM3 0x4000000 0x8000
RAM SRAM2 RAM4 0x20020000 0x8000

Add Flash Add RAM Split Delete

Import... Merge... Export...

~ Multicore slave projects settings

Optionally allow an existing slave project to be associated with this project.

Slave project for MOSLAVE

& By default, the slave images will be placed in the RAM2 block of the master project's memory map. The slave memory setting in the master project should match how the slave project was built.

Figure 19.5. New Project Wizard SDK M4 Master Memory

B

To adjust the memory layout, select the second RAM region (at location 0x20000000) and click
the ‘Up’ arrow to move this to the top of the RAM regions. The highlighted regions as shown
above will are effectively swapped.

Once this has been done, click ‘OK'.

Next, click Browse to locate a Slave project within the Workspace and select the previously
created Slave project, then click ‘OK’.
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m Slave project selection for MOSLAVE = a |55

Select a slave project to link with the master project being created.

(5 LPC54114)256_Project_MOSLAVE|

@ [ oK ] I Cancel

Figure 19.6. New Project Wizard SDK M4 Master Slave Selection

Note: ensure the Link Section name (default of RAM2 highlighted) selects a Master memory
region that matches the linked address of the Slave project. In this case RAM2 should correspond
to the address 0x2001000. If required, other memory regions can be selected here but please
note: the first Flash Region and the first RAM Region are not included in the drop down list

because it is assumed that these will be used for the Master Project. If required, this setting can
be changed later from:

Project Properties -> C/C++ Build -> Settings -> Multicore
Where all of the memory regions are available for selection.

Below we can see the edited project settings for the Master project.

~ Memory Configuration

Memory details

Default LinkServer Flash Driver Browse...

Type Name Alias Location size Driver .
Flash PROGRAM_FLASH Flash Qx0 0x40000 LPC5411x_256K.cfx v
RAM SRAMO RAM 0x20000000 0x10000 =
RAM SRAM1 RAM2 0x20010000 0x10000 =
RAM SRAMX RAM3 0x4000000 0x8000
RAM SRAM2 RAM4 0x20020000 0xB8000O

Add Flash Add RAM Split Join Delete
Import... Merge... Export...

~ Multicore slave projects settings
Optionally allow an existing slave project to be associated with this project.

Slave project for MOSLAVE [ LPC54114J256_Project MOSLAVE _r,] Browse... | Link Section RAM2 a

% By default, the slave images will be placed in the RAM2 block of the master project's memory map. The slave memory setting in the master project should match how the slave project was built.

Figure 19.7. New Project Wizard SDK M4 Master Project

Finally click Finish to generate the Master project.

Note: if the memory regions of these projects overlap, the linker will generate an error similar to:

MSLAVE execute address differs from address provided in source i mage
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19.3

19.3.1

To fix this issue, review (and edit) the memory settings of the related projects so that their
addresses do not overlap via Project Properties -> C/C++ Build -> MCU settings .

Creating a Master / Slave project Pair (using Preinstalled Part
Support)

The example described below is base around the LPC5411x multicore MCU.

Note: It is recommended to create and build LPC541xx multicore projects which are linked to
LPCOpen. Thus before you follow the below sequence, please ensure that you have imported

the chip and (optionally) the board library projects (for both the M4 and M0+) from an LPCOpen
package for the LPC5410x family or LPC5411x family (depending upon your target part).

Creating the MO Slave project

As discussed above, the Master projects configuration will need to reference the Slave project,
therefore the Slave project should be created first.

Launch the New Project Wizard and select the LPC54114-MO0 from the Preinstalled MCUs.

3 5DK Wizard

b SDK MCUs

Cortex-M part support

PCE0x
> LPCB2x
> LPCB4x
» LPCBNOx

LPChwx

©

(1) Cresting project for device: LPC54114)256-M0 } N L \57

. Board and/or Device selection page

- Preinstalled MCUs Please select an available board for your project.
i T Rl e a BT and Geenc Supported boards for device: LPC5411x
NXP LPC541141256-M0

.
p541141256 5 E
LPC541141256-M0 2

 PMT 300 LPCXpresso54114
> PN74000t i
Selected Device: LPC54114J256-M0 with no board. SDKs for selected MCU
Target Core: cortex-m0 MName SDK Version  Manifest Ve.. Location

Description: Dual Cortex-M4/Cortex-M0+ based microcentroller, with up to 256KB
Flash and 192KB RAM

= [FerEEs]

Available boards B &

[om

< Back Mext > Finish

Figure 19.8. New Project Wizard Preinstalled MO

MCUXpresso IDE User Guide -

Next, select a MultiCore MO Slave project type, below we have selected an LPCOpen — C Project.
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New project...
LPC5411x Multicore (M0+ slave) -> LPCOpen - C Project

. Wizard selection page.

Wizard
4 LPC54110
4 LPC5411x (MD+]
LPCOpen - C Project
LPCOpen - C Static Library Project
LPCOpen - C++ Project
LPCOpen - C++ Static Library Project
C Project
C Project (Semihosted)
C Static Library Project
C++ Project
C++ Static Library Project
4 LPC5411x Multicore (MO+ slave)
LPCOpen - C Project
LPCOpen - C++ Project
C Project
C Project (Semihosted)
C++ Project

(?:' < Back MNext >

Lo = =s]

Cancel

Figure 19.9. New Project Wizard Preinstalled MO C Project

Next, name the project, for example LPC54114 MO_Slave, then click next until the Memory
Configuration page is reached. From here we can see the MCU memory regions.

Note: MCUXpresso IDE’s managed linker script mechanism will default to link code to the first
Flash region in this view (if one exists) and use the first RAM region for data.

To force our project to link to a private area of RAM, simply delete the Flash and first RAM region
(RAMO_64) from this view (since these will be use for the M4 Master project). To do this, just
select the regions and click Delete. Since there will no longer be any Flash region, the default

Flash driver can also be removed.

MCUXpresso IDE User Guide - All information provided in this document is subject to legal disclaimers

© 2019 NXP Semiconductors. All rights reserved.

User Guide Rev. 11.0.0 — 23 May, 2019

211



NXP Semiconductors

MCUXpresso IDE User Guide

New project...
Memory Configuration Editor

. Wizard properties page.

Allows external flash to be defined and appropriate flash driver allocated, or for layout of internal RAM to be reconfigured.

Default flash driver
Type Name Alias Location Size Driver
"’Hash MFlash256 Flash 0 040000 ) s
NRAM __ Rami0 64 RAM 0x20000000 0,10000 &
RAM  Ramil_64 RAM2 (20010000 010000
RAM  Ram2.32 RAM3  (x20020000  0x8000
RAM  RamX_32 RAM4 04000000 0x8000
Add Flash Joil [1mport..] [Merge...| |Export...| [ Generate...
©) ot | [ (e

Figure 19.10. New Project Wizard Preinstalled MO Memory

The memory setting should then look as below. In this case our Slave projects code and data
will be linked to address 0x20010000 with the stack set to the top of this region.

= o e =]
New project...
Memoery Configuration Editor
. Wizard properties page.
Allows external flash to be defined and appropriate flash driver allocated, or for layout of internal RAM to be reconfigured.
Default flash driver | R
Type MName Alias Driver
RAM  Raml 64 RAM ; —
RAM  Ram2_32 RAM2 . 2
RAM  RamX_32 RAM3 04000000 0xB000
Add Flash | | Add RAM Split {Import..w IMerge...] [Etport...l [Ganerate...]
@ Next > ([ Finish )| Cancel

Figure 19.11. New Project Wizard Preinstalled MO Memory edited

Now click Next -> Finish to complete the MO Slave projects creation.

19.3.2

Creating the M4 Master project

To create the Master, Launch the New Project Wizard again and this time select the LPC54114
(M4) part and click Next. Select the matching ‘MultiCore M4 Master -> LPCOpen -C Project’ and
click Next again. Now, name the new project, for example LPC54114 M4 _Master and click next
until the Multicore Project Setup page is reached.

Note: The wizard will present an identical memory configuration page, but on this occasion, no
editing is required since the default Flash and RAM setting are

From here, click browse to select the previously created Slave project from the existing

Workspace

MCUXpresso IDE User Guide -
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® = ==
New project...
Multicore Project Setup

. Wizard properties page.

Multicore Slave Project selection

Select an existing slave project to be associated with this master project

Slave Project ~([Browse.. )

[X] slave Project =8 ECR (==

Browse to the slave project associated with this master project

(5 LPC54114_MO_Slave '
P Do PeRpTEso
(% Ipe_board_lpcxpresso_54114_m0

(5 Ipe_chip_5411x
(5 Ipe_chip_5411%_mD

Figure 19.12. New Project Wizard Preinstalled M4 Select Slave

Now click Next -> Finish to complete the M4 Master projects creation.

19.4 Debugging MultiCore Projects

The debug story for MultiCore MCUs can vary with their implementation and also the chosen
debug solution.

Our MultiCore model as described above, assumes that the Master project will both copy
the Slave MCUs code and data (into RAM) but also release the Slave from reset. Therefore
the Master project should be run (debugged) first and typically run to main(). Once here, the
instantiation of the Slave's code will be complete but the Slave will not have been released. On
some MCUs, a debug connection can be made to the Slave before it has been released, but on
others this will only be possible after they are released.

Note: Slave projects debug launch configurations may require user modification before a debug
connection can be made. Please see the section

In our example LPC54114, the Slave’s debug connection can be made as soon as the Master
reaches main(). The debug window will then look similar to that below.

B2 2T bl EERR)S LI FH OG-
%5 Debug 2

4 . LPC54114J256 _Project_MASTER LinkServer Debug [C/C++ (NXP Semicenductors) MCU Application]
4 [ LPC54114)256_Project_MASTER. ax‘F[LPC54114J256 (cortex-md)]

-gdb (£ LLLAMLTURLT}
4 . LPC54114J256 Project MOSLAVE LinkServer Debug [C/C++ (NXP Semiconductors) MCU Application]
4 {g LPC54114)256 Project MOSLAVE. a)dLnPC54114J156 (cortex-m0plus)]

o e e G S AT e

Q‘P@ Thread #1 1 (Stopped) (Running)
gl arm-none-eabi-gdb (LLLLAULIUALTT

Figure 19.13. MultiCore Debug

Note above: that the MultiCore debug controls have been highlighted, these controls differ from

the standard controls in that they operate on all cores being debugged. Via these, the system
to be stepped, run, paused, terminated etc.
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19.4.1

In addition, the M4 Master debug stack (blue) is shown stopped at main, while the Slave stack
(green) is waiting to be released by the Master; clicking between these stacks will change the
IDE’s debug scope from one core to the other. The currently selected core will be the one used
for displaying many of the debug related views, such as Registers and Locals.

Controlling Debug Views

It is also possible to create copies of many of the debug related views, and then lock each copy
to a particular core (as described below).

For example, to create two register views, one for the M4 and one for the MO+ ...First of all, use
the ‘Open New view’ button in the Registers view to create a second Registers view:

Project Ex Peripheral  ifii Registers 3 Symbol Vi =0 4l
' tB gt -~ vl
Mame Value Description :

| vA%1PC54114J256 (cortex-ma) LPCEA 114 2RenHav View
it 0x00000000
BiEir 0x200000F8

. w2 0x00000400 M |
| i3 0x00000001
Wira 0x00000160
s 0x00000001
a5 0x40000000
| 17 0x2000FFFO
Y 0x00000000
| 1 0x00000000

110

Figure 19.14. MultiCore Debug New View

Now pin the original view to the core currently selected in the Debug, using the ‘Pin to Debug

context’ button :

[ Project Ex 2, Periphera

LPC54114.256_Project MASTER.axf: Thread [1]

Mame

Value

¥ 54LPC54114J256 (cortex-md)

0x00000000
0x200000F8
0x00000400
0x00000001
0x00000160
0x00000001
0x40000000
Ox2000FFFO
0x00000000
0x00000000
0x00000000

Figure 19.15. MultiCore Debug Pin View

11! Registers 52 | &,

SymbolVi = O 4 Debug &
B il v | vEees:

h vRLPC

Description * Pin to Debug Ccmfxt
LPC54114J266_F —
o @rm

v@lLrese

v ELPC

Ll

s arm

[g LPCEAT"

MCUXpresso IDE User Guide -

Now select the other core in the Debug view, and go to the second Register view. Use this view's
‘Pin to Debug Context’ button to lock this second Registers view to the selected core:

All information provided in this document is subject to legal disclaimers

© 2019 NXP Semiconductors. All rights reserved.

User Guide

Rev. 11.0.0 — 23 May, 2019

214



NXP Semiconductors

MCUXpresso IDE User Guide

Project Exp Peripherals iili Registers 23

LPC54114J256_Project MASTER.axf: Thread [1]
Name Value
v 44 LPCE4114J266 (cortex-m4)

0x00000018
0x2000FFB8
0x20000010
0x0000000F
0x00000160
0x00000001
0x40000000

Nw2INNNCEEN

111l Registers <2> 3 i

LPC54114J256_Project_ MOSLAVE.axf: Thread [1]
Name Value
v 5ALPCE4114J256 (cortex-mo0...

fiti ] 0x00000017
it gl 0x20011EE4
w2 0x00714F42
itir3 Ox00714F42
itirg 0x20010110
it 0x00000001
e OxFFFFFFFF

itir7? Ox2001FFE8

Figure 19.16. MultiCore Debug Registers

SymbolVie = O % Debug &2
t © 9 v vELPC541140256 Project MASTER LinkServer C
¥ 2 LPCE4114J266_Project MASTER.axf [LPCE
Description v &% Thread #1 1 (Stopped) (Suspended : Sigr
LPCE4114J2566_F = main() at LPC54114J256_Project_MAS
s arm-none-eabi-gdb (7.12.1.20170417)
".LPCE:I‘I 14J256_Project_MOSLAVE LinkServer
¥ (2 LPC54114J256_Project_MOSLAVE.axf [LPC
v % Thread #1 1 (Stopped) (Suspended : Sigr
= main() at LPC54114J256_Project_MO¢
s arm-none-eabi-gdb (7.12.1.20170417)

B Cisf ¥= 0 | [gLPC54114J256_Project MASTER.c X | [€] LPCE

53 /* Start slave CPU. */

Description Z
L boot_multicore_slave(};

LPC54114J256_f

)

61 printf("Hello World from MASTER\n");

63 /* Force the counter to be placed in
64 volatile static int i = @ ;

65 /* Enter an infinite loop, just incr
66 while(1) {

67 | T 3

13 1

69 return @ ;

19.4.2 Slave Project Debug

Typically, the Master project will be debugged first in exactly the same way as a single CPU
project. However the slave projects debug launch configuration may require special settings in
order to establish a debug connection to the slave CPU.

MCUXpresso IDE will automatically configure the correct settings for LinkServer slave launch
configurations however, for other debug solutions the slave debug settings may require

modification, please see below:

« Core Selection - within a MultiCore MCU there will be more than one CPU (sometimes referred
to as a device). The debug connection needs to be made to the appropriate internal CPU for
both the Master and Slave Projects.

* LinkServer CMSIS-DAP Debug: this process is automatic and hidden from the user. The
selection details are stored within the projects build configuration folder(s) and will take the

suffix .jtag or .swd

* P&E Debug: the Master CPU will be selected automatically for the Master project, however
the launch configuration for the Slave project will need to be edited to select the required
CPU. In our example this will be Core: MO

 SEGGER Debug: the Master CPU will be selected automatically for the Master project,
however the launch configuration for the Slave project will need to be edited to select the
required CPU. In our example this will be LPC54114J256_MO

« Attach mode for the Slave CPU — as described above, the debug connection to the slave(s)

should be via an attach

e LinkServer CMSIS-DAP Debug: this option is set automatically when the LinkServer
debug launch configuration is created

« P&E Debug: the launch configuration for the Slave project will need to be edited to force

an attach operation

 SEGGER Debug: the launch configuration for the Slave project will need to be edited to

force an attach operation

e Managing the Debug Server - this is the low level interface between the debugger and target

* LinkServer CMSIS-DAP Debug: the LinkServer launch configuration is automatically
correctly configured when the debug connection is made
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* P&E Debug: the slave core is controlled via the master cores debug server, therefore the
slave launch configuration must be edited to ensure that:

* no Server is launched
« the Port Numbers match those set in the Master Project’s launch configuration

o GDB Server Settings

[T] Launch Server Locally GDBMI Port Number; 6224
Hostname or IP: localhost Server Port Number® 7224
e The Quickstart debug option cannot be used to make the slave debug connection.

Instead, select Run > Debug Configurations... Next, select the appropriate slave launch
configuration and then click Debug

* See the P&E FAQ for more information http://www.pemicro.com/fags/fag_view.cfm?
ID=231

« SEGGER Debug: the default settings can be used

19.5 MultiCore Projects additional Information
19.5.1 Defines
A number of compiler defines are automatically created for LPC5410x projects to allow
conditional compilation of certain blocks of code depending upon whether a specific project is
configured to be a Slave, a Master or neither.
_ MULTICORE_MASTER
» Defined automatically for a project that has been configured to be a Master project
_ MULTICORE_MASTER_SLAVE_MOSLAVE
« Defined automatically for a project that has been configured to be a Master project and has
had a Slave project associated with it (hence indicating to the Master project which cpu type
the Slave project is for).
_ MULTICORE_MOSLAVE
* Appropriate one defined automatically for a project that has been configured to be a Slave
project
_ MULTICORE_NONE
» Defined automatically for a project which has not been configured as either a Slave or Master
project
Note: The multicore support within MCUXpresso IDE is highly flexible and provides
functionality beyond that required for the LPC5411x family. Thus the symbols
_ MULTICORE_MASTER_SLAVE_MA4SLAVE and _ MULTICORE_MA4SLAVE are also
provided for completeness.
19.5.2 Slave Boot Code
boot_multicore_slave() is called by the Master project code created directly by the New project
wizard to release the Slave core from sleep.
Note: The source files containing this function will be included in all LPC541xx projects, but will
be conditionally compiled so that it is included only when required. This has been done to allow
projects originally created, for example, as a Slave project, to be reconfigured (via the project
properties — linker multicore tab) as a Master project.
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19.5.3 Reset Handler code

When configured as a Master project, the LPC541xx startup file will be built with additional
(assembler) code at the beginning of the reset handler, ResetISR(), with the ‘standard ‘ reset
handler code moved to ResetISR2().

This additional code is required in order to allow correct booting of both the Master and Slave
cores. It is written in assembler in order to force it to be ‘Thumbl’ code, and hence runnable by
both cores. h1l. Appendix — Additional Hints and Tips

19.6 Part Support Handling from SDKs

MCUXpresso IDE needs specific device information provided by the SDK in order to properly:

e Create/import projects
 with part specific startup code
« Define memory layout
« Create debugging launch configuration
e Perform flash programming

This detailed part knowledge is known as Part Support.

19.6.1 SDK Version control

MCUXpresso IDE obtains new Part Support from installed SDKs. The IDE’s internal database
only uses SDKs with the highest version number (latest version is v2.6). For example, a user
may have installed two SDKs for a single part:

+ SDK_2.3.0_FRDM-K64F
+ SDK_2.0.0_FRDM-K64F

The IDE loads only the 2.3.0 version of that SDK, and also provides a warning in the SDK View
header:

7

) Installed SDKs £2 [7] properties ) Console |*| Problems [] Memary Q} Instruction Trace g SWO Trace Config B Power Measure

) Installed SDKs 'SDK 2.x FRDM-KB4F' ('2.2.0') replaced by SDK version ('2.3.0').

To install an SDK, simply drag and drop an SDK (zip file/folder) into the ‘Installed SDKs' view.

Name SDK Version Manifest Version Location
{1 SDK_2.%_FRDM-KE4F 2.3.0 3.2.0 (=] /SDK_2.3.0_FRDM-KE4F.zip

In this situation, it is likely that the user no longer needs the older version of the SDK. Therefore
the IDE provides an option to delete this older SDK via clicking on the warning message, and
clicking the ‘X'

(_] Installed SDKs E3 j Properties E Conscle |:_ Problems D Memory G& Instruction Trace ;;' SWO Trace Config B3 Power Measuremt

5 Installed SDKs 'Sni 2« EBDM-KRAE {9 20 ranlacad bu SNK warsinn (22 % 00

To install an SDK, simply dra T 'SDK_2.x_FRDM-KB84F' ('2.2.0') replaced by SDK version |_'2.3.

Name SDK Version Manifest Version Location

 SDK_2.x_FRDM-KB4F 2.3.0 3.2.0 @‘ /SDK_2.3.0_FRDM-K64F.zip

Note: Once a new SDK for a part is installed, it will always replace any older installed SDK for
that part, even if the new SDK is deactivated (by unchecking the associated tick box). The effect
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19.6.3
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of deactivating an SDK is that part support and wizard will be removed from internal views. These
will be restored if the SDK is activated again.

SDK Manifest versioning

Along with SDK versioning, also the internal manifest in an SDK can have multiple versions.
MCUXpresso IDE loads the manifest associated to its internal version head info. Thus, assuming
an IDE with internal head version set to 3.3, we could have an SDK with the following manifests:
¢ Manifest version 3.3

* Manifest version 3.2

« Manifest version 3.1

¢ Manifest version 3.0

In such case, the IDE will load the manifest version 3.3 (the latest version is v3.5).

After loading, the IDE validates the manifest against the schema version head, and if for any
reason this is not valid, it will try with the other schema versions. If the manifest 3.3 cannot be
validated, then it tries with manifest 3.2, validating it, and so on. The manifest version is shown
in the SDK View and any validation errors are shown in the Error Log.

In the case that the IDE loads an older manifest, or in the case the SDK contains a manifest 3.4

and the IDE manifest head is 3.3, the SDK image in the SDK view is decorated with a warning
and, by clicking on the SDK, a message appears in the SDK view header:

(7] Installed SDKs #2 [] Properties ) Console |*/ Problems [] Memory

1 Installed SDKs A newer version of MCUXpresso IDE is recommendei

To install an SDK, simply drag and drop an SDK (zip file/folder) into the ‘Iinstalle

Mame SDK Version Manifest

‘%% SDK_2.x_FRDM-K64F 23.0 3.2.0

The full error will look like: "A newer version of the MCUXpresso IDE is recommended for use
with the selected SDK. Please update your MCUXpresso IDE in order to get full SDK features"

At the time of the MCUXpresso IDE v10.2.0 release, such an error should never occur. However,
in the future, newer SDKs may be released supporting features not understood by this version
of the IDE. This will be used to warn users that there is a miss match between the SDK and
IDE capabilities.

Device versions

If the user installs more than one SDK containing the same device (i.e. a device with the same
identifier), the IDE loads the part support from the device with the highest version number,
regardless of which SDK it is located within. If two or more SDKs have the same device with
the same version number, then the order these are presented to the IDE by the host OS will
determine which SDK is used.

If an SDK in the Installed SDK view contains a device that is not installed (because it is supplied
by another SDK), its image (and the device in the SDK tree) will be decorated with an icon:
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19.7.1

19.7.2

MCUXpresso IDE User Guide -

{J} Installed SDKs 2 7] properties &) Console |*! Problems G Memary & Instruction Trace ;;; SWO Trace Config BD Power Measurement £, Symbol Viewe
X
@ Installed SDKs

To install an SDK, simply drag and drop an SDK (zip file/ffolder) into the 'Installed SDKs' view.

Name SDK Version Manifest Version Lucalmn

1 SDK_2.x_FRDM-K&4F-AGMO1 2.2.0 3.0.0 (SDK_2.0_FRDM-KB4F-agm( » . Boards

[v] "% SDK_2.x_FRDM-KG4F 2. .0. Fk <Default Location>/SDK_2.0.0_FRDOM-KG4F.zip [ S sl

B

¥ [oig Compilers
¥ i3 Toolchains
P (2 Toolchain Se
¥ <k Components

How do | switch between Debug and Release builds?

By default, MCUXpresso IDE projects will automatically have two build configurations, Debug
and Release. Typically a project will be developed using the Debug build variant, but switched
to Release late in the development cycle to benefit from more compilation optimisations.

Changing the build configuration of a single project

You can switch between Debug and Release build configurations by selecting the project you
want to change the build configuration for in the Project Explorer view, then using one of the
below methods:

¢ Select the menu item Project->Build Configuration->Set Active and select Release or
Debug as necessary

¢ Use the drop down arrow next to the ‘sundial’ (Manage configurations for the current project)
icon on the main toolbar (next to the ‘hammer’ icon) and select Release or Debug as
necessary. Alternatively, you can use the drop down next to the ‘hammer’ icon to change the
current configuration and then immediately trigger a build.

% - % - 5 | {,:3 ..,;';'- - C::::I -'T'
0 v’th Debug (Debug bmldj ;
' 2 Releasze (Release build)

&

« Right click in the Project Explorer view to display the context sensitive menu and select Build
Configurations->Set Active entry.

Changing the build configuration of multiple projects

Itis also possible to set the build configuration of multiple projects at once. This may be necessary
if you have a main application project linked with a library project, or you have linked projects for
a multicore MCU such as an LPC43xx or LPC541xx (one project for the master Cortex-M4 CPU
and another for a slave Cortex-M0/M0+ CPU).

To do this, you first of all you need to select the projects that you wish to change the build
configuration for in the Project Explorer view — by clicking to select the first project, then use
shift-click or control-click to select additional projects as appropriate. If you want to change all
projects, then you can simply use Ctrl-A to select all of them.

Note: it is important that when you select multiple projects, you should ensure that none of the
selected projects are opened out — in other words, when you selected the projects, you must not
have been able to see any of the files or the directory structure within them. If you do not do this,
then some methods for changing the build configuration will not be available.

Once the required projects are selected, you then need to simply change the build configuration
as you would do for a single project.
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19.8 Editing Hints and Tips

The editor view within Eclipse, which sits under the MCUXpresso IDE, provides a large number
of powerful features for editing your source files.

19.8.1 Multiple views onto the same file
The Window -> Editor menu provides several ways of looking at the same file in parallel.
« Clone : two editor views onto the same file
« Toggle Split Editor : splits the view onto the current file into two (either horizontally or

vertically)

19.8.2 Viewing two edited files at once
To see more than one file at the same time, simply click the file tabs that you have open in the
editor view, and then keep the mouse button held down and drag that file tab across to the right.
After you've moved to the side, or below, an outline should appear showing you where that tab
will be placed once you release the mouse button.

19.8.3 Source folding
Within the editor view, functions, structures etc. may be folded to show the structure and hide
the detail.
Folding is controlled via, right click in the margin of the editor view to bring up the context sensitive
menu, then select Folding -> <option required>
When folding is enabled, you can then click on the + or - icon that now appear in the margin next
to each function, structure, etc, to expand or collapse it, or use the Folding -> Expand all and
Folding -> Collapse all options from the context sensitive menu
Various settings for Folding can also be controlled through:
Preferences -> C/C++ -> Editor -> Folding

19.8.4 Editor templates and Code completion
Within the editor, a number of related pieces of functionality allow you to enter code quickly and
easily.
First of all, templates are fragments of code that can be inserted in a semi-automatic manner to
ease the entering of repetitive code — such as blocks of code for C code structures such as for
loops, if-then-else statements and so on.
Secondly, the indexing of your source code that is done by default by the tools, allows for auto
completion of function and variable names. This is known as “content assist”.
« Ctrl-Space at any point will list available editor template, function names etc.
« Ctrl-Shift-Space will display function parameters
« Alt-/ for word completion (press multiple times to cycle through multiple options).
In addition, the predefined templates are user extensible via:
Preferences -> C/C++ -> Editor -> Templates

19.8.5 Brace matching
The editor can highlight corresponding open and closing braces in a couple of ways.
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First of all, if you place the cursor immediately to the right of a brace (either an opening or closing
brace), then the editor will display a rectangle around the corresponding brace.

Secondly, if you double click immediately to the right of a brace, then the editor will automatically
highlight all of the text between this brace and the corresponding one.

Syntax coloring

Syntax Coloring specifies how your source code is rendered in the editor view, with different
colors used for different elements of your source code. The settings used can be modified in:

Preferences -> C/C++ -> Editor -> Syntax Coloring

Note that general text editor settings such as the background color can be configured in:
Preferences -> General -> Text Editors

Fonts may be configured in:

Preferences -> General -> Appearance -> Colors and Fonts

Comment/uncomment block

The editor offers a number of ways of comment in or out one or more lines of text. These can
be accessed using the Source entry of the editor context-sensitive menu, or using the following
keyboard shortcuts...

¢ Select the line(s) to comment, then hit Ctrl-/ to comment out using // at the start of the line, or
uncomment if the line is currently commented out.

¢ Select the line(s) to comment, then hit Ctrl-Shift-/ to block comment out (placing /* at the start
and */ at the end).

¢ To remove a block comment, hit Ctrl-Shift-\.

Format code

The editor can format your code to match the coding standards in use ( Preferences -> C/C
++ -> Code Style). This can automatically deal with layout elements such as indentation and
where braces are placed. This can be carried out on the currently selected text using the Source-
>Format entry of the editor context-sensitive menu, or using the keyboard shortcuts Ctrl-Shift-F.
If no text is selected, then the format will take place on the whole of the current file.

Correct Indentation

As you enter code in the editor, it will attempt to automatically indent your code appropriately,
based on the code standards in use, and also the layout of the preceding text. However, in
some circumstances, for example after manually laying text out, you may end up with incorrect
indentation.

This can usually be corrected using the Source->Correct Indentation entry of the editor context-
sensitive menu, or using the keyboard shortcuts Ctrl-I.

Alternatively, use the “Format code” option which will fix other layout issues in addition to
indentation.

Insert spaces for tabs in editor

You can configure the IDE so that when editing a file, pressing the TAB key inserts spaces instead
of tab characters. To do this go to
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Preferences -> General -> Editors -> Text Editors

and tick the “Insert spaces for tabs” box. If you tick “Show white-space characters” you can see
whether a tab character or space characters are being inserted when you press the TAB key

Replacing tabs with spaces
To replace existing tabs with spaces throughout the file, open the Code Style preferences:

Preferences -> C/C++ -> Code Style

« Select a Code Style profile and then select Edit...
¢ Choose the Indentation tab

For the Tab policy, select Spaces only

Apply the changes.

* Note: If the Code Style has not been edited before, the Profile must be renamed before the
change can be applied.

¢ The new style will be applied when the source is next formatted using Source -> Format

Hardware Floating Point Support

Most ARM-based systems — including those based on Cortex-M0, MO+ and M3, have historically
not implemented any form of floating point in hardware. This means that any floating point
operations contained in your code will be converted into calls to library functions that then
implement the required operations in software.

However, many Cortex-M4 based MCUs do incorporate a single precision floating point hardware
unit. Note: that the optional Cortex-M4 floating point unit implements single precision operations
(C/C++float) only. Thus if your code makes use of double precision floating point (C/C++ double),
then any such floating point operations contained in your code will still be converted into calls to
library functions that then implement the required operations in software.

Similarly, Cortex-M7 based MCUs may incorporate a single precision or double precision floating
point hardware unit.

Floating Point Variants

When a hardware floating point unit is implemented, ARM define that it may be used in one of
two modes.

SoftABI

« Single precision floating point operations are implemented in hardware and hence provide a
large performance increase over code that uses traditional floating point library calls, but when
calls are made between functions any floating point parameters are passed in ARM (integer)
registers or on the stack.

¢ SoftABI is the ‘most compatible’ as it allows code that is not built with hardware floating point
usage enabled to be linked with code that is built using software floating point library calls.

HardABI

« Single precision floating point operations are implemented in hardware, and floating point
registers are used when passing floating point parameters to functions.

HardABI will provide the highest absolute floating point performance, but is the ‘least compatible’

as it means that all of the code base for a project (including all library code) must be built for
HardABI.
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Floating point use — Preinstalled MCUs

When targeting preinstalled MCUs, MCUXpresso IDE generally assumes that when Cortex-M4
hardware floating point is being used, then the SoftABI will be used. Thus generally this is the
mode that example code (including for example LPCOpen chip and board libraries) are compiled
for. This is done as it ensures that components will tend to work out of the box with each other.

When you use a project wizard for a Cortex-M4 where a hardware floating point unit may be
implemented, there will be an option to enable the use of the hardware within the wizard’s options.
This will default to SoftABI — for compatibility reasons.

Selecting this option will make the appropriate changes to the compiler, assembler and linker
settings to cause SoftABI code to be generated. It will also typically enable code within the startup
code generated by the wizard that will turn the floating point unit on.

You can also select the use of HardABI in the wizards. Again this will cause appropriate tool
settings to be used. But if you use this, you must ensure that any library projects used by your
application project are also configured to use HardABI. If such projects already exist, then you can
manually modify the compiler/assembler/linker settings in Project Properties to select HardABI.

Warning : Creating a project that uses HardABI when linked library projects have not been
configured and built with this option will result in link time errors.

Floating point use — SDK installed MCUs

When targeting SDK installed MCUs, MCUXpresso IDE generally assumes that when hardware
floating point is available, then the HardABI will be used. This will generally work without problem
as generally projects for such MCUs contain all required code (with no use of library projects).

However, it is still possible to switch to using SoftABI using the “Advanced Properties settings”
page of the |New project" and “Import SDK examples” wizards.

Modifying floating point configuration for an existing project

If you wish to change the floating point ABI for an existing project (for example to change it from
using SoftABI to HardABI), then go to:

Quickstart -> Quick Settings -> Set Floating Point type

and choose the required option.

Alternatively, you can configure the settings manually by going to:
Project -> Properties -> C/C++ Build -> Settings -> Tool Settings

and changing the setting in ALL of the following entries:

¢ MCU C Compiler -> Architecture -> Floating point
« MCU Assembler -> Architecture & Headers -> Floating point
¢ MCU Linker -> Architecture -> Floating point

Note: For C++ projects, you will also need to modify the setting for the MCU C++ Compiler.

Warning: Remember to change the setting for all associated projects, otherwise linker errors
may result.

Do all Cortex-M4 MCUs provide floating point in hardware?

Not all Cortex-M4 based MCUs implement floating point in hardware, so please check the
documentation provided for your specific MCU to confirm.
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In particular with some MCU families, some specific MCUs may not provide hardware floating
point, even though most of the members of the family do (for example the LPC407x_8x). Thus it
is a good idea to double check the documentation, even if the project wizard in the MCUXpresso
IDE for the family that you are targeting suggests that hardware floating point is available.

Why do | get a hard fault when my code executes a floating point
operation?

If you are getting a hard fault when your application tries to execute a floating point operation,
then you are almost certainly not enabling the floating point unit. This is normally done in the
LPCOpen or SDK initialisation code, or else in the startup file that MCUXpresso IDE generates.
But if there are configuration issues with your project, then you can run into problems.

For more information, please see the Cortex-M4 Technical Reference Manual, available on the
ARM website.

LinkServer Scripts

The LinkServer debug server supports a Basic like programming language that can be used to
script low level target operations. Within a LinkServer debug connection, we provide two call
outs where scripts can be referenced (if required). The first call out is intended to assist with the
initial debug connection, via a Connect Script, and the second is to assist with the targets reset
via a Reset Script.

These scripts are specified within a LinkServer launch configuration file and will be preselected
if needed for projects performing standard connections to known debug targets.

Supplied Scripts

A set of scripts are supplied within the MCUXpresso IDE installation at:

<install dir>/ide/bin/Scripts

These scripts will be used to prepopulate LinkServer launch configuration files when needed.

The purpose of certain scripts will be described below:

* kinetismasserase.scp - invoked by the GUI Flash Programmer to Resurrect locked Kinetis
device

¢ kinetisunlock.scp - if for any reason the GUI Flash Programmer fails to resurrect a locked part
(as above), this script can be specified in place of the above and the recovery attempt repeated

« delayexample.scp - an example script showing how a delay can be performed

User Scripts

Additional user generated scripts can be added directly to the product installation but more
typically they should be located within a project. The LinkServer launch configuration allows the
location of scripts to be either project relative, absolute or product local.

Debugging code from RAM

[This section is deprecated — please see
for details of the improved scheme]

MCUs have well defined boot strategies from reset, typically they will first run some internal
manufacturer boot ROM code that performs some hardware setup and then control passes to
code in flash (i.e. the users Application).
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On occasion it can be useful to run and debug code directly from RAM. Since an MCU will not
boot from RAM a scheme is needed to take control of the debuggers reset mechanism. This can
be achieved the use of a LinkServer reset script.

Within MCUXpresso IDE, certain pre-created scripts are located at:

{install dir}/bin/Scripts

Contained in this directory is a script called kinetisRamReset.scp (see below).

10 REM Kinetis K64F Internal RAM (@ 0x20000000) reset scri pt

20 REM Connect script is passed PC/SP fromthe vector table in the i mage by the debugger
30 REM For the sinple use case we pass them back to the debugger with the | ocation of the
45 REMreset context.

40 REM

50 REM Syntax here is that '~ commands a hex output, all integer variables are a%to z%
70 REM Find the probe index

80 p% = probefirstfound

90 REM Set the 'this' probe and core

100 sel ect probecore p% 0

110 REM NOTE!'! Vector table presuned RAM | ocation is address 0x20000000

120 REM The script passes the SP (%) and PC (%) back to the debugger as the reset context
130 b% = peek32 this 0x20000000

140 a% = peek32 this 0x20000004

150 print "Vector table SP/PC is the reset context."

160 print "PC = "; ~a%
170 print "SP = "; ~b%
180 print "XPSR = "; ~c%
190 end

This reset script makes an assumption that the user intends to run code from RAM at 0x20000000
— this is the value of the SRAM_Upper RAM block on Kinetis parts.

Note: To build a project to link against RAM, you can simply delete any flash entries within the
projects memory configuration. If the MCUXpresso IDEs default linker settings are used then
project will link to the first RAM block in the list. For many Kinetis parts, this address will match the
expected address within the script. For some parts (for example KLxx) however, the first RAM
block may take a different value. This problem can be resolved by editing the script or modifying
the projects RAM addresses.

For users if LPC parts, the RAM addresses will be different but the principal remains the same.
Within the Scripts directory, you will find an RAM reset script for the LPC18LPC43 parts, this
script is identical to the one above apart from the assumed RAM address.

Finally, to use the script, simply edit the projects launch configuration for the ‘Reset Script’ entry,
browse to the appropriate ‘RAMReset.scp’ script.

Note: When executing code from RAM, the projects Vector table will also be located at the
start of the RAM block. Cortex M MCUs can locate their vector table using an internal register
called VTOR (the vector table offset register). Typically this register will be set automatically by
a projects startup or init code. However, if execution fails when an interrupt occurs, check that
this register is set the correct value.

LinkServer Scripting Features
LinkServer scripts are written in a simple version of the BASIC programming language. In this

variant of BASIC, 26 variables are available (%a thru %z). On entry to the script some variable
have assigned values:
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% is the PC
% is the SP
% is the XPSR

On exit from the script %a is loaded into the PC and %b is loaded into the SP, thus providing a
way for the script to change the startup behavior of the application.

They offer functionality as shown below:

Generic BASIC like functions that only work inside scripts

GOTO ' Li neNunber'
IF '"relation' THEN 'statenent'
REPEAT : Start of a repeat block
UNTIL 'relation'
BREAKREPEATTO ' Li neNunber '
GOSUB ' Li neNunber '

RETURN

TIME : Returns a 10ms increnenting count fromthe host

End with condition of repeat block

Premature end of a repeat |oop

Generic BASIC like functions

PEEK8 {[TH 9] [ <Probel ndex> <Cor el ndex>]} <Address>
PEEK16 {[ TH ] [ <Probel ndex> <Cor el ndex>]} <Address>
[ <Probel ndex> <Cor el ndex>]} <Address>

POKES {[TH S|
POKE16 {[ THI S
POKE32 {[ THI S

[

[
PEEK32 {[THI S|

[

[

[ <Pr obel ndex>
[ <Pr obel ndex>
[ <Pr obel ndex>

<Cor el ndex>] }
<Cor el ndex>] }

<Addr ess> <Dat a>

<Addr ess> <Dat a>

<Cor el ndex>]} <Address> <Dat a>

QPOKE8 {[TH S] |
QPOKEL6 {[THI S] |
QPOKE32 {[THI'S] | [<Probel ndex> <Corel ndex>]} <Address> <Data>
QSTARTTRANSFERS {[ THI S] | [<Probel ndex> <Corel ndex>]} <NunReads>
MEMDUMP {[ THI S] | [<Probel ndex> <Corel ndex>]} <Byte Address> <Length>
MEMLOAD {[THI S] |
Limt>
MEMSAVE {[THI S] |
Saves nenory to binary file
PRI NT "TEXT"[;[~] Variabl e |

and/ or val ue of an internal

[ <Probel ndex> <Cor el ndex>]} <Address> <Dat a>
[ <Probel ndex> <Cor el ndex>]} <Address> <Dat a>

[ <Probel ndex> <Corel ndex>]} <FileNane> <Byte Address> <Length
Loads binary file data to nenory

[ <Probel ndex> <Corel ndex>]} <FileNane> <Byte Address> <Length>
Constant]: Print statenent.
variable (a%n0- 2989,
hexadeci mal [ ~] for mat

Prints quoted text
or constant integer
expression in decinmal, or
TIME : Returns an increnenting centisecond count fromthe host

TIMEMS : Returns an increnenting mllisecond count fromthe host
WAI T <nsec> :

LI ST: Lists a | oaded scri pt

Wait for the nunber of milliseconds before proceding

NEW Erases a | oaded script from menory
RENUMBER <Del t a>:

LOAD <"FI LENAME" >:
SAVE <" FI LENAME" >:

Renunber script lines with Delta increment (default is 10)

Loads a script fromthe current, absolute, or relative directory

Saves a script to the current, absolute, or relative directory

Probe related functions

PROBELI ST :
PROBENUM : Returns the nunber of probes attached
PROBEOPENBY! NDEX <Pr obel ndex> [ <" FlI LENAVE" >]
FI LENAME is text of <key = value> pairs used for
PROBEOPENBYSERI AL <" Ser i al Nunber "> :

Enunerates and returns an indexed |ist of known probe types

QOpens the probe associated with Probel ndex
internal configuration

Opens the probe associated with Serial Nunber
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PROBECLCOSEBY! NDEX <Pr obel ndex> : Cl oses the probe associated with Probel ndex
PROBECLOSEBYSERI AL <" Seri al Nunber"> : C oses the probe associated with Serial Nunber
PROBEFI RSTFOUND : Returns the THI' S Probel ndex or index of the first probe in the
enunerated |i st

PROBET!I ME <Probel ndex> : Returns el apsed tinme fromfirnware boot, if supported
PROBESTATUS [ <Pr obel ndex>]: Returns an indexed |ist sunmmary of the status of the
probes connected to the system

PROBEVERSI ON <Pr obel ndex>: Returns version information about probe firmare
PROBEI SOPEN <Pr obel ndex>: Returns TRUE or FALSE

PROBEHASJTAG <Pr obel ndex>: Returns TRUE or FALSE

PROBEHASSWD <Pr obel ndex>: Returns TRUE or FALSE

PROBEHASSW <Pr obel ndex>: Returns TRUE or FALSE

PROBEHASETM <Pr obel ndex>: Returns TRUE or FALSE

Core/TAP related functions

CORECONFI G {[THI S] | [<Probelndex>]}: Queries the scan chain configuration

CORESCONFI GURED <Pr obel ndex>: Returns TRUE or FALSE

CORELI ST {[THI'S] | [<Probelndex>]}: [<APLinmt>]: Detailed |ist of TAPs/Cores
connected to the specified probe. APLimt restricts queries to AP index.

COREREADI D {[THI S] | [<Probel ndex> <Corelndex>]}: Returns the DplD

Wire related functions

W RESWDCONNECT {[THI S] | [<Probel ndex>]}: Configures the wire for SWD and
returns the Dpl D

W REJTAGCONNECT {[THI S] | [<Probelndex>]}: Configures the wire for JTAG

W REI SPRESET {[THI S] | [<Probelndex>]}: Resets an LPC part into the ISP

boot | oader

W RETI MEDRESET <Probel ndex> <ns>: Asserts (Low) reset for ns nilliseconds and
returns the end state of the wire

W REHOLDRESET <Probel ndex> <State> : Asserts/Rel eases (Low Hi gh) reset and
returns the end state of the wire

W RESTATUS <Probel ndex> : Returns the status of the wire connection on the
probe specified

W RESETSPEED <Probel ndex> <Hz>: Requests a particular wire speed in Hz

W RECGETSPEED <Probel ndex> : Returns the current wire speed

W RESETI DLECYCLES <Pr obel ndex> <Cycl es>: Sets the nunber of idle cycles between
debug transacti ons

W RECETI DLECYCLES <Probel ndex> : Returns the current nunber of debug idle cycles
W REI SCONNECTED <Pr obel ndex>: >: Returns TRUE or FALSE if W RESWDCONNECT or
W REJTAGCONNECT is conpl ete

W REGETPROTOCOL <Pr obel ndex>: Returns SWD or JTAG

SELECTPROBECORE <Pr obel ndex> <Corel ndex> : Sets the THI S paraneter Probe/Core
pair

TH S : Displays the current Probe, Core pair

Cortex-M related functions

CM NI TAPDP {[THI S] | [<Probel ndex> <Corelndex>]}: Initialize a CM core ready
for debug connections

CMARI TEDP {[ THI S] | [<Probel ndex> <Corel ndex>]} <REG> <DATA>: Returns zero on
success

CMARI TEAP {[ THI S] | [<Probel ndex> <Corel ndex>]} <REG> <DATA>: Returns zero on
success

CVMREADDP {[THI S] | [<Probel ndex> <Corel ndex>]} <REG>: Returns data

CVREADAP {[THI S] | [<Probel ndex> <Corel ndex>]} <REG>: Returns data (handl es
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RDBUF on AP reads)

CMCLEARERRORS {[ THI S] | [<Probel ndex> <Cor el ndex>] }

CVHALT {[THI S] | [ <Probel ndex> <Corel ndex>]}

CVMRUN {[THI S] | [<Probel ndex> <Cor el ndex>]}

CVREGS {[THI S] | [ <Probel ndex> <Corel ndex>]}

CMVDEBUGSTATUS{[ THI S] | [ <Probel ndex> <Cor el ndex>] }

CMARI TEREG {[ THI S] | [ <Probel ndex> <Corel ndex>]} <RegNunmber> <Val ue>
CVMREADREG {[ THI S] | [ <Probel ndex> <Corel ndex>]} <RegNumber >

CMMTCHLI ST {[THI S] | [ <Probel ndex> <Cor el ndex>] }

CMMTCHSET {[THI S] | [ <Probel ndex> <Corel ndex>]} <DWIl ndex> <Address> [ <RW R W]
CMMTCHCLEAR {[ THI S] | [ <Probel ndex> <Corel ndex>]} <DWII ndex>

CMBREAKLI ST {[THI S] | [<Probel ndex> <Corelndex>]} : List the FPB breakpoints
CMBREAKSET {[THI S] | [ <Probel ndex> <Corel ndex>]} <Address> : Set an FPB
CMBREAKCLEAR {[ THI S] | [ <Probel ndex> <Corel ndex>]} [<Address>] : Clear an FPB
CMBYSRESETREQ {[ THI S] | [<Probel ndex> <Corelndex>]} : Systemreset request
CWECTRESETREQ {[ THI S] | [ <Probel ndex> <Corel ndex>]} : Core reset request
CVRESETVECTORCATCHSET {[ THI S] | [ <Probel ndex> <Corelndex>]} : Enable reset
vector catch

CVRESETVECTORCATCHCLEAR {[ THI S] | [<Probel ndex> <Corel ndex>]} : Disable reset
vector catch

Miscellanious

HELP : display hel p on LinkServer conmands

VERSION : returns the LinkServer version

CONNECTI ONS : di splay active connections

Scripts can be specified within a LinkServer launch configuration to be run before a connection
and/or before a reset.

RAM projects with LinkServer

MCUs have well defined boot strategies from reset, typically they will first run internal
manufacturer boot ROM code to perform some hardware setup and then pass control to code
in flash (i.e. the users Application).

Most examples and wizards create projects to run from MCU flash memory but on occasion it
can be useful to debug code directly from RAM. There are two stages to such a task:

1. Modify a project to that it links to run from RAM
2. Modify the default reset mechanism to ensure that the RAM image is executed

To build a project to link against RAM, simply delete any flash entries within the projects memory
configuration. If the MCUXpresso IDEs default linker settings are used then the project will then
link against the first RAM block in the list (provided no Flash entry is present). Alternatively, from:

Project Properties -> C/C++ Build -> Settings -> MCU Linker -> Manager Linker Script, you can
check the entry Link application to RAM.

Note: if the project has already been built to link to flash, then it should be cleaned before being
rebuilt.

Since an MCU will not automatically boot from RAM, a scheme is needed to take control of the
debuggers reset mechanism. This can be achieved via the use of a SOFT reset type. LinkServer
launch configurations can take an additional option, add the line --reset soft to override the default
reset type. Or preferably, set the reset type to 'SOFT' as shown below.
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LinkServer Options

~ Debug Connection
Settings for the debug connection

Attach only Reset on Connect

Reset script B4 | Workspace... File System...

Connect script | kinetisconnect.scp “ Workspace... File System...
Default

BootROM stall
SYSRESETREQ
VECTRESET

Flash driver reset handling 4 Resst handling v SOFT

Disconnect behavior cont u Semihosting support s a

A soft reset is performed by setting the PC to the images resetISR() address, the stack pointer
to the top of the first RAM region and VTOR (Vector Table Offset Register) to the base address
of the first RAM region.

Note: Typically, MCU RAM sizes will be smaller that Flash sizes, therefore such a scheme may
not be suitable for larger images.

19.11.1 Advantages of developing with RAM projects

There are a number of advantages when debugging from RAM:

* Breakpoints in RAM do not require dedicated HW resources, essentially there is no limit of the
number of breakpoints that can be set.

¢ Flash programming step is not required, so the build and debug cycle will be faster.

» Development of secondary bootloaders is free from BootROM considerations

« No risk of accidently triggering Flash security features.

« No requirement to understand or have flash programming capability allowing code (including
flash drivers) can be developed.

< Any flash contents are preserved while debugging

¢ Unit development of large applications

Note: It should be remembered that since the MCU will not undergo a true hardware reset,

peripheral configurations will be inherited from one debug session to the next.

19.12 The Console View

The Console View contains a number of different consoles providing textual information about the

operation of various parts of MCUXpresso IDE. It is located by default in the bottom right of the

Debug Perspective, in parallel with a number of other views — including the ‘Installed SDKs’ view.

The actual consoles available within the Console view will depend upon what operations are

currently taking place — in particular a number of consoles will only become available once a

debug session is started.

The currently displayed console will provide a local toolbar, with icons to do things like copying

the contents of the console or clearing its contents.

To see the list of currently available consoles, and, if required, change to a different one..

1. Switch to the Console View

2. Using the toolbar within the Console View click on the drop-down arrow next to the Display
Selected Console icon (which looks like a small monitor)

3. Select the require console from the drop down list
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(1) Installed SDKs (=] Properties [*! Problems E Console &2 Terminal . Image Info 53 Debugger Console s
- AR EEE 481
MKE4FN1 Moxxl“" Peninnd | inliaciine Mok PO IMVD O H -] L LASLL A tH 2. N AV ACAIA LM AN Panlaad ad

|[MCUXpresso | 1 RedlinkServer In
2 FreeRTOS Task Aware Debugger Console version 11.0.0 (201904171217)

[l 3 CDT Global Build Console
[ 4 CDT Build Console [MKE4FN1MO0xxx12_Project]
5 MK64FN1MOxxx12_Project LinkServer Debug [C/C++ (NXP Semiconductors) MCU Application] gdb traces
[ 6 MKE4FN1MOx00x12_Project Debug messages
[ 7 MK64FN1M0x0012_Project LinkServer Debug [C/C++ (NXP Semiconductors) MCU Application] MK64FN 1MOxxx12_Project.axf

19.12.1 Console types

Consoles you will typically see include the following...
Build Console and Global Build Console
The Build Console (sometimes referred to as the Build Log) is used by the MCUXpresso IDE
build tools (compiler,linker, etc.) to display output generated when building your project. In fact
MCUXpresso IDE has two build consoles — one of which records the output from building the
current project, and the second a global build console which will record the output from building
all projects.
By default, the number of lines stored in the Build Console is limited to 500 lines. You canincrease
this to any reasonable number as follows:
1. Select the Windows->Preferences menu option
2. Now choose C/C++ -> Build -> Console
3. Increase the "Limit Console out (number of lines)" to a larger number, for instance 5000.
Note: This setting, like most within the MCUXpresso IDE is saved as part of your workspace.
Thus you will need to make this change each time you create a new workspace.
Other options that can be set in Preferences include whether the console is cleared before a
build, whether it should be opened when a build starts, and whether to bring the console to the
top when building.
Once your build has completed, then if you have any build errors displayed in the console, clicking
on them will, by default, cause the appropriate source file to be opened at the appropriate place
for you to fix the error.
FreeRTOS Task Aware Debugger Console
This console displays status about the FreeRTOS TAD views. For more details, please see the
MCUXpresso IDE FreeRTOS Debug Guide.
gdb traces and arm-none-eabi-gdb Consoles
These consoles give access to the GDB command line debugger, that sits underneath the
MCUXpresso IDE’s graphical debugging front end.
RedlinkServer/LinkServer Console
This console gives access to the server application that sits at the bottom of the debug stack
when using a debug probe connected via the MCUXpresso IDEs native “LinkServer” debugging
mechanism. LinkServer commands can be entered from this console.
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Debug messages Console

The Debug Messages Console (sometimes referred to as the Debug Log) is used by the debug
driver to display additional information that may be helpful in understanding connection issues
when debugging your target MCU.

Semihosting Console

This console, generally displayed with .axf, allows semihosted output from the application running
on the MCU target to be displayed, and potentially for input to be sent down to the target.

19.12.2 Copying the contents of a console
Occasionally, you may wish to copy out the contents of a console. For instance, the MCUXpresso
IDE support team may ask you to provide the details of your Build Console in a forum thread.
To do this:
1. Clean, then build your project.
2. Select the appropriate Build Console as above:
3. Select the contents (e.g. Ctrl-A)
4. Copy to the clipboard (e.g. Ctrl-C).
5. Paste from clipboard into forum thread (e.g. Ctrl-V). If there is a large amount of text in the
build console, it is advisable to paste it into a text file, which can be ZIPed if appropriate.
Note: some console will provide a button in their local toolbar to copy or save out their contents.
19.12.3 Relocating and duplicating the Console view
By default the Console View is positioned in parallel with a number of other views. This can
mean, if a console is being regularly updated with new output (for instance the view displaying
semihosted output from the application running on the target MCU), then by default this may
cause the console to keep jumping to the foreground — hence hiding other views that you are
using (for instance one of the SWO Trace views)
To avoid this you may wish to relocate the Console. To do this ...
1. Click and hold down on the Console View
2. Continue to hold down, and drag the cursor to the location you want to Console view to be
displayed
3. Then release the mouse click, and the Console view will be placed at the required position
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Another alternative is to spawn a duplicate instance of the Console view. This allows multiple
consoles to be visible at the same time. To do this use the Open Console button on the Console
view local toolbar

=Nl BoRdlelld
mo_apps_bubpleaxf &

""""""""" Open Console

and then select "New Console View"

[ 4 | = Eﬁ = @lﬁ” :-‘ Ev ﬂv
1 C/C++ Build Console
2 CVWS

3 Mew Console View

# 4 FreeRTOS Task Aware Debugger Console

This will then display a second console view, which can be drag and dropped to a new location
within in the Perspective, as shown for the single Console view case described above.
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Awaiting telnet connection on port 3338 ... 2
GDB nonstop mode enabled

Opening flash driver FTFE_4K.cfx (already resident)

Writing 26688 bytes to address @x89608088 in Flash

Erased/Wrote page @-6 with 26688 bytes in 324msec

Closing flash driver FTFE_4K.cfx

Flash Write Done

Flash Program Summary: 26638 bytes in 8.32 seconds (88.44 KB/sec)
Stopped: Breakpoint #1 o

B]

frdmkb4f_demo_apps_bubble Debug messages

e = == .

Having opened a second console view, select which console you want displayed in it, and then
use the “Pin Console” button to ensure that it does not switch to one of the other consoles when
output is displayed.

& B~

apps
APEE Pin Conscle §

Using Terminal View for UART communication with target

MCUXpresso IDE v10.2.0 (and later) provide a Terminal View, which can be used to display
UART (serial) input/output between a host PC and the target MCU. In situations where a debug
probe is built into the target board, UART comms will often be possible via a VCOM connection
over the same USB cable as the debug connection. However, where this is not the case a
serial_to_USB cable can be used, alternatively, if the target MCU has built in USB then a VCOM
port can implemented in the application code running on the target MCU.

Using a Terminal View offers an alternative way of interacting with the target when compared to
semihosting output via debug channel (which is displayed in the Console View). There are pros
and cons to both approaches, but one distinct advantage to using the Terminal View for serial
output is that you can interact with the target MCU without a debug session being active!

To use the Terminal View within MCUXpresso IDE, the first thing you will need to do is open it (as
it is not visible by default). To do this go to: Window -> Show View -> Other and select Terminal.
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(=3 @ Show View

» = Git

> (= Help

» (= Java

» (= Java Browsing

> (= Make

> [>MCUXpresso Config Toals

» (= MCUXpresso IDE

* [~>MCUXpresso |DE FreeRTOS

» = MCUXpresso |IDE Power Measurement

» (= MCUXpresso |DE Trace

» (= PEmicro
A Terminal

b (= A\ lalidatinn Viowr

Cancel

Alternatively, just type “Terminal” into the “Quick Access” button in the top right of the IDE’s
window.

Next, ensuring that the serial connection between your PC and the target MCU is active first,
click on the “Open a Terminal” button in the Terminal View's toolbar:

& Terminal 2 2 i &= 0

Open a Terminal (“CGT)

Note: If using the LPC-Link2 built into many LPCXpresso boards, then you need to make sure the
probe has been booted before the serial connection will be available. You can do this manually
by using the “Boot Debug probe” button in the tool bar towards the top of the IDE window. Or
else you can pre-program the probe firmware into flash using LPCScrypt.

Now select the type of terminal required — a serial one :

® © Launch Terminal ‘
Choose terminal + Local Terminal ’
Setti SSH Terminal
Ll Serial Terminal _
Encoding: ( Telnet Terminal ‘

P e RV e P I

And then select the appropriate settings:
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Launch Terminal

<>

Choose terminal:  Serial Terminal
Settings
Serial port: jdev/cu.usbmodemDSATBQD2 ¥

Baudrate: 115200

<>

<>

Data size: 8

<>

Parity: None

<>

Stop bits: 1

Encoding: Default (ISO-8859-1)

<>

) Cancel OK

Note: that if you are receiving serial output via USB (for instance over a VCOM port from the
debug probe), then the default settings should normally be fine. The one setting you do need to
get correct is the Serial port to use. This will vary depending upon what devices are connected
within your PC, what OS you are running, and what the source for your serial port will be.

For instance if you are running on Windows, then the simplest way to identify the required serial
port is to open “Device Manager” (typically via the “Start Menu”), then expand the “Ports” tab.
This should allow you to identify the appropriate COM port needed.

After configuring the settings as required, click on the “OK” button. You should now see serial
output from the application running on the target MCU within the Terminal View:

® Terminal 2 = e ARERE Y Be-=

SHELL (build: Apr 20 2018)
Copyright (c) 2017 NXP Semiconductor
SHELL>> help

"help": Lists all the registered commands
"exit": Exit program

"led argl arg2":

Usage:
argl: 1121314... Led index
arg2: onloff Led status

SHELL>>

PUPO Y T P L Y

Note: the Terminal view only offers a simple terminal mechanism with a small number of
configuration options. If you require more control over the way the terminal behaves, you may
still need to use a standalone terminal application, such as PuUTTY, CoolTerm and Tera Term.
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Using and troubleshooting LPC-Link2

LPC-Link2 hardware

LPC-Link2 is a powerful, low cost debug probe design from NXP Semiconductors based on the
LPC43xx MCU. It has been implemented into a number of different systems, including:

¢ The standalone LPC-Link2 debug probe
e The debug probe built into the range of LPCXpresso V2/V3 boards.

For more details, see http://www.nxp.com/lpcxpresso-boards

Softloaded vs Pre-programmed probe firmware

One thing that most LPC-Link2 implementation offer is the ability to either softload the debug
probe firmware (using USB DFU functionality) or to have the debug probe firmware pre-
programmed into flash.

Programming the firmware into flash has some advantages, including:

¢ Allows the use of the LPC-Link2 with toolchains that, unlike MCUXpresso IDE, do not support
softloading of the probe firmware.

« Better supports the use of LPC-Link2 as a small production run programmer

¢ Allows the LPC-Link2 to be used with SEGGER J-Link firmware as an alternative to the normal
CMSIS-DAP firmware. For more details please visit http://www.segger.com

¢ Avoids issues that the re-enumeration of the LPC-Link2 can sometimes trigger as the firmware
softloads (particularly where virtual machines are in use).

The recommended way to program the firmware into the flash of LPC-Link2 is NXP’s LPCScrypt
flash programming tool. For more details, see http://www.nxp.com/LPCSCRYPT

However, when used with MCUXpresso IDE, softloading the probe firmware is the recommended
method of using LPC-Link2 in most circumstances.

This ensures that the firmware version matching the MCUXpresso IDE version can automatically
be loaded when the first debug session is started (so normally the latest version). It also allows
different probe firmware variants to be softloaded, depending on current user requirements.

For this to work, you need to make sure that the probe hardware is configured to allow DFU
booting. To do this:

¢ For standalone LPC-Link2: remove the link from header JP1 (nearest USB)
e For LPCXpresso V2/V3: add a link to the header "DFU link"

LPC-Link2 firmware variants

As well as providing debug probe functionality, NXP's CMSIS-DAP firmware for LPC-Link2 by
default also includes bridge channels to provide:

¢ Support for SWO Trace capture from the MCUXpresso IDE

¢ Support for Power Measurement from the MCUXpresso IDE (certain LPCXpresso V3 boards
only)

¢ Support fora UART VCOM port connected to the target processor (LPCXpresso V2/V3 boards
only)

e Support for a LPCSIO bridge that provides communication to 12C and SPI slave devices
(LPCXpresso V3 boards only)
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However, two other variants of the CMSIS-DAP firmware are provided that remove some of these
bridge channels.

« “Non Bridged”: This version of firmware provides debug features only — removing the bridged
channels such as trace, power measurement and VCOM. By removing the requirement for
these channels, USB bandwidth is reduced, therefore this firmware may be preferable if
multiple debug probes are to be used concurrently. The non-bridged build will also provide an
increase in download and general debug performance.

¢ “VYCOM Only”: This version of firmware provides only debug and VCOM features. The removal
of the other bridges allows better VCOM performance (though generally the bridged firmware
provides more than good enough VCOM performance).

A particular workspace can be switched to softload a different firmware variant via: Preferences
-> MCUXpresso IDE -> LinkServer Options -> LPC-Link2 boot type.

[ NN ) Preferences

LinkServer Options Sy v w

> General Ask to boot LPC-Link 2

»C/C++
| & HI:EIp Boot LPC-Link 2
* Install/Update LPC-Link 2 boot type v CMSIS-DAP (default) '
> Java . CMSIS-DAP (Non-bridged - Debug only)
» Library Hover Redlink server port (restart required) CMSIS-DAP (VCOM serial bridge only)

MCUXpresso Config Tools
¥MCUXpresso IDE
Debug Options (Advanced) CMSIS-DAP SWO server port 8989
Debug Options (Miscellaneous) Enable Registers View Double-Precision registers group
Debug Probe Discovery
Default Tool settings
» Editor Awareness

Redlink wirespeed in Hz (0 = default) 0

Block IDE requests to kill redlink server

FreeRTOS TAD Shutdown redlink server
General Kill redlink server on exit
| J-Link Options
| LinkServer Options . r .
LPC-Link Options Show timestamps in Redlink console
MCU settings Enable range stepping
Paths and Directories Pull ISP on reset (on LPC-Link 2)

PEMirro Ontions

Note: If a mix of bridged and unbridged debug probes is required, then it is recommended that
these probes are pre-programmed with the required debug firmware. This can easily be done
via LPCScrypt.

Manually booting LPC-Link2

The recommended way to use LPC-Link2 with the MCUXpresso IDE is to allow the GUI to boot
and softload a debug firmware image at the start of a debug session.

Normally, LPC-Link2 is booted automatically (when configured to operate in DFU mode)
however, under certain circumstances — such as when troubleshooting issues, or using the
LinkServer command line flash utility, you may need to boot it manually.

LPC-Link2 USB Details

The standard utilities to explore USB devices on MCUXpresso IDE supported host platforms are:

¢ Windows — Device Manager
* MCUXpressolDE also provides a listusb utility in:
* install_dir/ide/bin/Scripts
¢ Linux — terminal command: Isusb
¢ Mac OS X — terminal command: system_profiler SPUSBDataType
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Before boot, LPC-Link2 appears as a USB device with details:

Devi ce Vendor | D/ Product | D 0x1FC9/ 0x000C (NXP Semi conduct or s)

and will appear in Windows -> Devices and Printers, as below:

-

LPC

After boot, LPC-Link2 will by default appear as a USB device with details:

Devi ce Vendor| D/ Product | D: 0x1FC9/ 0x0090

and will appear in Windows -> Devices and Printers similar to below:

"

LPC-LINK2
CMSIS-DAP
V3.224

Note: Text details will vary depending on version number and which probe firmware variant is
booted.

Booting from the command line
MCUXpresso IDE provides a boot script for all supported platforms. To make use of this script

first of all connect the LPC-Link2 to your PC then enter the commands into a DOS command
prompt (or equivalent):

cd <install_dir>\ide\bin
boot _I i nk2

This will invoke the dfu-util utility to download the probe firmware into the RAM of the LPC-Link2's
LPC43xx MCU and then re-enumerate the probe.

Booting from the GUI
It is also possible to manually boot LPC-Link2 from the MCUXpresso IDE GUI, which may be a

more convenient solution than using the command line. To do this, first of all connect the LPC-
Link2 to your PC, then locate the red Boot icon on the Toolbar:

P A0~ Q

Boot Debug Probe

and then click OK in the dialog displayed :
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Debug probe selection B %
Select the debug probes to be booted
[¥] LinkServer
[ selectan | [ Deselectan |
@.,\' [ OK ] | Cancel |

19.14.5 LPC-Link2 windows drivers
The drivers for LPC-Link2 are installed as part of the main MCUXpresso IDE installation process.
Note: One thing to be aware of is that the first time you debug using a particular LPC-Link2 on
a particular PC, the drivers will need to be loaded. This first time can take a variable period of
time depending upon your PC and operating system version. This may mean that the first debug
attempt fails, as the IDE may time out waiting for the booted LPC-Link2 to appear. In such as
case, a second debug attempt should complete successfully. Otherwise, try booting the LPC-
Link2 manually and checking the drivers load correctly.
If you need to reinstall the drivers, then the installer can be found at:
C\nxp\<install _dir>\Drivers\|pc_driver_installer.exe
19.14.6 LPC-Link2 failing to enumerate

On some systems, after booting LPC-Link2 with CMSIS-DAP firmware, the booted debug probe
does not enumerate correctly and the MCUXpresso IDE (or other toolchain) is unable to see the
debug probe. This problem is normally caused by on old, obsolete, version of the VCOM driver
being found by Windows instead of the the correct driver. To see if this is the cause of a problem
on your computer, find the version number of the LPC-Link2 VCOM driver. The obsolete driver
version is 1.0.0.0.
To find the version number of the LPC-Link2 VCOM driver
If you are using a soft-booted LPC-Link2 debug probe, start by booting your LPC-Link2, as
described in . If your LPC-Link2 debug probe is booting from
an image preprogrammed into the flash, you can skip this step.
Once your LPC-Link2 has booted, find the device in Device Manager and look at the driver
version number.
¢ Open the Windows Device Manager
¢ Expand the “Ports (COM and LPT)” section
¢ Right-click on “LPC-Linkll UCom Port”, and select Properties
¢ Click on the Driver tab of the Properties dialog
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File Action View Help
= @ E HE B EXC
A PetePC A
a4 £ o LPC-Linkll UCom Port (COM3) Properties x
i Audio inputs and outputs
@ Batteries General Por Settings Driver Detalls Events
fi| Biometric devices
) Bluetooth ~g LPCLnKI UCom Port (COM3)
® Cameras -
& Computer — .
o Disk diives Driver Provider: ~ NXP
[ Display adapters Driver Date: 211124
¥ Firmware Driver Verson:  2.0.0.0
i Humfan Irlter_face Hievices Digital Signer: NXP Semiconductors USA. Inc.
:i‘; Imaging devices
& Jungo Connectivity
E3 Keyboards View details about the installed driver files.
m Mice and other pointing devices
B Monitors Update Driver Update the driver for this device.
I N T 'y
— 2 Foll Back Driver If the device fails after updating the driver, roll
v R ?__0'15 (COM & LPT) zinkests back to the previously installed driver.
W LPC-Linkll UCom Port (COM3)
Disable Device Disable the device.
i Printers
[ Processors Uninstall Device Uninstall the device from the system (Advanced).
B Security devices
f Software components
B Software devices OK Cancel
il Snund viden and name controllers &

Note: that this image shows the current correct version of the driver (2.0.0.0).

Removing the obsolete 1.0.0.0 LPC-Linkll UCOM driver

To remove the obsolete driver, perform the following actions:

00 ~NO Ol WODN B

9.

. In Device Manager, right-click on the LPC-Linkll UCOM device and select Uninstall

. If there is an option to delete the driver software, make sure it is checked, and press OK

. Select the menu item Action->Scan for hardware changes

. In Windows Control Panel, select Add/Remove program or Uninstall a program option

. Find the LPC Driver Installer, right-click on choose Uninstall

. Let the uninstaller complete

. Switch back to the Device Manager and Scan for hardware changes again

. If the LPC-Linkll UCOM driver version is still present, Uninstall it again (steps 1 through 3) and

repeat until the LPC-Linkll UCOM driver no longer appears
Now run the Ipc_driver_installer.exe found in the MCUXpresso IDE “Drivers” directory

Note: A reboot is recommended after running the Ipc_driver_installer.exe installer.

Now manually reboot the probe again (if softloading) and check Windows — Devices and
Printers to see if the device now appears correctly as an LPC-Link2 CMSIS-DAP VX.XXX.

If this fails to correct the problem, there is one final thing to try:

Open a Command Prompt as the Administrative user and run the following commands

cd % enmp%
pnputil -e >devices.txt

not epad devi ces. t xt
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¢ Search devices.txt for an entry similar to this, and note down the Published name (oemXX.inf)

Publ i shed nane : oenB8. i nf

Driver package provider : NXP

Class : Ports (COM & LPT)

Driver date and version : 09/12/2013 1.0.0.0

Si gner nane : NXP Semi conductors USA. |nc

« Using the name notes above, run the following command (replacing XX with the number found
above)

pnputil -f -d oemXX inf

19.14.7 Troubleshooting LPC-Link2

If you have been able to use LPC-Link2 in a debug session but now see issues such as “No

compatible emulator available” or “Priority O connection to this core already taken” when trying

to perform a debug operation ...

¢ Ensure you have shut down any previous debug session
* You must close a debug session (press the Red ‘terminate’ button) before starting another

debug session

 ltis possible that the debug driver is still running in the background. Use the task manager or
equivalent to kill any tasks called:

« redlinkserv
e arm-none-eabi_gdb*
e crt_emu_*

New in MCUXpresso IDE version 10.2.0 is an IDE button  to kill all low level debug executables.

If your host has never worked with LPC-Link2, then the following may help to identify the problem:

« Try manually booting your LPC-Link2 as per Manually booting LPC-Link2, and ensure that the
drivers have installed correctly.

¢ Try a different USB cable!

e Try a different USB port. If your host has USB3 and USB2, then try a USB2 port
« there are known issues with motherboard USB3 firmware, ensure your host is using the

latest driver from the manufacturer. Note: this is not referencing the host OS driver but the
motherboard firmware of the USB port

« If using a USB hub, first try a direct connection to the host computer

« If using a USB hub, try using one with a separate power supply — rather than relying on the
supply over USB from your PC.

e Try completely removing and re-installing the host device driver. See also

above.

« If using Windows 8.1 or later, then sometimes the Windows USB power settings can cause
problems. For more details use your favourite search engine to search for “windows 8 usb
power settings” or similar.

19.15 Creating bin, hex or S-Record files

When building a project, the MCUXpresso IDE tools create an ARM executable format (AXF) file

—which is actually standard ELF/DWARF file. This file can be programmed directly down to your

target using the MCUXpresso IDE debug functionality, but it may also be converted into a variety

of formats suitable for use in other external tools.
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Simple conversion within the IDE

The simplest way to create a one-off binary or hex file is to open up the Debug (or Release)
folder in Project Explorer right click on the .axf file, and "Binary Utilities->Create binary" (or
Create hex, S-Record).

[5Proje 52 &, Perip ¥} Regis £18ym = O Welcome [¢] bubble.c &3
=] Q:D - 111 PORT_SetPinConfig{I2C_RELEASE_SDA_PORT, I2(
112
¥ (=Debug 113 GPIO_PinInit{I2C_RELEASE_SCL_GPIO, I2C_RELI
F =accel 114 GPIO_PinInit{I2C_RELEASE_SDA_GPIO, I2C_RELI
iy ope: i /* Dri SDA 1 fi imul
> cMSIS 116 rive A low first to simulate a start
Ed : 117 GPIO_WritePinOutput(IZ2C_RELEASE_SDA_GPIO, !
F (= drivers 118 i2c_release_bus_delay();
(= s0Urce 119
b (= startup 120 /* Send 9 pulses on SCL and keep SDA high °
» = utilities 121 for (i =@; 1 = 9; i+4)
123 L7

" frdmk64f_d - -
bbbt Snlli Sl ey P GPIO_WritePinOutput(I2C_RELEASE_SCL_GP!

i2c_release_bus_delay();

frdmk&4f_demo_ap
frdmk64f_demo_ap  Open

£ frdmk64f_demo_ap  Open With p | GPIO_WritePinOutput(I2C_RELEASE_SDA_GP!
frdmkSAi_demo_ap i2c_release_bus_delay();
'_ [{:' Ccpy #C GPIO_WritePinOutput(I2C_RELEASE_SCL_GP!
P Paste i2c_release_bus_delay();
R LRy 3¢ Delete E  i2c_release_bus_delay(D;
. MCUXpresso IDE (Pt  Move...
\_DE ) Rename... F2 Eend stop */
D_WritePinQutput(I2C_RELEASE_SCL_GPIO, !
~ Start here s Import... _release_bus_delay():;
. Mew project... e Expon'" AL R AL L L FTE AP FACE FRA SATA
. Import SDK example(s).. Refresh F5 |
9| " A il il Propertie B Console 33 [ Problem
*® Import project(s) from fili Run As >
A Build 'frdmk64f_ demo_q  Debug As > ble [frdmk64f_demo_apps_bubble]
& Clean ‘frdmk64f demo ; Frofile As > . /board/board.c
, Launch Configurations B | C Compiler
#- Debug 'frdmk641_demo, Smart update p -gcc -std=gnu39 -DCR_INTEGER_PRINTF -DDE
£ | Utilities > ding: ../board/board.c
¥ Edit 'frdmkB4f demo_apbeibs Aol > Create hex
Tools > Create binary
® Quick Settings
D—:" S 3" Run C/C++ Code Analysis Create S-Record
i ! Team > € LinkServer GUI Flash programmer
JB Compare With > Disassemble
Replace With > Size

{mo Build all projects [Debug
. Strip debug symbols
b O S T T Bl sl | Process symdefs file

You can also change the underlying commands and options that are called by these menu entries
from the " Preferences->MCUXpresso IDE ->Utilities" preference page.

From the command line

The above “Binary Utilities” option within the IDE GUI is simply invoking the command line
objcopy tool (arm-none-eabi-objcopy). Objcopy can convert into the following formats:

e srec (Motorola S record format)
e binary

« ihex (Intel hex)

e tekhex

For example, to convert example.axf into binary format, use the following command:
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arm-none-eabi-objcopy -O binary example.axf example.bin

If you ctrl-click on the project name on the right hand side of the bottom bar of the IDE, this will
launch a command prompt in the project directory with appropriate tool paths set up. You can
also use the Project Explorer right-click “Utilities->Open command prompt here” option to do this.

All you need to do before running the objcopy command is change into the directory of the
required Build configuration.

Automatically converting the file during a build

Objcopy may be used to automatically convert an axf file during a build. To do this, create an
appropriate Post-build step

Binary files and checksums

When creating a binary file for most LPC MCUSs, you also need to ensure that you apply a
checksum to it — so that the LPC bootloader sees the image as being valid. Generally the linker
script will do this if the managed linker script mechanism is used. Otherwise the “checksum” utility
found in the \ide\bin subdirectory of your MCUXpresso IDE installation can be used.

Post-build (and Pre-build) steps

It is sometimes useful to be able to automatically post-process your linked application, typically
to run one or more of the GNU ‘binutils’ on the generated AXF file.

For example, any application project that you create using the Project wizard will have least one
such “post-build step” - typically to display the size of your application.

[ ] Post-build steps

Notes:
- A comment character (#) disables ALL FOLLOWING COMMANDS.
- Enter one command per line.
= After editing, commands are concatenated with a ';' separator.

arm-none-eabi-size “${BuildArtifactFileName}"
# arm-none-eabi-objcopy -v -0 binary "${BuildArtifactFileName}" “${BuildArtifactFileBaseName}.bin"
# checksum -p ${TargetChip} -d "${BuildArtifactFileBaseName}.bin"

cancel | (CIEN

Note: Additional commands may also be listed (for example to create a binary and to run a
checksum command), but be commented out by use of a # character and hence not executed.
Any commands following a comment #command will be ignored.

Adding additional steps is very simple. In the below example we are going to carry out three
post-link steps:

« displaying the size of the application
e generate an interleaved C / assembiler listing
» create a hex version of the application image

To do this:
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Open the Project properties. There are a number of ways of doing this. For example, make
sure the Project is highlighted in the Project Explorer view then open the menu “Project ->
Properties”.

In the left-hand list of the Properties window, open “C/C++ Build” and select “Settings”.
Select the “Build steps” tab

In the “Post-build steps - Command” field, click 'Edit..."

» Paste in the lines below and click 'OK'

arm none- eabi -si ze ${Buil dArtifactFil eNane};
ar m none- eabi - obj dunp -S ${Buil dArtifactFileName} > ${Buil dArtifactFileBaseNane}.|ss;
arm none- eabi - obj copy -O ihex ${Buil dArtifactFileName} ${Buil dArtifactFi| eBaseNane}. hex;

Click apply
Repeat for your other Build Configurations (Debug/Release)

Next time you do a build, this set of post-build steps will now run, displaying the application size
in the console, creating you an interleaved C/assembler listing file called .Iss and a hex file called
hex.

Note: Pre-build steps can be added to a project in exactly the same way if required.

Temporarily removing post-build steps

If you want to temporarily remove a step from your post-build process, rather than deleting it
completely — move that entry to the end of the line and pre-fix it with a “#” (hash) character. This
acts as a comment, causing the rest of the post-build steps to be ignored.
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